EJMikroElektronika

SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD . . . vvalivg ik sivnmple

H4}-‘d.:| BB AR BOANS AA e e

T T o—— Y

Develop your applications quickly and easily with the
world's most intuitive mikroBasic PRO for AVR
Microcontrollers.

Highly sophisticated IDE provides the power you need with
the simplicity of a Windows based point-and-click
environment.

With useful implemented tools, many practical code
examples, broad set of built-in routines, and a
comprehensive Help, mikroBasic PRO for AVR makes a
fast and reliable tool, which can satisfy needs of
experienced engineers and beginners alike.
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DISCLAIMER:

mikroBasic PRO for AVR and this manual are owned by mikroElektronika and are pro-
tected by copyright law and international copyright treaty. Therefore, you should treat this
manual like any other copyrighted material (e.g., a book). The manual and the compiler
may not be copied, partially or as a whole without the written consent from the mikroEelk-
tronika. The PDF-edition of the manual can be printed for private or local use, but not for
distribution. Modifying the manual or the compiler is strictly prohibited.

HIGH RISK ACTIVITIES:

The mikroBasic PRO for AVR compiler is not fault-tolerant and is not designed, manufac-
tured or intended for use or resale as on-line control equipment in hazardous environments
requiring fail-safe performance, such as in the operation of nuclear facilities, aircraft navigation
or communication systems, air traffic control, direct life support machines, or weapons sys-
tems, in which the failure of the Software could lead directly to death, personal injury, or severe
physical or environmental damage ("High Risk Activities"). mikroElektronika and its suppliers
specifically disclaim any express or implied warranty of fithess for High Risk Activities.

LICENSE AGREEMENT:

By using the mikroBasic PRO for AVR compiler, you agree to the terms of this agreement.
Only one person may use licensed version of mikroPascal for 8051 compiler at a time.
Copyright © mikroElektronika 2003 - 2009.

This manual covers mikroBasic PRO for AVR version 1.2 and the related topics. Newer
versions may contain changes without prior notice.

COMPILER BUG REPORTS:
The compiler has been carefully tested and debugged. It is, however, not possible to
guarantee a 100 % error free product. If you would like to report a bug, please contact us at
the address office@mikroe.com. Please include next information in your bug report:

- Your operating system

- Version of mikroBasic PRO for AVR

- Code sample

- Description of a bug

CONTACT US:
mikroElektronika

Voice: + 381 (11) 36 28 830
Fax: + 381 (11) 36 28 831
Web: www.mikroe.com
E-mail: office@mikroe.com

Windows is a Registered trademark of Microsoft Corp. All other trade and/or services marks
are the property of the respective owners.
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CHAPTER

Introduction to
mikroBasic PRO for AVR

The mikroBasic PRO for AVR is a powerful, feature-rich development tool for AVR
microcontrollers. It is designed to provide the programmer with the easiest possi-

ble solution to developing applications for embedded systems, without compromis-
ing performance or control.
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mikroBasic PRO for AVR IDE

Features
mikroBasic PRO for AVR allows you to quickly develop and deploy complex applications:

- Write your Basic source code using the built-in Code Editor (Code and Parameter
Assistants, Code Folding, Syntax Highlighting, Spell Checker, Auto Correct, Code
Templates, and more.)

- Use included mikroBasic PRO libraries to dramatically speed up the development:
data acquisition, memory, displays, conversions, communication etc.

- Monitor your program structure, variables, and functions in the Code Explorer.

- Generate commented, human-readable assembly, and standard HEX compatible
with all programmers.

- Inspect program flow and debug executable logic with the integrated Software
Simulator.

- Get detailed reports and graphs: RAM and ROM map, code statistics, assembly
listing, calling tree, and more.

- mikroBasic PRO for AVR provides plenty of examples to expand, develop, and use
as building bricks in your projects. Copy them entirely if you deem fit — that’'s why
we included them with the compiler.
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Where to Start

- In case that you're a beginner in programming AVR microcontrollers, read carefully
the AVR Specifics chapter. It might give you some useful pointers on AVR constraints,
code portability, and good programming practices.

- If you are experienced in Basic programming, you will probably want to consult
mikroBasic PRO for AVR Specifics first. For language issues, you can always refer
to the comprehensive Language Reference. A complete list of included libraries is
available at mikroBasic PRO for AVR Libraries.

- If you are not very experienced in Basic programming, don’t panic! mikroBasic
PRO for AVR provides plenty of examples making it easy for you to go quickly. We
suggest that you first consult Projects and Source Files, and then start browsing
the examples that you're the most interested in.
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MIKROELEKTRONIKA ASSOCIATES LICENSE STATEMENT AND
LIMITED WARRANTY

IMPORTANT - READ CAREFULLY

This license statement and limited warranty constitute a legal agreement (“License
Agreement”) between you (either as an individual or a single entity) and mikroElek-
tronika (“mikroElektronika Associates”) for software product (“Software”) identified
above, including any software, media, and accompanying on-line or printed docu-
mentation.

BY INSTALLING, COPYING, OR OTHERWISE USING SOFTWARE, YOU AGREE
TO BE BOUND BY ALL TERMS AND CONDITIONS OF THE LICENSE
AGREEMENT.

Upon your acceptance of the terms and conditions of the License Agreement,
mikroElektronika Associates grants you the right to use Software in a way provided
below.

This Software is owned by mikroElektronika Associates and is protected by copy-
right law and international copyright treaty. Therefore, you must treat this Software
like any other copyright material (e.g., a book).

You may transfer Software and documentation on a permanent basis provided. You
retain no copies and the recipient agrees to the terms of the License Agreement.
Except as provided in the License Agreement, you may not transfer, rent, lease,
lend, copy, modify, translate, sublicense, time-share or electronically transmit or
receive Software, media or documentation. You acknowledge that Software in the
source code form remains a confidential trade secret of mikroElektronika Associates
and therefore you agree not to modify Software or attempt to reverse engineer,
decompile, or disassemble it, except and only to the extent that such activity is
expressly permitted by applicable law notwithstanding this limitation.

If you have purchased an upgrade version of Software, it constitutes a single prod-
uct with the mikroElektronika Associates software that you upgraded. You may use
the upgrade version of Software only in accordance with the License Agreement.
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LIMITED WARRANTY

Respectfully excepting the Redistributables, which are provided “as is”, without war-
ranty of any kind, mikroElektronika Associates warrants that Software, once updat-
ed and properly used, will perform substantially in accordance with the accompany-
ing documentation, and Software media will be free from defects in materials and
workmanship, for a period of ninety (90) days from the date of receipt. Any implied
warranties on Software are limited to ninety (90) days.

mikroElektronika Associates’ and its suppliers’ entire liability and your exclusive
remedy shall be, at mikroElektronika Associates’ option, either (a) return of the price
paid, or (b) repair or replacement of Software that does not meet mikroElektronika
Associates’ Limited Warranty and which is returned to mikroElektronika Associates
with a copy of your receipt. DO NOT RETURN ANY PRODUCT UNTIL YOU HAVE
CALLED MIKROELEKTRONIKAASSOCIATES FIRST AND OBTAINED A RETURN
AUTHORIZATION NUMBER. This Limited Warranty is void if failure of Software has
resulted from an accident, abuse, or misapplication. Any replacement of Software
will be warranted for the rest of the original warranty period or thirty (30) days,
whichever is longer.

TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW,
MIKROELEKTRONIKA ASSOCIATES AND ITS SUPPLIERS DISCLAIM ALL
OTHER WARRANTIES AND CONDITIONS, EITHER EXPRESSED OR IMPLIED,
INCLUDED, BUT NOT LIMITED TO IMPLIED WARRANTIES OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, TITLE, AND
NON-INFRINGEMENT, WITH REGARD TO SOFTWARE, AND THE PROVISION
OF OR FAILURE TO PROVIDE SUPPORT SERVICES.

IN NO EVENT SHALL MIKROELEKTRONIKA ASSOCIATES OR ITS SUPPLIERS
BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT, OR CONSEQUENTIAL
DAMAGES WHATSOEVER (INCLUDING, WITHOUT LIMITATION, DAMAGES
FOR LOSS OF BUSINESS PROFITS AND BUSINESS INFORMATION, BUSINESS
INTERRUPTION, OR ANY OTHER PECUNIARY LOSS) ARISING OUT OF THE
USE OF OR INABILITY TO USE SOFTWARE PRODUCT OR THE PROVISION OF
OR FAILURE TO PROVIDE SUPPORT SERVICES, EVEN IF
MIKROELEKTRONIKAASSOCIATES HAS BEEN ADVISED OF THE POSSIBILITY
OF SUCH DAMAGES. IN ANY CASE, MIKROELEKTRONIKA ASSOCIATES
ENTIRE LIABILITY UNDER ANY PROVISION OF THIS LICENSE AGREEMENT
SHALL BE LIMITED TO THE AMOUNT ACTUALLY PAID BY YOU FOR
SOFTWARE PRODUCT PROVIDED, HOWEVER, IF YOU HAVE ENTERED INTO
A MIKROELEKTRONIKA ASSOCIATES SUPPORT SERVICES AGREEMENT,
MIKROELEKTRONIKA ASSOCIATES’ ENTIRE LIABILITY REGARDING
SUPPORT SERVICES SHALL BE GOVERNED BY THE TERMS OF THAT
AGREEMENT.

MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD 5



CHAPTER 1
Introduction mikroBasic PRO for AVR

HIGH RISK ACTIVITIES

Software is not fault-tolerant and is not designed, manufactured or intended for use
or resale as on-line control equipment in hazardous environments requiring fail-safe
performance, such as in the operation of nuclear facilities, aircraft navigation or
communication systems, air traffic control, direct life support machines, or weapons
systems, in which the failure of Software could lead directly to death, personal injury,
or severe physical or environmental damage (“High Risk Activities”). mikroElektron-
ika Associates and its suppliers specifically disclaim any expressed or implied war-
ranty of fitness for High Risk Activities.

GENERAL PROVISIONS

This statement may only be modified in writing signed by you and an authorised offi-
cer of mikroElektronika Associates. If any provision of this statement is found void
or unenforceable, the remainder will remain valid and enforceable according to its
terms. If any remedy provided is determined to have failed for its essential purpose,
all limitations of liability and exclusions of damages set forth in the Limited Warran-
ty shall remain in effect.

This statement gives you specific legal rights; you may have others, which vary, from
country to country. mikroElektronika Associates reserves all rights not specifically
granted in this statement.

mikroElektronika
Visegradska 1A,
11000 Belgrade,
Europe.

Phone: + 381 11 36 28 830
Fax: +381 11 36 28 831
Web: www.mikroe.com
E-mail: office@mikroe.com
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TECHNICAL SUPPORT

In case you encounter any problem, you are welcome to our support forums at
www.mikroe.com/forum/. Here, you may also find helpful information, hardware tips,
and practical code snippets. Your comments and suggestions on future develop-
ment of the mikroBasic PRO for AVR are always appreciated — feel free to drop a
note or two on our Wishlist.

In our Knowledge Base www.mikroe.com/en/kb/ you can find the answers to Fre-
quently Asked Questions and solutions to known problems. If you can not find the
solution to your problem in Knowledge Base then report it to Support Desk
www.mikroe.com/en/support/. In this way, we can record and track down bugs more
efficiently, which is in our mutual interest. We respond to every bug report and ques-
tion in a suitable manner, ever improving our technical support.
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HOW TO REGISTER

The latest version of the mikroBasic PRO for AVR is always available for download-
ing from our website. It is a fully functional software libraries, examples, and com-
prehensive help included.

The only limitation of the free version is that it cannot generate hex output over 2
KB. Although it might sound restrictive, this margin allows you to develop practical,
working applications with no thinking of demo limit. If you intend to develop really
complex projects in the mikroBasic PRO for AVR, then you should consider the pos-
sibility of purchasing the license key.

Who Gets the License Key

Buyers of the mikroBasic PRO for AVR are entitled to the license key. After you have
completed the payment procedure, you have an option of registering your mikroBa-
sic PRO. In this way you can generate hex output without any limitations.

How to Get License Key

After you have completed the payment procedure, start the program. Select Help »
How to Register from the drop-down menu or click the How To Register Icon =+ .
Fill out the registration form (figure below), select your distributor, and click the Send
button.

8 MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD
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[7] How Ta Register El (=} @

step 1. Fill in the form below. Please, make sure you fill in all required fields.
Step 2. Make sure that you provided a walid email address in the "EMAIL" edit bax. This email will be used far

sending yvou the activation key,

Step 3. Make sure you select a correct distributar which will rmake the registration process faster. If your
distributor is not on the list then select "Other” and type in distributor's email address in the box below,

Step 4. Press the SEMD button to send key request. A default email client will open with ready-to-send message.
Mote: If email client does not open, you may copy text of the message and paste it manually into 2 new email
message before sending it to vour distributar's email,

IW Marko Jovanovic
IW Enker your address
INVOICE Enter invaice numnber i available in the Form A8485/E6
lm Enter 2CheckOut Order Nurber if available (10 digits)
IW marko@mikyoe, com
IW marko@mikyoe, com
IW Enker commpary name
| PRODUCTID | 515C-557269-6F6D72-5CSE
IW Enter comments on wour arder
[DISTRIBUTOR™

I have made the payment and I wish to request ackivation ke For mikroBasic PR For AYE

* Required fields

Name:
Marko Jovanowvic

Address:

Invoice number:

2CheckOut order number:
Company:

E-Mail:
marko@mikroe. com

Product key:
515C-557269-6F007 2-5C5E

E:Q Copy to clipboard (4 sEND Cancel
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This will start your e-mail client with message ready for sending. Review the infor-
mation you have entered, and add the comment if you deem it necessary. Please,
do not modify the subject line.

Upon receiving and verifying your request, we will send the license key to the e-mail
address you specified in the form.

After Receving the License Key

The license key comes as a small autoextracting file — just start it anywhere on your
computer in order to activate your copy of compiler and remove the demo limit. You
do not need to restart your computer or install any additional components. Also,
there is no need to run the mikroBasic PRO for AVR at the time of activation.

Notes:

- The license key is valid until you format your hard disk. In case you need to format
the hard disk, you should request a new activation key.

- Please keep the activation program in a safe place. Every time you upgrade the
compiler you should start this program again in order to reactivate the license.

10
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The mikroBasic PRO for AVR is an user-friendly and intuitive environment;
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IDE OVERVIEW
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The Code Editor features adjustable Syntax Highlighting, Code Folding, Code
Assistant, Parameters Assistant, Spell Checker, Auto Correct for common typos
and Code Templates (Auto Complete).

The Code Explorer (with Keyboard shortcut browser and Quick Help browser) is at
your disposal for easier project management.

The Project Manager alows multiple project management

General project settings can be made in the Project Settings window

Library manager enables simple handling libraries being used in a project

The Error Window displays all errors detected during compiling and linking.

The source-level Software Simulator lets you debug executable logic step-by-step
by watching the program flow.

- The New Project Wizard is a fast, reliable, and easy way to create a project.

Help files are syntax and context sensitive.

Like in any modern Windows application, you may customize the layout of
mikroBasic PRO for AVR to suit your needs best.

Spell checker underlines identifiers which are unknown to the project. In this way
it helps the programmer to spot potential problems early, much before the project
is compiled.

Spell checker can be disabled by choosing the option in the Preferences dialog (F12).
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MAIN MENU OPTIONS

Available Main Menu options are:

File

Edit

Wiy

Project

Eun

Tools

Help

Related topics: Keyboard shortcuts
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mikroBasic PRO for AVR

FILE MENU OPTIONS

The File menu is the main entry point for manipulation with the source files.

| MewUnit  Crrl+h
& Open Chrl+0
Recent Files »
H zave Chrl+5
H Save As
Ll Close Ctrl+Fe
cem Prink..  ChreP
B Ext Al
File Description
'] Mewlnit ctrl+M |[[Open a new editor window.
2 Open Ctri+3 | Open source file for editing or image file for viewing.
Recent Files * | Reopen recently used file.
H zave Ctri+5 | Save changes for active editor.
B seveas Save the act_ive source file with the different name or
” change the file type.
0 Close alk+F4 | Close active source file.
2= Print..  Ctr+P ||Print Preview.
B Exit Alt+ | Exit IDE.

Related topics: Keyboard shortcuts, File Toolbar, Managing Source Files
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EDIT MENU OPTIONS

<A Undo Ctr+Z
fr Redo shift+Crl+Z
b Cut Chrl+x
.Eé Copy Chrl+C
[E Paste Chrl+y
X Delete

Select Al Chrl+a
42 Eind... Chrl+F
b Find Mext F3
43 Find Previous  Shift+F3
)ﬂ Replace. .. Chrl+R,
9] FindinFies...  Ak+F3
%] Gotoline... Ctrl+G

Advanced 3

File Description
<A Undo Chrl+Z |Undo last change.
fir Redo shift+Ctrl+Z  |Redo last change.
go Cut Ctr4+% |Cut selected text to clipboard.
Ee Copy Ctrl+Z |Copy selected text to clipboard.
T Paste Ctrl+y |Paste text from clipboard.
¥ Delete Delete selected text.
Select Al Ckrl+8  [Select all text in active editor.
22 Find... Chrl+F |Find text in active editor.
)3 Find Mext F3 |Find next occurence of text in active editor.
{}3 Find Previous  Shift+F3 |Find previous occurence of text in active editor.
)H Replace, ., i_trl+R |Replace text in active editor.
Find text in current file, in all i in fi
@ Find In Files...  Alb+F3 _ , opened files, or in files
from desired folder.
+ | Gotoline... Ctrl+5 |Goto to the desired line in active editor.
Advanced » |Advanced Code Editor options

MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD
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mikroBasic PRO for AVR

File

Description

{..}  Comment Shift+Cerl+.

Comment selected code or put single line com-
ment if there is no selection.

—_
——

Uncamment  Shift+Cerl+,

Uncomment selected code or remove single line
comment if there is no selection.

Indent Shifk+CErlH-T

Indent selected code.

Cutdent Shift+CerH4-1

Outdent selected code.

L 2 U {1

Lowercase ctri+alk+L | Changes selected text case to lowercase.

Uppercase Ctrl+alt+0 | Changes selected text case to uppercase.

Titlecase Ctrl+alk+T | Changes selected text case to titlercase.
Find Text

Find Text

Search for:
—Options
Case sensitivity
Whole words anly
Search from caret

Selected text only

Reaqular expression

-
Direction
@ Forward
' Backward
Ok Cancel

Dialog box for searching the document for the specified text. The search is per-
formed in the direction specified. If the string is not found a message is displayed.

16
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Find In Files

Dialog box for searching for a text string in current file, all opened files, or in files on a disk.

The string to search for is specified in the Text to find field. If Search in directories option
is selected, The files to search are specified in the Files mask and Path fields.

Grep search

EX3

—Options

Whole wo

Text to find: | [pallH g = (=4 gl g11 4=}

Case sensitive

Where

rds

_! Current file
' All opened files
@ Search in directories

-

—Search direch

I

ary options

Files mask: *.*

Path: CiWProgram filesh,

nclude subdirectories

QK

Cancel

Go To Line

Dialog box that allows the user to specify the line number at which the cursor should

be positioned.

Go To Line

Go To Line Mube

QK

]
r 1]

Cancel

Regular expressions

By checking this box, you will be able to advance your search, through Regular

expressions.

Find Text
Search for:

—Options
Case sensit

Wrhole word

Search from caret

Selected text only

Ex5)
unsignedyx20int -
Direction
ity @ Forward
s anly
! Backward
oK rancel Related topics: Keyboard shortcuts,
Edit Toolbar, Advanced Edit Toolbar
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VIEW MENU OPTIONS

Toolbars 4

Debug Windows 4
E Routines List

Project Settings

T8 Code Explarer
Project Manager  Chrl+F11

Library Manager

Bookmarks
Messages
Macra Editar
7| Windows
File Description
Toaolbars » | Show/Hide toolbars.
Debug Windows Show/Hide debug windows.
1] Routines List Show/Hide Routine List in active editor.
Praject Settings Show/Hide Project Settings window.
T2 Code Explorer Show/Hide Code Explorer window.

Project Manager Shift+Ctrl+F11 | Show/Hide Project Manager window.

Libraty Manager Show/Hide Library Manager window.

Bookmarks Show/Hide Bookmarks window.

Messages Show/Hide Error Messages window.

Macra Editar Show/Hide Macro Editor window.
Windows Show Window List window.
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mikroBasic PRO for AVR Environment

TOOLBARS
File Toolbar
BN 28 = REE S

File Toolbar is a standard toolbar with following options:

Icon Description

|j Opens a new editor window.

@ ~ |Open source file for editing or image file for viewing.

Save changes for active window.

Save changes in all opened windows.

LD

Close current editor.

k.

Close all editors.

% Print Preview.

Edit Toolbar
A [E

Edit Toolbar is a standard toolbar with following options:

Description

Undo last change.

Redo last change.

Cut selected text to clipboard.

Copy selected text to clipboard.

fwd | | S [ 2 |2 g’

Paste text from clipboard.
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Advanced Edit Toolbar
) S L

Advanced Edit Toolbar comes with following options:

&1
[t

Icon Description

{..; |Comment selected code or put single line comment if there is no selection

i Uncomment selected code or remove single line comment if there is no
i selection.

44 |Select text from starting delimiter to ending delimiter.

Go to ending delimiter.

Go to line.

Indent selected code lines.

Outdent selected code lines.

Generate HTML code suitable for publishing current source code on
the web.

R a2

Find/Replace Toolbar
U&- 06 M q &

Find/Replace Toolbar is a standard toolbar with following options:

Description

Find text in current editor.

Find next occurence.

Find previous occurence.

Replace text.

Find text in files.

B=o ||| §
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Project Toolbar
i 8 s e T Y N

Project Toolbar comes with following options:

Description

Open new project wizard. wizard.

Open Project

Save Project

Add existing project to project group.

Remove existing project from project group.

Add File To Project

Remove File From Project

Close current project.

Build Toolbar

S = NN

Build Toolbar comes with following options:

Icon

Description

B,

Build current project.

Build all opened projects.

-
=

Build and program active project.

Start programmer and load current HEX file.

Open assembly code in editor.

G
T
[ard

View statistics for current project.
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mikroBasic PRO for AVR

Debugger

@;

Eh By w0 #; o0 ol | &8 [F

Debugger Toolbar comes with following options:

&

Icon

Description

Start Software Simulator.

|'_§n 1 Run/Pause debugger.
E—E Stop debugger.
gl ) Step into.
d:'“ Step over.
Step out.

Run to cursor.

Toggle breakpoint.

Toggle breakpoints.

Clear breakpoints.

View watch window

View stopwatch window

Styles Toolbar

Office 2003 Blue |

Office 200
Office 2003 Olive
Office %P
Chocolate
Archic
Sikverfom
Soft zand

[v

Styles toolbar allows you to easily customize your workspace.

22
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Tools Toolbar

IR N =
Tools Toolbar comes with following default options:
Icon Description
EI Run USART Terminal
-:| |EEPROM
A ASCI| Chart

B

Seven segment decoder tool.

The Tools toolbar can easily be customized by adding new tools in Options(F12)

window.

Related topics: Keyboard shortcuts, Integrated Tools, Debugger Windows
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PROJECT MENU OPTIONS

*. Buid Chrl+Fo
4% Buid All Projects Shift+F9
p

Build + Program Chrl4+F11

Edit Search Paths...

Zlean Project Folder. ..

Add File To Project...

Remaove File Fram Project

Teva Project. .. Shift+Ckrl-+Hh

Zpen Project,,.  Shift+Ctrl+o

Open Projeck Group...
lose Project Group

Sawve Projeck As...

Recent Projects 3

(R SH GRG0 e Ge P 5 G T

Close Project
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Environment
Project Description
N Build Ctrl+F3 | Build active project.
A% Buid Al Shift+F3 | Build all projects.
% Evild + Program Ctri+F11 | Build and program active project.
| Wiew Assemnbly View Assembly.

Edit Search Paths. ..

Edit search paths.

Clean Project Faolder. ..

Clean Project Folder

4dd File To Praoject. ..

Add file to project.

Remove File From Project

Remove file from project.

Mews Project, ..

Open New Project Wizard

Open Prajeck,,.  Shift+Cerl+0

Open existing project.

Save Project

Save current project.

Dpen Project Group. ..

Open project group.

Close Project Group

Close project group.

e EEEEEE

Save Projeck As...

Save active project file with the different name.

Recent Projects

Open recently used project.

Close Projeck

Close active project.

Related topics: Keyboard shortcuts, Project Toolbar, Creating New Project, Project

Manager, Project Settings
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RUN MENU OPTIONS

é}; Start Debugger F9

Eﬂa Stop Debugger Chrl+F2

S|} Pauss Debugger Fé&

qxi1 Skep Into F7

d>[] Step Cwer Fg

0 Shep gk Chrl+Fa

@ Jump Ta Interrupt Fz

= | Toaggle Breakpaint FS

i=| Breakpoints Shift+F4

[§, Clear Breakpoints  Shift+Ctrl+FS

& Wakch Window Shift+F3

@-) ‘iews Stopwatch

Disassermbly mode Alk+D
File Description

E%, Start Debugger F2 | Start Software Simulator.
|';=E] Stop Debugger Ckrl+Fz | Stop debugger.
éj_, Pause Debugger Fa |Pause Debugger.
0 Step Into F7 |Step Into.
@, Step Over F5 |Step Over.
(i Skep oot Ctrl+Fg | Step Out.
¥  Jump To Interrupt Fz |Jump to interrupt in current project.
E Toggle Breakpoint FS | Toggle Breakpoint.

8=| Show/Hide Breakpaints  Shift+F4 | Breakpoints.
'8, Clear Breakpoirks  Shift+Ctrl+FS | Clear Breakpoints.
érd” akch wWindow Shift+F5 | Show/Hide Watch Window
{f—} Yiew Stopwatch Show/Hide Stopwatch Window

Disassembly mode Ctri+D | Toggle between Basic source and disassembly.

Related topics: Keyboard shortcuts, Debug Toolbar
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TOOLS MENU OPTIONS

&

mE Prograrnmer Fi1

USART Terminal Chrl4T
EEPRCM Editar

Ascii Chart

Seven Segment Convertor

Export Code To HTRL

LD Cuskom Character

iy GLCD Eitmap Editor

LDP Terminal
& Options F12

Tools Description

% mE Programmer F11 [|Run mikroElektronika Programmer
Bl UsaRT Terminal Ctr+T ||Run USART Terminal
" EEPROM Editar Run EEPROM Editor
A Asci Chart Run ASCII Chart
@' Seven Segment Converkbor Run 7 Segment Display Decoder
1 Export Code To HTHL Generate HTML code suitable for publishing

source code on the web.

Li_D Custom Characker

Generate your own custom Lcd characters

GLCD Bitrmap Edikar

Generate bitmap pictures for Glcd

LIDP Terminal

UDP communication terminal.

=l

Options Flz

Open Options window

Related topics: Keyboard shortcuts, Tools Toolbar
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HELP MENU OPTIONS
@) Help F1

Check For Updates
mikroElekkronika Support Forums
mikroElekkronika Web Page

' How To Reqister

About

File Description
@ Help F1 |Open Help File.
Quick Help.
iCheck For Updates Check if new compiler version is available.

Open mikroElektronika Support Forums in

mikroElekkranika Suppart Forums a default browser.

Open mikroElektronika Web Page in a

mikroElekkranika Web Page default browser.

2 How To Regisker Information on how to register

Shout Open About window.

Related topics: Keyboard shortcuts
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KEYBOARD SHORTCUTS

Below is a complete list of keyboard shortcuts available in mikroBasic PRO for AVR IDE.

You can also view keyboard shortcuts in the Code Explorer window, tab Keyboard.

IDE Shortcuts Ctrl+X Cut

F1 Help Ctrl+Y Delete entire line
Ctrl+N New Unit Ctrl+Z Undo
CtrI+O Open Ctrl+Shift+Z Redo
Ctrl+Shift+O |Open Project Advanced Editor Shortcuts
Ctrl+Shift+N [Open New Project Ctrl+Space Code Assistant
Ctri+K Close Project Ctrl+Shift+Space |Parameters Assistant
Ctrl+F9 Compile CtrI+D Find declaration
Shift+F9 Compile All Ctri+E Incremental Search
Ctrl+F11 Compile and Program Ctrl+L Routine List
Shift+F4 View breakpoints Ctri+G Goto line
Ctrl+Shift+F5 |Clear breakpoints Ctrl+J Insert Code Template
F11 Start AVRFlash Programmer | | Ctrl+Shift+. Comment Code
F12 Preferences Ctrl+Shift+, Uncomment Code

Basic Editor Shortcuts Ctrl+number Goto bookmark
F3 Find, Find Next Ctrl+Shift+number | Set bookmark
Shift+F3 Find Previous Ctrl+Shift+] Indent selection
Alt+F3 Grep Search, Find in Files Ctrl+Shift+U Unindent selection
Ctri+A Select All TAB Indent selection
Ctri+C Copy Shift+TAB Unindent selection
Ctri+F Find Alt+Select Select columns
Ctri+R Replace Ctrl+Alt+Select Select columns
Ctrl+P Print Ctri+Alt+L Convert selection to lowercase
Ctrl+S Save unit Ctrl+Alt+U Convert selection to uppercase
Ctrl+Shift+S | Save All Ctri+Alt+T Convert to Titlecase
Ctri+V Paste

MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD
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Software Simulator Shortcuts

F2 Jump To Interrupt

F4 Run to Cursor

F5 Toggle Breakpoint

F6 Run/Pause Debugger

F7 Step into

F8 Step over

F9 Debug

Ctrl+F2 Reset

Ctrl+F5 Add to Watch List

Ctrl+F8 Step out

Alt+D Dissasembly view

Shift+F5 Open Watch Window
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IDE OVERVIEW

The mikroBasic PRO for AVR is an user-friendly and intuitive environment:

o] e P Fr R iy SToEs
Bt [t View Broject fun Tools Help
e 2 b BCAE=Y PRAPRIA D S W@ S0 AP SE | e L P

2. A b 79 Loy (B o s ot s

13 Code Exioer 52| (1) b

W © Elsub procedure Move belay()
Delay_ms(500)

- Lend sub

Ttz m "EasyAVRSAT
txu3 = “Lodapice
xt4 = “enamplen
Lod_tnie()

Lo Crd (LGD_CLEAR)
Led_c on_CFF)

LED_gut
Delay_ma (2000)
Lad_Cmed (LED_CLEAR)

LED_out (1, 1, tRt1)
LED_Out (2, 4, txtz)
Delay_ms (500}

* Moving text
for 170 to 3
Lod_Cmd (LED_SHIFT_RIGHT)
Move_telay()
next 1

()
el
while TRUE
fax 1-0 ta §
Led_Cod (LCD_SHIFT_LEFT)
Have_telay()
next 1
for -0 to
Led_Cud (LCD_SUIPT_RIGHT)
ave_velay(}
next 1
wena

PC= 0B Cysle= 000

Rt st =

ne: 50 Cman

- The Code Editor features adjustable Syntax Highlighting, Code Folding, Code
Assistant, Parameters Assistant, Spell Checker, Auto Correct for common typos
and Code Templates (Auto Complete).

- The Code Explorer (with Keyboard shortcut browser and Quick Help browser) is at
your disposal for easier project management.

- The Project Manager alows multiple project management

- General project settings can be made in the Project Settings window

- Library manager enables simple handling libraries being used in a project

- The Error Window displays all errors detected during compiling and linking.

- The source-level Software Simulator lets you debug executable logic step-by-step
by watching the program flow.

- The New Project Wizard is a fast, reliable, and easy way to create a project.

- Help files are syntax and context sensitive.

- Like in any modern Windows application, you may customize the layout of
mikroBasic PRO for AVR to suit your needs best.

- Spell checker underlines identifiers which are unknown to the project. In this way
it helps the programmer to spot potential problems early, much before the project
is compiled.

Spell checker can be disabled by choosing the option in the Preferences dialog (F12).
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CUSTOMIZING IDE LAYOUT

Docking Windows

You can increase the viewing and editing space for code, depending on how you
arrange the windows in the IDE.

Step 1: Click the window you want to dock, to give it focus.

[l ETEHEIERYED

4 % LedBlinking.mbpay
47 Sources
P LedBlinking. mbas

{7 Binaries

A7) Project level defines
7] Image Files

id[7) Output Files

Step 2: Drag the tool window from its current location. A guide diamond appears.
The four arrows of the diamond point towards the four edges of the IDE.

32 MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD



CHAPTER 2
mikroBasic PRO for AVR Environment

Step 3: Move the pointer over the corresponding portion of the guide diamond. An
outline of the window appears in the designated area.

Step 4: To dock the window in the position indicated, release the mouse button.

Tip: To move a dockable window without snapping it into place, press CTRL while
dragging it.

Saving Layout

Once you have a window layout that you like, you can save the layout by typing the
name for the layout and pressing the Save Layout Icon E .

To set the layout select the desired layout from the layout drop-down list and click
the Set Layout Icon i

To remove the layout from the drop-down list, select the desired layout from the list
and click the Delete Layout Icon .

<Default Layout:
Code Layout
Debug Layout
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Auto Hide

Auto Hide enables you to see more of your code at one time by minimizing tool win-
dows along the edges of the IDE when not in use.

- Click the window you want to keep visible to give it focus.
- Click the Pushpin lcon L on the title bar of the window.

- H
[l ]
ﬂ Praject Manager E]
BN E S - = o
E =l Sm—"
A-{j':‘_j FirstProject.mbpay E_E E Project Mana § 5=
4 -] Sources i = [ 5 -
E] SecondProject.mbas |. |_|% 'ig %_ .
=1 Binaries 4 4 131-, FirstPro % b2 5| =
1 Project level defines EEEEE NS 4407 E_IDLII"I % o
=1 Imange Files B % Tl %.
1 Oubput Files 1 Binarf] = 2
=) Other Files [ Proje =
1 Imag E
] Qutp @
Illlllllllllllliﬂlllill* _l Othe
IIIIIIIIIIIIIIIIIIIII*

When an auto-hidden window loses focus, it automatically slides back to its tab on
the edge of the IDE. While a window is auto-hidden, its name and icon are visible
on a tab at the edge of the IDE. To display an auto-hidden window, move your point-
er over the tab. The window slides back into view and is ready for use.
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ADVANCED CODE EDITOR

The Code Editor is advanced text editor fashioned to satisfy needs of professionals.
General code editing is the same as working with any standard text-editor, including
familiar Copy, Paste and Undo actions, common for Windows environment.

Advanced Editor Features

- Adjustable Syntax Highlighting

- Code Assistant

- Code Folding

- Parameter Assistant

- Code Templates (Auto Complete)
- Auto Correct for common typos

- Spell Checker

- Bookmarks and Goto Line

- Comment / Uncomment

You can configure the Syntax Highlighting, Code Templates and Auto Correct from
the Editor Settings dialog. To access the Settings, click Tools » Options from the
drop-down menu, click the Show Options Icon g or press F12 key.
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’epf-ons |
Editor Settings

Project Files
¥ Restore Last Opened Project Restore All Opened Files
V' Save Breakpoints ¥ Save Bookmarks

[IF Opened File Is Externally Modified

) Prompt for action @ Reload file, but do nat prompt ) Ignaore externaly made changes
Auto Save

W Enable Auto Save Tirneout Interval: 3 minutes

Highlighter

Highlight begin. .end pairs
' Highlight brackets

Spelling

W Check Spelling

Comment skyl
@ poy

@ fi tsingle line)

Advanced Editar Options

E Open options diglog

Code Folding
¥ Enable code folding

Show Ident Guides

K Apply Cancel

Code Assistant

If you type the first few letters of a word and then press Ctrl+Space, all valid identi-
fiers matching the letters you have typed will be prompted in a floating panel (see
the image below). Now you can keep typing to narrow the choice, or you can select
one from the list using the keyboard arrows and Enter.

wanable  sfr unzigned char SP

varable  sfr unzigned char SPDR
variable  sfr unsigned char SPSR
variable  sfr unzsigned char SPCR

36
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Code Folding

Code folding is IDE feature which allows users to selectively hide and display sec-
tions of a source file. In this way it is easier to manage large regions of code within
one window, while still viewing only those subsections of the code that are relevant
during a particular editing session.

While typing, the code folding symbols (|- and || ) appear automatically. Use the
folding symbols to hide/unhide the code subsections.

%main:

FCORTAL u}
FCORTE u}

Led Indit ()

LCD out(l,1,exc[0]]
LCD out(Z,1,txt[1]]
delay ms(1000)

Lod Cmd(1)

LCD out(l,1,txt[1]]
LCD Out(z,4,ext[z2]]
delay_ms(500)

end.

main: El

If you place a mouse cursor over the tooltip box, the collapsed text will be shown in
a tooltip style box.

main: '__|\|,)

main e
PORTA = O
PORTE = O
Led Init()

LCD_oOut(1,1,t=xt[0])
LCD_oOut (2,1,txt[1]])
delay ms({1000)

Lod Cmd (1)

LCD_oOut(1,1,t=xt[1]])
LCD_oOut (2,4, txt[2])
delay ms (500)

end.
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Parameter Assistant

The Parameter Assistant will be automatically invoked when you open parenthesis
“(” or press Shift+Ctrl+Space. If the name of a valid function precedes the parenthe-
sis, then the expected parameters will be displayed in a floating panel. As you type
the actual parameter, the next expected parameter will become bold.

channel : byte
ADC Res

Code Templates (Auto Complete)

You can insert the Code Template by typing the name of the template (for instance,
whiles), then press Ctrl+J and the Code Editor will automatically generate a code.

You can add your own templates to the list. Select Tools » Options from the drop-
down menu, or click the Show Options Icon and then select the Auto Complete Tab.
Here you can enter the appropriate keyword, description and code of your template.

Autocomplete macros can retreive system and project information:

- $DATES - current system date

- $TIMES - current system time

- ¢DEVICES - device(MCU) name as specified in project settings
- $DEVICE CLOCK: - clock as specified in project settings

- $COMPILERS - current compiler version

These macros can be used in template code, see template ptemplate provided with
mikroBasic PRO for AVR installation.

Auto Correct

The Auto Correct feature corrects common typing mistakes. To access the list of rec-
ognized typos, select Tools » Options from the drop-down menu, or click the Show
Options Icon &' and then select the Auto Correct Tab. You can also add your own
preferences to the list.

Also, the Code Editor has a feature to comment or uncomment the selected code by sim-
ple click of a mouse, using the Comment Icon {.} and Uncomment Icon !.. from the
Code Toolbar.
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Spell Checker

The Spell Checker underlines unknown objects in the code, so it can be easily
noticed and corrected before compiling your project.

Select Tools » Options from the drop-down menu, or click the Show Options Icon
&/ and then select the Spell Checker Tab.

Bookmarks

Bookmarks make navigation through a large code easier. To set a bookmark, use
Ctrl+Shift+number. To jump to a bookmark, use Ctrl+number.

Goto Line

The Goto Line option makes navigation through a large code easier. Use the short-
cut Ctrl+G to activate this option.

Comment / Uncomment

Also, the Code Editor has a feature to comment or uncomment the selected code by sim-
ple click of a mouse, using the Comment Icon {..} | and Uncomment Icon ;.1 | from the
Code Toolbar.
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CODE EXPLORER

The Code Explorer gives clear view of each item declared inside the source code.
You can jump to a declaration of any item by right clicking it. Also, besides the list of
defined and declared objects, code explorer displays message about first error and
it's location in code.

Code Explorer 2]
=L
QUses
4 Wmain
- @ LCD_RS
- @ LCD_EM
o LCD_D4
- @ LCD_DS
o LCD_D&
- @ LCD_D7
@ LCD_RS_Direction
- @ LCD_EM_Direction
@ LCD_Dd_Direction
- @ LCD_D5_Direction
@ LCD_De_Direction
@ LCD_D7_Direction
B tatl
S v
Ll #sac]
Sl ar |
B
GMDVE_DBlaY

Following options are available in the Code Explorer:

Icon Description

‘Eg} Expand/Collapse all nodes in tree.

e Locate declaration in code.

40 MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD



CHAPTER 2

mikroBasic PRO for AVR Environment

@ Tore1
- @Tone:

{ Sound_Play_Pin
| ® Sound_Play_Pin_diraction

ROUTINE LIST

Routine list diplays list of routines, and enables filtering routines by name. Routine
list window can be accessed by pressing Ctrl+L.

You can jump to a desired routine by double clicking on it.

i

riae e melony mvelow neuser i S |

i

i

Erites 1cuting 1ot L fites e kit

i

§e%

i

RSG5
Software,
software,
E
‘Souned
SPLGked
SPELed
5P Ldd
LT
e
TEIAC
T
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"

1029
13107 (91%)
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PROJECT MANAGER

Project Manager is IDE feature which allows users to manage multiple projects.
Several projects which together make project group may be open at the same time.
Only one of them may be active at the moment.

Setting project in active mode is performed by double click on the desired project
in the Project Manager.

Project Manager =]
Wy || B | R 3 o | | | B
Aﬁl‘ LedBlinking.mbpay
4|7 Sources
E] LedBlinking.mbas
1 Binaries
1 Praject level defines
1 Image Files
4| Qutput Files
% LedBlinking. hex
2= Ledblinking, asm
g LedBlinking. |st
1 Other Files

Following options are available in the Project Manager:

Icon Description

Save project Group.

Open project group.

Close the active project.

Close project group.

Add project to the project group.

Remove project from the project group.

Add file to the active project.

Remove selected file from the project.

Build the active project.

| | | e | 0 D |OB| 8| 038 | P

Run mikroElektronika's Flash programmer.

For details about adding and removing files from project see Add/Remove Files from
Project.

Related topics: Project Settings, Project Menu Options, File Menu Options, Project
Toolbar, Build Toolbar, Add/Remove Files from Project
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PROJECT SETTINGS WINDOW

Following options are available in the Project Settings Window:

- Device - select the appropriate device from the device drop-down list.
- Oscillator - enter the oscillator frequency value.

Project Settings &l
Name: | ATMEGALS -

=4 Oscillator _
Value: | 10.000000 | MHz

Related topics: Project Manager
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LIBRARY MANAGER

Library Manager enables simple handling libraries being used in a project. Library
Manager window lists all libraries (extencion .mc1) which are instantly stored in the
compiler Uses folder. The desirable library is added to the project by selecting check
box next to the library name.

In order to have all library functions accessible, simply press the button Check All
"] and all libraries will be selected. In case none library is needed in a project,
press the button Clear All | and all libraries will be cleared from the project.
Only the selected libraries will be linked.

Library banager [

> [] Amc

> [7] Butkon

Ol _Type

- [¥] cam_sPI

- [] Compact_Flash_FaT16
> [T] Compact_Flash
> [7] Conversions

- [ EEFROM

> (] FLASH

L[] Gled_Fants

> [¥] @led

> [0 kevpaddxd
&[T Led_Constants
> [ Led

> [] Manchesker

- [ Mmc_FaT16

> (] Mmne

> 0] One_Wire

- [¥] Part_Expandsr
> [ P2

> [C] P

> (] Peet

- [ rs4as

> [7] software_I2C
> [7] Software_SPI
> [7] Software_UART
> [0 sound

> ] 5P1_sled

> ] 5PT_Led

> [] SPI_Leds

> [¥] SPT_TR963C

> (] Te963C

> (] Time:

> [T] Trigonometry

- (] Tt
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Icon Description

Refresh Library by scanning files in "Uses" folder.Useful when new
libraries are added by copying files to "Uses" folder.

Rebuild all available libraries. Useful when library sources are available and
need refreshing.

No libraries from the list will be included in current project.

K
=
A
|_] Include all available libraries in current project.
L]

Restore library to the state just before last project saving.

Related topics: mikroBasic PRO for AVR Libraries, Creating New Library

MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD 45



CHAPTER 2
Environment mikroBasic PRO for AVR

ERROR WINDOW

In case that errors were encountered during compiling, the compiler will report them
and won’t generate a hex file. The Error Window will be prompted at the bottom of
the main window by default.

The Error Window is located under message tab, and displays location and type of
errors the compiler has encountered. The compiler also reports warnings, but these
do not affect the output; only errors can interefere with the generation of hex.

Messages E
Errors Warnings Hints
Line Message Mo, Message Text Unik:
a 1 mBAYR. exe -DBG -pATMEGALS -MSF =¥ -DL -0,
o 132 Compilation Started C:\PROGRAM FILES\MIKROELEKTRONIKANMIKROBASIC PRO FOR AYR\EXAMPLES\WOTHER|SOUND. ..
42 303 Identifier "Tone2" was not declared Sound, mbas
42 304 Syntax errar: Expected "end” but "Tone2" found  Sound.mbas
42 304 Syntax errar: Expected "sub" but "{" Found Sound.mbas
42 304 Syntax error: Expected "end” but ") found Sound.mbas
4z 304 Synkax error: Expected ™" but "Tones" found Sound.mbas
1] 102 Finished (with errors): 29 Nov 2008, 09:23:26 Sound.mbpay

Double click the message line in the Error Window to highlight the line where the
error was encountered.

Related topics: Error Messages
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STATISTICS

After successful compilation, you can review statistics of your code. Click the Statis-
tics Icon [ | -

Memory Usage Windows

Provides overview of RAM and ROM usage in the form of histogram.
RAM Memory

Rx Memory Space

Displays Rx memory space usage in form of histogram.

Statistics
4 - Memory Usage
4 RaM

Rénd hiemory Usage (locations)

16 Free RxData RAM
16 Uzed RxData RAM

4 - Procedures
- Gize
.. Locations
- HTML

Free RxData RAM Used RxData Ram
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Data Memory Space

Displays Data memory space usage in form of histogram.

4 - Memary Uzage
- RAM

R ata
SFR 9 Used data RAM
GPR
4-ROM
. ROM &llacation
4 - Procedures
- Size
‘.. Logations

Special Function Registers

Summarizes all Special Function Registers and their addresses.

4 - Memary Uzage
4 RaM Special function registers [SFR)
RxData
%ﬁ Address Feqister
SFR 0x00
GPF 0401 R

4 ROM
* ROM Allacation D402 A2
0403 R3

4 - Procedures

- Sige 004 R4

*- Loeations 0x05 R5
- HTHL (3 R
007 R7
008 R&
0x09 R3
Ox04 R10
0x0B R11
0x0C Riz2
000 R13
0:0E R14
0x0F R15
0x10 R16
0x11 R17
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General Purpose Registers

Summarizes all General Purpose Registers and their addresses. Also displays sym-
bolic names of variables and their addresses.

Statistics
4 - Memary Uzage 1l
- RAM General purpose registers [GPR)
Address Register a |
0460 E
052 DefDevicedddress  [_Lib_SPIGled_DefDevicedddiess)
063 spifontyy’  [_Lib SPIGlcd_spifantiy]
0xE4 spifontH  [__Lib_SPIGlcd_spifontH]
. 065 spifontDef  [_spifantDef]
i Locations OHE7 SpiRd P [_Spi_Rd_Ph
- HTML Inaccessible | color [FARG_SPL_Gled H_Linesd)
Inaccessible loc  [SPI_Gled_H_Line_loc_L0O]
Inaccessible # pos  [FARG_SPI_Gled_H_Line+2]
Inaccessible w_start  [FARG_SPI_Gled_H_Line+0)
Inaccessible w end  [FARG_SPI_Glcd_H_Line+1)
Inaccessible data_out [FARG_SPN_Read+0)
Inaccessible color  [FARG_SPI_Gled v _Line+3)
Inaccessible loc  [SPI_Gled *_Line_loc_LO)
Inaccessible w_pos  [FARG_SPI_Gled_Y_Line+2)
Inaccessible p start  [FARG_SPI_Glcd_V_Line+0)
Inaccessible pend  [FARG_SPI_Gled W_Line+1] |
Inaccessible Plstr]_SPI_Gled -
ROM Memory

ROM Memory Usage

Displays ROM memory usage in form of histogram.

Statistics
4 - Memom Usage I
ROM Memary Usage (hytes)

4,600 Free RO
9,734 Uzed ROM

4 ROM
- ROM Allocation
4 - Procedures
Sz
- Locations
HTHL

Free RO Used RO

MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD 49



CHAPTER 2

Environment

mikroBasic PRO for AVR

ROM Memory Allocation

Displays ROM memory allocation.

Statistics

4 - Memary Uzage
4 RAM

| -RuData
- Data
SFR

| ROM Allacation
4 - Procedures

i Size

- Lacations
- HTML

0x0000  Ox0C342Z5
0x0004  O0x0CS400
0x0008  O0x0CS400
0x000C  O0x0CS400
0x0010  0x0C3400
0x0014 0x0C2400
0x0015 0=x0C3400
0x001C  O0x0CS400
0x0020  O0x0CS400
0x0024  O0x0CS400
0x0022  0x0C3400
0x00zZC  0x0C2400
0x0030  0x0C2400
0x0034  O0x0CS400
0x0038  0x0CS400
0x003C  O0x0CS400
0x0040  0x0C3400
0x0044 0Ox0C3400
0x0045 0x0C3400
0x004C  0x0C2400
0x0050  O0x0CS400
Ox15FZ OxEZZES

0x1E5F4 0Ox1BEF

0x1EFE  Ox00EOQ

0x15F5 0O=x0A435

Ox15FA OxFLF7

Ox15FC OxlASE

Fi

»

Procedures Windows

Provides overview procedures locations and

Procedures Size Window

Displays size of each procedure.

sizes.

Statistics

4 - Memary Uzage
PREY
-~ RaData
- Data
- 5FR
- GPR
ROM
- ROM llacation
4 - Procedures
! Size

Locations
- HTML

Delay_1us
Hihul_16x16
SPH_Read
Expander_Read_Ports
Expander_Set_DirectionPortB
Expander_Wirite_PortB
SPH _Init_Sdvanced
SPI_Gled_Y_Line
SPlL_Glod_Set Page
SP|_Strobe
SPI_Glod_Set_Side
Expancer_Wiite_Byte
SPI_Glcd_Rectangle
SPI_Glod_Read_Data
SPI_Gled_Fil

SP|_Glod mage
SPI_Gled_Line

main

ROM usage by procedure (ROM locations)

T T
200 300
ROM locations
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Procedures Locations Window

Displays how functions are distributed in microcontroller’'s memory.

4 - Memory Usage

- ROM Allacation
4 - Procedures

Size

.. Locations |
“ HTML

HTML Window

Display statistics in default web browser.

4 - Memory Usage

- ROM Allacation
4 - Procedures

Size

- Locations
~ HTML

You can generate statistics in HTML format too. it is suitable for printing and for documenting your
project.

Press the button bellow to generate HTML statistics and to open them in the default web browser

i HTML statistics
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INTEGRATED TOOLS

USART Terminal

The mikroBasic PRO for AVR includes the USART communication terminal for
RS232 communication. You can launch it from the drop-down menu Tools » USART
Terminal or by clicking the USART Terminal Icon = from Tools toolbar.

R5232 Terminal =]

rSettings —Communication

o] it ; Echo seadl 'E?I;'
Baud: [%DD 'l append: [ CR send as typing m
Stop Bits: | ONe Stop Bit v

LF Send as number al Hist
. ear Histo
Parity: [N':'”E 'l _ SEe
Check Parity F‘:ecewe data as - -
_ : @ ASCII ") HE= ) DEC
Data bits: [Elght vl
~Cemmands Connected to COM3 -
RIS LTR Sent Echo
@ Off @ Off
on on
Copnect [ Ll CoRReEk
—Status

Send FReceive CTS DSR
L+ L+ L+ L+

—Log Files

=)
Read fram:
Write to:

W Append to W Create file
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ASCII Chart

The ASCII Chart is a handy tool, particularly useful when working with Lcd display.

You can launch it from the drop-down menu Tools > ASCII chart or by clicking the
View ASCII Chart Icon

from Tools toolbar.

Ascii Chart
1] 1 2 3 4 5 6 7 8 9 A B [H D E F
0 NUL 50H S5TX ETX EOT ENQ ACK BEL | BS HT LF YT  FF CR |50  5I
0 1 2 3 4 5 £ 7 5 9 1 |11 |12 |13 | 14 | 15
4 |PLE DC1 DC2 DC3 DC4 NAK SYN ETB CAN EM SUB ESC FS GS RS US
16 | 17 |15 |19 | 20 |21 |22 | 23 | 24 | 25 |26 | 27 |28 | 29 | 30 | 31
s [8PC Y " #§ % R /
32 | 33 | 34 35 | 36 | 37 | 33 39 40 | 41 | 42 | 43 | 44 | 45 | 46 | 47
3 1] 1 2 3 4 5 3] 7 8 9 H H < = > ?
43 | 49 | S0 | 51 | 52 | 53 | 54 |55 | 56 | 57 | 53 59 | &0 | 61 | 62 | B3
4 m A B C D E F G H 1 ] K L M1 M ]
& | 65 | 66 | BF | &3 | 69 | 7D | 7l | F2 | F3 | 74 VS | Ve | FP |7 79
s [P|Q|R|S|T U |V W x ¥ 2| [(\N[]1[~]_
B0 | 81 | 82 | 83 | 84 | 85 | =6 92 | 93 | 94 | 95
6 N a b ¢ d e f | m ©n O
9 | 97 | 95 | 99 | 100 | 101 | 102 108 | 109 | 110 | 111
7 P q r s t u v | ¥ ~ DEL
112 | 113 | 114 | 115 | 116 | 117 | 118 124 | 125 | 128 | 127
8 € ’ F 1 t E 2
128 | 129 | 130 | 131 | 132 | 133 | 134 | 135 | 136 | 137 | 135 | 139 | 140 | 141 | 142 | 143
1 » u » - _ _ - T H y o= 3 ili
9
144 | 145 | 146 | 147 | 148 | 149 | 150 | 151 | 152 | 153 | 154 | 155 | 156 | 157 | 158 | 159
A i ¢ | £ | o | ¥ i § |7 @3« a2 - @
160 | 161 | 162 | 163 | 164 | 165 | 166 | 167 | 168 | 169 | 170 | 171 | 172 | 173 | 174 | 175
B @ + 2 3 i H L] . R 1 o wo Vg Ve | 3 | £
176 | 177 | 175 | 179 | 150 | 181 | 132 | 183 | 154 | 185 | 136 | 187 | 183 | 189 | 190 | 191
C A A A A A A E C E E E E I 1 I I
192 | 193 | 194 | 195 | 196 | 197 | 195 | 199 | 200 | 201 | 202 | 203 | 204 | 205 | 208 | 207
D b N 0 0 0 n} 0 ® @ u u u u Y u] n
205 | 209 | 210 | 211 | 212 | 213 | 214 | 215 | 216 | 217 | 218 | 219 | 220 | 221 | 222 | 223
E 4 ala a a|/éd a ¢ e 5 & | 8 i i i )
224 | 225 | 2e6 | 227 | 225 | 229 | 230 | 231 | 232 | 233 | 234 | 235 | 236 | 237 | 238 | 239
F a f o o6 |6 |06 6 + e 0 a0 aly|p ¢
240 | 241 | 242 | 243 | 244 | 245 | 246 | 247 | 245 | 249 | 250 | 251 | 252 | 253 | 254 | 255
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EEPROM Editor

The EEPROM Editor is used for manipulating MCU's EEPROM memory. You can
launch it from the drop-down menu Tools » EEPROM Editor. When Use this
EEPROM definition is checked compiler will generate Intel hex file
project name.ihex that contains data from EEPROM editor.

When you run mikroElektronika programmer software from mikroBasic PRO for AVR
IDE - project name.hex file will be loaded automatically while ihex file must be
loaded manually.

mikraElektronika EEFROM Tool |
=/ ——
& / - E E PROM Editor [Tl use Eeprom in project Help
Device: EEPROM Size: EEPROM Fill: EEPROM File

Custom = vislzB‘ftes ¥alue: Ox FF | Fill | | Load | | Save |

EEPROM Data

[IE) FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF PV RV
[IEl rF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF PR

[T}{) FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF ST RV

[L[1) FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF PEVRR PRI

[T} FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF YRRV -
EEPROM Edit:

Input Format: Edit Yalue:

D EEPROM Address: T

| Dec Hex No: O Edit

@ Hex Start Address: 0% FFFF

: Float 7l Size:

= o_a ¥] AutoInc | Byte ) Word @ DWord

) String
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7 Segment Display Decoder

The 7 Segment Display Decoder is a convenient visual panel which returns deci-
mal/hex value for any viable combination you would like to display on 7seg. Click on
the parts of 7 segment image to get the requested value in the edit boxes. You can
launch it from the drop-down menu Tools » 7 Segment Decoder or by clicking the
Seven Segment Icon E from Tools toolbar.

Seven Segrent Editor ]

Cormmon cathode:
071

Common anode:
Decoding Format:
' Decimal
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UDP Terminal

The mikroBasic PRO for AVR includes the UDP Terminal. You can launch it from the
drop-down menu Tools » UDP Terminal.

$5) UDP Communication Terminal @

Settings
IP Address: [192.166.20 25

Eart; |1 o001

Send:

| mikroElektronika Send

Append: [ CR [~ Send as typing
[ LF [ Send as number

mikroE lektronika

Receive

f* ASCII " HEX " DEC

Clear
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Graphic Lcd Bitmap Editor

The mikroBasic PRO for AVR includes the Graphic Lcd Bitmap Editor. Output is the
mikroBasic PRO for AVR compatible code. You can launch it from the drop-down
menu Tools > Glcd Bitmap Editor.

mikroElektronika Graphic LCD Bitmap generator
{KSO0T087 | Teg63 | Mokiaz110|

File loaded: truck.bmp

Pickure preview — 12&x64 pix [ bw
[ LosdBMPpicture |

[ Create CODE |

[ irwertPIcTURE |

GLCD Size | controller

s
/7 GLCD Picture name: truck.bmp
/7 GLCD Model: KS@168 128xhd

s

m| »

Copy COLE ko Clipboard

conat truckﬁhmp g aEray[1824] of hyte =

<

- - - o 8. 8. 8. 8, 8 8, 12, 12, 12, 12.

12, 18, 19, 18, 18, 18, 18, 9, 9. 9. 2. 9, 9. 9. %, 9,

9. 9. 9. 9. 9, 9, - 9. 9. 9.137.137.137.437.137,.137,
137.137,137.137.137.137.137,. 2. 2, 2. 2. 2. 9. 9. %?. 2.

9. 9. 13,253, 13,195, 6.252, @, @. 8. @, B, B, B, O,

. B, 8, 6, A, B, @, A, @, B, A, 8. B, A, @, B8, -

ver: 2.0.1 - 27012005 System status: Win NT like 05
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Lcd Custom Character

mikroBasic PRO for AVR includes the Lcd Custom Character. Output is mikroBasic
PRO for AVR compatible code. You can launch it from the drop-down menu Tools >
Lcd Custom Character.

| LCD custom character =] ® s
u e % & -
AR ¢
5x7 B=x10 | Save... Load.. | Fill all Clear all Invert

Fresview:

B %10+ curzon line -

CGRAM address:

Char: ID 5‘
I 5‘

Char data row:

GENERATE |
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MACRO EDITOR

A macro is a series of keystrokes that have been 'recorded' in the order performed.
A macro allows you to 'record' a series of keystrokes and then 'playback’, or repeat,
the recorded keystrokes.

Macros =)
< P2 |2 &

Mame

Macrod

] 1] | 3

The Macro offers the following commands:

Icon Description

ﬁ?ﬂ Starts 'recording’ keystrokes for later playback.

Stops capturing keystrokesthat was started when the Start Recordig com-
d? mand was selected.

[;%53 Allows a macro that has been recorded to be replayed.
_9? New macro.
@ Delete macro.

Related topics: Advanced Code Editor, Code Templates
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OPTIONS

Options menu consists of three tabs: Code Editor, Tools and Output settings
Code editor

The Code Editor is advanced text editor fashioned to satisfy needs of professionals.
Tools

The mikroBasic PRO for AVR includes the Tools tab, which enables the use of short-

cuts to external programs, like Calculator or Notepad.
You can set up to 10 different shortcuts, by editing ToolO - Tool9.

Toal Name: ToolD

File Name: Press button to open file dislog

Parameters:

Macro: S.HEX FILE_NAME Fullpath and neme.of the out... v | Insert

Shorteut: F11 -

| ¥ Clear 2l fields

Output
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Output settings

By modifying Output Settings, user can configure the content of the output files.

You can enable or disable, for example, generation of ASM and List file.

Also, user can choose optimization level, and compiler specific settings, which
include case sensitivity, dynamic link for string literals setting (described in mikroBa-
sic PRO for AVR specifics).

Build all files as library enables user to use compiled library ( .mc1) on any AVR
MCU (when this box is checked), or for a selected AVR MCU (when this box is left

unchecked).

For more information on creating new libraries, see Creating New Library.

Options

Dutput

Qutput Settings

¥ Generate ASM file
¥ Include HEX oprodes
¥ Include ROM constants
¥ Include ROM Addresses

V' Generate lisk File

¥ Include debug info

¥ Include source lines in output files

Optimization level:

Four A2

Campiler

W Case sensitive
WV Dynamic link For string literals

W Build all files as library

QK

Apply

Cancel

MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD 61



CHAPTER 2
Environment mikroBasic PRO for AVR

REGULAR EXPRESSIONS
Introduction

Regular Expressions are a widely-used method of specifying patterns of text to
search for. Special metacharacters allow you to specify, for instance, that a particu-
lar string you are looking for, occurs at the beginning, or end of a line, or contains n
recurrences of a certain character.

Simple matches

Any single character matches itself, unless it is a metacharacter with a special
meaning described below. A series of characters matches that series of characters
in the target string, so the pattern "short" would match "short" in the target string.
You can cause characters that normally function as metacharacters or escape
sequences to be interpreted by preceding them with a backslash "\ .

For instance, metacharacter "~ matches beginning of string, but "\ " matches
character "~", and "\\ " matches "\ ", etc.

Examples :

unsigned matches string 'unsigned’
\ “unsigned matches string '“unsigned’

Escape sequences

Characters may be specified using a escape sequences: "\ n" matches a newline,
"\ t" a tab, etc. More generally, \ xnn, where nn is a string of hexadecimal digits,
matches the character whose ASCII value is nn.

If you need wide (Unicode) character code, you can use '\ x{ nnnn} ', where 'nnnn'
- one or more hexadecimal digits.

-\ xnn - char with hex code nn

-\ x{ nnnn) - char with hex code nnnn (one byte for plain text and two bytes
for Unicode)

-\t - tab (HT/TAB), same as \ x09

-\ n - newline (NL), same as \ x0a

-\ r - car.return (CR), same as \x0d

-\ f - form feed (FF), same as \ x0c

-\ a - alarm (bell) (BEL), same as \ x07

-\e - escape (ESC), same as \ x1b

Examples:

unsigned\x20int matches 'unsigned int' (note space in the middle)
\ tunsigned matches 'unsigned' (predecessed by tab)
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Character classes

You can specify a character class, by enclosing a list of characters in [], which will
match any of the characters from the list. If the first character after the "[" is "*", the
class matches any character not in the list.

Examples:
count[ aeiou] r finds strings 'countar', 'counter', etc. but not
'countbr', 'countcr', etc.
count[ “aeiou] r finds strings 'countbr', 'countcr', etc. but not
'countar', ‘'counter', etc.

Within a list, the "~ character is used to specify a range, so that a-z represents all
characters between "a" and "z", inclusive.

If you want "-" itself to be a member of a class, put it at the start or end of the list,
or precede it with a backslash.
If you want '] ', you may place it at the start of list or precede it with a backslash.
Examples:
az] matches 'a', 'z'and '-'
az-] matches 'a', 'z' and '’
a\-z] matches '2', 'z'and '-'

[ -
[
[
[ a-z] matches all twenty six small characters from 'z" to 'z
[\n-\x0D] matches any of #10,#11,#12,#13.

[ \d-t] matches any digit, '-' or 't'.
[ 1 -a] matches any charfrom '] '..'a".

Metacharacters

Metacharacters are special characters which are the essence of regular expres-
sions. There are different types of metacharacters, described below.

Metacharacters - Line separators

~ - start of line

$ - end of line

\ A - start of text

\ z - end of text

. - any character in line
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Examples:

~PORTA - matches string ' POrRT2 ' only if it's at the beginning of line
PORTAS - matches string ' rorT2 ' only if it's at the end of line
~PORTAS - matches string ' porT2 ' only if it's the only string in line
PORT. r - matches strings like 'porT2", 'PORTB', 'PORT1" and so on

The "~ metacharacter by default is only guaranteed to match beginning of the input
string/text, and the "s" metacharacter only at the end. Embedded line separators
will not be matched by ~" or "s".

You may, however, wish to treat a string as a multi-line buffer, such that the "~ will
match after any line separator within the string, and s will match before any line
separator.

Regular expressions works with line separators as recommended at http://www.uni-
code.org/unicode/reports/tr18/

Metacharacters - Predefined classes

\'w - an alphanumeric character (including " ")
\ W - a nonalphanumeric character

\ d - a numeric character

\ D - a non-numeric character

\'s - any space (same as [\ t\n\r\f])

\'S - a non space

You may use \w, \dand \s within custom character classes.
Example:

routi\de - matches strings like 'routile', 'routice' and so on, but not
'routine', 'routime' and so on.

Metacharacters - Word boundaries

A word boundary ("\b") is a spot between two characters that has an alphanumer-
ic character ("\w") on one side, and a nonalphanumeric character ("\w") on the
other side (in either order), counting the imaginary characters off the beginning and
end of the string as matching a "\ w".

\b - match a word boundary)
\ B - match a non-(word boundary)
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Metacharacters - Iterators

Any item of a regular expression may be followed by another type of metacharac-
ters - iterators. Using this metacharacters,you can specify number of occurences of
previous character, metacharacter or subexpression.

« - zero or more ("greedy"), similar to {0,}

+ - one or more ("greedy"), similar to {1,}

2 - zero or one ("greedy"), similar to {0,1}

{n} - exactly n times ("greedy")

{n,} -atleastn times ("greedy")

{n,m - atleastn but not more than m times ("greedy")
*2 - zero or more ("non-greedy"), similar to {0,}?

+2 - one or more ("non-greedy"), similar to {1,}?

2?2 - zero or one ("non-greedy"), similar to {0,1}?

{ n} 2 - exactly n times ("non-greedy")

{n,}? - atleast n times ("non-greedy")

{n,m 2 - atleast n but not more than m times ("non-greedy")

So, digits in curly brackets of the form, { n, m} , specify the minimum number of times to
match the item n and the maximum . The form { n} is equivalentto { n,n; and match-
es exactly n times. The form { n,} matches n or more times. There is no limit to the size
of n or m, but large numbers will chew up more memory and slow down execution.

If a curly bracket occurs in any other context, it is treated as a regular character.
Examples:

count.*r B-matches strings like 'counter', 'countelkjdflkjor' and 'countr'
count . +r - matches strings like 'counter', 'countelkidflkjor' butnot 'countr’
count.?r - matches strings like 'counter', ‘'countar' and 'countr' but not
'countelkj9r'

countel{ 2} r - matches string 'counteer’

countef{ 2,} r - matches strings like 'counteer', 'counteeer', 'counteeer' efc.
countef{ 2, 3} r - matches strings like 'counteer', Or 'counteecer’ but not 'coun-
teeeer'!

A little explanation about "greediness". "Greedy" takes as many as possible, "non-
greedy" takes as few as possible.

For example, 'b+' and 'b*' applied to string 'abbbbc' return 'bbbb', b2
returns 'b', 'b*2 ' returns empty string, 'b{2,3}2' returns 'bb', 'b{2,3}"
returns 'bbb'.
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Metacharacters - Alternatives

You can specify a series of alternatives for a pattern using " | " to separate them, so
that bit|bat|bot will match any of "bit", "bat", or "bot" in the target string as would
"b(il]alo)t)". The first alternative includes everything from the last pattern delimiter
("(", "[", or the beginning of the pattern) up to the first "|", and the last alternative con-
tains everything from the last "|" to the next pattern delimiter. For this reason, it's
common practice to include alternatives in parentheses, to minimize confusion
about where they start and end.

Alternatives are tried from left to right, so the first alternative found for which the
entire expression matches, is the one that is chosen. This means that alternatives
are not necessarily greedy. For example: when matching rou|rout against "routine”,
only the "rou" part will match, as that is the first alternative tried, and it successfully
matches the target string (this might not seem important, but it is important when
you are capturing matched text using parentheses.) Also remember that "|" is inter-
preted as a literal within square brackets, so if you write [ bit |bat|bot], you're
really only matching [ biao|] .

Examples:
rou(tine|te) - matches strings 'routine' Or 'route'.
Metacharacters - Subexpressions

The bracketing construct ( ... ) may also be used for define regular subexpres-
sions. Subexpressions are numbered based on the left to right order of their open-
ing parenthesis. First subexpression has number "1’

Examples:

(int){ 8,10} matches strings which contain 8, 9 or 10 instances of the 'int'
routi([ 0-9] |la+t)e matches 'routioe', 'routile' , 'routine’',
'routinne', 'routinnne' etc.

Metacharacters - Backreferences

Metacharacters \ 1 through \ ¢ are interpreted as backreferences. \ matches previ-
ously matched subexpression #.

Examples:

(.)\ 1+ matches 'zaz2"and 'cc'.

(.+)\ 1+ matches 'abab'and '123123'

(C '"12) (\d+)\ 1 matches "13" (in double quotes), or "4 (in single quotes)
or 77 (without quotes) etc
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MIKROBASIC PRO FOR AVR COMMAND LINE OPTIONS

Usage: mBAvr.exe [ -<opts> [ —<opts>]] [<infile> [ -<opts>]] [ -<opts>]
Infile can be of *.mbas and » .mc1 type.

The following parameters and some more (see manual) are valid:

-p : MCU for which compilation will be done.

-r0 : Set oscillator [in MHZ].

-sp : Add directory to the search path list.

-1p : Add directory to the #include search list.

-n : Output files generated to file path specified by filename.
-B : Save compiled binary files (x .mc1) to 'directory'.
-0 : Miscellaneous output options.

-DBG : Generate debug info.

-1, : Check and rebuild new libraries.

-pL : Build all files as libraries.

-v : Dynamic link for string literals.

-c : Turn on case sensitivity.

Example:

mBAvr.exe -MSF -DBG -pATMEGA16 -C -011111114 -fo8 -
N"C:\Lcd\Lcd.mcpav" -SP"C:\Program Files\Mikroelektronika\mikroBasic
PRO for AVR\Defs\"
-SP"C:\Program Files\Mikroelektronika\mikroBasic PRO
for AVR\Uses\LTE64KW\" -SP"C:\Lcd\" "Lcd.mbas" " Lib Math.mcl"
" Lib MathDouble.mcl"

" "

__Lib System.mcl"
" Lib LcdConsts.mcl" " Lib Lcd.mcl”

~ Lib Delays.mcl"

Parameters used in the example:

-Ms¥ : Short Message Format; used for internal purposes by IDE.

-DBG : Generate debug info.

-pATMEGAL6 : MCU ATMEGA16 selected.

-C : Turn on case sensitivity.

-011111114 : Miscellaneous output options.

-fo8 : Set oscillator frequency [in MHZz].

-N"C:\Lcd\ Led.mcpav"  -SP"C:\Program Files\Mikroelektronika\mikroBasic
PRO for AVR\defs\" : Output files generated to file path specified by filename.
-SP"C:\ Program Files\Mikroelektronika\mikroBasic PRO for AVR\defs\":
Add directory to the search path list.

-SP"C:\ Program Files\Mikroelektronika\mikroBasic PRO for AVR\uses\"':
Add directory to the search path list.

-sp"c:\Lcd\ " :Add directory to the search path list.

"Led.mbas™ " Lib Math.mcl"™ " Lib MathDouble.mcl" " Lib System.mcl"
" Lib Delays.mcl" " Lib LcdConsts.mcl" " Lib Led.mcl" :Specﬂyinputmes
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PROJECTS

The mikroBasic PRO for AVR organizes applications into projects, consisting of a
single project file (extension .mcpav) and one or more source files (extension ).
mikroBasic PRO for AVR IDE allows you to manage multiple projects (see Project
Manager). Source files can be compiled only if they are part of a project.

The project file contains the following information:

- project name and optional description,

- target device,

- device flags (config word),

- device clock,

- list of the project source files with paths,
- image files,

- other files.

Note that the project does not include files in the same way as preprocessor does,
see Add/Remove Files from Project.

NEW PROJECT

The easiest way to create a project is by means of the New Project Wizard, drop-

down menu Project » New Project or by clicking the New Project Icon :l, from

Project Toolbar.
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New Project Wizard Steps

Start creating your New project, by clicking Next button:
Mew Project Wizard

Welcome to the New Project
Wizard

This wizard helps you:

s Create a new project

e Select the device for your project

* Setup device clock and choose device flags
s Select desired memaory model

o Add project files

Click Mext to continue

Back Mext 5 Cancel

Step One - Select the device from the device drop-down list.

Mewy Project Wizard @
Step 1/5

Select the dewvice you want to use.

Device Mame: ATMEGALE -

4@ Back Mext 5 Cancel

MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD 69



CHAPTER 2
Environment mikroBasic PRO for AVR

Step Two - Enter the oscillator frequency value.

Mewy Project Wizard @
Step 275

Setup the clock, for example 11,0592 MHz.

Device Clock: 11.059200| MHz

4@ Back Mext 5 Cancel

Step Three - Specify the location where your project will be saved.

Mew Project Wizard [=E3]

Step 3/5

Specify where your project will be saved.

Project File Name:
i ProjectsiFirstProject\FirstProject .mbpay

4 Back Next 5 Cancel
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Step Four - Add project file to the project if they are avaiable at this point. You can
always add project files later using Project Manager.

Mew Project Wizard (==

Step 45
add project files if they are available at this point.
You can always add project files later using the Froject Manager in IDE.

Add File To Project:

D:\Projects)FirstProjectiDefinit.mbas . Add ¢

File: Mame:

D:\Projects\FirstProjectiDefinit.mbas
Remove
Remove All

4@ Back Mext 5 Cancel
Step Five - Click Finish button to create your New Project:
Mew Project Wizard (=23

Step 5/5

You have successfully created a new project. Click Finish to save the changes
and to close the wizard.

'

N

4 Back ] Finish Cancel

Related topics: Project Manager, Project Settings

MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD 71



CHAPTER 2
Environment mikroBasic PRO for AVR

CUSTOMIZING PROJECTS
Edit Project

You can change basic project settings in the Project Settings window. You can
change chip and oscillator frequency. Any change in the Project Setting Window
affects currently active project only, so in case more than one project is open, you
have to ensure that exactly the desired project is set as active one in the Project
Manager.

Managing Project Group

mikroBasic PRO for AVR IDE provides covenient option which enables several proj-
ects to be open simultaneously. If you have several projects being connected in
some way, you can create a project group.

The project group may be saved by clicking the Save Project Group Icon % from
the Project Manager window. The project group may be reopend by clicking the
Open Project Group Icon .@ . All relevant data about the project group is stored in
the project group file (extension .mpg)

ADD/REMOVE FILES FROM PROJECT

The project can contain the following file types:

- .mbas source files

- .mc1 binary files

- .pld project level defines files

- image files

- .hex, .asm and .Ist files, see output files. These files can not be added or
removed from project.

- other files
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Project Manager ]
GBS SHST 3
Auﬁﬁ T6963C_240x128.mbpavy

4[] Sources

% TE963C_240x128.mbas

Ej bitmap.mbas

Binaries

bitmapz2.mcl

Praject level defines

Image Files

sample.jpg

Qutput Files

EE| TEo53C_240x125 hex

5| Te953C_240x125.asm

g TEIEIC_240x128 Ist

a-| ) Other Files

£} DaTA - doc3286, pdf

|
|
|
|

The list of relevant source files is stored in the project file (extension .mbpav).

To add source file to the project, click the Add File to Project Icon D‘j’ . Each added
source file must be self-contained, i.e. it must have all necessary definitions after
preprocessing.

To remove file(s) from the project, click the Remove File from Project Icon D’f .

Note: For inclusion of the module files, use the inc1ude clause. See File Inclusion
for more information.

Project Level Defines

Project Level Defines (.p14) files can also be added to project. Project level define files
enable you to have defines that are visible in all source files in the project. One project
may contain several p1d files. A file must contain one definition per line, for example:

ANALOG
DEBUG
TEST

There are some predefined project level defines. See predefined project level defines

Related topics: Project Manager, Project Settings
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SOURCE FILES

Source files containing Basic code should have the extension .mbas. The list of
source files relevant to the application is stored in project file with extension .mbpav,
along with other project information. You can compile source files only if they are
part of the project.

Managing Source Files
Creating new source file

To create a new source file, do the following:

1. Select File » New Unit from the drop-down menu, or press Ctrl+N, or click the
New File Icon ,j from the File Toolbar.

2. A new tab will be opened. This is a new source file. Select File > Save from the
drop-down menu, or press Ctrl+S, or click the Save File Icon [ from the File
Toolbar and name it as you want.

If you use the New Project Wizard, an empty source file, named after the project with

extension .mbas, will be created automatically. The mikroBasic PRO for AVR does

not require you to have a source file named the same as the project, it’s just a mat-
ter of convenience.

Opening an existing file

1. Select File » Open from the drop-down menu, or press Ctrl+O, or click the Open
File Icon [#~ from the File Toolbar. In Open Dialog browse to the location of the
file that you want to open, select it and click the Open button.

2. The selected file is displayed in its own tab. If the selected file is already open, its
current Editor tab will become active.

Printing an open file

1. Make sure that the window containing the file that you want to print is the
active window.

2. Select File » Print from the drop-down menu, or press Ctrl+P.

3. In the Print Preview Window, set a desired layout of the document and click the
OK button. The file will be printed on the selected printer.
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Saving file

1. Make sure that the window containing the file that you want to save is the
active window.

2. Select File » Save from the drop-down menu, or press Ctrl+S, or click the Save
File Icon |4 from the File Toolbar.

Saving file under a different name

1. Make sure that the window containing the file that you want to save is the
active window.

2. Select File » Save As from the drop-down menu. The New File Name dialog will
be displayed.

3. In the dialog, browse to the folder where you want to save the file.

4. In the File Name field, modify the name of the file you want to save.

5. Click the Save button.

Closing file

1. Make sure that the tab containing the file that you want to close is the active tab.

2. Select File » Close from the drop-down menu, or right click the tab of the file that
you want to close and select Close option from the context menu.

3. If the file has been changed since it was last saved, you will be prompted to save
your changes.

Related topics:File Menu, File Toolbar, Project Manager, Project Settings,
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CLEAN PROJECT FOLDER

Clean Project Folder

This menu gives you option to choose which files from your current project you want

to delete.

Files marked in bold can be easily recreated by building a project. Other files should
be marked for deletion only with a great care, because IDE cannot recover them.

Clean Project Falder [l
Below is the list of all files in the project folder. Files in bold are those
generated by the compiler and they can be easily recreated when the
project is rebuilt.

Select which files you want to remoaove frorm the project folder. Please
note that selected files will be permanently deleted from your disl if

I .........

-[¥] LCD.dbg
-[¥] Led.dct
-[¥] LcD i
-[C]LCD.hex
-] Led Jog

-[¥] LCD.Ist
-] Led . mbas
-] Led. mbas.ini
-] Led mbpa
-[¥] LCD.mbpav_callertable.txt
[ Led. ml
-[¥] Led.mil
[ Led user . dic
-[¥] Led.wch

Clean Cancel

C\Prograrm Files\MikroelektronikatmikroBasic PRO for AWRNExarmplesiLody
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COMPILATION

When you have created the project and written the source code, it's time to compile
it. Select Project > Build from the drop-down menu, or click the Build Icon % | from
the Project Toolbar. If more more than one project is open you can compile all open
projects by selecting Project > Build All from the drop-down menu, or click the Build
All Icon -Hﬁ‘ from the Project Toolbar.

Progress bar will appear to inform you about the status of compiling. If there are

some errors, you will be notified in the Error Window. If no errors are encountered,
the mikroBasic PRO for AVR will generate output files.

Output Files
Upon successful compilation, the mikroBasic PRO for AVR will generate output files

in the project folder (folder which contains the project file .mbpav). Output files are
summarized in the table below:

Format Description File Type
Intel style hex records. Use this file to program §
Intel HEX AVR MCU. .hex
Binar mikro Compiled Library. Binary distribution of -
y application that can be included in other projects. |
- Overview of AVR memory allotment: instruction
List File . . 1st
addresses, registers, routines and labels.
Assembler File Human readable assembly with symbolic names, em
extracted from the List File. N

Assembly View

After compiling the program in the mikroBasic PRO for AVR, you can click the View
Assembly icon [l or select Project > View Assembly from the drop-down menu
to review the generated assembly code (.zsm file) in a new tab window. Assembly
is human-readable with symbolic names.

Related topics:Project Menu, Project Toolbar, Error Window, Project Manager, Pro-
ject Settings
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ERROR MESSAGES

Compiler Error Messages:

- "%s"is not valid identifier.

- Unknown type "ss".

- Identifier "=s" was not declared.

- Syntax error: Expected "2s" but "<s" found.

- Argument is out of range "2s".

- Syntax error in additive expression.

- File "%s" not found.

- Invalid command "2s".

- Not enough parameters.

- Too many parameters.

- Too many characters.

- Actual and formal parameters must be identical.

- Invalid ASM instruction: "%s".

- Identifier "2s" has been already declared in "2s".

- Syntax error in multiplicative expression.

- Definition file for "2s" is corrupted.

- ORG directive is currently supported for interrupts only.
- Not enough ROM.

- Not enough RAM.

- External procedure "<s" used in "2s" was not found.
- Internal error: "=s".

- Unit cannot recursively use itself.

- "3s" cannot be used out of loop.

- Supplied and formal parameters do not match ("%s" to "2s").
- Constant cannot be assigned to.

- Constant array must be declared as global.

- Incompatible types ("%s" to "3s").

- Too many characters ("2s").

- Soft_Uart cannot be initialized with selected baud rate/device clock.
- Main label cannot be used in modules.

- Break/Continue cannot be used out of loop.

- Preprocessor Error: "2s".

- Expression is too complicated.

- Duplicated label "<s™.

- Complex type cannot be declared here.

- Record is empty.

- Unknown type "ss".

- File not found "<s.

- Constant argument cannot be passed by reference.

- Pointer argument cannot be passed by reference.
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- Operator "=s" not applicable to these operands "2s".

- Exit cannot be called from the main block.

- Complex type parameter must be passed by reference.

- Error occured while compiling "=s".

- Recursive types are not allowed.

- Adding strings is not allowed, use "strcat" procedure instead.

- Cannot declare pointer to array, use pointer to structure which has array field.
- Return value of the function "<s" is not defined.

- Assignment to for loop variable is not allowed.

- "zs" is allowed only in the main program.

- Start address of "2s" has already been defined.

- Simple constant cannot have fixed address.

- Invalid date/time format.

- Invalid operator "=s.

- File "=s" is not accessible.

- Forward routine "=s" is missing implementation.

- ;" is not allowed before "else".

- Not enough elements: expected "=s", but "2s" elements found.
- Too many elements: expected "=s" elements.

- "external" is allowed for global declarations only.

- Destination size ("=s") does not match source size ("ss").

- Routine prototype is different from previous declaration.

- Division by zero.

- Uart module cannot be initialized with selected baud rate/device clock.
- 2 cannot be of "2s" type.

Warning Messages:

- Implicit typecast of integral value to pointer.

- Library "<s" was not found in search path.

- Interrupt context saving has been turned off.

- Variable "<s" is not initialized.

- Return value of the function "<s" is not defined.
- Identifier "2s" overrides declaration in unit "%s".

- Generated baud rate is "2s" bps (error = "2s" percent).
- Result size may exceed destination array size.
- Infinite loop.

- Implicit typecast performed from "2s" to "2s".

- Source size ("2s") does not match destination size ("ss").

- Array padded with zeros ("+s") in order to match declared size ("2s").
- Suspicious pointer conversion.

Hint Messages:

- Constant "2s" has been declared, but not used.
- Variable "<s" has been declared, but not used.

- Unit "2s" has been recompiled.

- Variable "<s" has been eliminated by optimizer.
- Compiling unit "2s".
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SOFTWARE SIMULATOR OVERVIEW

The Source-level Software Simulator is an integral component of the mikroBasic
PRO for AVR environment. It is designed to simulate operations of the AVR MCUs
and assist the users in debugging Basic code written for these devices.

After you have successfully compiled your project, you can run the Software Simu-
lator by selecting Run > Start Debugger from the drop-down menu, or by clicking
the Start Debugger Icon E@ from the Debugger Toolbar. Starting the Software Sim-
ulator makes more options available: Step Into, Step Over, Step Out, Run to Cursor,
etc. Line that is to be executed is color highlighted (blue by default).

Note: The Software Simulator simulates the program flow and execution of instruc-

tion lines, but it cannot fully emulate AVR device behavior, i.e. it doesn’t update
timers, interrupt flags, etc.

Watch Window

The Software Simulator Watch Window is the main Software Simulator window which
allows you to monitor program items while simulating your program. To show the Watch
Window, select View > Debug Windows > Watch from the drop-down menu.

The Watch Window displays variables and registers of the MCU, along with their
addresses and values.

There are two ways of adding variable/register to the watch list:

- by its real name (variable's name in "Basic" code). Just select desired
variable/register from Select variable from list drop-down menu and click the
Add Button == Add

- by its name ID (assembly variable name). Simply type name ID of the
variable/register you want to display into Search the variable by assemby name
box and click the Add Button == Add

Variables can also be removed from the Watch window, just select the variable that
you want to remove and then click the Remove Button ¥ Remove

Add All Button %4 Add All  adds all variables.
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Remove All Button i Remove All removes all variables.

You can also expand/collapse complex variables, i.e. struct type variables, strings...

Values are updated as you go through the simulation. Recently changed items are

colored red.

Wiatch Walues

Select variable fram list:

r
Search for variable by assembly name:
FARG_TE3E3C_circle+4

| Peripherals Freeze

Marme Value Address
pic 0
panel 0
T&e963C_dataPart 0
T&963C_cntrst 0
TEO63C_grwidth 0
start il
miode a
r 1]

PC= 0x0009FE Cycle= 560,00

Zh B 2 | oo & ob o] | & [

a Add  $ Remove < Properties

B | o

g AddAll kgl Removeall

()

00039
00031
00050
00094
00020
00046
00034
00036

B

-

Double clicking a variable or clicking the Properties Button <!s Fropertizs  opens

the Edit Value window in which you can assign a new value to the selected

variable/register. Also, you can choose the format of variable/register representation

between decimal, hexadecimal, binary, float or character. All representations except

float are unsigned by default. For signed representation click the check box next to

the Signed label.

An item's value can be also changed by double clicking item's value field and typing

the new value directly.
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[ Edit Walue: ACD

Dec

Signed

Representation

Hex

o[ E) ]Sl
0100 0000 1000 0011 aoo1 ooioo0iio 1111
@) Bin Float Char
oK H Zancel

Stopwatch Window

The Software Simulator Stopwatch Window is available from the drop-down menu,
View > Debug Windows > Stopwatch.

The Stopwatch Window displays a current count of cycles/time since the last Soft-
ware Simulator action. Stopwatch measures the execution time (number of cycles)
from the moment Software Simulator has started and can be reset at any time. Delta
represents the number of cycles between the lines where Software Simulator action
has started and ended.

Note: The user can change the clock in the Stopwatch Window, which will recalcu-
late values for the latest specified frequency. Changing the clock in the Stopwatch
Window does not affect actual project settings — it only provides a simulation.

Stopwvatch

Delta:

Skopwatch:

Clock:

Cycles:

Current Count: |8

Z

g

Reset To Zero

10

&
Tirne:
2,60 us

2.40us

9,60 us

MHz
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RAM Window

The Software Simulator RAM Window is available from the drop-down menu, View

> Debug Windows > RAM.

The RAM Window displays a map of MCU’s RAM, with recently changed items col-
ored red. You can change value of any field by double-clicking it.

RAk
RAM
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SOFTWARE SIMULATOR OPTIONS

Function | Toolbar

Name Description Key lcon

Start Debugger |Start Software Simulator. [F9]

@:’

Run/Pause

Debugger Run or pause Software Simulator. [F6] IE:]J
Stop Debugger |Stop Software Simulator. [CtrI+F2] E—E]
Toggle breakpoint at the current cursor position.
Toaal To view all breakpoints, select Run > View Break-
Bogg c points from the drop—down menu. Double clicking [F5] T}
reakpoints

an item in the Breakpoints Window List locates
the breakpoint.

Execute all instructions between the current

fun o cursor instruction and cursor position. [F41 vl

Execute the current Basic (single or multi-cycle)
instruction, then halt. If the instruction is a routine [F7] &0
call, enter the routine and halt at the first instruc-

tion following the call.

Step Into

Execute the current Basic (single or multi—cycle)

Step Over .
oeep instruction, then halt.

[F8] i

Execute all remaining instructions in the current

Step Out .
oeep routine, return and then halt.

[Ctrl+F8] | @1

Related topics: Run Menu, Debug Toolbar
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CREATING NEW LIBRARY

mikroBasic PRO for AVR allows you to create your own libraries. In order to create
a library in mikroBasic PRO for AVR follow the steps bellow:

1. Create a new Basic source file, see Managing Source Files
2. Save the file in one of the subfolders of the compiler's Uses folder (LTEG64kW or
GT64kW, see note on the end of the page):
DriveName:\ Program Files\Mikroelektronika\mikroBasic PRO for
AVR\Uses\LTE64kW\ Lib Example.mbas
3. Write a code for your library and save it.
4.Add 1ib Example file in some project, see Project Manager. Recompile the
project.
If you wish to use this library for all MCUs, then you should go to Tools » Options
» Output settings, and check Build all files as library box.
This will build libraries in a common form which will work with all MCUs. If this
box is not checked, then library will be build for selected MCU.
Bear in mind that compiler will report an error if a library built for specific MCU is
used for another one.
5. Compiled file 1ib Example.mcl should appearin ...\mikroBasic PRO for
AVR\ Uses\ LTE64kuw\ folder.
6. Open the definition file for the MCU that you want to use. This file is placed in the
compiler's Defs folder:
DriveName:\ Program Files\Mikroelektronika\mikroBasic PRO for
AVR\ Defs\ and itis named mMcU NAME.m1k, for example ATMEGAT6 . m1k
7. Add the the following segment of code to <1.1B8rRARTES> node of the definition file
(definition file is in XML format):
<LIB>
<ALIAS>Example Library</ALIAS>
<FILE> Lib Example</FILE>
<TYPE>REGULAR</TYPE>
</LIB>
8. Add Library to mlk file for each MCU that you want to use with your library.
9. Click Refresh button in Library Manager
10. Example Library should appear in the Library manager window.
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Multiple Library Versions

Library Alias represents unique name that is linked to corresponding Library .mcl
file. For example UART library for ATMEGA16 is different from UART library for
ATMEGA128 MCU. Therefore, two different UART Library versions were made, see
mlk files for these two MCUs. Note that these two libraries have the same Library
Alias (UART) in both mik files. This approach enables you to have identical repre-
sentation of UART library for both MCUs in Library Manager.

Note: In the Uses folder, there should be two subfolders, LTE64kW and GT64kW,

depending on the Flash memory size of the desired MCU. See AVR Specifics for a
detailed information regarding this subject.

Related topics: Library Manager, Project Manager, Managing Source Files
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The following topics cover the specifics of mikroBasic PRO for AVR compiler:

- Basic Standard Issues

- Predefined Globals and Constants
- Accessing Individual Bits

- Interrupts

- AVR Pointers

- Linker Directives

- Built-in Routines

- Code Optimization
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BASIC STANDARD ISSUES

Divergence from the Basic Standard

Function recursion is not supported because of no easily-usable stack and limited
memory AVR Specific

Basic Language Exstensions

mikroBasic PRO for AVR has additional set of keywords that do not belong to the
standard Basic language keywords:

- code

- data

- io

- rx

- register
- at

- sbit

- bit

- sfr

Related topics: Keywords, AVR Specific
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PREDEFINED GLOBALS AND CONSTANTS

In order to facilitate AVR programming, mikroBasic PRO for AVR implements a num-
ber of predefined globals and constants.

SFRs and related constants

All AVR SFRs are implicitly declared as global variables of volatile word type.
These identifiers have an external linkage, and are visible in the entire project.
When creating a project, the mikroBasic PRO for AVR will include an appropriate
(*.mbas) file from defs folder, containing declarations of available SFRs and con-
stants (such as PORTB, ADPCFG, etc). All identifiers are in upper case, identical to
nomenclature in the Microchip datasheets.

For a complete set of predefined globals and constants, look for “Defs” in the
mikroBasic PRO for AVR installation folder, or probe the Code Assistant for specific
letters (Ctrl+Space in the Code Editor).

Math constants

In addition, several commonly used math constants are predefined in mikroBasic

PRO for AVR:

PI = 3.1415926
PI HALF = 1.5707963
TWO PIT = 6.2831853
E = 2.7182818

Predefined project level defines

These defines are based on a value that you have entered/edited in the current proj-
ect, and it is equal to the name of selected device for the project.

If ATmega16 is selected device, then ATmega16 token will be defined as 1, so it can
be used for conditional compilation:

#IFDEF ATmegalb6
#ENDIF

Related topics: Project level defines
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ACCESSING INDIVIDUAL BITS

The mikroBasic PRO for AVR allows you to access individual bits of 8-bit variables.
It also supports sbit and bit data types

Accessing Individual Bits Of Variables

To access the individual bits, simply use the direct member selector (.) with a vari-
able, followed by one of identifiers BO, B1, ... , B7, or 0, 1, ... 7, with 7 being the
most significant bit :

// Clear bit 0 on PORTA
PORTA.BO = 0

// Clear bit 5 on PORTB
PORTB.5 = 0

There is no need of any special declarations. This kind of selective access is an
intrinsic feature of mikroBasic PRO for AVR and can be used anywhere in the code.
Identifiers BO—B7 are not case sensitive and have a specific namespace. You may
override them with your own members BO-B7 within any given structure.

See Predefined Globals and Constants for more information on register/bit names.
sbit type

The mikroBasic PRO for AVR compiler has sbit data type which provides access to
bit-addressable SFRs. You can access them in several ways:

dim LEDA as sbit at PORTA.BO
dim Name as sbit at sfr-name.B<bit-position>

dim LEDB as sbit at PORTB.O
dim Name as sbit at sfr-name.<bit-position>
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bit type

The mikroBasic PRO for AVR compiler provides a bit data type that may be used
for variable declarations. It can not be used for argument lists, and function-return
values.

dim bf as bit ' bit variable

There are no pointers to bit variables:

dimrotr—as—btt ' invalid

An array of type bit is not valid:

e L —a v 74
arm—oarr—as—arrayr o7 ot invalid

Note :
- Bit variables can not be initialized.
- Bit variables can not be members of structures.
- Bit variables do not have addresses, therefore unary operator ¢ (address
of) is not applicable to these variables.

Related topics: Predefined globals and constants
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INTERRUPTS

AVR derivates acknowledges an interrupt request by executing a hardware gener-
ated CALL to the appropriate servicing routine ISRs. ISRs are organized in IVT. ISR
is defined as a standard function but with the org directive afterwards which con-
nects the function with specific interrupt vector. For example org 0x000B is IVT
address of Timer/Counter 2 Overflow interrupt source of the ATMEGA16.

For more information on interrupts and IVT refer to the specific data sheet.

Function Calls from Interrupt

Calling functions from within the interrupt routine is allowed. The compiler takes care
about the registers being used, both in "interrupt" and in "main" thread, and performs
"smart" context-switching between them two, saving only the registers that have
been used in both threads. It is not recommended to use function call from interrupt.
In case of doing that take care of stack depth.

sub procedure Interrupt() org 0x16
RS485Master Receive (dat)

end sub

Most of the MCUs can access interrupt service routines directly, but some can not
reach interrupt service routines if they are allocated on addresses greater than 2K
from the IVT. In this case, compiler automatically creates Goto table, in order to jump
to such interrupt service routines.
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These principles can be explained on the picture below :

Interrupt Vector Interrupt Vector
Table Table
— Interrupt vector | — Interrupt vector
Goto table
——{ Interrupt service routine | ] Golo table block —

| Interrupt service routing  J+—

Direct accessing interrupt service routine and accessing interrupt service routine via
Goto table.
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LINKER DIRECTIVES

mikroBasic PRO for AVR uses internal algorithm to distribute objects within memo-
ry. If you need to have a variable or routine at the specific predefined address, use
the linker directives absolute and org.

Note: You must specify an even address when using the linker directives.
Directive absolute

The directive absolute specifies the starting address in RAM for a variable. If the
variable spans more than 1 word (16-bit), higher words will be stored at the consec-
utive locations.

The zbsolute directive is appended to the declaration of a variable:

dim x as word absolute 0x32
' Variable x will occupy 1 word (16 bits) at address 0x32

dim y as longint absolute 0x34
' Variable y will occupy 2 words at addresses 0x34 and 0x36

Be careful when using absolute directive, as you may overlap two variables by acci-
dent. For example:

dim i as word absolute 0x42
' Variable i will occupy 1 word at address 0x42;

dim jj as longint absolute 0x40

' Variable will occupy 2 words at 0x40 and Ox42; thus,

' changing i changes jj at the same time and vice versa

Note: You must specify an even address when using the directive absolute.

Directive org

The directive org specifies the starting address of a routine in ROM. It is appended
to the declaration of routine. For example:

sub procedure proc(dim par as word) org 0x200
' Procedure will start at the address 0x200;

end sub

Note: You must specify an even address when using the directive org.
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BUILT-IN ROUTINES

The mikroBasic PRO for AVR compiler provides a set of useful built-in utility func-
tions.

The 1.0, Hi, Higher, Highest routines are implemented as macros. If you want
to use these functions you must include built in.h header file (located in the in1-
clude folder of the compiler) into your project.

The pelay us and pelay ms routines are implemented as “inline”; i.e. code is gen-
erated in the place of a call, so the call doesn’t count against the nested call limit.

The vdelay ms, Delay Cyc and Get Fosc kHz are actual Basic routines. Their
sources can be found in Delays.mbas file located in the uses folder of the compiler.

- Lo

- Hi

- Higher
- Highest

- Inc
- Dec

- Delay_us
- Delay_ms
- Vdelay_ms
- Delay_Cyc

- Clock_Khz
- Clock_Mhz

- SetFuncCall
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Lo
Prototype sub function Lo (number as longint) as byte
Returns Lowest 8 bits (byte) of number, bits 7. .0.
Function returns the lowest byte of number. Function does not interpret bit pat-
terns of number — it merely returns 8 bits as found in register.
Description
This is an “inline” routine; code is generated in the place of the call, so the call
doesn’t count against the nested call limit.
Requires Arguments must be variable of scalar type (i.e. Arithmetic Types and Pointers).
E I d = 0x1AC30F4
xample tmp = Lo (d) ' Equals 0OxF4
Hi
Prototype sub function Hi (number as longint) as byte
Returns Returns next to the lowest byte of number, bits 8..15.
Function returns next to the lowest byte of number. Function does not interpret
bit patterns of number — it merely returns 8 bits as found in register.
Description
This is an “inline” routine; code is generated in the place of the call, so the call
doesn’t count against the nested call limit.
Requires Arguments must be variable of scalar type (i.e. Arithmetic Types and Pointers).
E I d = 0x1AC30F4
xample tmp = Hi(d) ' Equals 0x30
Higher
Prototype sub function Higher (number as longint) as byte
Returns Returns next to the highest byte of number, bits 16..23.
Function returns next to the highest byte of number. Function does not interpret
bit patterns of number — it merely returns 8 bits as found in register.
Description
This is an “inline” routine; code is generated in the place of the call, so the call
doesn’t count against the nested call limit.
Requires Arguments must be variable of scalar type (i.e. Arithmetic Types and Pointers).
E I d = 0x1AC30F4
xample tmp = Higher (d) ' Equals 0xAC
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Highest

Prototype sub function Highest (number as longint) as byte

Returns Returns the highest byte of number, bits 24..31.
Function returns the highest byte of number. Function does not interpret bit pat-
terns of number — it merely returns 8 bits as found in register.

Description
This is an “inline” routine; code is generated in the place of the call, so the call
doesn’t count against the nested call limit.

Requires Arguments must be variable of scalar type (i.e. Arithmetic Types and Pointers).

E I d = 0x1AC30F4

xample tmp = Highest (d) ' Equals 0x01

Inc

Prototype sub procedure Inc(dim byref par as longint)

Returns Nothing.

Description |Increases parameter par by 1.

Requires Nothing.
p = 4

Example Inc(p) ' p is now 5

Dec

Prototype sub procedure Dec (dim byref par as longint)

Returns Nothing.

Description |Decreases parameter par by 1.

Requires Nothing.
p = 4

Example Dec (p) ' p is now 3
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Delay_us
Prototype sub procedure Delay us(const time in us as longword)
Returns Nothing.
Creates a software delay in duration of time in us microseconds (a constant).
Range of applicable constants depends on the oscillator frequency.
Description
This is an “inline” routine; code is generated in the place of the call, so the call
doesn’t count against the nested call limit.
Requires Nothing.
Example Delay us(1000) ' One millisecond pause
Delay_ms
Prototype sub procedure Delay ms(const time in ms as longword)
Returns Nothing.
Creates a software delay in duration of time in ms milliseconds (a constant).
Range of applicable constants depends on the oscillator frequency.
Description
This is an “inline” routine; code is generated in the place of the call, so the call
doesn’t count against the nested call limit.
Requires Nothing.
Example Delay ms(1000) ' One second pause
Vdelay_ms
Prototype sub procedure Vdelay ms(time in ms as word)
Returns Nothing.
Creates a software delay in duration of time in ms milliseconds (a variable).
Generated delay is not as precise as the delay created by Delay_ms.
Description
Note that vdelay ms is library function rather than a built-in routine; it is pre-
sented in this topic for the sake of convenience.
Requires Nothing.
pause = 1000
Example oL
Vdelay ms (pause) ' ~ one second pause
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Delay_Cyc

Prototype sub procedure Delay Cyc(Cycles div by 10 as byte)

Returns Nothing.

Creates a delay based on MCU clock. Delay lasts for 10 times the input param-
eter in MCU cycles.

Description Note that be1ay cyc is library function rather than a built-in routine; it is pre-
sented in this topic for the sake of convenience. There are limitations for
Cycles_div_by 10 value. Value Cycles_div_by_ 10 must be between 2 and 257.

Requires Nothing.

Example Delay Cyc(10) ' Hundred MCU cycles pause

Clock_KHz

Prototype sub function Clock Khz () as word

Returns Device clock in KHz, rounded to the nearest integer.

Function returns device clock in KHz, rounded to the nearest integer.

Description This is an “inline” routine; code is generated in the place of the call, so the call

doesn’t count against the nested call limit.

Requires Nothing.

Example clk = Clock kHz ()

Clock_MHz

Prototype sub function Clock MHz () as byte

Returns Device clock in MHz, rounded to the nearest integer.

Function returns device clock in MHz, rounded to the nearest integer.

Description This is an “inline” routine; code is generated in the place of the call, so the call

doesn’t count against the nested call limit.

Requires Nothing.

Example clk = Clock Mhz()
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SetFuncCall

Prototype sub procedure SetFuncCall (FuncName as string)

Returns Nothing.

Function informs the linker about a specific routine being called. SetFuncCall
has to be called in a routine which accesses another routine via a pointer.
Description
Function prepares the caller tree, and informs linker about the procedure usage,
making it possible to link the called routine.

Requires Nothing.

sub procedure first(p, g as byte)

SetFuncCall (second) ' let linker know that we will call the

Exan“ﬂe routine 'second'

end sub
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CODE OPTIMIZATION

Optimizer has been added to extend the compiler usability, cut down the amount of
code generated and speed-up its execution. The main features are:

Constant folding

All expressions that can be evaluated in the compile time (i.e. are constant) are
being replaced by their results. (3 + 5 -> 8);

Constant propagation

When a constant value is being assigned to a certain variable, the compiler recog-
nizes this and replaces the use of the variable by constant in the code that follows,
as long as the value of a variable remains unchanged.

Copy propagation

The compiler recognizes that two variables have the same value and eliminates one
of them further in the code.

Value numbering

The compiler "recognizes" if two expressions yield the same result and can there-
fore eliminate the entire computation for one of them.

"Dead code" ellimination

The code snippets that are not being used elsewhere in the programme do not affect
the final result of the application. They are automatically removed.

Stack allocation

Temporary registers ("Stacks") are being used more rationally, allowing VERY com-
plex expressions to be evaluated with a minimum stack consumption.

Local vars optimization

No local variables are being used if their result does not affect some of the global or
volatile variables.

Better code generation and local optimization

Code generation is more consistent and more attention is payed to implement spe-
cific solutions for the code "building bricks" that further reduce output code size.
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Types Efficiency

First of all, you should know that AVR ALU, which performs arithmetic operations, is
optimized for working with bytes. Although mikroBasic PRO for AVR is capable of
handling very complex data types, AVR may choke on them, especially if you are
working on some of the older models. This can dramatically increase the time need-
ed for performing even simple operations. Universal advice is to use the smallest
possible type in every situation. It applies to all programming in general, and doubly
so with microcontrollers. Types efficiency is determined by the part of RAM memo-
ry that is used to store a variable/constant.
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Nested Calls Limitations

There are no Nested Calls Limitations, except by RAM size. A Nested call repre-
sents a function call to another function within the function body. With each function
call, the stack increases for the size of the returned address. Number of nested calls
is equel to the capacity of RAM which is left out after allocation of all variables.

Important notes:

- There are many different types of derivates, so it is necessary to be familiar with
characteristics and special features of the microcontroller in you are using.

- Some of the AVR MCUs have hardware multiplier. Due to this, be sure to pay
attention when porting code from one MCU to another, because compiled code
can vary by its size.

- Not all microcontrollers share the same instruction set. It is advisable to carefully
read the instruction set of the desired MCU, before you start writing your code.
Compiler automatically takes care of appropiate instruction set, and if unapropriate
asm instruction is used in in-line assembly, compiler will report an error.

- Program counter size is MCU dependent. Thus, there are two sets of libraries :

- MCUs with program counter size larger than 16 bits (flash memory size
larger than 128kb)

- MCUs with program counter size less or equal 16 bits (flash memory size
smaller than 128kb)

- Assembly SPM instruction and its derivates must reside in Boot Loader section of
program memory.

- Part of flash memory can be dedicated to Boot Loader code. For details, refer to
AVR memory organization.

Related topics: mikroBasic PRO for AVR specifics, AVR memory organization
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AVR MEMORY ORGANIZATION

The AVR microcontroller's memory is divided into Program Memory and Data
Memory. Program Memory (ROM) is used for permanent saving program being exe-
cuted, while Data Memory (RAM) is used for temporarily storing and keeping inter-
mediate results and variables.

Program Memory (ROM)

Program Memory (ROM) is used for permanent saving program (CODE) being exe-
cuted, and it is divided into two sections, Boot Program section and the Application
Program section. The size of these sections is configured by the BOOTSZ fuse.
These two sections can have different level of protection since they have different
sets of Lock bits.

Depending on the settings made in compiler, program memory may also used to
store a constant variables. The AVR executes programs stored in program memory
only. code memory type specifier is used to refer to program memory.

A
Application Flash
Section
Program
Memory
Boot Flash
Section
v

Data Memory
Data memory consists of :

- Rx space

- 1/0 Memory

- Extended 1/O Memory (MCU dependent)
- Internal SRAM
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Rx space consists of 32 general purpose working 8-bit registers (R0-R31). These
registers have the shortest (fastest) access time, which allows single-cycle Arith-
metic Logic Unit (ALU) operation.

I/O Memory space contains addresses for CPU peripheral function, such as Control
registers, SPI, and other I/O functions.

Due to the complexity, some AVR microcontrollers with more peripherals have
Extended I/O memory, which occupies part of the internal SRAM. Extended 1/O
memory is MCU dependent.

Storing data in I/O and Extended 1/0O memory is handled by the compiler only. Users
can not use this memory space for storing their data.

Internal SRAM (Data Memory) is used for temporarily storing and keeping interme-
diate results and variables (static link and dynamic link).

There are four memory type specifiers that can be used to refer to the data memo-
ry: rx, data, io, sfr i register.

AVR memory
spaces

A

Register
Space

A4
Y \

/0
Space

X

SRAM
(Data) Space

Related topics: Accessing individual bits, SFRs, Memory type specifiers
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MEMORY TYPE SPECIFIERS

The mikroBasic PRO for AVR supports usage of all memory areas. Each variable may be explic-
itly assigned to a specific memory space by including a memory type specifier in the declaration,
or implicitly assigned.

The following memory type specifiers can be used:

- code

- data

- rx

- io

- sfr

- register

Memory type specifiers can be included in variable declaration.

For example:

dim data buffer as byte data ' puts data buffer in data ram
const txt = "Enter parameter" code ' puts text in program memory
code

Description | The code memory type may be used for allocating constants in program memory.

' puts txt in program memory

Example const txt = "Enter parameter" code

data

Description | This memory specifier is used when storing variable to the internal data SRAM.

' puts data buffer in data ram

Example ;0 data puffer as byte data

rx
This memory specifier allows variable to be stored in the Rx space (Register file).

.. Note: In most of the cases, there will be enough space left for the user variables

Description |. . . )
in the Rx space. However, since compiler uses Rx space for storing temporary
variables, it might happen that user variables will be stored in the internal data
SRAM, when writing complex programs.

Exanuﬂe ' puts y in Rx space

dim y as char rx
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io

Description | This memory specifier allows user to access the /O Memory space.

1

put io buff in io memory space

Example ./ i, Lurf as byte io

sfr

This memory specifier in combination with (rx, io, data) allows user to
Description |access special function registers. It also instructs compiler to maintain same
identifier in Basic and assembly.

dim io buff as byte io sfr ' put io buff in I/O memory space
dim as char rx sfr ! uts in Rx space

Example N P Y " :
dim temp as byte data sfr and dim temp as byte sfr are equiva-
lent, and put temp in Extended I/O Space.

register

If no other memory specifier is used (rx, io, sfr, code ordata), the regis-
Description | e+ specifer places variable in Rx space, and instructs compiler to maintain
same identifier in C and assembly.

Example dim y as char register

Note: If none of the memory specifiers are used when declaring a variable, data specifier will be
set as default by the compiler.

Related topics: AVR Memory Organization, Accessing individual bits, SFRs, Constants, Functions
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mikroBasic PRO for
AVR Language
Reference

The mikroBasic PRO for AVR Language Reference describes the syntax, semantics
and implementation of the mikroBasic PRO for AVR language.

The aim of this reference guide is to provide a more understandable description of
the mikroBasic PRO for AVR language to the user.
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MIKROBASIC PRO FOR AVR LANGUAGE REFERENCE

Lexical Elements
Whitespace
Comments
Tokens
Literals
Keywords
Identifiers
Punctuators
Program Organization
Program Organization
Scope and Visibility
Modules
Variables
Constants
Labels
Symbols
Functions and Procedures
Functions
Procedures
Types
Simple Types
Arrays
Strings
Pointers
Structures
Types Conversions
Implicit Conversion
Explicit Conversion
Operators
Introduction to Operators
Operators Precedence and Associativity
Arithmetic Operators
Relational Operators
Bitwise Operators
Boolean Operators
Expressions
Expressions
Statements
Introduction to Statements
Assignment Statements
Conditional Statements
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If Statement
Select Case Statement

Iteration Statements (Loops)
For Statement
While Statement
Do Statement

Jump Statements
Break and Continue Statements
Exit Statement
Goto Statement
Gosub Statement

asm Statement

Directives
Compiler Directives
Linker Directives

LEXICAL ELEMENTS OVERVIEW

These topics provide a formal definition of the mikroBasic PRO for AVR lexical ele-
ments. They describe different categories of word-like units (tokens) recognized by
the language.

In tokenizing phase of compilation, the source code file is parsed (that is, broken
down) into tokens and whitespace. The tokens in mikroBasic PRO are derived from
a series of operations performed on your programs by the compiler.

A mikroBasic PRO program starts as a sequence of ASCII characters representing
the source code, created by keystrokes using a suitable text editor (such as the
mikroBasic PRO Code Editor). The basic program unit in mikroBasic PRO is a file.
This usually corresponds to a named file located in RAM or on disk, having the
extension .mbas.
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WHITESPACE

Whitespace is a collective name given to spaces (blanks), horizontal and vertical
tabs, and comments. Whitespace serves to indicate where tokens start and end, but
beyond this function, any surplus whitespace is discarded.

For example, the two sequences

dim tmp as byte

dim j as word
and

dim tmp as Dbyte

dim 7 as word
are lexically equivalent and parse identically.
Newline Character

Newline character (CR/LF) is not a whitespace in BASIC, and serves as a statement
terminator/separator. In mikroBasic PRO for AVR, however, you may use newline to
break long statements into several lines. Parser will first try to get the longest pos-
sible expression (across lines if necessary), and then check for statement termina-
tors.

Whitespace in Strings

The ASCII characters representing whitespace can occur within string literals, where
they are protected from the normal parsing process (they remain as a part of the
string). For example, statement

some_string = "mikro foo"

parses to four tokens, including a single string literal token:

some string

"mikro foo"
newline character
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COMMENTS

Comments are pieces of text used to annotate a program, and are technically anoth-
er form of whitespace. Comments are for the programmer’s use only; they are
stripped from the source text before parsing.

Use the apostrophe to create a comment:

' Any text between an apostrophe and the end of the

' line constitutes a comment. May span one line only.
There are no multi-line comments in mikroBasic PRO for AVR
TOKENS

Token is the smallest element of a mikroBasic PRO for AVR program, meaningful to
the compiler. The parser separates tokens from the input stream by creating the
longest token possible using the input characters in a left—to-right scan.
mikroBasic PRO for AVR recognizes the following kinds of tokens:

- keywords

- identifiers

- constants

- operators

- punctuators (also known as separators)
Token Extraction Example
Here is an example of token extraction. See the following code sequence:

end flag = O

The compiler would parse it into four tokens:

end flag ' variable identifier

= ' assignment operator
0 ' literal

newline ' statement terminator

Note that end f1ag would be parsed as a single identifier, rather than the keyword
end followed by the identifier _f1agq.
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LITERALS

Literals are tokens representing fixed numeric or character values.

The data type of a constant is deduced by the compiler using such clues as numer-
ic value and format used in the source code.

Integer Literals

Integral values can be represented in decimal, hexadecimal or binary notation.

In decimal notation, numerals are represented as a sequence of digits (without com-
mas, spaces or dots), with optional prefix + or - operator to indicate the sign. Values

default to positive (6258 is equivalent to +6258).

The dollar-sign prefix (s) or the prefix 0x indicates a hexadecimal numeral (for
example, $8F or 0x8F).

The percent-sign prefix () indicates a binary numeral (for example, <0101).

Here are some examples:

11 ' decimal literal

S11 ' hex literal, equals decimal 17
Ox11 ' hex literal, equals decimal 17
311 ' binary literal, equals decimal 3

The allowed range of values is imposed by the largest data type in mikroBasic PRO
for AVR — 1longword. The compiler will report an error if the literal exceeds
4294967295 (SFFFFFFEF).

Floating Point Literals
A floating-point value consists of:
- Decimal integer
- Decimal point
- Decimal fraction
- e or E and a signed integer exponent (optional)

You can omit either decimal integer or decimal fraction (but not both).

Negative floating constants are taken as positive constants with the unary operator
minus (-) prefixed.
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mikroBasic PRO limits floating-point constants to the range of +1.17549435082 *
10-38 .. £6.80564774407 * 1038.

Here are some examples:

0. ''= 0.0

-1.23 = -1.23
23.45e6 ''= 23.45 * 1076
2e-5 '=2.0* 10"-5
3E+10 ''= 3.0 * 10”710
.09E34 ''=0.09 * 10734

Character Literals

Character literal is one character from the extended ASCII character set, enclosed
with quotes (for example, "~"). Character literal can be assigned to variables of
byte and char type (variable of byte will be assigned the ASCII value of the char-
acter). Also, you can assign character literal to a string variable.

String Literals

String literal is a sequence of characters from the extended ASCII character set,
enclosed with quotes. Whitespace is preserved in string literals, i.e. parser does not
“go into” strings but treats them as single tokens.

Length of string literal is a number of characters it consists of. String is stored inter-
nally as the given sequence of characters plus a final nu11 character. This nul1
character is introduced to terminate the string, it does not count against the string’s
total length.

String literal with nothing in between the quotes (null string) is stored as a single null
character.

You can assign string literal to a string variable or to an array of char.

Here are several string literals:

"Hello world!"
"Temperature is stable"

" "

message, 12 chars long
message, 21 chars long
two spaces, 2 chars long
"c" letter, 1 char long

o ' null string, 0 chars long

The quote itself cannot be a part of the string literal, i.e. there is no escape
sequence. You could use the built-in function Chr to print a quote: chr (34). Also,
see String Splicing.
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KEYWORDS

Keywords are special-purpose words which cannot be used as normal identifier
names.

Beside standard BASIC keywords, all relevant SFR are defined as global variables
and represent reserved words that cannot be redefined (for example: r0, TMR1,
T1con, etc). Probe Code Assistant for specific letters (Ctrl+Space in Editor) or refer
to Predefined Globals and Constants.

Here is the alphabetical listing of keywords in mikroBasic PRO for AVR:

Abstract Far Override Then
And File package Threadvar
Array Finalization Packed To

As Finally Pascal Try

at For pdata Type
Asm Forward platform Unit
Assembler Function Private Until
Automated Goto Procedure Uses
bdata idata Program Var
Begin If Property Virtual
bit ilevel Protected Volatile
Case Implementation Public While
Cdecl In Published With
Class Index Raise Write
Code Inherited Read Writeonly
compact Initialization Readonly xdata
Const Inline Record Xor
Constructor Interface Register

Contains Is Reintroduce

Data Label Repeat

Default large requires

deprecated Library Reset

Destructor Message Resourcestring

Dispid Mod Resume

Dispinterface name Safecall

Div Near sbit

Do Nil Set

Downto Not sfr

Dynamic Object Shl

Else Oof Shr

End on small

Except Or Stdcall

Export org Stored

Exports Oout String

External overload Stringresource

Also, mikroBasic PRO for AVR includes a number of predefined identifiers used in
libraries. You could replace them by your own definitions, if you plan to develop your
own libraries. For more information, see mikroBasic PRO for AVR Libraries.
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IDENTIFIERS

Identifiers are arbitrary names of any length given to functions, variables, symbolic
constants, user-defined data types and labels. All these program elements will be
referred to as objects throughout the help (don't be confused with the meaning of
object in object-oriented programming).

Identifiers can contain letters from a to z and = to z, the underscore character “ ”
and digits from 0 to 9. First character must be a letter or an underscore, i.e. identifi-
er cannot begin with a numeral.

Case Sensitivity

mikroBasic PRO for AVR is not case sensitive, so sum, sum, and suM are equiva-
lent identifiers.

Uniqueness and Scope

Although identifier names are arbitrary (within the rules stated), errors result if the
same name is used for more than one identifier within the same scope. Simply,
duplicate names are illegal within the same scope. For more information, refer to
Scope and Visibility.

Identifier Examples

Here are some valid identifiers:

temperature V1
Pressure

no hit
dat2string
SUM3

_vtext

... and here are some invalid identifiers:

/temp ' NO -- cannot begin with a numeral

higher ' NO -- cannot contain special characters

XOr ' NO -- cannot match reserved word

323.07.04 ' NO -- cannot contain special characters (dot)
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PUNCTUATORS

The mikroBasic PRO punctuators (also known as separators) are:

- [ ] — Brackets
- () — Parentheses

-, —Comma
-:—Colon
- . — Dot
Brackets
Brackets | ] indicate single and multidimensional array subscripts:

dim alphabet as byte[ 30]

alphabet[ 2] = "c"
For more information, refer to Arrays.
Parentheses

Parentheses ( ) are used to group expressions, isolate conditional expressions and
indicate function calls and function declarations:

d=c¢c* (a + b) ' Override normal precedence
if (d = z) then ... ' Useful with conditional statements
func () ' Function call, no arguments

sub function func2(dim n as word)' Function declaration w/ parameters

For more information, refer to Operators Precedence and Associativity, Expressions,
or Functions and Procedures.

Comma

Comma (, ) separates the arguments in function calls:

Led Out (1, 1, txt)

Furthermore, the comma separates identifiers in declarations:

dim i, j, k as word

The comma also separates elements in initialization lists of constant arrays:

const MONTHS as bytel 12] = (31,28,31,30,31,30,31,31,30,31,30,31)
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Colon

Colon (:) is used to indicate a labeled statement:

start: nop

gotg.é:art

For more information, refer to Labels.

Dot

Dot (.) indicates access to a structure member. For example:
person.surname = "Smith"

For more information, refer to Structures.

Dot is a necessary part of floating point literals. Also, dot can be used for accessing
individual bits of registers in mikroBasic PRO.
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PROGRAM ORGANIZATION

mikroBasic PRO for AVR imposes strict program organization. Below you can find
models for writing legible and organized source files. For more information on file
inclusion and scope, refer to Modules and to Scope and Visibility.

Organization of Main Module

Basically, a main source file has two sections: declaration and program body. Dec-
larations should be in their proper place in the code, organized in an orderly man-
ner. Otherwise, the compiler may not be able to comprehend the program correctly.

When writing code, follow the model presented below. The main module should look
like this:

program <program name>
include <include other modules>

Tk R AR A AR A AR A AR AR A AR A AR AR A AR AR A AR A KA AR A AR AR A A A XA A A A AR A AR, K

'* Declarations (globals):
LR I I i I b e b I I b b I I b b I I b b I I b b I I b b I I b b I I b b b I b b b I b b b b b b i 3

' symbols declarations

symbol

' constants declarations
const

' structures declarations
structure

' variables declarations
dim Name[ , Name?2...] as [ "] type [ absolute 0x123] [ external]
[ volatile] [ register] [ sfr]

' procedures declarations
sub procedure procedure name(...)
<local declarations>

end sub

' functions declarations
sub function function name(...) as return type
<local declarations>

end sub

TR R A A AR A AR A AR A AR AR A AR AR A AR A A A AR A KA AR A AR A KA AR AR A A AR AR AR, K

'* Program body:

Tk R AR AR A AR A AR AR A AR A AR AR A AR A A A AR A KA AR A AR AR A AR AR A A AR AR A AR, K

main:
' write your code here
end.
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Organization of Other Modules

Modules other than main start with the keyword module. Implementation section
starts with the keyword imp1lements. Follow the model presented below:

module <module name>
include <include other modules>

Thdhkhkhhhkhhkdhhhhhkhhkhhhhrkhkhhhhhkhrhkhhkhhkdkhkhrhhrhhkhkdhkhkhk ok hkrkhkxkxkx

'* Interface (globals):

Thd ko khhhkhhdhkhhhkhkhhhhhhrkhkhhhhhkhkrhkhhkhhkdkhrhhrh ko dhkhhk ok hkhrkrxkx

' symbols declarations

symbol

' constants declarations
const

' structures declarations
structure

' variables declarations
dim Name[ , Name2...] as [ "] type [ absolute 0x123] [ external]
[ volatile] [ register] [ sfr]

' procedures prototypes
sub procedure sub procedure name ([ dim byref] [ const] ParamName as

[ "] type, [ dim byref] [ const] ParamName2, ParamName3 as [ "] type)

' functions prototypes

sub function sub function name ([ dim byref] [ const] ParamName as
[ "] type, [dim byref] [ const] ParamName2, ParamName3 as [ "] type) as
[ "] type

Thdhhkhkhhhkhhdhhhkrhkhhhhhhrkhk kb hhhkhrhkhhkhhkdhkhrhkhkhkhkhkdhkhkhk ok hkrkhxkx

'* Implementation:
Th A hkhhkkhhkhhh kA hhhkhkhkrhhkhkhAhkhhkhkhkrhhk kA hkhhkhkhkrhhkhkhkhkhhkkhhkrhhkhkkxxx**

implements

' constants declarations
const

' variables declarations
dim
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' procedures declarations
sub procedure sub procedure name ([ dim byref] [ const] ParamName as
[ "] type, [dim byref] [ const] ParamName2, ParamName3 as [ "] type);
[ ilevel 0x123] [ overload] [ forward]

<local declarations>

end sub
' functions declarations
sub function sub function name ([ dim byref] [ const] ParamName as
[ "] type, [dim byref] [ const] ParamName2, ParamName3 as [ "] type) as
[ "] type [ ilevel 0x123] [ overload] [ forward]

<local declarations>
end sub

end.

Note: Sub functions and sub procedures must have the same declarations in the
interface and implementation section. Otherwise, compiler will report an error.
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SCOPE AND VISIBILITY

Scope

The scope of identifier is a part of the program in which the identifier can be used to
access its object. There are different categories of scope, depending on how and

where identifiers are declared:

Place of declaration

Scope

Identifier is declared in the
declaration section of the main
module, out of any function or
procedure

Scope extends from the point where it is
declared to the end of the current file, including
all routines enclosed within that scope. These
identifiers have a file scope and are referred to
as globals.

Identifier is declared in the
function or procedure

Scope extends from the point where it is
declared to the end of the current routine. These
identifiers are referred to as locals.

Identifier is declared in the
interface section of the module

Scope extends the interface section of a module
from the point where it is declared to the end of
the module, and to any other module or program
that uses that module. The only exception are
symbols which have a scope limited to the file in
which they are declared.

Identifier is declared in the
implementation section of the
module, but not within any
function or procedure

Scope extends from the point where it is
declared to the end of the module. The identifier
is available to any function or procedure in the
module.

Visibility

The visibility of an identifier is a region of the program source code from where a

legal access to the identifier’s associated object can be made .

Scope and visibility usually coincide, though there are circumstances under which
an object becomes temporarily hidden by the appearance of a duplicate identifier:
the object still exists but the original identifier cannot be used to access it until the

scope of the duplicate identifier is ended.

Technically, visibility cannot exceed scope, but scope can exceed visibility.
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MODULES

In mikroBasic PRO for AVR, each project consists of a single project file and one or
more module files. The project file, with extension .mbpav contains information on
the project, while modules, with extension .mbas, contain the actual source code.
See Program Organization for a detailed look at module arrangement.

Modules allow you to:

- break large programs into encapsulated modules that can be edited separately,
- create libraries that can be used in different projects,
- distribute libraries to other developers without disclosing the source code.

Each module is stored in its own file and compiled separately; compiled modules are
linked to create an application. To build a project, the compiler needs either a source
file or a compiled module file for each module.

Include Clause

mikroBasic PRO for AVR includes modules by means of the include clause. It con-
sists of the reserved word include, followed by a quoted module name. Extension of
the file should not be included.

You can include one file per include clause. There can be any number of the include
clauses in each source file, but they all must be stated immediately after the pro-
gram (or module) name.

Here’s an example:
program MyProgram

include "utils"
include "strings"
include "MyUnit"

For the given module name, the compiler will check for the presence of .mcl and
.mbas files, in order specified by search paths.

- If both .mbas and .mc1 files are found, the compiler will check their dates and
include the newer one in the project. If the .mbas file is newer than the .mc1, then
.mbas file will be recompiled and new .mc1 will be created, overwriting the old .mc1.

- If only the .mbas file is found, the compiler will create the .mc1 file and include it in
the project;

- If only the .nc1 file is present, i.e. no source code is available, the compiler will
include it as found;

- If none of the files found, the compiler will issue a “File not found” warning.
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Main Module

Every project in mikroBasic PRO for AVR requires a single main module file. The
main module is identified by the keyword program at the beginning. It instructs the
compiler where to “start”.

After you have successfully created an empty project with Project Wizard, Code Edi-
tor will display a new main module. It contains the bare-bones of the program:

program MyProject

1

main procedure
main:
' Place program code here

end.

Other than comments, nothing should precede the keyword program. After the pro-
gram name, you can optionally place the include clauses.

Place all global declarations (constants, variables, labels, routines, structures)
before the label main.

Other Modules

Modules other than main start with the keyword modu1e. Newly created blank mod-
ule contains the bare-bones:

module MyModule
implements

end.

Other than comments, nothing should precede the keyword modu1e. After the mod-
ule name, you can optionally place the incilude clauses.

Interface Section

Part of the module above the keyword implements is referred to as interface sec-
tion. Here, you can place global declarations (constants, variables, labels, routines,
structures) for the project.

Do not define routines in the interface section. Instead, state the prototypes of rou-
tines (from implementation section) that you want to be visible outside the module.
Prototypes must exactly match the declarations.
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Implementation Section

Implementation section hides all the irrelevant innards from other modules, allowing
encapsulation of code.

Everything declared below the keyword implements is private, i.e. has its scope lim-
ited to the file. When you declare an identifier in the implementation section of a
module, you cannot use it outside the module, but you can use it in any block or rou-
tine defined within the module.

By placing the prototype in the interface section of the module (above the impie-
ments) you can make the routine public, i.e. visible outside of module. Prototypes
must exactly match the declarations.
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VARIABLES

Variable is an object whose value can be changed during the runtime. Every vari-
able is declared under unique name which must be a valid identifier. This name is
used for accessing the memory location occupied by the variable.

Variables are declared in the declaration part of the file or routine — each variable needs
to be declared before it is used. Global variables (those that do not belong to any enclos-
ing block) are declared below the include statements, above the label main.

Specifying a data type for each variable is mandatory. mikroBasic PRO syntax for
variable declaration is:

dim identifier list as type

Here, identifier list is a comma-delimited list of valid identifiers, and type can
be any data type.

For more details refer to Types and Types Conversions. For more information on
variables’ scope refer to the chapter Scope and Visibility.

Here are a few examples:

dim i, j, k as byte
dim counter, temp as word

dim samples as longint[ 100]
Variables and AVR

Every declared variable consumes part of RAM memory. Data type of variable deter-
mines not only the allowed range of values, but also the space a variable occupies
in RAM memory. Bear in mind that operations using different types of variables take
different time to be completed. mikroBasic PRO for AVR recycles local variable
memory space — local variables declared in different functions and procedures
share the same memory space, if possible.

There is no need to declare SFR explicitly, as mikroBasic PRO for AVR automatically
declares relevant registers as global variables of word. For example: wo, TvR1, etc.
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CONSTANTS

Constant is a data whose value cannot be changed during the runtime. Using a con-
stant in a program consumes no RAM memory. Constants can be used in any
expression, but cannot be assigned a new value.

Constants are declared in the declaration part of the program or routine, with the fol-
lowing syntax:

const constant name [ as type] = value

Every constant is declared under unique constant name which must be a valid
identifier. It is a tradition to write constant names in uppercase. Constant requires
you to specify value, which is a literal appropriate for the given type. t ype is option-
al and in the absence of it , the compiler assumes the “smallest” type that can
accommodate value.

Note: You cannot omit type if declaring a constant array.

Here are a few examples:

const MAX as longint = 10000

const MIN = 1000 ' compiler will assume word type

const SWITCH = "n" ' compiler will assume char type

const MSG = "Hello" ' compiler will assume string type

const MONTHS as bytel 12] = (31,28,31,30,31,30,31,31,30,31,30,31)
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LABELS

Labels serve as targets for the goto and gosub statements. Mark the desired state-
ment with label and colon like this:

label identifier : statement
No special declaration of label is necessary in mikroBasic PRO for AVR.

Name of the label needs to be a valid identifier. The labeled statement and
goto/gosub statement must belong to the same block. Hence it is not possible to
jump into or out of routine. Do not mark more than one statement in a block with the
same label.

Note: The label mzin marks the entry point of a program and must be present in the
main module of every project. See Program Organization for more information.

Here is an example of an infinite loop that calls the procedure reep repeatedly:

loop:
Beep
goto loop
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SYMBOLS

mikroBasic PRO symbols allow you to create simple macros without parameters.
You can replace any line of code with a single identifier alias. Symbols, when prop-
erly used, can increase code legibility and reusability.

Symbols need to be declared at the very beginning of the module, right after the
module name and (optional) include clauses. Check Program Organization for
more details. Scope of a symbol is always limited to the file in which it has been
declared.

Symbol is declared as:
symbol alias = code
Here, =1ias must be a valid identifier which you will use throughout the code. This
identifier has a file scope. The code can be any line of code (literals, assignments,

function calls, etc).

Using a symbol in the program consumes no RAM — the compiler will simply replace
each instance of a symbol with the appropriate line of code from the declaration.

Here is an example:

symbol MAXALLOWED = 216 ' Symbol as alias for numeric value
symbol PORT = PO ' Symbol as alias for SFR

symbol MYDELAY = Delay ms(1000) ' Symbol as alias for procedure call
dim cnt as byte ' Some variable

main:

if cnt > MAXALLOWED then
cnt = 0
PORT.1 = 0
MYDELAY

end if

Note: Symbols do not support macro expansion in a way the C preprocessor does.
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FUNCTIONS AND PROCEDURES

Functions and procedures, collectively referred to as routines, are subprograms (self-con-
tained statement blocks) which perform a certain task based on a number of input param-
eters. When executed, a function returns value while procedure does not.

Functions

Function is declared like this:

sub function function name (parameter list) as return type
[ local declarations
function body

end sub

function name represents a function’s name and can be any valid identifier.
return type is a type of return value and can be any simple type. Within parenthe-
ses, parameter list is @ formal parameter list similar to variable declaration. In
mikroBasic PRO for AVR, parameters are always passed to a function by value. To
pass an argument by address, add the keyword byrer ahead of identifier.

Local declarations are optional declarations of variables and/or constants, local
for the given function. Function body is a sequence of statements to be executed
upon calling the function.

Calling a function

A function is called by its name, with actual arguments placed in the same sequence
as their matching formal parameters. The compiler is able to coerce mismatching
arguments to the proper type according to implicit conversion rules. Upon a function
call, all formal parameters are created as local objects initialized by values of actu-
al arguments. Upon return from a function, a temporary object is created in the place
of the call and it is initialized by the value of the function result. This means that func-
tion call as an operand in complex expression is treated as the function result.

In standard Basic, a function name is automatically created local variable that can
be used for returning a value of a function. mikroBasic PRO for AVR also allows you
to use the automatically created local variable result to assign the return value of
a function if you find function name to be too ponderous. If the return value of a func-
tion is not defined the compiler will report an error.

Function calls are considered to be primary expressions and can be used in situa-
tions where expression is expected. A function call can also be a self-contained
statement and in that case the return value is discarded.
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Example

Here’s a simple function which calculates x” based on input parameters < and n (n > 0):

sub function power(dim x, n as byte) as longint
dim i as byte
result = 1
if n > 0 then
for i = 1 ton
result = result*x
next 1
end if

end sub

Now we could call it to calculate, say, 312:

tmp = power (3, 12)
PROCEDURES

Procedure is declared like this:

sub procedure procedure name (parameter list)
[ local declarations
procedure body

end sub

procedure name represents a procedure’s name and can be any valid identifier. Within
parentheses, parameter 1ist isaformal parameter list similar to variable declaration. In
mikroBasic PRO for AVR, parameters are always passed to procedure by value; to pass
argument by address, add the keyword by ref ahead of identifier.

Local declarations are optional declaration of variables and/or constants, local
for the given procedure. procedure body is a sequence of statements to be execut-
ed upon calling the procedure.

Calling a procedure

A procedure is called by its name, with actual arguments placed in the same
sequence as their matching formal parameters. The compiler is able to coerce mis-
matching arguments to the proper type according to implicit conversion rules. Upon
procedure call, all formal parameters are created as local objects initialized by val-
ues of actual arguments.

Procedure call is a self-contained statement.
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Example

Here’s an example procedure which transforms its input time parameters, preparing
them for output on Lcd:

sub procedure time prep(dim byref sec, min, hr as byte)

sec = ((sec and SF0) >> 4)*10 + (sec and S$0F)

min = ((min and S$FO0) >> 4)*10 + (min and $OF)

hr = ((hr and $FO0) >> 4)*10 + (hr and S$0F)
end sub

Function Pointers

Function pointers are allowed in mikroBasic PRO for AVR. The example shows how
to define and use a function pointer:

Example:

Example demonstrates the usage of function pointers. It is shown how to declare a
procedural type, a pointer to function and finally how to call a function via pointer.

program Example;

typedef TMyFunctionType = function (dim paraml, param2 as byte, dim
param3 as word) as word ' First, define the procedural type

dim MyPtr as "“TMyFunctionType ' This 1s a pointer to previously
defined type
dim sample as word

sub function Funcl (dim pl, p2 as byte, dim p3 as word) as word ' Now,
define few functions which will be pointed to. Make sure that param-
eters match the type definition

result = pl and p2 or p3
end sub

sub function Func?2 (dim abc, def as byte, dim ghi as word) as word '
Another function of the same kind. Make sure that parameters match
the type definition

result = abc * def + ghi
end sub

sub function Func3(dim first, yellow as byte, dim monday as word) as

word ' Yet another function. Make sure that parameters match the
type definition

result = monday - yellow - first
end sub
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' main program:

main:

MyPtr = (@Funcl ' MyPtr now points to Funcl

Sample = MyPtr”~ (1, 2, 3) ' Perform function call via pointer, call
Funcl, the return value is 3

MyPtr = Q@Func?2 ' MyPtr now points to Func?2

Sample = MyPtr”~ (1, 2, 3) ' Perform function call via pointer, call
Func2, the return value is 5

MyPtr = @Func3 ' MyPtr now points to Func3

Sample = MyPtr”~ (1, 2, 3) ' Perform function call via pointer, call
Func3, the return value is 0
end.

A function can return a complex type. Follow the example bellow to learn how to
declare and use a function which returns a complex type.

Example:

This example shows how to declare a function which returns a complex type.
program Example
structure TCircle ' Structure
dim CenterX, CenterY as word
dim Radius as byte
end structure

dim MyCircle as TCircle ' Global variable

sub function DefineCircle(dim x, y as word, dim r as byte) as TCircle
' DefineCircle function returns a Structure

result.CenterX = x

result.CenterY = y

result.Radius = r
end sub
main:

MyCircle = DefineCircle (100, 200, 30) ' Get
a Structure via function call

MyCircle.CenterX = DefineCircle (100, 200, 30).CenterX + 20 '

Access a Structure field via function call

! |-— - L |

! \ \

! Function returns TCircle Access to one
field of TCircle
end.
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Forward declaration

A function can be declared without having it followed by it's implementation, by hav-
ing it followed by the forward procedure. The effective implementation of that func-
tion must follow later in the module. The function can be used after a forward dec-
laration as if it had been implemented already. The following is an example of a for-
ward declaration:

program Volume
dim Volume as word
sub function First(a as word, b as word) as word forward
sub function Second(c as word) as word
dim tmp as word
tmp = First (2, 3)
result = tmp * c

end sub

sub function First(a, b as word) as word

result = a * b
end sub
main:

Volume = Second(4)
end.
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TYPES

Basic is strictly typed language, which means that every variable and constant need
to have a strictly defined type, known at the time of compilation.

The type serves:

- to determine correct memory allocation required,
- to interpret the bit patterns found in the object during subsequent accesses,
- in many type-checking situations, to ensure that illegal assignments are trapped.

mikroBasic PRO supports many standard (predefined) and user-defined data types,
including signed and unsigned integers of various sizes, arrays, strings, pointers
and structures.

Type Categories
Types can be divided into:

- simple types
- arrays

- strings

- pointers

- structures

136 MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD



CHAPTER 5
mikroBasic PRO for AVR Language Reference

SIMPLE TYPES

Simple types represent types that cannot be divided into more basic elements and
are the model for representing elementary data on machine level. Basic memory
unit in mikroBasic PRO for AVR has 8 bits.

Here is an overview of simple types in mikroBasic PRO for AVR:

Type Size Range
byte, char 8—bit 0..255
short 8—bit 127 .. 128
word 16—bit 0 .. 65535
integer 16-bit -32768 .. 32767
longword 32-bit 0 .. 4294967295
longint 32-bit -2147483648 .. 2147483647
I 32 bit £1.17549435082 * 1038 |
+6.80564774407 * 1038
bit 1-bit Oor1
sbit 1-bit Oor1

You can assign signed to unsigned or vice versa only using the explicit conversion.
Refer to Types Conversions for more information.
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ARRAYS

An array represents an indexed collection of elements of the same type (called the
base type). Since each element has a unique index, arrays, unlike sets, can mean-
ingfully contain the same value more than once.

Array Declaration

Array types are denoted by constructions in the following form:

typel array length]

Each of elements of an array is numbered from 0 through array length - 1. Every
element of an array is of type and can be accessed by specifying array name fol-
lowed by element’s index within brackets.

Here are a few examples of array declaration:

dim weekdays as byte[ 7]
dim samples as word 50]

main:
' Now we can access elements of array variables, for example:
samples[ 0] = 1
if samples[ 37] = 0 then

1

Constant Arrays

Constant array is initialized by assigning it a comma-delimited sequence of values
within parentheses. For example:

' Declare a constant array which holds number of days in each month:
const MONTHS as byte[ 12] = (31,28,31,30,31,30,31,31,30,31,30,31)

Note that indexing is zero based; in the previous example, number of days in Jan-
uary is MmonNTHS[ 0] and number of days in December is MoNTHS[ 11] .

The number of assigned values must not exceed the specified length. Vice versa is
possible, when the trailing “excess” elements will be assigned zeroes.

For more information on arrays of char, refer to Strings.
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STRINGS

A string represents a sequence of characters equivalent to an array of char. It is
declared like this:

string] st

ring length]

The specifier string length is @ number of characters a string consists of. The
string is stored internally as the given sequence of characters plus a final nu11 char-
acter (zero). This appended “stamp” does not count against string’s total length.

A null string (") is stored as a single nu11 character.

You can assign string literals or other strings to string variables. The string on the
right side of an assignment operator has to be shorter than another one, or of equal

length. For

dim msgl
dim msg2

main:
msgl =
msgz2 =
msgl =

Alternately,

dim s as

is

9]

is

9]

is

9]

is

9]

s = "mik"
1
1
1
1
1

is

9]

g W NP O

]
]
]
]
]
]

is

03]

example:

as string] 20]
as string] 19]

"This is some message"
"Yet another message"

msg?2 ' this is ok, but vice versa would be illegal

you can handle strings element—by—element. For example:

string| 5]

char literal "m"
char literal "i"
char literal "k"
Zero

undefined

undefined

Be careful when handling strings in this way, since overwriting the end of a string will
cause an unpredictable behavior.

Note

mikroBasic PRO for AVR includes String Library which automatizes string related tasks.
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POINTERS

A pointer is a data type which holds a memory address. While a variable accesses
that memory address directly, a pointer can be thought of as a reference to that
memory address.

To declare a pointer data type, add a carat prefix (*) before type. For example, if you
are creating a pointer to an integer, you would write:

“integer

To access the data at the pointer’s memory location, you add a carat after the vari-
able name. For example, let's declare variable p which points to word, and then
assign the pointed memory location value 5:

dim p as “word

1

p® =5

A pointer can be assigned to another pointer. However, note that only address, not
value, is copied. Once you modify the data located at one pointer, the other pointer,
when dereferenced, also yields modified data.

@ Operator

The @ operator returns the address of a variable or routine, i.e. ¢ constructs a
pointer to its operand. The following rules are applied to ¢:

- If x is a variable, ex returns the address of x.
- If 7 is a routine (a function or procedure), ¢r returns F’s entry point (the result
is of Tongint).
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STRUCTURES

A structure represents a heterogeneous set of elements. Each element is called a
member; the declaration of a structure type specifies a name and type for each
member. The syntax of a structure type declaration is

structure structname
dim memberl as typel

dim membern as typen

end structure

where structname is a valid identifier, each type denotes a type, and each member
is a valid identifier. The scope of a member identifier is limited to the structure in
which it occurs, so you don’t have to worry about naming conflicts between member
identifiers and other variables.

For example, the following declaration creates a structure type called Dot:

structure Dot
dim x as float
dim y as float

end structure

Each pot contains two members: < and y coordinates; memory is allocated when
you instantiate the structure, like this:

dim m, n as Dot
This variable declaration creates two instances of pot, called m and n.

A member can be of the previously defined structure type. For example:

' Structure defining a circle:
structure Circle

dim radius as float

dim center as Dot
end structure
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Structure Member Access

You can access the members of a structure by means of dot (.) as a direct member
selector. If we had declared the variables circlel and circle2 of the previously
defined type Circle:

dim circlel, circle2 as Circle

we could access their individual members like this:

.7
0
0

circlel.radius

I w

circlel.center.

X
circlel.center.y

You can also commit assignments between complex variables, if they are of the
same type:

circle2 = circlel ' This will copy values of all members
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TYPES CONVERSIONS

Conversion of variable of one type to variable of another type is typecasting.
mikroBasic PRO for AVR supports both implicit and explicit conversions for built-in
types.

Implicit Conversion
Compiler will provide an automatic implicit conversion in the following situations:

- statement requires an expression of particular type (according to language
definition) and we use an expression of different type,

- operator requires an operand of particular type and we use an operand of
different type,

- function requires a formal parameter of particular type and we pass it an object of
different type,

- result does not match the declared function return type.

Promotion

When operands are of different types, implicit conversion promotes the less com-
plex to the more complex type taking the following steps:

byte/char =+ word
short * integer
short -+ longint
integer * longint
integral * float

Higher bytes of extended unsigned operand are filled with zeroes. Higher bytes of
extended signed operand are filled with bit sign (if number is negative, fill higher
bytes with one, otherwise with zeroes). For example:

dim a as byte

dim b as word

SFF

b = a ' a is promoted to word, b becomes $00FF

a
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Clipping

In assignments and statements that require an expression of particular type, desti-
nation will store the correct value only if it can properly represent the result of
expression, i.e. if the result fits in destination range.

If expression evaluates to more complex type than expected excess data will be
simply clipped (the higher bytes are lost).

dim i as byte
dim j as word

j = SFFOF
i =7 ' 1 becomes $0F, higher byte $FF is lost

EXPLICIT CONVERSION

Explicit conversion can be executed at any point by inserting type keyword (byte,
word, short, integer, longint, OF float) ahead of the expression to be con-
verted. The expression must be enclosed in parentheses. Explicit conversion can be
performed only on the operand left of the assignment operator.

Special case is the conversion between signed and unsigned types. Explicit conver-
sion between signed and unsigned data does not change binary representation of
data — it merely allows copying of source to destination.

For example:

dim a as byte
dim b as short

b = -1
a = byte (b) ''a is 255, not 1

' This is because binary representation remains
' 11111111; it's Jjust interpreted differently now

You cannot execute explicit conversion on the operand left of the assignment operator:

word(b) = a ' Compiler will report an error
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OPERATORS

Operators are tokens that trigger some computation when being applied to variables
and other objects in an expression.

There are four types of operators in mikroBasic PRO for AVR:

- Arithmetic Operators
- Bitwise Operators

- Boolean Operators

- Relational Operators

OPERATORS PRECEDENCE AND ASSOCIATIVITY

There are 4 precedence categories in mikroBasic PRO for AVR. Operators in the
same category have equal precedence with each other.

Each category has an associativity rule: left-to-right ( -, or right-to-left ( «). In the
absence of parentheses, these rules resolve the grouping of expressions with oper-
ators of equal precedence.

Precedence | Operands Operators Associativity
4 1 @ not + - -
3 2 * / div mod and << >> —
2 2 + - or XOT —
1 2 = < < > <= >= N
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ARITHMETIC OPERATORS

Arithmetic operators are used to perform mathematical computations. They have numer-
ical operands and return numerical results. Since the char operators are technically
bytes, they can be also used as unsigned operands in arithmetic operations.

All arithmetic operators associate from left to right.

Operator Operation Operands Result

byte, short, word, |byte, short, word,

+ addition integer, longint, integer, longint,
longword, float longword, float
byte, short, word, |byte, short, word,

- subtraction integer, longint, |integer, longint,
longword, float longword, float
byte, short, word, |word, integer,

* multiplication integer, longint, |longint, longword,
longword, float float

byte, short, word,
/ division, floating-point integer, longint, |[float
longword, float

byte, short, word, |byte, short, word,
integer, longint, integer, longint,
longword longword

division, rounds down to near-

div .
est integer

modulus, returns the remainder |byte, short, word, |byte, short, word,
mod of integer division (cannot be integer, longint, |integer, longint,
used with floating points) longword longword

Division by Zero

If O (zero) is used explicitly as the second operand (i.e. x div 0), the compiler will
report an error and will not generate code.

But in case of implicit division by zero: x div vy, where y is 0 (zero), the result will
be the maximum integer (i.e 255, if the result is byte type; 655356, if the result is word
type, etc.).

Unary Arithmetic Operators

Operator - can be used as a prefix unary operator to change sign of a signed value.
Unary prefix operator + can be used, but it doesn’t affect data.

For example:

b = -a
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RELATIONAL OPERATORS

Use relational operators to test equality or inequality of expressions. All relational
operators return TRUE or FALSE.

Operator Operation
equal
<> not equal
> greater than
< less than
>= greater than or equal
<= less than or equal

All relational operators associate from left to right.
Relational Operators in Expressions

The equal sign (=) can also be an assignment operator, depending on context.

Precedence of arithmetic and relational operators was designated in such a way to
allow complex expressions without parentheses to have expected meaning:

if aa + 5 >= bb - 1.0 / cc then ' same as: if (aa + 5) >= (bb -
(1.0 / cc)) then
dd = My Function()

end if
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BITWISE OPERATORS

Use the bitwise operators to modify the individual bits of numerical operands.

Bitwise operators associate from left to right. The only exception is the bitwise com-
plement operator not which associates from right to left.

Bitwise Operators Overview

Operator Operation

bitwise AND; compares pairs of bits and generates a 1 result if both

and bits are 1, otherwise it returns 0

bitwise (inclusive) OR; compares pairs of bits and generates a 1 result

o if either or both bits are 1, otherwise it returns 0

bitwise exclusive OR (XOR); compares pairs of bits and generates a 1

wor result if the bits are complementary, otherwise it returns 0

not bitwise complement (unary); inverts each bit

bitwise shift left; moves the bits to the left, it discards the far left bit

o and assigns 0 to the right most bit.

bitwise shift right; moves the bits to the right, discards the far right bit

. and if unsigned assigns 0 to the left most bit, otherwise sign extends

Logical Operations on Bit Level

and| 0 | 1 or| 0| 1 xor| 0 | 1 not| 0 | 1
0(O0]O 00| 1 00| 1 1710
11011 1|1 1 11110

The bitwise operators znd, or, and xor perform logical operations on the appro-
priate pairs of bits of their operands. The operator not complements each bit of its
operand. For example:
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$1234 and $5678 ' equals $1230
' because

$1234 : 0001 0010 0011 0100
$5678 : 0101 0110 0111 1000

and : 0001 0010 0011 0000

' .. that is, $1230°'

Similarly:

$1234 or $5678 ' equals $567C
$1234 xor $5678 ' equals $444C
not $1234 ' equals SEDCB

Unsigned and Conversions

If number is converted from less complex to more complex data type, the upper
bytes are filled with zeroes. If number is converted from more complex to less com-
plex data type, the data is simply truncated (upper bytes are lost).

For example:
dim a as byte
dim b as word
a = SAA
b = SFOFO
b = b and a
'a

is extended with zeroes; b becomes $00AQ0
Signed and Conversions

If number is converted from less complex to more complex data type, the upper
bytes are filled with ones if sign bit is 1 (number is negative); the upper bytes are
filled with zeroes if sign bit is 0 (number is positive). If number is converted from
more complex to less complex data type, the data is simply truncated (the upper
bytes are lost).

For example:
dim a as byte
dim b as word
a = -12
b = S$70FF
b = b and a
' a is sign extended, upper byte is SFF;
' b becomes $70F4
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Bitwise Shift Operators

The binary operators << and >> move the bits of the left operand by a number of
positions specified by the right operand, to the left or right, respectively. Right
operand has to be positive and less than 255.

With shift left (<<), left most bits are discarded, and “new” bits on the right are
assigned zeroes. Thus, shifting unsigned operand to the left by n positions is equiv-
alent to multiplying it by 2n if all discarded bits are zero. This is also true for signed
operands if all discarded bits are equal to the sign bit.

With shift right (>>), right most bits are discarded, and the “freed” bits on the left are
assigned zeroes (in case of unsigned operand) or the value of the sign bit (in case
of signed operand). Shifting operand to the right by n positions is equivalent to divid-
ing it by 2.

BOOLEAN OPERATORS

Although mikroBasic PRO for AVR does not support boolean type, you have
Boolean operators at your disposal for building complex conditional expressions.
These operators conform to standard Boolean logic and return either TrUE (all ones)
or FALSE (zero):

Operator Operation

and logical AND

or logical OR

xor logical exclusive OR (XOR)

not logical negation

Boolean operators associate from left to right. Negation operator not associates
from right to left.
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EXPRESSIONS

An expression is a sequence of operators, operands, and punctuators that returns
a value.

The primary expressions include: literals, constants, variables and function calls.
From them, using operators, more complex expressions can be created. Formally,
expressions are defined recursively: subexpressions can be nested up to the limits
of memory.

Expressions are evaluated according to certain conversion, grouping, associativity
and precedence rules that depend on the operators used, presence of parentheses,
and data types of the operands. The precedence and associativity of the operators
are summarized in Operator Precedence and Associativity. The way operands and
subexpressions are grouped does not necessarily specify the actual order in which
they are evaluated by mikroBasic PRO for AVR.
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STATEMENTS

Statements define algorithmic actions within a program. Each statement needs to
be terminated with a semicolon (;). In the absence of specific jump and selection
statements, statements are executed sequentially in the order of appearance in the
source code.

The most simple statements are assignments, procedure calls and jump statements.
These can be combined to form loops, branches and other structured statements.

Refer to:
- Assignment Statements
- Conditional Statements
- lteration Statements (Loops)
- Jump Statements

- asm Statement

ASSIGNMENT STATEMENTS

Assignment statements have the following form:

variable = expression

The statement evaluates expression and assigns its value to variable. All rules of
implicit conversion are applied. variable can be any declared variable or array ele-
ment, and expression can be any expression.

Do not confuse the assignment with relational operator = which tests for equality.
mikroBasic PRO for AVR will interpret the meaning of the character = from the context.
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CONDITIONAL STATEMENTS

Conditional or selection statements select from alternative courses of action by test-
ing certain values. There are two types of selection statements:

- if
- select case

IF STATEMENT

Use the keyword if to implement a conditional statement. The syntax of the if state-
ment has the following form:

if expression then
statements

[ else
other statements]

end if

When expression evaluates to true, statements execute. If expression is false,
other statements execute. The expression must convert to a boolean type; oth-
erwise, the condition is ill-formed. The <1se keyword with an alternate block of state-
ments (other statements) is optional.

Nested if statements

Nested if statements require additional attention. A general rule is that the nested
conditionals are parsed starting from the innermost conditional, with each eise
bound to the nearest available i r on its left:

if expressionl then
if expression2 then
statementl

else

statement2

end if

end if

The compiler treats the construction in this way:

if expressionl then
if expression2 then
statementl
else
statement2
end if
end if
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In order to force the compiler to interpret our example the other way around, we
have to write it explicitly:

if expressionl then
if expression2 then
statementl
end if
else
statement?
end if

SELECT CASE STATEMENT

Use the select case statement to pass control to a specific program branch, based
on a certain condition. The select case statement consists of selector expression
(condition) and list of possible values. The syntax of the select case statementis:

select case selector
case value 1
statements 1

case value n
statements n
[ case else
default statements]
end select

selector is an expression which should evaluate as integral value. values can be
literals, constants or expressions and statements can be any statements. The case
else clause is optional.

First, the selector expression (condition) is evaluated. The select case statement
then compares it against all available va1ues. If the match is found, the statements
following the match evaluate, and the select case statement terminates. In case
there are multiple matches, the first matching statement will be executed. If none of
the values matches the selector, then default statements in the case else
clause (if there is one) are executed.

Here is a simple example of the select case statement:

select case operator

case Mk

res = nl * n2
case "/"

res = nl / n2
case "+"

res = nl + n2
case mw_mn

res = nl - n2
case else

res = 0

cnt = cnt + 1

end select
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Also, you can group values together for a match. Simply separate the items by com-
mas:

select case reg
case 0
opmode
case 1,2,
opmode
case 5,06,
opmode

14

I~ W
) — o

end select
Nested Case Statements

Note that the select case statements can be nested — values are then assigned
to the innermost enclosing select case statement.

ITERATION STATEMENTS

Iteration statements let you loop a set of statements. There are three forms of iter-
ation statements in mikroBasic PRO for AVR:

- for
- while
- repeat

You can use the statements break and continue to control the flow of a loop state-
ment. break terminates the statement in which it occurs, while continue begins exe-
cuting the next iteration of the sequence.
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FOR STATEMENT

The for statement implements an iterative loop and requires you to specify the num-
ber of iterations. The syntax of the for statement is:

for counter = initial value to final value [ step step value]
statements
next counter

counter is a variable being increased by step value with each iteration of the loop.
The parameter step value is an optional integral value, and defaults to 1 if omit-
ted. Before the first iteration, counter is set to initial value and will be incre-
mented until it reaches (or exceeds) the final value. With each iteration, state-
ments will be executed.

initial value and final value should be expressions compatible with counter;
statements can be any statements that do not change the value of counter.

Note that the parameter step value may be negative, allowing you to create a
countdown.

Here is an example of calculating scalar product of two vectors, 2 and b, of length
n, using the for statement:

s =0
for i

= 0 to n-1
s s + af i] *

a Pl 1]

next 1
Endless Loop

The for statement results in an endless loop if final value equals or exceeds the
range of the counter’ s type.
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WHILE STATEMENT

Use the while keyword to conditionally iterate a statement. The syntax of the while
statement is:

while expression
statements
wend

statements are executed repeatedly as long as expression evaluates true. The
test takes place before statements are executed. Thus, if expression evaluates
false on the first pass, the loop does not execute.

Here is an example of calculating scalar product of two vectors, using the while
statement:

s =0

i =0

while i < n
s = s + a[ 1] * D[ 1]
i=1+1

wend

Probably the easiest way to create an endless loop is to use the statement:

while TRUE

wend
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DO STATEMENT

The do statement executes until the condition becomes true. The syntax of the do
statement is:

do
statements

loop until expression

statements are executed repeatedly until expression evaluates true. expression
is evaluated after each iteration, so the loop will execute statements at least once.

Here is an example of calculating scalar product of two vectors, using the do statement:

s =0

i =0

do

s = s + a[ 1] * D[ 1]
i=1+1

loop until i = n

JUMP STATEMENTS

A jump statement, when executed, transfers control unconditionally. There are five
such statements in mikroBasic PRO for AVR:

- break

- continue
- exit

- goto

- gosub
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BREAK AND CONTINUE STATEMENTS

Break Statement

Sometimes, you might need to stop the loop from within its body. Use the break
statement within loops to pass control to the first statement following the innermost
loop (for, while, or do).

For example:

Lecd Out(l, 1, "No card inserted")

' Wait for CF card to be plugged; refresh every second
while true
if Cf Detect() = 1 then
break
end if
Delay ms (1000)
wend

' Now we can work with CF card ...
Lecd Out(l, 1, "Card detected ")

Continue Statement
You can use the continue statement within loops to “skip the cycle”:

- continue statement in the for loop moves program counter to the line with
keyword for

- continue statementin the while loop moves program counter to the line with loop
condition (top of the loop),

- continue statement in the do loop moves program counter to the line with loop
condition (bottom of the loop).

' continue jumps ' continue jumps do
here here .
for i = ... while condition continue
continue continue ' continue jumps
. . here
next i wend loop until condition
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EXIT STATEMENT

The exit statement allows you to break out of a routine (function or procedure). It
passes the control to the first statement following the routine call.

Here is a simple example:

sub procedure Procl ()
dim error as byte
. ' we're doing something here
if error = TRUE then
exit
end if
' some code, which won't be executed if error is true

end sub

Note: If breaking out of a function, return value will be the value of the local variable
result at the moment of exit.
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GOTO STATEMENT

Use the goto statement to unconditionally jump to a local label — for more informa-
tion, refer to Labels. The syntax of the goto statement is:

goto label name

This will transfer control to the location of a local label specified by 1abel name. The
goto line can come before or after the label.

Label and goto statement must belong to the same block. Hence it is not possible
to jump into or out of a procedure or function.

You can use goto to break out from any level of nested control structures. Never
jump into a loop or other structured statement, since this can have unpredictable
effects.

The use of goto statement is generally discouraged as practically every algorithm
can be realized without it, resulting in legible structured programs. One possible
application of the goto statement is breaking out from deeply nested control struc-

tures:
for i = 0 to n
for j = 0 tom

if disaster
goto Error

end if
next j
next i
Error: ' error handling code
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GOSUB STATEMENT

Use the gosub statement to unconditionally jump to a local label — for more infor-
mation, refer to Labels. The syntax of the gosub statement is:

gosub label name
label name:
return

This will transfer control to the location of a local label specified by 1abel name.
Also, the calling point is remembered. Upon encountering the return statement,
program execution will continue with the next statement (line) after gosub. The
gosub line can come before or after the label.

It is not possible to jump into or out of routine by means of gosub. Never jump into
a loop or other structured statement, since this can have unpredictable effects.

Note: Like with coto, the use of gosub statement is generally discouraged. mikroBasic
PRO for AVR supports gosub only for the sake of backward compatibility. It is better to rely
on functions and procedures, creating legible structured programs.
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ASM STATEMENT

mikroBasic PRO for AVR allows embedding assembly in the source code by means
of the asm statement. Note that you cannot use numerals as absolute addresses for
register variables in assembly instructions. You may use symbolic names instead
(listing will display these names as well as addresses).

You can group assembly instructions with the asm keyword:

asm
block of assembly instructions

end asm

mikroBasic PRO comments are not allowed in embedded assembly code. Instead,
you may use one-line assembly comments starting with semicolon.

If you plan to use a certain mikroBasic PRO variable in embedded assembly only, be sure
to at least initialize it (assign it initial value) in mikroBasic PRO code; otherwise, the linker
will issue an error. This is not applied to predefined globals such as PO.

For example, the following code will not be compiled because the linker won’t be
able to recognize the variable myvar:

program test
dim myvar as word

main:
asm
MOV #10, WO
MOV WO, myvar
end asm
end.

Adding the following line (or similar) above the asm block would let linker know that
variable is used:

mnyvar = 20
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DIRECTIVES

Directives are words of special significance which provide additional functionality
regarding compilation and output.

The following directives are at your disposal:

- Compiler directives for conditional compilation,
- Linker directives for object distribution in memory.

COMPILER DIRECTIVES

Any line in source code with leading # is taken as a compiler directive. The initial #
can be preceded or followed by whitespace (excluding new lines). The compiler
directives are not case sensitive.

You can use conditional compilation to select particular sections of code to compile
while excluding other sections. All compiler directives must be completed in the
source file in which they begun.

Directives #DEFINE and #UNDEFINE

Use directive #pErINE to define a conditional compiler constant (“flag”). You can use
any identifier for a flag, with no limitations. No conflicts with program identifiers are
possible because the flags have a separate name space. Only one flag can be set
per directive.

For example:
#DEFINE extended format
Use #unpEFINE to undefine (“clear”) previously defined flag.

Directives #IFDEF, #ELSEIF and #ELSE

Conditional compilation is carried out by the #1rpEF directive. #1rDEF tests whether
a flag is currently defined or not; i.e. whether the previous #perinE directive has
been processed for that flag and is still in force.

The directive # 1rDEF is terminated by the #enD1F directive and can have any num-
ber of the #E1L.sE1F clauses and an optional #E1.sE clause:
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#IFDEF flag THEN
block of code

[ #ELSEIF flag 1 THEN
block of code 1

#ELSEIF flag n THEN

block of code n ]
[ #ELSE

alternate block of code ]
#ENDIF

First, # TrDEF checks if flag is set by means of #per1nE. If so, only block of code will
be compiled. Otherwise, the compiler will check flags f1ag 1 .. flag n and exe-
cute the appropriate block of code i. Eventually, if none of the flags is set, alternate
block of code in #rLsE (if any) will be compiled.

#ENDIF ends the conditional sequence. The result of the preceding scenario is that
only one section of code (possibly empty) is passed on for further processing. The
processed section can contain further conditional clauses, nested to any depth;
each #1rDEF must be matched with a closing #ENDTF.

Here is an example:
' Uncomment the appropriate flag for your application:
'"#DEFINE resolution8
"#DEFINE resolutionlO
'"#DEFINE resolutionl?2

#IFDEF resolution8 THEN
... ' code specific to 8-bit resolution
#ELSEIF resolutionl(O THEN
... ' code specific to 10-bit resolution
#ELSEIF resolutionl2 THEN
... ' code specific to 12-bit resolution
#ELSE
... ' default code
#ENDIF
Predefined Flags

The compiler sets directives upon completion of project settings, so the user does-
n't need to define certain flags.
Here is an example:

#IFDEF ATMEGAl6 ' If ATmegal6 MCU is selected
#IFDEF ATMEGA128 ' If ATmegal28 MCU is selected

In some future releases of the compiler, the JTAG flag will be added also.

See also predefined project level defines.
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LINKER DIRECTIVES

mikroBasic PRO for AVR uses internal algorithm to distribute objects within memo-
ry. If you need to have a variable or routine at the specific predefined address, use
the linker directives absolute and org.

Note: You must specify an even address when using the linker directives.
Directive absolute

The directive absolute specifies the starting address in RAM for a variable. If the
variable spans more than 1 word (16-bit), higher words will be stored at the consec-
utive locations.

The zbsolute directive is appended to the declaration of a variable:

dim x as word absolute 0x32
' Variable x will occupy 1 word (16 bits) at address 0x32

dim y as longint absolute 0x34
' Variable y will occupy 2 words at addresses 0x34 and 0x36

Be careful when using absolute directive, as you may overlap two variables by
accident. For example:

dim i as word absolute 0x42
' Variable i will occupy 1 word at address 0x42;

dim jj as longint absolute 0x40
' Variable will occupy 2 words at 0x40 and 0Ox42; thus,

' changing i changes jj at the same time and vice versa

Note: You must specify an even address when using the directive absolute.
Directive org

The directive org specifies the starting address of a routine in ROM. It is appended
to the declaration of routine. For example:

sub procedure proc(dim par as word) org 0x200
' Procedure will start at the address 0x200;

end sub

Note: You must specify an even address when using the directive org.
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mikroBasic PRO for AVR provides a set of libraries which simplify the initialization
and use of AVR compliant MCUs and their modules:

Use Library manager to include mikroBasic PRO for AVR Libraries in you project.

167



CHAPTER 6
Libraries mikroBasic PRO for AVR

HARDWARE AVR-SPECIFIC LIBRARIES

- ADC Library

- CANSPI Library

- Compact Flash Library

- EEPROM Library

- Flash Memory Library

- Graphic Lcd Library

- Keypad Library

- Lcd Library

- Manchester Code Library
- Multi Media Card library
- OneWire Library

- Port Expander Library

- PS/2 Library

- PWM Library

- PWM 16 bit Library

- RS-485 Library

- Software 12C Library

- Software SPI Library

- Software UART Library

- Sound Library

- SPI Library

- SPI Ethernet Library

- SPI Graphic Lcd Library
- SPI Lcd Library

- SPI Lcd8 Library

- SPI T6963C Graphic Lcd Library
- T6963C Graphic Lcd Library
- TWI Library

- UART Library

Miscellaneous Libraries

- Button Library

- Conversions Library
- Math Library

- String Library

- Time Library

- Trigonometry Library

See also Built-in Routines.
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LIBRARY DEPENDENCIES

Certain libraries use (depend on) function and/or variables, constants defined in

other libraries.

Image below shows clear representation about these dependencies.

For example, SPI _Glcd uses
Glcd_Fonts and Port_Expander
library which uses SPI library.

This means that if you check
SPI_Glcd library in Library manag-
er, all libraries on which it depends
will be checked too.

Related topics: Library manager,
AVR Libraries
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ADC LIBRARY

ADC (Analog to Digital Converter) module is available with a number of AVR micros. Library func-
tion ADC Rread is included to provide you comfortable work with the module in single-ended mode.

ADC_Read

Prototype sub function ADC Read(dim channel as byte) as word

Returns 10-bit or 12-bit (MCU dependent) unsigned value from the specified channel.

Initializes AVR ’s internal ADC module to work with XTAL frequency prescaled
by 128. Clock determines the time period necessary for performing A/D conver-
. sion.

Description
Parameter channel represents the channel from which the analog value is to be
acquired. Refer to the appropriate datasheet for channel-to-pin mapping.

Requires Nothing.

dim tmp as word
Example

tmp = ADC Read(2) ' Read analog value from channel 2

Library Example
This example code reads analog value from channel 2 and displays it on PORTB and PORTC.
program ADC on LEDs
dim adc rd as word
main:
DDRB = OxFF ' Set PORTB as output

DDRC = OxFF ' Set PORTC as output

while TRUE

temp res = ADC Read(2) ' get ADC value from 2nd channel
PORTB = adc_rd ' display adc_xd[ 7..0]
PORTC = Hi (adc_rd) ' display adc_rd[ 9..8]

wend

end.
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HW Connection
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mikroBasic PRO for AVR

CANSPI LIBRARY

The SPI module is available with a number of the AVR compliant MCUs. The
mikroBasic PRO for AVR provides a library (driver) for working with mikroElektroni-
ka's CANSPI Add-on boards (with MCP2515 or MCP2510) via SPI interface.

The CAN is a very robust protocol that has error detection and signalization,
self-checking and fault confinement. Faulty CAN data and remote frames are re-
transmitted automatically, similar to the Ethernet.

Data transfer rates depend on distance. For example, 1 Mbit/s can be achieved at
network lengths below 40m while 250 Kbit/s can be achieved at network lengths
below 250m. The greater distance the lower maximum bitrate that can be achieved.
The lowest bitrate defined by the standard is 200Kbit/s. Cables used are shielded
twisted pairs.

CAN supports two message formats:

- Standard format, with 11 identifier bits and
- Extended format, with 29 identifier bits

Note:

- Consult the CAN standard about CAN bus termination resistance.

- An effective CANSPI communication speed depends on SPI and certainly is
slower than “real” CAN.

- CANSPI module refers to mikroElektronika's CANSPI Add-on board connected to
SPI module of MCU.

- Prior to calling any of this library routines, Spi_Rd_Ptr needs to be initialized with
the appropriate SPI_Read routine.
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External dependencies of CANSPI Library

The following variables

must be defined in all

projects using CANSPI
Library:

Description:

Example :

dim CanSpi CS as sbit
sfr external

Chip Select line.

dim CanSpi CS as sbit
at PORTB.BO

dim CanSpi Rst as
sbit sfr external

Reset line.

dim CanSpi Rst as
sbit at PORTB.B2

dim
CanSpi CS Bit Directi
on as sbit sfr
external

Direction of the Chip
Select pin.

dim
CanSpi CS Bit Directi
on as sbit at DDRB.BO

dim
CanSpi Rst Bit Direct
ion as sbit sfr
external

Direction of the Reset pin.

dim
CanSpi Rst Bit Direct
ion as sbit at
DDRB.B2

Library Routines

- CANSPISetOperationMode
- CANSPIGetOperationMode

- CANSPlInitialize

- CANSPISetBaudRate

- CANSPISetMask
- CANSPISetFilter
- CANSPIread
- CANSPIWrite

The following routines are for an internal use by the library only:

- RegsToCANSPIID
- CANSPIIDToRegs

Be sure to check CANSPI constants necessary for using some of the sub functions.
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CANSPISetOperationMode

sub procedure CANSPISetOperationMode (dim mode as byte, dim WAIT
as byte)

Prototype

Returns Nothing.

Sets the CANSPI module to requested mode.
Parameters :

- mode: CANSPI module operation mode. Valid values: canspI op MODE con-
Description [stants (see CANSPI constants).

-wa1T: CANSPI mode switching verification request. If watT = 0, the call is non-
blocking. The sub function does not verify if the CANSPI module is switched to
requested mode or not. Caller must use CANSPIGetOperationMode to verify correct
operation mode before performing mode specific operation. If watT = 0, the call is
blocking — the sub function won't “return” until the requested mode is set.

The CANSPI routines are supported only by MCUs with the SPI module.

Requires MCU has to be properly connected to mikroElektronika's CANSPI Extra Board
or similar hardware. See connection example at the bottom of this page.

' set the CANSPI module into configuration mode (wait inside
Example CANSPISetOperationMode until this mode is set)
CANSPISetOperationMode (CANSPI MODE CONFIG, OxFF)

CANSPIGetOperationMode

Prototype sub function CANSPIGetOperationMode () as byte

Returns Current operation mode.

The sub function returns current operation mode of the CANSPI module. Check
Description |canspr op MoDE constants (see CANSPI constants) or device datasheet for
operation mode codes.

The CANSPI routines are supported only by MCUs with the SPI module.

Requires . .
q MCU has to be properly connected to mikroElektronika's CANSPI Extra Board
or similar hardware. See connection example at the bottom of this page.
' check whether the CANSPI module is in Normal mode and if it is
do something.
Example if (CANSPIGetOperationMode () = CANSPI MODE NORMAL) then

end if
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CANSPIinitialize

Prototype

sub procedure CANSPIInitialize(dim SJW as byte, dim BRP as byte,
dim PHSEGl as byte, dim PHSEG2 as byte, dim PROPSEG as byte, dim
CAN CONFIG FLAGS as byte)

Returns

Nothing.

Description

Initializes the CANSPI module.
Stand-Alone CAN controller in the CANSPI module is set to:

- Disable CAN capture

- Continue CAN operation in Idle mode

- Do not abort pending transmissions

- Fcan clock: 4*Tcy (Fosc)

- Baud rate is set according to given parameters

- CAN mode: Normal

- Filter and mask registers IDs are set to zero

- Filter and mask message frame type is set according to can conFIG FLAGS value

SAM, SEG2PHTS, WAKFIL and DBEN bits are set according to can coneIc FLAGS value.
Parameters:

- sgw as defined in CAN controller's datasheet

- BrP as defined in CAN controller's datasheet

- pHSEG1 as defined in CAN controller's datasheet

- pHSEG2 as defined in CAN controller's datasheet

- proPsSEG as defined in CAN controller's datasheet

- CAN CONFIG FLAGS is formed from predefined constants (see CANSPI constants)

Requires

Global variables :

- canspi cs: Chip Select line

- Canspi Rst: Reset line

- CanSpi Cs Bit Direction: Direction of the Chip Select pin
- CanSpi Rst Bit Direction: Direction of the Reset pin

must be defined before using this function.
The CANSPI routines are supported only by MCUs with the SPI module.

The SPI module needs to be initialized. See the SPI1_Init and
SPI1_Init_Advanced routines.

MCU has to be properly connected to mikroElektronika's CANSPI Extra Board
or similar hardware. See connection example at the bottom of this page.
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' CANSPI module connections

dim CanSpi CS as sbit at PORTB.BO
CanSpi CS Direction as sbit at DDRB.BO
CanSpi Rst as sbit at PORTB.B2
CanSpi Rst Direction as sbit at DDRB.B2

' End CANSPI module connections

dim Can Init Flags as byte

Can Init Flags = CAN CONFIG SAMPLE THRICE and !

form value to
Example be used

CAN CONFIG PHSEG2 PRG ON and ' with
CANSPIInitialize

CAN_CONFIG XTD MSG and

CAN CONFIG DBL BUFFER ON and

CAN CONFIG VALID XTD MSG

Spi Rd Ptr @SPI1 Read ' Pass pointer to SPI Read func-
tion of used SPI module

SPI1 Init() J
SPI module

CANSPIInitialize(1,3,3,3,1,Can Init Flags) !
nal CANSPI module

initialize

initialize exter-
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CANSPISetBaudRate

sub procedure CANSPISetBaudRate (dim SJW as byte, dim BRP as byte,
Prototype dim PHSEGl as byte, dim PHSEG2 as byte, dim PROPSEG as byte, dim
CAN CONFIG FLAGS as byte)
Returns Nothing.
Sets the CANSPI module baud rate. Due to complexity of the CAN protocol,
you can not simply force a bps value. Instead, use this sub function when the
CANSPI module is in Config mode.
saM, sEG2pHTS and wAKFIL bits are set according to can conrFIc FLAGS value.
Refer to datasheet for details.
Description |Parameters:
- sgu as defined in CAN controller's datasheet
- BrP as defined in CAN controller's datasheet
- pHSEG1 as defined in CAN controller's datasheet
- pHSEG2 as defined in CAN controller's datasheet
- prOPSEG as defined in CAN controller's datasheet
- caN conNrFIG FLAGS is formed from predefined constants (see CANSPI constants)
The CANSPI module must be in Config mode, otherwise the sub function will be
ignored. See CANSPISetOperationMode.
Requires The CANSPI routines are supported only by MCUs with the SPI module.
MCU has to be properly connected to mikroElektronika's CANSPI Extra Board
or similar hardware. See connection example at the bottom of this page.
' set required baud rate and sampling rules
dim can config flags as byte
CANSPISetOperationMode (CANSPI MODE CONFIG, OxFF) !
set CONFIGURATION mode (CANSPI module mast be in config mode for
baud rate settings)
Example can config flags = CANSPI CONFIG SAMPLE THRICE and
CANSPI CONFIG PHSEG2 PRG ON and
CANSPI CONFIG STD MSG and
CANSPI CONFIG DBL BUFFER ON and
CANSPI CONFIG VALID XTD MSG and
CANSPI CONFIG LINE FILTER OFF
CANSPISetBaudRate(1l, 1, 3, 3, 1, can config flags)
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CANSPISetMask

sub procedure CANSPISetMask(dim CAN MASK as byte, dim val as

Prototype longint, dim CAN CONFIG FLAGS as byte)

Returns Nothing.

Configures mask for advanced filtering of messages. The parameter value is
bit-adjusted to the appropriate mask registers.

Parameters:

- can_mask: CANSPI module mask number. Valid values: canspT Mask
constants (see CANSPI constants)

Description |- va1: mask register value

- CAN CONFIG FLAGS: selects type of message to filter. Valid values:

CANSPI CONFIG ALL VALID MSG,
CANSPI CONFIG_MATCH MSG_TYPE and CANSPI CONFIG_STD MSG,
CANSPI CONFIG MATCH MSG TYPE and CANSPI CONFIG XTD MSG.

(see CANSPI constants)

The CANSPI module must be in Config mode, otherwise the sub function will be
ignored. See CANSPISetOperationMode.

Requires The CANSPI routines are supported only by MCUs with the SPI module.

MCU has to be properly connected to mikroElektronika's CANSPI Extra Board
or similar hardware. See connection example at the bottom of this page.

' set the appropriate filter mask and message type value
CANSPISetOperationMode(CANSPIiMODEACONFIG,OXFF) !
set CONFIGURATION mode (CANSPI module must be in config mode for
mask settings)

Exan“ﬂe ' Set all Bl mask bits to 1 (all filtered bits are relevant):
' Note that -1 is just a cheaper way to write OxFFFFFFFF.

' Complement will do the trick and fill it up with ones.
CANSPISetMask (CANSPI MASK Bl, -1, CANSPI CONFIG MATCH MSG TYPE
and CANSPI CONFIG XTD MSG)
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CANSPISetFilter

Prototvpe sub procedure CANSPISetFilter (dim CAN FILTER as byte, dim wval as
ypP longint, dim CAN CONFIG FLAGS as byte)
Returns Nothing.
Configures message filter. The parameter va1ue is bit-adjusted to the appropri-
ate filter registers.
Parameters:
- can_ rILTER: CANSPI module filter number. Valid values: canspr FILTER
constants (see CANSPI constants)
Description |- . 1: filter register value
- CAN CONFIG FLAGS: selects type of message to filter. Valid values:
CANSPI CONFIG ALL VALID MSG,
CANSPI CONFIG MATCH MSG TYPE and CANSPI CONFIG STD MSG,
CANSPI CONFIG MATCH MSG TYPE and CANSPI CONFIG XTD MSG.
(see CANSPI constants)
The CANSPI module must be in Config mode, otherwise the sub function will be
ignored. See CANSPISetOperationMode.
Requires The CANSPI routines are supported only by MCUs with the SPI module.
MCU has to be properly connected to mikroElektronika's CANSPI Extra Board
or similar hardware. See connection example at the bottom of this page.
' set the appropriate filter value and message type
CANSPISetOperationMode (CANSPI MODE CONFIG, OxFF)
' set CONFIGURATION mode (CANSPI module must be in config mode
Example for filter settings)
' Set id of filter Bl F1 to 3:
CANSPISetFilter (CANSPI FILTER Bl F1, 3, CANSPI CONFIG XTD MSG)
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CANSPIRead

sub function CANSPIRead (dim byref id as longint, dim byref
Prototype rd data as byte[ 8] , dim data len as byte, dim CAN RX MSG FLAGS as
byte) as byte

- 0 if nothing is received

Returns - oxrr if one of the Receive Buffers is full (message received)

If at least one full Receive Buffer is found, it will be processed in the following way:

- Message ID is retrieved and stored to location provided by the i d parameter

- Message data is retrieved and stored to a buffer provided by the rd_data parameter

- Message length is retrieved and stored to location provided by the data len
parameter

- Message flags are retrieved and stored to location provided by the

Description | caAN rRX MSG FLAGS parameter

Parameters:

- id: message identifier storage address

- rd data: data buffer (an array of bytes up to 8 bytes in length)
- data len: data length storage address.

- CAN RX MSG FLAGS: message flags storage address

The CANSPI module must be in a mode in which receiving is possible. See
CANSPISetOperationMode.

Requires The CANSPI routines are supported only by MCUs with the SPI module.

MCU has to be properly connected to mikroElektronika's CANSPI Extra Board
or similar hardware. See connection example at the bottom of this page.

' check the CANSPI module for received messages. If any was
received do something.
dim msg rcvd, rx flags, data len as byte

rd data as bytel 8]

msg _id as longint

CANSPISetOperationMode (CANSPI MODE NORMAL, OxFF)
Exanuﬂe ' set NORMAL mode (CANSPI module must be in mode in which
receive is possible)

rx flags = 0
clear message flags

if (msg rcvd = CANSPIRead(msg id, rd data, data len, rx flags)

end if
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CANSPIWrite

sub function CANSPIWrite (dim id as longint, dim byref wr data as

Prototype byte[ 8] , dim data len as byte, dim CAN TX MSG FLAGS as byte) as byte

- 0 if all Transmit Buffers are busy

Returns - 0xrr if at least one Transmit Buffer is available
If at least one empty Transmit Buffer is found, the sub function sends message
in the queue for transmission.
Parameters:

Description

- id:CAN message identifier. Valid values: 11 or 29 bit values, depending on
message type (standard or extended)

-wr data: data to be sent (an array of bytes up to 8 bytes in length)

- data len: datalength. Valid values: 1 to 8

- CAN RX MSG FLAGS: message flags

The CANSPI module must be in mode in which transmission is possible. See
CANSPISetOperationMode.

Requires The CANSPI routines are supported only by MCUs with the SPI module.

MCU has to be properly connected to mikroElektronika's CANSPI Extra Board
or similar hardware. See connection example at the bottom of this page.

' send message extended CAN message with the appropriate ID and
data
dim tx flags as byte

rd data as bytel 8]

msg _id as longint

Example CANSPISetOperationMode (CAN MODE NORMAL, OxFF) '
set NORMAL mode (CANSPI must be in mode in which transmission is
possible)

tx flags = CANSPI TX PRIORITY 0 ands CANSPI TX XTD FRAME
' set message flags
CANSPIWrite (msg id, rd data, 2, tx flags)
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CANSPI Constants

There is a number of constants predefined in the CANSPI library. You need to be
familiar with them in order to be able to use the library effectively. Check the exam-
ple at the end of the chapter.

CANSPI_OP_MODE

The CANSPI_OP_MODE constants define CANSPI operation mode. Function
CANSPISetOperationMode expects one of these as it's argument:

const
CANSPI MODE BITS as byte = SEO Use this to access opmode bits
CANSPI MODE NORMAL as byte = 0
CANSPI MODE_ SLEEP as byte = 520
CANSPI MODE LOOP as byte = 540
CANSPI MODE LISTEN as byte = 560
CANSPI _MODE CONFIG as byte = 580

CANSPI_CONFIG_FLAGS

The CANSPI_CONFIG_FLAGS constants define flags related to the CANSPI mod-
ule configuration. The functions CANSPIInitialize, CANSPISetBaudRate,
CANSPISetMask and CANSPISetFilter expect one of these (or a bitwise combina-
tion) as their argument:

const

CANSPI CONFIG DEFAULT as byte = SFF 'U11111111
CANSPI CONFIG PHSEG2 PRG BIT as byte = $01

CANSPI CONFIG PHSEGZ2 PRG _ON as byte = SFF 'OXXXXXXX1
CANSPI CONFIG PHSEG2 PRG OFF as byte = S$SFE XXX XXXXO
CANSPI CONFIG LINE FILTER BIT as byte = $02

CANSPI CONFIG LINE FILTER ON as byte = SFF 'OXXXXXX1X
CANSPI CONFIG LINE FILTER OFF as byte = S$FD 'OXXXXXX0OX
CANSPI CONFIG SAMPLE BIT as byte = 504

CANSPI CONFIG SAMPLE ONCE as byte = SFF 'OXXXXX1XX
CANSPI CONFIG SAMPLE THRICE as byte = S$SFB ' XXXXXOXX
CANSPI CONFIG MSG TYPE BIT as byte = 508

CANSPI CONFIG STD MSG as byte = SFF 'OXXXXTIXXX
CANSPI CONFIG XTD MSG as byte = S$F7 ' XXXXOXXX
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CANSPI CONFIG DBL BUFFER BIT as byte = $10

CANSPI CONFIG DBL BUFFER ON as byte = $FF 'OXXXIXXXX
CANSPIACONFIGiDBLiBUFFERioFF as byte = SEF XXX OXXXX
CANSPI CONFIG MSG BITS as byte = $60

CANSPI CONFIG ALL MSG as byte = SFF ' X11XXXXX
CANSPI CONFIG VALID XTD MSG as byte = SDF ' X10XXXXX
CANSPI CONFIG VALID STD MSG as byte = S$BF ' X01XXXXX
CANSPI CONFIG ALL VALID MSG as byte = $9F ' X00XXXXX

You may use bitwise and to form config byte out of these values. For example:

init = CANSPI CONFIG_SAMPLE THRICE and
CANSPI CONFIG PHSEG2 PRG ON and
CANSPI CONFIG STD MSG and
CANSPI CONFIG DBL BUFFER ON and
CANSPI CONFIG VALID XTD MSG and

CANSPI CONFIG LINE FILTER OFF

éAﬁSPIInit(l, 1, 3, 3, 1, init) ' initialize CANSPI
CANSPI_TX_MSG_FLAGS

CANSPI_TX _MSG_FLAGS are flags related to transmission of a CAN message:

const

CANSPI TX PRIORITY BITS as byte = $03

CANSPI TX PRIORITY O as byte = S$FC 'XXXXXX00
CANSPI TX PRIORITY 1 as byte = S$FD 'OXXXXXX01
CANSPI TX PRIORITY 2 as byte = SFE 'OXXXXXX10
CANSPI TX PRIORITY 3 as byte = SFF 'OXXXXXX11
CANSPI TX FRAME BIT as byte = $08

CANSPI TX STD FRAME as byte = SFF 'OXXXXX1XX
CANSPI TX XTD FRAME as byte = S§F7 'OXXXXXOXX
CANSPI TX RTR BIT as byte = $40

CANSPI TX NO RTR FRAME as byte = SFF ' XTIXXXXXX
CANSPI TX RTR FRAME as byte = $BF ' XOXXXXXX

You may use bitwise and to adjust the appropriate flags. For example:

' form value to be used with CANSendMessage:

send config = CANSPI TX PRIORITY 0 and
CANSPI TX XTD FRAME and
CANSPI TX NO RTR FRAME

CANSPIlWrite(id, data, 1, send config)
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CANSPI_RX_MSG_FLAGS

CANSPI_RX _MSG_FLAGS are flags related to reception of CAN message. If a par-
ticular bit is set then corresponding meaning is TRUE otherwise it will be FALSE.

const

CANSPI RX FILTER BITS as byte = $07 ' Use this to access
filter bits

CANSPI RX FILTER 1 as byte = 500

CANSPI RX FILTER 2 as byte = 501

CANSPI RX FILTER 3 as byte = 502

CANSPI RX FILTER 4 as byte = 3503

CANSPI RX FILTER 5 as byte = 504

CANSPI RX FILTER 6 as byte = 3505

CANSPI RX OVERFLOW as byte = 508 ' Set if Overflowed
else cleared

CANSPI RX INVALID MSG as byte = $10 ' Set if invalid
else cleared

CANSPI RX XTD FRAME as byte = $20 ' Set if XTD mes-
sage else cleared

CANSPI RX RTR FRAME as byte = $40 ' Set if RTR mes-
sage else cleared

CANSPI RX DBL BUFFERED as byte = $80 ' Set if this mes-

sage was hardware double-buffered

You may use bitwise and to adjust the appropriate flags. For example:
if (MsgFlag and CANSPI RX OVERFLOW) <> 0 then

' Receiver overflow has occurred.
' We have lost our previous message.

end if
CANSPI_MASK

The CANSPI_MASK constants define mask codes. Function CANSPISetMask
expects one of these as it's argument:

const

CANSPI MASK Bl as byte = 0
CANSPI MASK B2 as byte = 1

CANSPI_FILTER

The CANSPI_FILTER constants define filter codes. Functions CANSPISetFilter
expects one of these as it's argument:
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const
CANSPI FILTER Bl Fl1 as byte =
CANSPI FILTER Bl F2 as byte =
CANSPI FILTER B2 Fl as byte =
CANSPI FILTER B2 F2 as byte =
CANSPI FILTER B2 F3 as byte =
CANSPI FILTER B2 F4 as byte =

g W NP O

Library Example

This is a simple demonstration of CANSPI Library routines usage. First node initi-
ates the communication with the second node by sending some data to its address.
The second node responds by sending back the data incremented by 1. First node
then does the same and sends incremented data back to second node, etc.

Code for the first CANSPI node:
program Can Spi 1st

dim Can Init Flags, Can Send Flags, Can Rcv Flags as byte ' can flags

Rx Data Len as byte ' received data length in bytes
RxTx Data as byte[ 8] ' can rx/tx data buffer

Msg Rcvd as byte ' reception flag

Tx ID, Rx ID as longint ' can rx and tx ID

' CANSPI module connections

dim CanSpi CS as sbit at PORTB.BO
CanSpi CS Direction as sbit at DDRB.BO
CanSpi Rst as sbit at PORTB.B2
CanSpi Rst Direction as sbit at DDRB.B2

' End CANSPI module connections

main:
ADCSRA.7 = 0 ' Set AN pins to Digital I/O
PORTC = 0
DDRC = 255

Can Init Flags = 0 !

Can_Send Flags = 0 ' clear flags

Can Rcv _Flags = 0 !

Can_Send Flags = CANSPI TX PRIORITY O and ' form value to be used
_CANSPI TX XTD FRAME and ' with CANSPIWrite

_CANSPI_TX NO_RTR FRAME

Can Init Flags = CANSPI CONFIG SAMPLE THRICE and ' form value to be
used
_CANSPI CONFIG PHSEG2 PRG ON and ' with CANSPIInit
_CANSPI CONFIG XTD MSG and
_CANSPI CONFIG DBL BUFFER ON and
_CANSPI CONFIG VALID XTD MSG
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SPI1 Init() '
Spi Rd Ptr @SPI1 Read

initialize SPI1 module

Pass pointer to SPI Read sub function of used SPI module

CANSPIInitialize(1,3,3,3,1,Can Init Flags)

Initialize external CANSPI module

CANSPISetOperationMode (  CANSPI MODE CONFIG, OxFF)

set CONFIGURATION mode
CANSPISetMask ( CANSPI MASK Bl1,-1,
set all maskl bits to ones
CANSPISetMask ( CANSPI MASK B2,-1,
set all mask2 bits to ones

_CANSPI_CONFIG XTD MSG) '

_CANSPI_CONFIG XTD MSG) '

CANSPISetFilter ( CANSPI FILTER B2 F4,3, CANSPI CONFIG XTD MSG) '

set id of filter Bl F1 to 3

CANSPISetOperationMode (  CANSPI MODE NORMAL, OxFF) '

= 9 '

RxTx Data[ 0]

Tx ID 12111 !
CANSPIWrite (Tx ID, RxTx Data,
send initial message
while TRUE !

1,

Msg Rcvd = CANSPIRead(Rx ID ,
Can_Rcv_Flags) ' receive message
if ((Rx_ID = 3) and Msg Rcvd)

' if message received check id
PORTC RxTx Datal 0] !
Inc (RxTx Datal 0] ) !
Delay ms (10)

CANSPIWrite(TinD,
' send incremented data back
end if
wend
end.

Code for the second CANSPI node:
program Can_ Spi 2nd

dim Can Init Flags, Can Send Flags,
Rx Data Len as byte !
RxTx Data as byte[ 8] !
Msg Rcvd as byte !
Tx ID, Rx ID as longint

1

id correct,
increment received

set NORMAL mode
set initial data to be sent
set transmit ID

Can_Send Flags)

endless loop
RxTx Data , Rx_Data Len,
then

data at PORTC
data

output

RxTx Data, 1, Can_Send Flags)

Can_Rcv _Flags as byte ' can flags
received data length in bytes
CAN rx/tx data buffer

reception flag

can rx and tx ID
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' CANSPI module connections

dim CanSpi CS as sbit at PORTB.BO
CanSpi CS Direction as sbit at DDRB.BO
CanSpi Rst as sbit at PORTB.B2
CanSpi Rst Direction as sbit at DDRB.B2

' End CANSPI module connections

main:
PORTC = 0 ' clear PORTC
DDRC = 255 ' set PORTC as output

Can Init Flags 0
Can_Send Flags = 0 ' clear flags
Can_Rcv _Flags = 0

Can Send Flags = CANSPI TX PRIORITY O and ' form value to be used
_CANSPI TX XTD FRAME and ' with CANSPIWrite
_CANSPI TX NO RTR FRAME

Can _Init Flags = CANSPI CONFIG SAMPLE THRICE and ' Form value
to be used
_CANSPI CONFIG PHSEG2 PRG ON and '
with CANSPIInit
_CANSPI_CONFIG _XTD MSG and
_CANSPI_CONFIG_DBL BUFFER ON and
_CANSPI_CONFIG_VALID XTD MSG and
_CANSPI_CONFIG _LINE FILTER OFF

SPI1 Init()
initialize SPI1 module

Spi_Rd_Ptr = @SPI1_Read

' Pass pointer to SPI Read sub function of used SPI module
CANSPIInitialize(1,3,3,3,1,Can Init Flags)

' initialize external CANSPI module
CANSPISetOperationMode (_CANSPI MODE CONFIG, O0xFF)

' set CONFIGURATION mode

CANSPISetMask ( CANSPI MASK Bl,-1, CANSPI CONFIG XTD MSG)

' set all maskl bits to ones

CANSPISetMask ( CANSPI MASK B2,-1, CANSPI CONFIG XTD MSG)

' set all mask2 bits to ones

CANSPISetFilter ( CANSPI FILTER B2 F3,12111, CANSPI CONFIG XTD MSG)
' set id of filter Bl F1 to 3
CANSPISetOperationMode ( CANSPI MODE NORMAL, OxFF)

' set NORMAL mode

Tx ID = 3 ' set tx ID
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while TRUE ' endless loop
Msg Rcvd = CANSPIRead(Rx ID , RxTx Data , Rx Data Len,
Can_Rcv_Flags) ' receive message

if ((Rx_ID = 12111) and Msg Rcvd) then
if message received check id
PORTC = RxTx Data[ 0] ' id correct, output data at PORTC
Inc (RxTx Datal 0] ) ' increment received data
CANSPIWrite (Tx ID, RxTx Data, 1, Can_Send Flags)
send incremented data back
end if
wend
end.

HW Connection
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Example of interfacing CAN transceiver MCP2510 with MCU via SPI interface
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COMPACT FLASH LIBRARY

The Compact Flash Library provides routines for accessing data on Compact Flash
card (abbr. CF further in text). CF cards are widely used memory elements, com-
monly used with digital cameras. Great capacity and excellent access time of only
a few microseconds make them very attractive for the microcontroller applications.

In CF card, data is divided into sectors. One sector usually comprises 512 bytes.
Routines for file handling, the Cf_Fat routines, are not performed directly but suc-
cessively through 512B buffer.

Note: Routines for file handling can be used only with FAT16 file system.
Note: Library functions create and read files from the root directory only.

Note: Library functions populate both FAT1 and FAT2 tables when writing to files,
but the file data is being read from the FAT1 table only; i.e. there is no recovery if
the FAT1 table gets corrupted.

Note: If MMC/SD card has Master Boot Record (MBR), the library will work with the
first available primary (logical) partition that has non-zero size. If MMC/SD card has
Volume Boot Record (i.e. there is only one logical partition and no MBRs), the library
works with entire card as a single partition. For more information on MBR, physical
and logical drives, primary/secondary partitions and partition tables, please consult
other resources, e.g. Wikipedia and similar.

Note: Before writing operation, make sure not to overwrite boot or FAT sector as it
could make your card on PC or digital camera unreadable. Drive mapping tools,
such as Winhex, can be of great assistance.
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External dependencies of Compact Flash Library

The following variables
must be defined in all
projects using Compact
Flash Library:

Description:

Example :

dim CF Data Port as
byte sfr external

Compact Flash Data Port.

dim CF Data Port as
byte at PORTD

dim
CF Data Port Direction
as byte sfr external

Direction of the Compact
Flash Data Port.

dim
CF Data Port Directio
n as byte at DDRD

dim CF RDY as sbit
sfr external

Ready signal line.

dim CF RDY as sbit at
PINB.B7

dim CF WE as sbit
sfr external

Write Enable signal line.

dim CF WE as sbit at
PORTB.B6

dim CF OE as sbit
sfr external

Output Enable signal line.

dim CF OE as sbit at
PORTB.B5

dim CF CD1 as sbit
sfr external

Chip Detect signal line.

dim CF CD1 as sbit at
PINB.B4

dim CF CEl as sbit
sfr external

Chip Enable signal line.

dim CF CEl as sbit at
PORTB.B3

dim CF A2 as sbit
sfr external

Address pin 2.

dim CF A2 as sbit at
PORTB.B2

dim CF Al as sbit
sfr external

Address pin 1.

dim CF Al as sbit at
PORTB.B1

dim CF A0 as sbit
sfr external

Address pin 0.

dim CF A0 as sbit at
PORTB.BO

dim CF RDY direction
as sbit sfr external

Direction of the Ready pin.

dim CF RDY direction
as sbit at DDRB.BR7

dim CF WE direction
as sbit sfr external

Direction of the Write
Enable pin.

dim CF WE direction
as sbit at DDRB.B6

dim CF OE direction
as sbit sfr external

Direction of the Output
Enable pin.

dim CF OE direction
as sbit at DDRB.BS5

dim CF CD1 direction
as sbit sfr external

Direction of the Chip
Detect pin.

dim CF CD1 direction
as sbit at DDRB.B4

dim CF CE1l direction

Direction of the Chip

dim CF CE1l direction

as sbit sfr external Enaue[jn, as sbit at DDRB.R3
dim CF A2 direction |Direction of the Address 2 |dim CF A2 direction
as sbit sfr external Mn_ as sbit at DDRB.B2
dim CF Al direction [Direction of the Address 1 |dim CF Al direction
as sbit sfr external mn_ as sbit at DDRB.B1

dim CF A0 direction
as sbit sfr external

Direction of the Address 0
pin.

dim CF A0 direction
as sbit at DDRB.BO
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Library Routines

- Cf_Init

- Cf_Detect

- Cf_Enable

- Cf_Disable

- Cf_Read_lInit

- Cf_Read_Byte

- Cf_Write_Init

- Cf_Write_Byte

- Cf_Read_Sector
- Cf_Write_Sector

Routines for file handling:

- Cf_Fat_Init

- Cf_Fat_QuickFormat

- Cf_Fat_Assign

- Cf_Fat_Reset

- Cf_Fat_Read

- Cf_Fat_Rewrite

- Cf_Fat_Append

- Cf_Fat_Delete

- Cf_Fat_Write

- Cf_Fat_Set_File_Date
- Cf_Fat_Get_File_Date
- Cf_Fat_Get_File_Size
- Cf_Fat_Get_Swap_File
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Cf_Init

Prototype |sub procedure Cf Init()

Returns Nothing.

Description |[Initializes ports appropriately for communication with CF card.

Global variables :

- cr pata port : Compact Flash data port
- cr rDY : Ready signal line

- cr_we : Write enable signal line

- cr or : Output enable signal line

- cr cpl : Chip detect signal line

- cr _cel : Enable signal line

- cr a2 :Address pin 2

- cr Al :Address pin 1

- cr A0 :Address pin 0

Requires o o
- CF Data port direction : Direction of the Compact Flash data direction port
- CF RDY direction : Direction of the Ready pin
- CF wWE direction : Direction of the Write enable pin
- Cr OE direction : Direction of the Output enable pin
- CF CD1 direction : Direction of the Chip detect pin
- CF CEl direction : Direction of the Chip enable pin
- CF A2 direction : Direction of the Address 2 pin
- CF Al direction : Direction of the Address 1 pin
- CF A0 direction : Direction of the Address 0 pin
must be defined before using this function.

' set compact flash pinout

dim CF Data Port as byte at PORTD

dim Cf Data Port Direction as byte at DDRD

dim CF RDY as sbit at PINB.B7

dim CF WE as sbit at PORTB.B6

dim CF OE as sbit at PORTB.B5

dim CF CDl1 as sbit at PINB.B4

dim CF CEl1l as sbit at PORTB.B3

dim CF A2 as sbit at PORTB.B2

dim CF Al as sbit at PORTB.Bl

dim CF A0 as sbit at PORTB.BO
Example B

dim CF RDY direction as sbit at DDRB.B7
dim CF WE direction as sbit at DDRB.B6
dim CF OE direction as sbit at DDRB.B5
dim CF CDl direction as sbit at DDRB.B4
dim CF CEl direction as sbit at DDRB.B3
dim CF A2 direction as sbit at DDRB.B2
dim CF Al direction as sbit at DDRB.B1
dim CF AQ direction as sbit at DDRB.BO
' end of cf pinout

"Init CF
Cf Init()
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Cf_Detect
Prototype sub function CF Detect() as byte
Returns - 1 - if CF card was detected
- 0 - otherwise
Description |Checks for presence of CF card by reading the chip detect pin.
Requires The c_orrespondlng MCU ports must be appropriately initialized for CF card. See
Cf_Init.
' Wait until CF card is inserted:
while (Cf Detect () = 0)
Example -
nop
wend
Cf_Enable
Prototype sub procedure Cf Enable ()
Returns Nothing.
Enables the device. Routine needs to be called only if you have disabled the
Description |device by means of the Cf_Disable routine. These two routines in conjunction
allow you to free/occupy data line when working with multiple devices.
Requires The cprrespondmg MCU ports must be appropriately initialized for CF card. See
Cf_Init.
' enable compact flash
Example Cf Enable ()
Cf Disable
Prototype sub procedure Cf Disable()
Returns Nothing.
Routine disables the device and frees the data lines for other devices. To
Description |enable the device again, call Cf_Enable. These two routines in conjunction
allow you to free/occupy data line when working with multiple devices.
Requires The c_orrespondlng MCU ports must be appropriately initialized for CF card. See
Cf_Init.
Exanuﬂe ' disable compact flash

Cf Disable()
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Cf_Read_lInit

sub procedure Cf Read Init (dim address as longword, dim

Prototype sector count as byte)
Returns Nothing.
Initializes CF card for reading.
i Parameters :
Description
- address: the first sector to be prepared for reading operation.
- sector count: number of sectors to be prepared for reading operation.
. The corresponding MCU ports must be appropriately initialized for CF card. See
Requires A
Cf_Init.
' initialize compact flash for reading from sector 590
Example

Cf Read Init (590, 1)

Cf_Read_Byte

Prototype sub function CF Read Byte() as byte

Returns a byte read from Compact Flash sector buffer.

Returns
Note: Higher byte of the unsigned return value is cleared.
i Reads one byte from Compact Flash sector buffer location currently pointed to
Description . . . . . .
by internal read pointers. These pointers will be autoicremented upon reading.
The corresponding MCU ports must be appropriately initialized for CF card. See
. Cf_Init.
Requires -
CF card must be initialized for reading operation. See Cf_Read_Init.
' Read a byte from compact flash:
dim data as byte
Example

data = Cf Read Byte()
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Cf_Write_Init
Protot sub procedure Cf Write Init(dim address as longword, dim sectcnt
rototype as byte)
Returns Nothing.
Initializes CF card for writing.
i Parameters :
Description
- address: the first sector to be prepared for writing operation.
- sectent: number of sectors to be prepared for writing operation.
. The corresponding MCU ports must be appropriately initialized for CF card. See
Requires ¢ it
Exanuﬂe ' initialize compact flash for writing to sector 590

Cf Write Init (590, 1)

Cf_Write_Byte

Prototype sub procedure Cf Write Byte(dim data as byte)

Returns Nothing.

Writes a byte to Compact Flash sector buffer location currently pointed to by
writing pointers. These pointers will be autoicremented upon reading. When
sector buffer is full, its content will be transfered to appropriate flash memory
i sector.

Description

Parameters :

- data : byte to be written.

The corresponding MCU ports must be appropriately initialized for CF card. See

Requires Cf_Init.
CF card must be initialized for writing operation. See Cf_Write_Init.
dim data as byte

Example  1i.ta - oxaa

Cfiwﬁ te Byte (data)
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Cf_Read_Sector

sub procedure Cf Read Sector (dim sector number as longword, dim

Prototype byref buffer as bytel 512])
Returns Nothing.
Reads one sector (512 bytes). Read data is stored into buffer provided by the
buffer parameter.
Description |Parameters :
- sector number: sector to be read.
- buffer: data buffer of at least 512 bytes in length.
Requires The c_orrespondmg MCU ports must be appropriately initialized for CF card. See
Cf_Init.
' read sector 22
Example dim data as arrayl 512] of byte
Cf Read Sector (22, data)
Cf_Write_Sector
Protot sub procedure Cf Write Sector (dim sector number as longword, dim
rototype byref buffer as bytel 512])
Returns Nothing.
Writes 512 bytes of data provided by the buffer parameter to one CF sector.
i Parameters :
Description
- sector number: sector to be written to.
- buffer: data buffer of 512 bytes in length.
Requires The cprrespondmg MCU ports must be appropriately initialized for CF card. See
Cf_Init.
' write to sector 22
Example dim data as array| 512] of byte

Cf Write Sector (22, data)
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Cf_Fat_Init
Prototype sub function Cf Fat Init() as byte

- 0 - if CF card was detected and successfully initialized

Returns - 1 - if FAT16 boot sector was not found
- 255 - if card was not detected
Describtion Initializes CF card, reads CF FAT16 boot sector and extracts data needed by
P the library.
Requires Nothing.
init the FAT library
Exanuﬂe if (Cf Fat Init() = 0) then
ena‘if
Cf_Fat_QuickFormat
Protot sub function Cf Fat QuickFormat (dim byref cf fat label as
rotolyPe  |string 111) as byte
- 0 - if CF card was detected, successfully formated and initialized
Returns - 1 - if FAT16 format was unseccessful
- 255 - if card was not detected
Formats to FAT16 and initializes CF card.
Parameters :
-cf fat label: volume label (11 characters in length). If less than 11
characters are provided, the label will be padded with spaces. If an empty
Description string is passed, the volume will not be labeled.
Note: This routine can be used instead or in conjunction with the Cf_Fat_Init
routine.
Note: If CF card already contains a valid boot sector, it will remain unchanged
(except volume label field) and only FAT and ROOT tables will be erased. Also,
the new volume label will be set.
Requires Nothing.
'-—- format and initialize the FAT library
Exanuﬂe if ( Cf Fat QuickFormat ('mikroE') = 0) then
en&.if
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Cf_Fat_Assign

sub function Cf Fat Assign(dim byref filename as char{ 12] , dim
file cre attr as byte) as byte

Prototype

- 0 if file does not exist and no new file is created.

Returns - 1 if file already exists or file does not exist but a new file is created.

Assigns file for file operations (read, write, delete...). All subsequent file opera-
tions will be applied to the assigned file.

Parameters :

- filename: name of the file that should be assigned for file operations. The file
name should be in DOS 8.3 (file_name.extension) format. The file name and
extension will be automatically padded with spaces by the library if they have
less than length required (i.e. "mikro.tx" -> "mikro .tx "), so the user does not
have to take care of that. The file name and extension are case insensitive.
The library will convert them to the proper case automatically, so the user does
not have to take care of that.

Also, in order to keep backward compatibility with the first version of this
library, file names can be entered as UPPERCASE string of 11 bytes in length
with no dot character between the file name and extension (i.e.
"MIKROELETXT" -> MIKROELE.TXT). In this case the last 3 characters of the
string are considered to be file extension.

Description |- file cre attr: file creation and attributs flags. Each bit corresponds to the
appropriate file attribut:

Bit | Mask Description

0 0x01 |Read Only

1 0x02 |Hidden

2 0x04 [System

3 0x08 [Volume Label

4 0x10 |[Subdirectory

5 0x20 [Archive

6 0x40 |Device (internal use only, never found on disk)

4 0x80 File cre_atioq flag. If _the file does _not exist and this flag is set,
a new file with specified name will be created.

Note: Long File Names (LFN) are not supported.

Requires CF card and CF library must be initialized for file operations. See Cf_Fat_Init.

' create file with archive attribut if it does not already exist

Exan“ﬂe Cf Fat Assign ('MIKRO0O07.TXT',0xAQ)
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Cf_Fat_Reset

Prototype sub procedure Cf Fat Reset (dim byref size as longword)
Returns Nothing.
Opens currently assigned file for reading.
e Parameters :
Description
- size: buffer to store file size to. After file has been open for reading its size is
returned through this parameter.
CF card and CF library must be initialized for file operations. See Cf_Fat_Init.
Requires
File must be previously assigned. See Cf_Fat_Assign.
dim size as longword
Example -
Cf Fat Reset(size)
Cf_Fat_Read
Prototype sub procedure Cf Fat Read(dim byref bdata as byte)
Returns Nothing.
Reads a byte from currently assigned file opened for reading. Upon function
execution file pointers will be set to the next character in the file.
Description |Parameters :
- bdata: buffer to store read byte to. Upon this function execution read byte is
returned through this parameter.
CF card and CF library must be initialized for file operations. See Cf_Fat_|Init.
Requires File must be previously assigned. See Cf Fat_Assign.
File must be open for reading. See Cf_Fat Reset.
dim character as byte
Example S
Cf Fat Read(character)
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Cf_Fat_Rewrite

Prototype sub procedure Cf Fat Rewrite()
Returns Nothing.
Description Opens currently assigned file for writing. If the file is not empty its content will
be erased.
CF card and CF library must be initialized for file operations. See Cf_Fat_Init.
Requires
The file must be previously assigned. See Cf_Fat_Assign.
Example ' open file for writing

Cf Fat Rewrite()

Cf_Fat_Append

Prototype sub procedure Cf Fat Append()
Returns Nothing.
Opens currently assigned file for appending. Upon this function execution file
Description |pointers will be positioned after the last byte in the file, so any subsequent file
writing operation will start from there.
CF card and CF library must be initialized for file operations. See Cf_Fat_Init.
Requires
File must be previously assigned. See Cf_Fat_Assign.
Example ' open file for appending

Cf Fat Append/()

Cf_Fat_Delete

Prototype sub procedure Cf Fat Delete ()
Returns Nothing.
Description |Deletes currently assigned file from CF card.
CF card and CF library must be initialized for file operations. See Cf_Fat_Init.
Requires
File must be previously assigned. See Cf_Fat_Assign.
' delete current file
Example

Cf Fat Delete()
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Cf_Fat_Write

sub procedure Cf Fat Write(dim byref fdata as byte[ 512] , dim
data len as word)

Prototype

Returns Nothing.

Writes requested number of bytes to currently assigned file opened for writing.

o Parameters :
Description

- fdata: data to be written.
- data len: number of bytes to be written.

CF card and CF library must be initialized for file operations. See Cf_Fat_Init.
Requires File must be previously assigned. See Cf_Fat_Assign.

File must be open for writing. See Cf_Fat_Rewrite or Cf_Fat_Append.

dim file contents as array| 42] of byte
Example S
Cf Fat Write(file contents, 42) ' write data to the assigned file

Cf_Fat_Set_File_Date

sub procedure Cf Fat Set File Date(dim year as word, dim month as
Prototype byte, dim day as byte, dim hours as byte, dim mins as byte, dim
seconds as byte)

Returns Nothing.

Sets the date/time stamp. Any subsequent file writing operation will write this
stamp to currently assigned file's time/date attributs.

Parameters :

Description |- vear: year attribute. Valid values: 1980-2107
- month: month attribute. Valid values: 1-12

- day: day attribute. Valid values: 1-31

- hours: hours attribute. Valid values: 0-23

- mins: minutes attribute. Valid values: 0-59

- seconds: seconds attribute. Valid values: 0-59

CF card and CF library must be initialized for file operations. See Cf_Fat_|Init.
Requires File must be previously assigned. See Cf_Fat_Assign.

File must be open for writing. See Cf_Fat_Rewrite or Cf_Fat_Append.

Example Cf Fat Set File Date(2005,9,30,17,41,0)

MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD 201



CHAPTER 6
Libraries mikroBasic PRO for AVR

Cf_Fat_Get_File_Date

sub procedure Cf Fat Get File Date (dim byref year as word, dim
Prototype byref month as byte, dim byref day as byte, dim byref hours as
byte, dim byref mins as byte)

Returns Nothing.

Reads time/date attributes of currently assigned file.
Parameters :

- yvear: buffer to store year attribute to. Upon function execution year attribute is
returned through this parameter.

- month: buffer to store month attribute to. Upon function execution month
attribute is returned through this parameter.

- day: buffer to store day attribute to. Upon function execution day attribute is
returned through this parameter.

- hours: buffer to store hours attribute to. Upon function execution hours
attribute is returned through this parameter.

-mins: buffer to store minutes attribute to. Upon function execution minutes
attribute is returned through this parameter.

Description

CF card and CF library must be initialized for file operations. See Cf_Fat_Init.

Requires
File must be previously assigned. See Cf_Fat_Assign.
dim year as word
month, day, hours, mins as byte
Example Jooned B Y

Cf Fat Get File Date(year, month, day, hours, mins)

Cf_Fat_Get_File_Size

Prototype sub function Cf Fat Get File Size() as longword

Returns Size of the currently assigned file in bytes.

Description |This function reads size of currently assigned file in bytes.

CF card and CF library must be initialized for file operations. See Cf_Fat_Init.
Requires
File must be previously assigned. See Cf_Fat_Assign.

dim my file size as longword
Example S
my file size = Cf Fat Get File Size()

202 MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD



mikroBasic PRO for AVR

CHAPTER 6

Libraries

Cf_Fat_Get_Swap_File

Prototype

sub function Cf Fat Get Swap File(dim sectors cnt as longint, dim
byref filename as stringl 11] , dim file attr as byte) as longword

Returns

- Number of the start sector for the newly created swap file, if there was
enough free space on CF card to create file of required size.
- 0 - otherwise.

Description

This function is used to create a swap file of predefined name and size on the
CF media. If a file with specified name already exists on the media, search for
consecutive sectors will ignore sectors occupied by this file. Therefore, it is rec-
ommended to erase such file if it exists before calling this function. If it is not
erased and there is still enough space for a new swap file, this function will
delete it after allocating new memory space for a new swap file.

The purpose of the swap file is to make reading and writing to CF media as fast
as possible, by using the Cf Read_Sector() and Cf_Write_Sector() functions
directly, without potentially damaging the FAT system. The swap file can be con-
sidered as a "window" on the media where the user can freely write/read data.
Its main purpose in the mikroBasic's library is to be used for fast data acquisi-
tion; when the time-critical acquisition has finished, the data can be re-written
into a "normal" file, and formatted in the most suitable way.

Parameters:

- sectors cnt: number of consecutive sectors that user wants the swap file to
have.

- filename: name of the file that should be assigned for file operations. The file
name should be in DOS 8.3 (file_name.extension) format. The file name and
extension will be automatically padded with spaces by the library if they have
less than length required (i.e. "mikro.tx" -> "mikro .tx "), so the user does not
have to take care of that. The file name and extension are case insensitive.
The library will convert them to the proper case automatically, so the user does
not have to take care of that.

Also, in order to keep backward compatibility with the first version of this
library, file names can be entered as UPPERCASE string of 11 bytes in length
with no dot character between the file name and extension (i.e.
"MIKROELETXT" -> MIKROELE.TXT). In this case the last 3 characters of the
string are considered to be file extension.

- file attr: file creation and attributs flags. Each bit corresponds to the
appropriate file attribut:
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Bit | Mask Description
0 0x01 [Read Only
1 0x02 |Hidden
2 0x04 [System
3 0x08 [Volume Label

Description 4 0x10 [Subdirectory
5 0x20 [Archive
6 0x40 [Device (internal use only, never found on disk)
7 0x80 |Not used

Note: Long File Names (LFN) are not supported.

Requires CF card and CF library must be initialized for file operations. See Cf_Fat_Init.

program
e Try to create a swap file with archive atribute,
whose size will be at least 1000 sectors.

! If it succeeds, it sends the No. of start sec-
tor over USART

dim size as longword

main:

Example size = Cf Fat Get Swap File (1000, "mikroE.txt", 0x20)
if size then
UART1 Write (0xAA)
UART1 Write (Lo (size))
UART1 Write (Hi(size))
UART1 Write (Higher (size))
UART1 Write (Highest (size))
UART1 Write (OxAA)
end if
end.
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Library Example

The following example is a simple demonstration of CF(Compact Flash) Library

which shows how to use CF card data accessing routines.

program CF Fatl6 Test

dim

' set compact flash pinout
Cf Data Port as byte at PORTD

Cf Data Port Direction as byte at DDRD

CF_RDY as
CF WE as
CF OE as
CF CD1 as
CF CEl as
CF A2 as
CF Al as
CF A0 as

sbit
sbit
sbit
sbit
sbit
sbit
sbit
sbit

at PINB.B7

at PORTB.B6
at PORTB.BS

at PINB.B4

at PORTB.B3
at PORTB.B2
at PORTB.B1
at PORTB.BO

CF_RDY direction as

CF _WE direction
CF OE direction

as
as

CF CD1 direction as
CF CEl direction as

CF_A2 direction
CF_Al direction
CF_AQ direction

as
as
as

' end of cf pinout

sbit
sbit
sbit
sbit
sbit
sbit
sbit
sbit

FAT TXT as stringl 20]
file contents as stringl 50]

filename as stringl 14]

character as byte

loop , loop2 as byte

size as longint

Buffer as byte[ 512]

dim
i as byte

Writes string to USART
sub procedure Write Str(dim byref ostr as byte[ 2]

at
at
at
at
at
at
at
at

DDRB.
DDRB.
DDRB.
DDRB.
DDRB.
DDRB.
DDRB.
DDRB.

B7
B6
B5S
B4
B3
B2
Bl
BO

File names

)
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i =0
while ostzr[ i] <> 0
UART1 Write (ostrf i])
Inc (i)
wend
UART1 Write ($0A)
end sub'~

—————————————— Creates new file and writes some data to it
sub procedure Create New File

filename[ 7] = "A"
Cf Fat Assign(filename, 0xAQ) ' Will not find file and then
create file
Cf Fat Rewrite() ' To clear file and start with
new data
for loop =1 to 90 ' We want 5 files on the MMC
card
PORTC = loop
file contents[ 0] = loop div 10 + 48
file contents[ 1] = loop mod 10 + 48
Cf Fat Write(file contents, 38) ' write data to the assigned file

UART1 Write(".")
next loop
end sub'~

—————————————— Creates many new files and writes data to them
sub procedure Create Multiple Files

for loop2 = "B" to "Z"

UART1 Write(loop2) ' this line can slow down the performance

filename[ 7] = loop2 ' set filename

Cf Fat Assign(filename, 0xAQ0) ' find existing file or cre-
ate a new one

Cf Fat Rewrite ' To clear file and start
with new data

for loop = 1 to 44

file contents[ 0] loop div 10 + 48
file contents[ 1] loop mod 10 + 48
Cf Fat Write(file contents, 38) ' write data to the assigned

file
next loop
next loop2
end sub'~

—————————————— Opens an existing file and rewrites it
sub procedure Open File Rewrite
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filename[ 7] = "C" ' Set filename for single-file tests
Cf Fat Assign(filename, O0)
Cf Fat Rewrite

for loop =1 to 55
file contents[ 0] = byte(loop div 10 + 48)
file contents[ 1] = byte(loop mod 10 + 48)
Cf Fat Write(file contents, 38) ' write data to the assigned file
next loop
end sub'~

—————————————— Opens an existing file and appends data to it
(and alters the date/time stamp)

sub procedure Open File Append

filename[ 7] = "B"

Cf Fat Assign(filename, 0)

Cf Fat Set File Date(2005,6,21,10,35,0)

Cf Fat Append

file contents = " for mikroElektronika 2005" ' Prepare file
for append

file contents[ 26] = 10 ' LF

Cf Fat Write(file contents, 27) ' Write data
to assigned file
end sub'~

—————————————— Opens an existing file, reads data from it and puts
it to USART
sub procedure Open File Read

filename[ 7] = "B"
Cf Fat Assign(filename, O0)
Cf Fat Reset(size) ' To read file, sub procedure returns

size of file
while size > 0
Cf Fat Read(character)
UART1 Write (character) ' Write data to USART
Dec (size)
wend
end sub'~

—————————————— Deletes a file. If file doesn"t exist, it will first
be created
' and then deleted.
sub procedure Delete File
filename[ 7] = "F"
Cf Fat Assign(filename, O0)
Cf Fat Delete
end sub'~

—————————————— Tests whether file exists, and if so sends its cre-
ation date
! and file size wvia USART
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sub procedure Test File Exist (dim fname as byte)
dim

fsize as longint

year as word

month , day, hour , minute as byte

outstr as bytel 12]

filename[ 7] = "B" 'uncomment this line to search for file
that DOES exists
' filename[ 7] = "F" 'uncomment this line to search for file

that DOES NOT exist
if Cf Fat Assign(filename, 0) <> 0 then
'-—— file has been found - get its date
Cf Fat Get File Date(year,month ,day,hour ,minute )
WordToStr (year, outstr)

Write Str(outstr)
ByteToStr (month , outstr)
Write Str(outstr)
WordToStr (day, outstr)
Write Str(outstr)
WordToStr (hour , outstr)
Write Str(outstr)
WordToStr (minute , outstr)

Write Str(outstr)
'--- get file size
fsize = Cf Fat Get File Size
LongIntToStr (fsize, outstr)
Write Str(outstr)

else
'-—— file was not found - signal it
UART1 Write (0x55)
Delay ms (1000)
UART1 Write (0x55)

end if

end sub'~

P Tries to create a swap file, whose size will be at
least 100
' sectors (see Help for details)
sub procedure M Create Swap File
dim i as word

for i=0 to 511

Buffer[ i] = 1
next 1
size = Cf Fat Get Swap File (5000, "mikroE.txt", 0x20) ' see

help on this sub function for details

if (size <> 0) then
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LongIntToStr (size, fat txt)

Write Str(fat txt)

for i=0 to 4999
Cf Write Sector(size, Buffer)

size = size+l
UART1 Write(".™)
next 1
end if
end sub'~

—————————— Main. Uncomment the sub function(s) to test the

desired operation (s)

main:

ing

FAT TXT = "FAT16 not found"

file contents = "XX CF FAT16 library by Anton Rieckert"
file contents[ 37] = 10 ' newline

filename = "MIKROOOXTXT"

' we will use PORTC to signal test end

DDRC = 0OxFF
PORTC = 0
UART1 Init(19200) ' Set up USART for file read-

delay ms (100)
UART1 Write Text (":Start:")

' —-—- Init the FAT library
' --- use Cf Fat QuickFormat instead of init routine if a for-

mat is needed

end.'

if Cf Fat Init() = O then

'-—-—- test sub functions
e test group #1
Create New File()
Create Multiple Files()
e test group #2
Open File Rewrite()
Open File Append ()
Delete File
P test group #3
Open File Read()
Test File Exist ("F")
M Create Swap File()
'-—-—- Test termination
UARTI_Write(OXAA)
else
UART1 Write Text (FAT TXT)
end if
'-—- signal end-of-test
UART1 Write Text (":End:")

~1
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HW Connection
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210 MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD



mikroBasic PRO for AVR

CHAPTER 6
Libraries

EEPROM LIBRARY

EEPROM data memory is available with a number of AVR family. The mikroBasic PRO for AVR
includes a library for comfortable work with MCU's internal EEPROM.

Note: EEPROM Library functions implementation is MCU dependent, consult the appropriate
MCU datasheet for details about available EEPROM size and address range.

Library Routines

- EEPROM_Read
- EEPROM_Write

EEPROM_Read

Prototype sub function EEPROM Read(dim address as word) as byte
Returns Byte from the specified address.

Reads data from specified address.
Description |[Parameters :

- address: address of the EEPROM memory location to be read.
Requires Nothing.

dim eeAddr as word

temp as byte
Example S

eeAddr = 2

temp = EEPROM Read (eeAddr)
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EEPROM_Write

Prototype sub procedure EEPROM Write (dim address as word, dim wrdata as byte)

Returns Nothing.

Writes wrdata to specified address.

Parameters :
Description |_ address: address of the EEPROM memory location to be written.
- wrdata: data to be written.

Note: Specified memory location will be erased before writing starts.

Requires Nothing.

dim eeWrite as byte
wrAddr as word

Example eellrite = 0x02

wrAddr = O0xAA

EEPROM Write (wrAddr, eeWrite)

212 MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD



CHAPTER 6

mikroBasic PRO for AVR Libraries

Library Example
This example demonstrates using the EEPROM Library with ATmega16 MCU.

First, some data is written to EEPROM in byte and block mode; then the data is read
from the same locations and displayed on PORTA, PORTB and PORTC.

program EEPROM
dim counter as byte ' loop variable

main:
DDRA = OxFF
DDRB = OxFF
DDRC = OxFF

for counter = 0 to 31 ' Fill data buffer
EEPROM Write (0x100 + counter, counter) ' Write data to
address 0x100+counter
next counter

EEPROM Write (0x02,0xAA) ' Write some data at address 2
EEPROM Write (0x150,0x55) ' Write some data at address 0x150

Delay ms (1000) ' Blink PORTA and PORTB diodes
PORTA = OxFF ! to indicate reading start
PORTB = OxFF

Delay ms (1000)

PORTA = 0x00

PORTB = 0x00

Delay ms (1000)

PORTA = EEPROM Read(0x02) ' Read data from
address 2 and display it on PORTA
PORTB = EEPROM Read (0x150) ' Read data from

address 0x150 and display it on PORTB
Delay ms (1000)

for counter = 0 to 31 ' Read 32 bytes block from address 0x100
PORTC = EEPROM Read (0x100+counter) ! and display
data on PORTC
Delay ms (100)
next counter
end.
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FLASH MEMORY LIBRARY

This library provides routines for accessing microcontroller Flash memory. Note that prototypes
differ for MCU to MCU due to the amount of Flash memory.

Note: Due to the AVR family flash specifics, flash library is MCU dependent. Since some AVR
MCU's have more or less than 64kb of Flash memory, prototypes may be different from chip to
chip.

Please refer to datasheet before using flash library.

Note: Currently, Write operations are not supported. See mikroBasic PRO for AVR specifics for
details.

Library Routines

- FLASH_Read_Byte
- FLASH_Read_Bytes
- FLASH_Read_Word
- FLASH_Read_Words

FLASH_Read_Byte

' for MCUs with 64kb of Flash memory or less
sub function FLASH Read Byte(dim address as word) as byte

Prototype

' for MCUs with Flash memory larger than 64kb

sub function FLASH Read Byte(dim address as longword) as byte
Returns Returns data byte from Flash memory.

Description |Reads data from the specified address in Flash memory.

Requires Nothing.

' for MCUs with Flash memory larger than 64kb
dim tmp as longword

Example S
tmp = Flash Read (0x0DO0O)
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FLASH_Read_Bytes

' for MCUs with 64kb of Flash memory or less
sub procedure FLASH Read Bytes(dim address as word, dim buffer as
“byte, dim NoBytes as word)
Prototype
' for MCUs with Flash memory larger than 64kb
sub procedure FLASH Read Bytes(dim address as longword, dim
pbuffer as “byte, dim NoBytes as word)
Returns Nothing.
o Reads number of data bytes defined by NoBytes parameter from the specified
Description : . .
address in Flash memory to varibale pointed by buffer.
Requires Nothing.
'for MCUs with Flash memory larger than 64kb
const F ADDRESS as longint = 0x200
Example dim dat buff[ 32] as word
FLASH Read Bytes (F _ADDRESS,dat buff, 64)

FLASH_Read_Word

' for MCUs with 64kb of Flash memory or less

sub function FLASH Read Word(dim address as word) as word
Prototype

' for MCUs with Flash memory larger than 64kb

sub function FLASH Read Word(dim address as longword) as word
Returns Returns data word from Flash memory.
Description |Reads data from the specified address in Flash memory.
Requires Nothing.

' for MCUs with Flash memory larger than 64kb

dim tmp as longword
Example S

tmp = Flash Read(0x0DO0O0)
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FLASH_Read_Words

' for MCUs with 64kb of Flash memory or less
sub procedure FLASH Read Words (dim address as word, dim buffer as
“word, dim NoWords as word)

Prototype
' for MCUs with Flash memory larger than 64kb

sub procedure FLASH Read Words (dim address as longword, dim
buffer as “word, dim NoWords as word)

Returns Nothing.

Reads number of data words defined by nowords parameter from the specified

Description address in Flash memory to varibale pointed by buffer.

Requires Nothing.

'for MCUs with Flash memory larger than 64kb
const F ADDRESS as longint = 0x200
Example dim dat buff[ 32] as word

FLASH Read Bytes (F_ADDRESS,dat buff, 64)

Library Example

The example demonstrates simple write to the flash memory for AVR, then reads the data and
displays it on PORTB and PORTD.

program Flash MCU test
const F ADDRESS as longint = 0x200

const data as word 32] = ( ' constant table
0x0000,0x0001,0x0002,0x0003,0x0004,0x0005,0x0006,0x0007,
0x0008,0x0009,0x000A,0x000B,0x000C,0x000D, 0x000E, 0x000F,
0x0000,0x0100,0x0200,0x0300,0x0400,0x0500,0x0600,0x0700,
0x0800,0x0900,0x0A00,0x0B00,0x0C00,0x0D00, 0x0E00, 0x0F00
) org 0x200

dim counter as byte
word as word
dat buff as word 32]
'dat buff as word 32]

main:
DDRD = OxFF ' set direction to be output
DDRB = O0OxFF ' set direction to be output
word = data [ 0] ' link const table
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counter = 0
while ( counter < 64 ) ' reading 64 bytes in loop
PORTD = FLASH Read Byte (F ADDRESS + counter) ' demonstration

of reading single byte

Inc (counter)

PORTB = FLASH Read Byte (F ADDRESS + counter) ' demonstration
of reading single byte

Inc (counter)

Delay ms (200)

wend
FLASH Read Bytes (F ADDRESS, @dat buff, 64) ' demonstration
of reading 64 bytes
for counter = 0 to 31
PORTD = dat buff[ counter] ' output low byte to PORTD
PORTB = word((dat buff[ counter] >> 8)) ' output high-

er byte to PORTB
Delay ms (200)
next counter

counter = 0
while (counter <= 63) ' reading 32 words in loop
word = FLASH Read Word(F ADDRESS + counter) ' demonstration
of reading single word
PORTD = word ' output low byte to PORTD
PORTB = Hi(word )' >> 8) ' output higher byte to PORTB
counter = counter + 2
Delay ms (200)
wend
FLASH Read Words (F_ADDRESS, @dat buff, 32) ' demonstration
of reading 64 bytes
for counter = 0 to 31
PORTD = dat buff[ counter] ' output low byte to PORTD
PORTB = word((dat buff[ counter] >> 8)) ' output high-

er byte to PORTB
Delay ms (200)
next counter
end.
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GRAPHIC LCD LIBRARY

The mikroBasic PRO for AVR provides a library for operating Graphic Lcd 128x64 (with
commonly used Samsung KS108/KS107 controller).

For creating a custom set of Glcd images use Glcd Bitmap Editor Tool.

External dependencies of Graphic Lcd Library

The following variables must
be defined in all projects
using Graphic Lcd Library:

Description:

Example :

dim GLCD DataPort as byte
sfr external

Glcd Data Port.

dim GLCD DataPort as
byte at PORTC

dim
GLCD DataPort Direction
as byte sfr external

Direction of the Glcd Data
Port.

dim
GLCD DataPort Directi
on as byte at DDRC

dim GLCD CS1 as sbit sfr
external

Chip Select 1 line.

dim GLCD CS1 as sbit
at PORTD.B2

dim GLCD CS2 as sbit sfr
external

Chip Select 2 line.

dim GLCD CsS2 as sbit
at PORTD.B3

dim GLCD RS as sbit sfr
external

Register select line.

dim GLCD RS as sbit
at PORTD.B4

dim GLCD RW as sbit sfr
external

Read/Write line.

dim GLCD RW as sbit
at PORTD.BS

dim GLCD RST as sbit sfr
external

Reset line.

dim GLCD RST as sbit
at PORTD.B6

dim GLCD EN as sbit sfr
external

Enable line.

dim GLCD EN as sbit
at PORTD.B7

dim GLCD CS1 Direction as
sbit sfr external

Direction of the Chip
Select 1 pin.

dim
GLCD CS1 Direction as
sbit at DDRD.B2

dim GLCD CS2 Direction as
sbit sfr external

Direction of the Chip
Select 2 pin.

dim
GLCD CS2 Direction as
sbit at DDRD.B3

dim GLCD RS Direction as
sbit sfr external

Direction of the Register
select pin.

dim GLCD RS Direction
as sbit at DDRD.B4

dim GLCD RW Direction as
sbit sfr external

Direction of the
Read/Write pin.

dim GLCD RW Direction
as sbit at DDRD.B5

dim GLCD EN Direction as
sbit sfr external

Direction of the Enable pin.

dim GLCD EN Direction
as sbit at DDRD.B6

dim GLCD RST Direction as
sbit sfr external

Direction of the Reset pin.

dim
GLCD RST Direction as
sbit at DDRD.B7
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Library Routines
Basic routines:

- Gled_Init

- Glcd_Set_Side

- Gled_Set X

- Glcd_Set_Page
- Glcd_Read_Data
- Glcd_Write_Data

Advanced routines:

- Glcd_Fill

- Gled_Dot

- Gled_Line

- Gled_V _Line

- Gled_H_Line

- Glcd_Rectangle
- Gled_Box

- Gled_Circle

- Glcd_Set_Font
- Glcd_Write_Char
- Glcd_Write_Text
- Gled_Image
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Glcd_lInit
Prototype sub procedure Glcd Init()
Returns Nothing.
e Initializes the Glcd module. Each of the control lines is both port and pin config-
Description . . . ; ]
urable, while data lines must be on a single port (pins <0:7>).
Global variables :
- cLcp cs1 : Chip select 1 signal pin
- cLcp cs2 : Chip select 2 signal pin
- GLCD RS : Register select signal pin
- cLcp rw : Read/Write Signal pin
- GLcD EN : Enable signal pin
- GLCD RST : Reset signal pin
- GLCD DataPort : Data port
Requires o _ _
- GLCD cs1 Direction : Direction of the Chip select 1 pin
- GLCD cs2 Direction : Direction of the Chip select 2 pin
- GLCD RS Direction : Direction of the Register select signal pin
- GLCD RW Direction : Direction of the Read/Write signal pin
- GLCD EN Direction : Direction of the Enable signal pin
- GLCD RST Direction : Direction of the Reset signal pin
- GLCD DataPort Direction : Direction of the Data port
must be defined before using this function.
// Glcd module connections
dim GLCD DataPort as byte at PORTC
GLCD DataPort Direction as byte at DDRC
dim GLCD CS1 as sbit at PORTD.B2
GLCD CS2 as sbit at PORTD.B3
GLCD RS as sbit at PORTD.B4
GLCD RW as sbit at PORTD.B5
GLCD EN as sbit at PORTD.B6
GLCD RST as sbit at PORTD.B7
Example dim GLCD CS1 Direction as sbit at DDRD.B2
GLCD CS2 Direction as sbit at DDRD.B3
GLCD RS Direction as sbit at DDRD.B4
GLCD RW Direction as sbit at DDRD.B5
GLCD EN Direction as sbit at DDRD.B6
GLCD RST Direction as sbit at DDRD.B7
// End Glcd module connections
Glcd Init()
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Glcd_Set_Side

Prototype sub procedure Glcd Set Side(dim x pos as byte)

Returns Nothing.

Selects Glcd side. Refer to the Glcd datasheet for detailed explaination.
Parameters :

- x_pos: position on x-axis. Valid values: 0..127
Description
The parameter x pos specifies the Glcd side: values from 0 to 63 specify the
left side, values from 64 to 127 specify the right side.

Note: For side, x axis and page layout explanation see schematic at the bottom
of this page.

Requires Glcd needs to be initialized, see Glcd_Init routine.

The following two lines are equivalent, and both of them select the left side of

Glcd:
Example
Glcd Select Side(0)
Glcd Select Side(10)
Glcd_Set_X
Prototype sub procedure Glcd Set X(dim x pos as byte)
Returns Nothing.
Sets x-axis position to x_pos dots from the left border of Glcd within the select-
ed side.
Parameters :

Description
- x_pos: position on x-axis. Valid values: 0..63

Note: For side, x axis and page layout explanation see schematic at the bottom
of this page.

Requires Glcd needs to be initialized, see Glcd_Init routine.

Example Glcd Set X(25)
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Glcd_Set_Page

Prototype sub procedure Glcd Set Page (dim page as byte)

Returns Nothing.

Selects page of the Glcd.

Parameters :

Description - page: page number. Valid values: 0..7

Note: For side, x axis and page layout explanation see schematic at the bottom
of this page.

Requires Glcd needs to be initialized, see Glcd_Init routine.

Example Glcd Set Page(5)

Glcd_Read_Data

Prototype sub function Glcd Read Data() as byte

Returns One byte from Glcd memory.

Reads data from from the current location of Glcd memory and moves to the

Description next location.

Glcd needs to be initialized, see Glcd_Init routine.

Requires Glcd side, x-axis position and page should be set first. See functions
Glcd_Set_Side, Glcd_Set_X, and Glcd_Set_Page.
dim data as byte

Example

data = Glcd Read Data()
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Glcd_Write_Data

Prototype sub procedure Glcd Write Data(dim ddata as byte)
Returns Nothing.
Writes one byte to the current location in Glcd memory and moves to the next
location.
Description Parameters :
- ddata: data to be written
Glcd needs to be initialized, see Glcd_Init routine.
Requires Glcd side, x-axis position and page should be set first. See functions
Glcd_Set_Side, Glcd_Set_X, and Glcd_Set_Page.
dim data as byte
Example -
Glcd Write Data (data)
Glcd_Fill
Prototype sub procedure Glcd Fill (dim pattern as byte)
Returns Nothing.
Fills Glcd memory with the byte pattern.
Parameters :
Description |- pattern: byte to fill Glcd memory with
To clear the Glcd screen, use Glcd Fill(0).
To fill the screen completely, use Glcd Fill (0xFF) .
Requires Glcd needs to be initialized, see Glcd_Init routine.
E I ' Clear screen
xample Gled Fill(0)
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Glcd_Dot
Proknype sub procedure Glcd Dot (dim x pos as byte, dim y pos as byte, dim
color as byte)
Returns Nothing.
Draws a dot on Glcd at coordinates (x pos, v pos).
Parameters :
- x_pos: X position. Valid values: 0..127
. - v pos: y position. Valid values: 0..63
Description | color: color parameter. Valid values: 0..2
The parameter color determines a dot state: O clears dot, 1 puts a dot, and 2
inverts dot state.
Note: For x and y axis layout explanation see schematic at the bottom of this page.
Requires Glcd needs to be initialized, see Glcd_Init routine.
E I ' Invert the dot in the upper left corner
xample  lc1ca pot(o, 0, 2)
Glcd_Line
Protot sub procedure Glcd Line(dim x start as integer, dim y start as inte-
rototype ger, dim x end as integer, dim y end as integer, dim color as byte)
Returns Nothing.
Draws a line on Glcd.
Parameters :
- x_start: X coordinate of the line start. Valid values: 0..127
Description |~ Y-S Y coordinate of the line start. Valid values: 0..63
P - x_end: X coordinate of the line end. Valid values: 0..127
- v _end: y coordinate of the line end. Valid values: 0..63
- color: color parameter. Valid values: 0..2
The parameter color determines the line color: 0 white, 1 black, and 2 inverts
each dot.
Requires Glcd needs to be initialized, see Glcd_Init routine.
' Draw a line between dots (0,0) and (20,30)
Example

Glcd Line(O0, O, 20, 30, 1)
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Glcd_V_Line
sub procedure Glcd V Line(dim y start as byte, dim y end as byte,
PrOtOtype dim x pos as byte, dim color as byte)
Returns Nothing.
Draws a vertical line on Glcd.
Parameters :
- v start: y coordinate of the line start. Valid values: 0..63
Description |- v end: y coordinate of the line end. Valid values: 0..63
- x_pos: X coordinate of vertical line. Valid values: 0..127
- color: color parameter. Valid values: 0..2
The parameter color determines the line color: 0 white, 1 black, and 2 inverts
each dot.
Requires Glcd needs to be initialized, see Glcd_Init routine.
Example ' Draw a vertical line between dots (10,5) and (10,25)
P Gled V Line(5, 25, 10, 1)
Glcd_H_Line
Prototvpe sub procedure Glcd V Line(dim x start as byte, dim x end as byte,
yp dim y pos as byte, dim color as byte)
Returns Nothing.
Draws a horizontal line on Glcd.
Parameters :
- x_start: X coordinate of the line start. Valid values: 0..127
Description |- = end: x coordinate of the line end. Valid values: 0..127
- v pos: y coordinate of horizontal line. Valid values: 0..63
- color: color parameter. Valid values: 0..2
The parameter color determines the line color: 0 white, 1 black, and 2 inverts
each dot.
Requires Glcd needs to be initialized, see Glcd_Init routine.
Example ' Draw a horizontal line between dots (10,20) and (50,20)
P Glcd H Line (10, 50, 20, 1)

MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD

225



CHAPTER 6
Libraries mikroBasic PRO for AVR

Glcd_Rectangle

sub procedure Glcd Rectangle(dim x upper left as byte, dim
Prototype y _upper left as byte, dim x bottom right as byte, dim
y bottom right as byte, dim color as byte)

Returns Nothing.

Draws a rectangle on Glcd.
Parameters :

- x upper left: x coordinate of the upper left rectangle corner. Valid values:
0..127

- v upper left: y coordinate of the upper left rectangle corner. Valid values:
0..63

- x bottom right: X coordinate of the lower right rectangle corner. Valid
values: 0..127

- v bottom right: y coordinate of the lower right rectangle corner. Valid
values: 0..63

- color: color parameter. Valid values: 0..2

Description

The parameter color determines the color of the rectangle border: 0 white, 1
black, and 2 inverts each dot.

Requires Glcd needs to be initialized, see Glcd_Init routine.

' Draw a rectangle between dots (5,5) and (40,40)

Example Glcd_Rectangle (5, 5, 40, 40, 1)
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Glcd_Box

sub procedure Glcd Box(dim x upper left as byte, dim y upper left
Prototype as byte, dim x bottom right as byte, dim y bottom right as byte,
dim color as byte)

Returns Nothing.

Draws a box on Glcd.
Parameters :

- x upper left: x coordinate of the upper left box corner. Valid values: 0..127
- v upper left: y coordinate of the upper left box corner. Valid values: 0..63
- % _bottom right: X coordinate of the lower right box corner. Valid values: 0..127

-y bottom right: y coordinate of the lower right box corner. Valid values: 0..63

- color: color parameter. Valid values: 0..2

Description

The parameter color determines the color of the box fill: 0 white, 1 black, and 2
inverts each dot.

Requires Glcd needs to be initialized, see Glcd_Init routine.

' Draw a box between dots (5,15) and (20,40)

Example Gled Box (5, 15, 20, 40, 1)

Glcd_Circle

Prototvpe sub procedure Glcd Circle(dim x center as integer, dim y center
yp as integer, dim radius as integer, dim color as byte)

Returns Nothing.

Draws a circle on Glcd.
Parameters :

- x _center: X coordinate of the circle center. Valid values: 0..127
Description |- v center: y coordinate of the circle center. Valid values: 0..63
- radius: radius size

- color: color parameter. Valid values: 0..2

The parameter color determines the color of the circle line: 0 white, 1 black,
and 2 inverts each dot.

Requires Glcd needs to be initialized, see Glcd_Init routine.

' Draw a circle with center in (50,50) and radius=10

Exan“ﬂe Glcd Circle (50, 50, 10, 1)
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Glcd_Set_Font

sub procedure Glcd Set Font (dim byref const ActiveFont as “byte, dim
FontWidth as byte, dim FontHeight as byte, dim FontOffs as word)

Prototype

Returns Nothing.

Sets font that will be used with Glcd_Write_Char and Glcd_Write_Text routines.
Parameters :

- activeFont: font to be set. Needs to be formatted as an array of char

- aFontwidth: width of the font characters in dots.

- aFontHeight : height of the font characters in dots.

Description |- arontoffs: number that represents difference between the mikroBasic PRO
for AVR character set and regular ASCII set (eg. if 'A" is 65 in ASCII character,
and 'A' is 45 in the mikroBasic PRO for AVR character set, aFontOffs is 20).
Demo fonts supplied with the library have an offset of 32, which means that
they start with space.

The user can use fonts given in the file “_Lib_ GLCDFonts.mbas” file located in
the Uses folder or create his own fonts.

Requires Glcd needs to be initialized, see Glcd_Init routine.

' Use the custom 5x7 font "myfont" which starts with space (32):

Example Glcd Set Font (myfont, 5, 7, 32)
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Glcd_Write_Char

Protot sub procedure Glcd Write Char (dim chr as byte, dim x pos as byte,
rototype dim page num as byte, dim color as byte)
Returns Nothing.
Prints character on the Glcd.
Parameters :
- chr: character to be written
- x_pos: character starting position on x-axis. Valid values: 0..(127-FontWidth)
- page num: the number of the page on which character will be written. Valid
Description | values: 0..7
- color: color parameter. Valid values: 0..2
The parameter color determines the color of the character: 0 white, 1 black,
and 2 inverts each dot.
Note: For x axis and page layout explanation see schematic at the bottom of
this page.
Glcd needs to be initialized, see Glcd_Init routine. Use Glcd_Set Font to speci-
Requires fy the font for display; if no font is specified, then default 5x8 font supplied with
the library will be used.
E I ' Write character 'C' on the position 10 inside the page 2:
xample Glcd Write Char('C', 10, 2, 1)
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Glcd_Write Text

Protot sub procedure Glcd Write Text (dim byref text as stringl 20] , dim

rototype X pos as byte, dim page num as byte, dim color as byte)

Returns Nothing.

Prints text on Glcd.
Parameters :
- text: text to be written
- x_pos: text starting position on x-axis.
. - page num: the number of the page on which text will be written. Valid values: 0..7

Description - h )

- color: color parameter. Valid values: 0..2

The parameter color determines the color of the text: 0 white, 1 black, and 2
inverts each dot.

Note: For x axis and page layout explanation see schematic at the bottom of
this page.

Glcd needs to be initialized, see Glcd_Init routine. Use Glcd_Set_Font to speci-

Requires fy the font for display; if no font is specified, then default 5x8 font supplied with
the library will be used.

E I ' Write text "Hello world!" on the position 10 inside the page 2:

xample Glcd Write Text ("Hello world!", 10, 2, 1)

Glcd_Image

Prototype sub procedure Glcd Image (dim byref const image as “byte)

Returns Nothing.

Displays bitmap on Gicd.
Parameters :

Description | image: image to be displayed. Bitmap array must be located in code memory.
Use the mikroBasic PRO for AVR integrated Glcd Bitmap Editor to convert
image to a constant array suitable for displaying on Glcd.

Requires Glcd needs to be initialized, see Glcd_Init routine.

Exanuﬂe ' Draw image my image on Glcd

Glcd Image (my image)
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Library Example

The following example demonstrates routines of the Glcd library: initialization,

clear(pattern fill), image displaying, drawing lines, circles, boxes and rectangles, text
displaying and handling.

program Glcd Test

include bitmap

' Glcd module connections

dim GLCD DataPort as byte at PORTC
GLCD DataPort Direction as byte at DDRC

dim GLCD CS1 as sbit at PORTD.B2
GLCD CS2 as sbit at PORTD.B3
GLCD RS as sbit at PORTD.B4
GLCD RW as sbit at PORTD.B5
GLCD EN as sbit at PORTD.B6
GLCD RST as sbit at PORTD.B7

dim GLCD CS1 Direction as sbit at DDRD.B2
GLCD CS2 Direction as sbit at DDRD.B3
GLCD RS Direction as sbit at DDRD.B4
GLCD RW Direction as sbit at DDRD.B5
GLCD _EN Direction as sbit at DDRD.B6
GLCD RST Direction as sbit at DDRD.B7

' End Glcd module connections

dim counter as byte
someText as char| 18]

sub procedure Delay2S() !
function

Delay ms (2000)
end sub

2 seconds delay sub

main:
Glcd Init() !
Glcd Fill (0x00) !

Initialize Glcd
Clear Glcd
while TRUE

Glcd Image (@truck bmp) ' Draw image
Delay2S () delay2S()

Glcd Fill(0x00) ' Clear Glcd
Glcd Box(62,40,124,63,1) ' Draw box

Glcd Rectangle(5,5,84,35,1) ' Draw rectangle
Glcd Line(0, 0, 127, 63, 1) ' Draw line
Delay2S()

counter 5
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while (counter <= 59) ' Draw horizontal and vertical lines
Delay ms (250)
Glcd V Line (2, 54, counter, 1)
Glcd H Line(2, 120, counter, 1)

Counter = counter + 5

wend

Delay2S ()

Glcd Fill(0x00) ' Clear Glcd

Glcd Set Font (@Character8x7, 8, 7, 32) ' Choose font

"Character8x7"

Glcd Write Text ("mikroE", 1, 7, 2) ' Write string

for counter = 1 to 10 ' Draw circles

Glcd Circle (63,32, 3*counter, 1)
next counter

Delay2S ()
Glcd Box (12,20, 70,57, 2) ' Draw box
Delay2S ()
Glcd Fill (OxFF) ' Fill Glcd
Glcd Set Font (@Character8x7, 8, 7, 32) ' Change font
someText = "8x7 Font"
Glcd Write Text (someText, 5, 0, 2) ' Write string
delay2S ()
Glcd Set Font (@System3x6, 3, 5, 32) ' Change font
someText = "3X5 CAPITALS ONLY"
Glcd Write Text (someText, 60, 2, 2) ' Write string
delay2S ()
Glcd Set Font (@Gfontdx7, 5, 7, 32) ' Change font
someText = "5x7 Font"
Glcd Write Text (someText, 5, 4, 2) ' Write string
delay2S ()
Glcd Set Font (@FontSystemb5x7 v2, 5, 7, 32) ' Change font
someText = "5x7 Font (v2)"
Glcd Write Text (someText, 5, 6, 2) ' Write string
delay2S ()

wend

end.
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HW Connection
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KEYPAD LIBRARY

The mikroBasic PRO for AVR provides a library for working with 4x4 keypad. The
library routines can also be used with 4x1, 4x2, or 4x3 keypad. For connections

explanation see schematic at the bottom of this page.

Note: Since sampling lines for AVR MCUs are activated by logical zero Keypad
Library can not be used with hardwares that have protective diodes connected with
anode to MCU side, such as mikroElektronika's Keypad extra board HW.Rev v1.20

The following variable
must be defined in all

byte sfr external

projects using Keypad Description: Example :
Library:
dim keypadPort as Keypad Port. dim keypadPort as

byte at PORTB

dim
keypadPort Direction
as byte sfr external

Direction of the Keypad
Port.

dim

keypadPort Direction
as byte at DDRB

Library Routines

- Keypad_Init

- Keypad_Key_ Press
- Keypad_Key_ Click
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Keypad_Init

Prototype sub procedure Keypad Init ()

Returns Nothing.

Description |[Initializes port for working with keypad.
Global variables :

. -k dport Reg - Keypad port

Requires eypadrort_neg =t yp , P o
- keypadPort Reg Direction - Direction of the Keypad port
must be defined before using this function.
' Initialize PORTB for communication with keypad
dim keypadPort as byte at PORTB

Example dim keypadPort Direction as byte at DDRB

Keypad Init ()

Keypad_Key_Press

Prototype sub function Keypad Key Press() as byte
The code of a pressed key (1..16).

Returns
If no key is pressed, returns 0.

Description [Reads the key from keypad when key gets pressed.

Requires Port needs to be initialized for working with the Keypad library, see Keypad_Init.
dim kp as byte

Example

kp = Keypad Key Press|()

Keypad_Key_Click

Prototype sub function Keypad Key Click() as byte
The code of a clicked key (1..16).

Returns
If no key is clicked, returns 0.
Call to Keypad_Key_Click is a blocking call: the function waits until some key is
pressed and released. When released, the function returns 1 to 16, depending

Description |on the key. If more than one key is pressed simultaneously the function will wait
until all pressed keys are released. After that the function will return the code of
the first pressed key.

Requires Port needs to be initialized for working with the Keypad library, see Keypad_ Init.
dim kp as byte

Example

kp = Keypad Key Click()
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Library Example

This is a simple example of using the Keypad Library. It supports keypads with 1..4
rows and 1..4 columns. The code being returned by Keypad_Key_Click() function is
in range from 1..16. In this example, the code returned is transformed into ASCII
codes [0..9,A..F] and displayed on Lcd. In addition, a small single-byte counter dis-
plays in the second Lcd row number of key presses.

program Keypad Test

dim kp, cnt, oldstate as byte
txt as bytel 7]

' Keypad module connections

dim keypadPort as byte at PORTB

dim keypadPort Direction as byte at DDRB

' End Keypad module connections

' Lcd pinout definition

dim LCD RS as sbit at PORTD.
LCD EN as sbit at PORTD.
LCD D4 as sbit at PORTD.
LCD D5 as sbit at PORTD.
LCD D6 as sbit at PORTD.
LCD D7 as sbit at PORTD.

g o 0w N

dim LCD RS Direction as sbit at DDRD.
LCD EN Direction as sbit at DDRD.
LCD D4 Direction as sbit at DDRD.
LCD D5 Direction as sbit at DDRD.
LCD D6 Direction as sbit at DDRD.
LCD D7 Direction as sbit at DDRD.
' end Lcd pinout definitions
main:
oldstate = 0
cnt = 0 ' Reset counter
Keypad Init () ' Initialize Keypad
Led Init () ' Initialize Lcd
Lcd Cmd (LCD_CLEAR) ' Clear display
Lcd Cmd (LCD_CURSOR _OFF) ' Cursor off
Lcd Out(l, 1, "Key :") ' Write message text on
LCD
Led Out (2, 1, "Times:")

while TRUE

kp = 0 ' Reset key code variable
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' Wait for key to be pressed and released
while ( kp = 0 )
kp = Keypad Key Click() ' Store key code in kp variable
wend
' Prepare value for output, transform key to it"s ASCII value
select case kp

'case 10: kp = 42 vomem v Uncomment this block for keypad4dx3
'case 11: kp = 48 oo
'case 12: kp = 35 vorgn

'default: kp += 48

case 1

kp = 49 ' 1 ' Uncomment this block for keypaddx4
case 2

kp = 50 '2
case 3

kp = 51 '3
case 4

kp = 65 ' A
case 5

kp = 52 ' 4
case 6

kp = 53 "5
case 7

kp = 54 ''6
case 3

kp = 66 ' B
case 9

kp = 55 v
case 10

kp = 56 '8
case 11

kp = 57 "9
case 12

kp = 67 ' C
case 13

kp = 42 vox
case 14

kp = 48 "0
case 15

kp = 35 ' #
case 16

kp = 68 ' D

end select

if (kp <> oldstate) then ' Pressed key differs from previous
cnt = 1
oldstate = kp

MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD 237



CHAPTER 6

Libraries mikroBasic PRO for AVR
else ' Pressed key 1is same as previous
Inc(cnt)
end if
Lecd Chr(l, 10, kp) ' Print key ASCII wvalue on Lcd
if (cnt = 255) then ' If counter varialble overflow
cnt = 0
Led Out (2, 10, " ")
end if
WordToStr (cnt, txt) ' Transform counter value to string
Lecd Out (2, 10, txt) ' Display counter value on Lcd
wend
end.
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HW Connection
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LCD LIBRARY

The mikroBasic PRO for AVR provides a library for communication with Lcds (with
HD44780 compliant controllers) through the 4-bit interface. An example of Lcd con-
nections is given on the schematic at the bottom of this page.

For creating a set of custom Lcd characters use Lcd Custom Character Tool.

External dependencies of Lcd Library

The following variables
must be defined in all

. - Description: Example :
projects using Lcd P P
Library:
dim LCD RS as sbit Register Select line dim LCD RS as sbit at
sfr external g ' PORTD.B2
dim LCD EN as sbit Enable lin dim LCD EN as sbit at
sfr external abie line. PORTD.B3
dim LCD D7 as sbit Data 7 line dim LCD D7 as sbit at
sfr external ’ PORTD.B4
dim LCD D6 as sbit Data 6 line dim LCD D6 as sbit at
sfr external ’ PORTD.B5
dim LCD D5 as sbit Data 5 line dim LCD D5 as sbit at
sfr external ’ PORTD.B6
dim LCD D4 as sbit Data 4 line dim LCD D4 as sbit at
sfr external ’ PORTD.B7

dim LCD RS Direction
as sbit sfr external

dim LCD EN Direction
as sbit sfr external
dim LCD D7 Direction
as sbit sfr external
dim LCD D6 Direction
as sbit sfr external
dim LCD D5 Direction
as sbit sfr external

dim LCD D4 Direction
as sbit sfr external

dim LCD RS Direction
as sbit at DDRD.B2

dim LCD EN Direction
as sbit at DDRD.B3
dim LCD D7 Direction
as sbit at DDRD.R4
dim LCD D6 Direction
as sbit at DDRD.B5
dim LCD D5 Direction
as sbit at DDRD.B6
dim LCD D4 Direction
as sbit at DDRD.R7

Register Select direction pin.

Enable direction pin.

Data 7 direction pin.

Data 6 direction pin.

Data 5 direction pin.

Data 4 direction pin.
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- Led_Init
- Led_Out
- Led_Out_Cp
- Led_Chr
- Led_Chr_Cp
-Lcd_ Cmd
Lcd_Init
Prototype sub procedure Lcd Init()
Returns Nothing.
Description |Initializes Lcd module.
Global variables:
- Lcp D7: Data bit 7
- L.cD D6: Data bit 6
- LcD D5: Data bit 5
- LcD D4: Data bit 4
- Lch Rs: Register Select (data/instruction) signal pin
- .cp eN: Enable signal pin
Requires o '
- 1L.CD D7 Direction: Direction of the Data 7 pin
- LCD D6 Direction: Direction of the Data 6 pin
- LCD D5 Direction: Direction of the Data 5 pin
- 1L.CD D4 Direction: Direction of the Data 4 pin
- LCD RS Direction: Direction of the Register Select pin
- LCD EN Direction: Direction of the Enable signal pin
must be defined before using this function.
' Lcd module connections
dim
LCD RS as sbit at PORTD.B2
LCD EN as sbit at PORTD.B3
LCD D7 as sbit at PORTD.B4
LCD D6 as sbit at PORTD.BS
LCD D5 as sbit at PORTD.B6
LCD D4 as sbit at PORTD.B7
E I dim
Xamplie LCD RS as sbit at DDRD.B2
LCD EN as sbit at DDRD.B3
LCD D7 as sbit at DDRD.B4
LCD D6 as sbit at DDRD.B5
LCD D5 as sbit at DDRD.B6
LCD D4 as sbit at DDRD.B7
' End Lcd module connections
Led Init ()
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Lcd_Out

sub procedure Lcd Out (dim row as byte, dim column as byte, dim

Prototype byref text as stringf 20])
Returns Nothing.
Prints text on Lcd starting from specified position. Both string variables and liter-
als can be passed as a text.
o Parameters :
Description

- row: starting position row number
- column: starting position column number
- text: text to be written

Requires The Lcd module needs to be initialized. See Lcd_Init routine.

' Write text "Hello!" on Lcd starting from row 1, column 3:

Example Led Out (1, 3, "Hellol!M)

Lcd Out Cp

Prototype sub procedure Lcd Out Cp(dim byref text as stringf 19])

Returns Nothing.

Prints text on Lcd at current cursor position. Both string variables and literals
can be passed as a text.

Description Parameters :

- text: text to be written

Requires The Lcd module needs to be initialized. See Lcd_Init routine.

rite text ere! at current cursor position:
' Write text "H '"oat t K t

Example Lcd Out Cp("Here!")
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Lcd_Chr

sub procedure Lcd Chr(dim row as byte, dim column as byte, dim

Prototype out char as byte)

Returns Nothing.

Prints character on Lcd at specified position. Both variables and literals can be
passed as a character.

_ Parameters :
Description
- row: writing position row number
- column: writing position column number
- out char: character to be written

Requires The Lcd module needs to be initialized. See Lcd_Init routine.

' Write character "i" at row 2, column 3:

Example Led Chr(2, 3, 'i')

Lcd _Chr_Cp

Prototype sub procedure Lcd Chr Cp(dim out char as byte)

Returns Nothing.

Prints character on Lcd at current cursor position. Both variables and literals
can be passed as a character.

Description Parameters :

- out char: character to be written

Requires The Lcd module needs to be initialized. See Lcd_Init routine.

' Write character "e" at current cursor position:

Example Lcd Chr Cp('e'")
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Lcd_Cmd

Prototype sub procedure Lcd Cmd(dim out char as byte)

Returns Nothing.

Sends command to Lcd.

Parameters :

Description
P - out char: command to be sent

Note: Predefined constants can be passed to the function, see Available SPI
Lcd Commands.

Requires The Lcd module needs to be initialized. See Lcd_Init table.

' Clear Lcd display:

Example Led Cmd (LCD_CLEAR)

Available Lcd Commands

Lcd Command Purpose

LCD_FIRST ROW Move cursor to the 1st row
LCD_SECOND_ROW Move cursor to the 2nd row
LCD_THIRD ROW Move cursor to the 3rd row
LCD_FOURTH ROW Move cursor to the 4th row
LCD_CLEAR Clear display

Return cursor to home position, returns a shifted display to its

ROD_RETURN_FOME original position. Display data RAM is unaffected.

LCD_CURSOR _OFF Turn off cursor

LCD UNDERLINE ON Underline cursor on

LCD BLINK CURSOR ON Blink cursor on

LCD MOVE CURSOR LEFT Move cursor left without changing display data RAM

LCD MOVE CURSOR RIGHT Move cursor right without changing display data RAM

LCD_TURN ON Turn Lcd display on

LCD_TURN OFF Turn Lcd display off

LCD SHIFT LEFT Shift display left without changing display data RAM
LCD SHIFT RIGHT Shift display right without changing display data RAM
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Library Example

The following code demonstrates usage of the Lcd Library routines:
' LCD module connections

dim LCD RS as sbit at PORTD.
dim LCD EN as sbit at PORTD.
dim LCD D4 as sbit at PORTD.
dim LCD D5 as sbit at PORTD.
dim LCD D6 as sbit at PORTD.
dim LCD D7 as sbit at PORTD.

~N o U1 W N

dim LCD RS Direction as sbit at DDRD.B2
dim LCD EN Direction as sbit at DDRD.B3
dim LCD D4 Direction as sbit at DDRD.B4
dim LCD D5 Direction as sbit at DDRD.B5
dim LCD D6 Direction as sbit at DDRD.B6
dim LCD D7 Direction as sbit at DDRD.B7
' End Lcd module connections

dim txtl as charf 17]
1

txt2 as char| 10]
txt3 as char| 9]
txt4 as char| 8]
i as byte ' Loop variable
sub procedure Move Delay() ' Function used for text moving
Delay ms (500) ' You can change the moving speed here
end sub
main:
txtl = "mikroElektronika"
txt2 = "EasyAVR5A"
txt3 = "Lcd4bit"
txtd = "example"
Led Init () ' Initialize Lcd
Lcd Cmd (LCD_CLEAR) ' Clear display
Lcd Cmd (LCD_CURSOR_OFF) ' Cursor off
LCD Out(1l,6,txt3) ' Write text in first row
LCD Out (2,6, txt4) ' Write text in second row
Delay ms (2000)
Lcd Cmd (LCD_CLEAR) ' Clear display
LCD Out(1l,1,txtl) ' Write text in first row
LCD Out (2,4, txt2) ' Write text in second row
Delay ms (500)
' Moving text
for i=0 to 3 ' Move text to the right 4 times
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Led Cmd (LCD SHIFT RIGHT)
Move Delay ()
next i
while TRUE ' Endless loop
for i=0 to 6 ' Move text to the left 7 times
Led Cmd (LCD SHIFT LEFT)
Move Delay ()
next i
for i=0 to 6 ' Move text to the right 7 times
Led Cmd (LCD SHIFT RIGHT)
Move Delay ()
next i
wend
end.
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MANCHESTER CODE LIBRARY

The mikroBasic PRO for AVR provides a library for handling Manchester coded sig-
nals. The Manchester code is a code in which data and clock signals are combined
to form a single self-synchronizing data stream; each encoded bit contains a transi-
tion at the midpoint of a bit period, the direction of transition determines whether the
bit is 0 or 1; the second half is the true bit value and the first half is the complement
of the true bit value (as shown in the figure below).

Manchester RF_Send_Byte format

St1|5t2|Cir |B7 |B6|B5|B4 | B3| B2|B1|BO

Bi-phase coding
Al
1 0

2ms Example of transmission

117000100011

Notes: The Manchester receive routines are blocking calls (Man Receive Init and
Man Synchro). This means that MCU will wait until the task has been performed
(e.g. byte is received, synchronization achieved, etc).

Note: Manchester code library implements time-based activities, so interrupts need
to be disabled when using it.

External dependencies of Manchester Code Library

The following variables
must be defined in all

projects using Man- Description: Example :
chester Code Library:
dim MANRXPIN as sbit R ive lin dim MANRXPIN as sbit
sfr external eceive e. at PINB.BO
dim MANTXPIN as sbit - dim MANTXPIN as sbit
Transmit line
sfr external ’ at PORTB.BR1
dim . . . dim
Direction of the Receiv
MANRXPIN Direction as| . ection of the Receive MANRXPIN Direction as
sbit sfr external pin. sbit at DDRB.BO
dim . . . dim
Direction of the Transmit
MANTXPIN Direction as| . ection o e Irans MANTXPIN Direction as
sbit sfr external pin. sbit at DDRB.BI1
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Library Routines

- Man_Receive_|Init
- Man_Receive

- Man_Send_Init

- Man_Send

- Man_Synchro

- Man_Break

The following routines are for the internal use by compiler only:
- Manchester_0
- Manchester_1

- Manchester_Out

Man_Receive_lInit

Prototype sub function Man Receive Init()as word
Returns - 0 - if initialization and synchronization were successful.
- 1 - upon unsuccessful synchronization.
The function configures Receiver pin and performs synchronization procedure in
order to retrieve baud rate out of the incoming signal.
Description
Note: In case of multiple persistent errors on reception, the user should call this
routine once again or Man_Synchro routine to enable synchronization.
Global variables :
. - MANRXPIN : Receive line
Requires ‘ i . .
- MANRXPIN Direction : Direction of the receive pin
must be defined before using this function.
' Initialize Receiver
dim MANRXPIN as sbit at PINB.RO
Example dim MANRXPIN Direction as sbit at DDRB.BO
Man Receive Init ()
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Man_Receive

Prokﬂype sub function Man Receive (dim byreferror as byte) as byte
Returns A byte read from the incoming signal.
The function extracts one byte from incoming signal.
i Parameters :
Description
- error: error flag. If signal format does not match the expected, the error flag
will be set to non-zero.
. To use this function, the user must prepare the MCU for receiving. See
Requires . )
Man_Receive_|Init.
dim data, error as byte
data = 0
error = 0
Example data = Man Receive (&error)
if (error <> 0) then
' error handling
end if
Man_Send_lInit
Prototype sub procedure Man Send Init ()
Returns Nothing.
Description |The function configures Transmitter pin.
Global variables :
. - MANRXPIN : Receive line
Requires ‘ e . .
- MANRXPIN Direction : Direction of the receive pin
must be defined before using this function.
' Initialize Transmitter:
dim MANTXPIN as sbit at PINB.B1
Example dim MANTXPIN Direction as sbit at DDRB.BI

ManisendiLnit()
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Man_Send
Prototype sub procedure Man Send(tr data as byte)

Returns Nothing.

Sends one byte.
Parameters :

Description
- tr data: data to be sent

Note: Baud rate used is 500 bps.

To use this function, the user must prepare the MCU for sending. See
Man_Send_ Init.

dim msg as byte

Requires

Example -
Man Send (msg)

Man_Synchro

Prototype sub function Man Synchro() as word

- 0 - if synchronization was not successful.
Returns - Half of the manchester bit length, given in multiples of 10us - upon successful
synchronization.

Description [Measures half of the manchester bit length with 10us resolution.

To use this function, you must first prepare the MCU for receiving. See

Requires Man_Receive_|nit.

dim man half bit len as word

Example S
man_half bit len = Man Synchro()
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Man_Break
Prototype sub procedure Man Break()
Returns Nothing.
Man_Receive is blocking routine and it can block the program flow. Call this
routine from interrupt to unblock the program execution. This mechanism is sim-
e ilar to WDT.
Description
Note: Interrupts should be disabled before using Manchester routines again
(see note at the top of this page).
Requires Nothing.
dim datal, error, counter as byte
sub procedure TimerOOverflow ISR org 0xl12
counter = 0
if (counter >= 20) then
Man Break ()
counter = 0 ' reset counter
else
Inc (counter) ' increment counter
end if
end sub
main:
TOIEO bit 1 ' Timer0 overflow interrupt enable
TCCRO bit =5 ' Start timer with 1024 prescaler
Example SREG_I bit = 0 ' Interrupt disable
Man Receive Init()
' try Man Receive with blocking prevention mechanism
SREG I bit =1 ' Interrupt enable
datal = Man Receive (Q@error);
SREG I bit =0 ' Interrupt disable
end.
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Library Example

The following code is code for the Manchester receiver, it shows how to use the
Manchester Library for receiving data:

program Manchester Receiver

' Lcd module connections

dim LCD RS as sbit at PORTD.B2
LCD EN as sbit at PORTD.B3
LCD D4 as sbit at PORTD.B4
LCD D5 as sbit at PORTD.BS5S
LCD D6 as sbit at PORTD.B6
LCD D7 as sbit at PORTD.B7

dim LCD RS Direction as sbit at DDRD.B2
LCD EN Direction as sbit at DDRD.B3
LCD D4 Direction as sbit at DDRD.B4
LCD D5 Direction as sbit at DDRD.B5S
LCD D6 Direction as sbit at DDRD.B6
LCD D7 Direction as sbit at DDRD.B7

End Lcd module connections

v

' Manchester module connections

dim MANRXPIN as sbit at PINB.RO
MANRXPIN Direction as sbit at DDRB.BO
MANTXPIN as sbit at PORTB.B1
MANTXPIN Direction as sbit at DDRB.BI1

' End Manchester module connections

dim error , ErrorCount, temp as byte
main:
ErrorCount = 0
Delay 10us()
Led Init () ' Initialize Lcd
Lcd Cmd (LCD_CLEAR) ' Clear Lcd display
Man Receive Init() ' Initialize Receilver
while TRUE ' Endless loop
Lcd Cmd (LCD_FIRST ROW) ' Move cursor to the 1lst row
while TRUE ' Wait for the "start" byte
temp = Man Receive (error ) ' Attempt byte receive
if (temp = O0x0B) then ' "Start" byte, see Transmitter example
break ' We got the starting sequence
end if
if (error_ <> 0) then ' Exit so we do not loop forever
break
end if
wend
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while (temp <> 0x0E)
temp Man Receive (error ) !
if (error <> 0) then

Led Chr CP ("2 ") '

Inc (ErrorCount)
if

Attempt byte receive

If error occured

Write question mark on Lcd
Update error counter

v

(ErrorCount > 20) then ' In case of multiple errors
temp Man Synchro () ' Try to synchronize again
'Man Receive Init() ' Alternative, try to Initialize
Receiver again
ErrorCount = 0 ' Reset error counter
end if
else ' No error occured
if (temp <> OxOE) then ' If "End" byte was received (see

Transmitter example)
Lcd Chr CP(temp) !
end if

Delay ms (25)
end if

do not write received byte on Lcd

wend !
wend
end.

If "End"

byte was received exit do loop

The following code is code for the Manchester transmitter, it shows how to use the
Manchester Library for transmitting data:

program Manchester Transmitter
' Manchester module connections
dim MANRXPIN as sbit at PORTB.BO

MANRXPIN Direction as sbit at DDRB.BO

MANTXPIN as sbit at PORTB.B1

MANTXPIN Direction as sbit at DDRB.B1
' End Manchester module connections
dim index, character as byte

sl as char[ 17]

main:
sl "mikroElektronika"
Man Send Init() !

Initialize transmitter

while TRUE '
Man Send (0x0B) !
Delay ms (100) '
character s1[ 0] !
index 0 !

Endless loop

Send "start" byte

Wait for a while

Take first char from string
Initialize index variable
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while (character <> 0) ' String ends with =zero
Man Send(character) ' Send character
Delay ms (90) ' Wait for a while
Inc (index) ' Increment index variable
character = sl[ index] ' Take next char from string

wend

Man Send (0x0E) ' Send "end" byte

Delay ms (1000)

wend
end.

Connection Example

(
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254  MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD



CHAPTER 6
mikroBasic PRO for AVR Libraries

MULTI MEDIA CARD LIBRARY

The Multi Media Card (MMC) is a flash memory card standard. MMC cards are cur-
rently available in sizes up to and including 1 GB, and are used in cell phones, mp3
players, digital cameras, and PDA’s.

mikroBasic PRO for AVR provides a library for accessing data on Multi Media Card
via SPI communication.This library also supports SD(Secure Digital) memory cards.

Secure Digital Card

Secure Digital (SD) is a flash memory card standard, based on the older Multi Media
Card (MMC) format.

SD cards are currently available in sizes of up to and including 2 GB, and are used
in cell phones, mp3 players, digital cameras, and PDAs.

Notes:

- Routines for file handling can be used only with FAT16 file system.

- Library functions create and read files from the root directory only;

- Library functions populate both FAT1 and FAT2 tables when writing to files, but the
file data is being read from the FAT1 table only; i.e. there is no recovery if FAT1
table is corrupted.

- Prior to calling any of this library routines, Spi_Rd_Ptr needs to be initialized with
the appropriate SPI_Read routine.

External dependencies of MMC Library

The following variable
must be defined in all
projects using MMC
library:

Description: Example :

dim Mmc Chip Select
as sbit sfr external

dim Mmc Chip Select

Chlp select pin. as sbit at PINB.RO

dim dim

Mmc Chip Select Direc |Direction of the chip select |Mmc Chip Select Direc
tion as sbit sfr Mn_ tion as sbit at
external DDRB.BO
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Library Routines

- Mmc_Init

- Mmc_Read_Sector
- Mmc_Write_Sector
- Mmc_Read_Cid

- Mmc_Read_Csd

Routines for file handling:

- Mmc_Fat_|Init

- Mmc_Fat_QuickFormat

- Mmc_Fat_Assign

- Mmc_Fat_Reset

- Mmc_Fat_Read

- Mmc_Fat_Rewrite

- Mmc_Fat_Append

- Mmc_Fat_Delete

- Mmc_Fat_Write

- Mmc_Fat_Set_File_Date
- Mmc_Fat_Get _File_Date
- Mmc_Fat_Get_File_Size
- Mmc_Fat_Get Swap_File
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Prototype sub function Mmc Init() as byte
- 0 - if MMC/SD card was detected and successfully initialized
Returns :
- 1 - otherwise
Initializes MMC through hardware SPI interface.
i Parameters:

Description
- port: chip select signal port address.
- cspin: chip select pin.
Global variables :
-Mmc Chip select: Chip Select line

. -Mmc Chip Select Direction: Direction of the Chip Select pin

Requires - - -
must be defined before using this function.
The appropriate hardware SPI module must be previously initialized. See the
SPI1_Init, SPI1_Init_Advanced routines.
' MMC module connections
dim Mmc Chip Select as sbit sfr at PORTB.B2
dim Mmc Chip Select Direction as sbit sfr at DDRB.B2
' MMC module connections
error = Mmc_ Init () ' Init with CS line at PORTB.B2

Example dim i as byte
SPI1 Init Advanced( SPI MASTER, SPI FCY DIV2, SPI CLK LO LEAD-
ING)
Spi Rd Ptr = @SPI1 Read // Pass pointer to SPI Read function
of used SPI module
1 = Mmc Init()
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Mmc_Read_Sector

sub function Mmc Read Sector (dim sector as longint, dim byref

Prokﬂype data as bytel 512] ) as byte
- 0 - if reading was successful
Returns .
- 1 - if an error occurred
The function reads one sector (512 bytes) from MMC card.
i Parameters:
Description

- sector: MMC/SD card sector to be read.
- dbuff: buffer of minimum 512 bytes in length for data storage.

Requires MMC/SD card must be initialized. See Mmc_Init.

' read sector 510 of the MMC/SD card
dim error as word

sectorNo as longword

dataBuffer as char 512]

Example .
main:

sectorNo = 510
error = Mmc Read Sector (sectorNo, dataBuffer)

end.
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Mmc_Write_Sector

Prototvpe sub function Mmc Write Sector(dim sector as longint, dim byref
yp data as byte[ 512] ) as byte
- 0 - if writing was successful
Returns - 1 - if there was an error in sending write command
- 2 - if there was an error in writing (data rejected)
The function writes 512 bytes of data to one MMC card sector.
e Parameters:

Description

- sector: MMC/SD card sector to be written to.

- dbuff: data to be written (buffer of minimum 512 bytes in length).
Requires MMC/SD card must be initialized. See Mmc_lnit.

' write to sector 510 of the MMC/SD card

dim error as word

sectorNo as longword
dataBuffer as char][ 512]

Example .

maln:

sectorNo = 510
error = Mmc Write Sector (sectorNo, dataBuffer)
end.
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Mmc_Read_Cid

Prototype sub function Mmc Read Cid(dim byref data cid as byte[ 16] ) as byte

- 0 - if CID register was read successfully

Returns . . :
- 1 - if there was an error while reading

The function reads 16-byte CID register.
Description |Parameters:

- data cid: buffer of minimum 16 bytes in length for storing CID register content.

Requires MMC/SD card must be initialized. See Mmc_lnit.

dim error as word
dataBuffer as byte[ 16]

main:
Example
error = MmciReadicid<dataBuffer)

end.

Mmc_Read_Csd

sub function Mmc Read Csd(dim byref data for registers as

PrOtOtype byte[ 16] ) as byte

- 0 - if CSD register was read successfully

Returns . . )
- 1 - if there was an error while reading

The function reads 16-byte CSD register.
Description |Parameters:

- data csd: buffer of minimum 16 bytes in length for storing CSD register content.

Requires MMC/SD card must be initialized. See Mmc_Init.

dim error as word
dataBuffer as char| 16]

main:
Example
error = Mmc Read Csd(dataBuffer)

end.
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Mmc_Fat_Init

Prototype sub function Mmc Fat Init() as byte

- 0 - if MMC/SD card was detected and successfully initialized
Returns - 1 - if FAT16 boot sector was not found
- 255 - if MMC/SD card was not detected

Initializes MMC/SD card, reads MMC/SD FAT16 boot sector and extracts neces-

Description |°2"Y data needed by the library.

Note: MMC/SD card has to be formatted to FAT16 file system.

-Mmc Chip Select: Chip Select line

-Mmc Chip Select Direction: Direction of the Chip Select pin
Requires must be defined before using this function.

The appropriate hardware SPI module must be previously initialized. See the
SPI1_Init, SPI1_Init_Advanced routines.

' init the FAT library

Example if (Mmc _Fat Init() = 0) then

end if
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Mmc_Fat_QuickFormat

sub function Mmc Fat QuickFormat (dim mmc fat label as stringl 11])

Prototype as byte

- 0 - if MMC/SD card was detected, successfully formated and initialized
Returns - 1 - if FAT16 format was unseccessful
- 255 - if MMC/SD card was not detected

Formats to FAT16 and initializes MMC/SD card.

Parameters:

-mmc fat label: volume label (11 characters in length). If less than 11
characters are provided, the label will be padded with spaces. If null string is

. passed volume will not be labeled

Description

Note: This routine can be used instead or in conjunction with Mmc_Fat_Init rou-

tine.

Note: If MMC/SD card already contains a valid boot sector, it will remain
unchanged (except volume label field) and only FAT and ROOT tables will be
erased. Also, the new volume label will be set.

Requires The appropriate hardware SPI module must be previously initialized.

' format and initialize the FAT library

if (Mmc Fat QuickFormat ('mikroE') = 0) then
Example - =

end if
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Mmc_Fat_Assign
sub function Mmc Fat Assign(dim byref filename as char[ 12], dim
Prototype file cre attr as byte) d
Returns - 1 - if file already exists or file does not exist but a new file is created.
- 0 - if file does not exist and no new file is created.

Assigns file for file operations (read, write, delete...). All subsequent file opera-

tions will be applied on an assigned file.

Parameters:

- filename: name of the file that should be assigned for file operations. File
name should be in DOS 8.3 (file_name.extension) format. The file name and
extension will be automatically padded with spaces by the library if they have
less than length required (i.e. "mikro.tx" -> "mikro .tx "), so the user does no
have to take care of that. The file name and extension are case insensitive.
The library will convert them to proper case automatically, so the user does not
have to take care of that.

Also, in order to keep backward compatibility with the first version of this
library, file names can be entered as UPPERCASE string of 11 bytes in length
with no dot character between file name and extension (i.e. "MIKROELETXT" -
> MIKROELE.TXT). In this case last 3 characters of the string are considered
to be file extension.
Description |- file cre attr: file creation and attributs flags. Each bit corresponds to the
appropriate file attribut:
Bit | Mask Description
0 0x01 [Read Only
1 0x02 |Hidden
2 0x04 |System
3 0x08 [Volume Label
4 0x10 |Subdirectory
5 0x20 |Archive
6 0x40 |Device (internal use only, never found on disk)
File creation flag. If the file does not exist and this flag is set,
7 0x80 . . e :
a new file with specified name will be created.

Note: Long File Names (LFN) are not supported.

Reaqui MMC/SD card and MMC library must be initialized for file operations. See
equires .

Mmc_Fat_Init.

E I ' create file with archive attribut if it does not already exist
xample Mmc Fat Assign ("MIKROOO7.TXT", 0xAO)
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Mmc_Fat_Reset

Prototype sub procedure Mmc Fat Reset (dim byref size as longword)

Returns Nothing.

Opens currently assigned file for reading.

. Parameters:
Description

- size: buffer to store file size to. After file has been open for reading its size is
returned through this parameter.

MMC/SD card and MMC library must be initialized for file operations. See

. Mmc_Fat_Init.
Requires - =

The file must be previously assigned. See Mmc_Fat_Assign.

dim size as longword

main:
Example -
Mmc Fat Reset (size)

end.
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Mmc_Fat_Read

Prototype sub procedure Mmc Fat Read(dim byref bdata as byte)
Returns Nothing.
Reads a byte from the currently assigned file opened for reading. Upon function
execution file pointers will be set to the next character in the file.
Description |Parameters:
- bdata: buffer to store read byte to. Upon this function execution read byte is
returned through this parameter.
MMC/SD card and MMC library must be initialized for file operations. See
Mmc_Fat_Init.
Requires The file must be previously assigned. See Mmc_Fat_Assign.
The file must be opened for reading. See Mmc_Fat_Reset.
dim character as byte
main:
Example -
Mmc Fat Read (character)
enci.

Mmc_Fat_Rewrite

Prototype sub procedure Mmc Fat Rewrite()

Returns Nothing.

Description Opens the currently assigned file for writing. If the file is not empty its content
will be erased.
MMC/SD card and MMC library must be initialized for file operations. See

. Mmc_Fat_Init.

Requires
The file must be previously assigned. See Mmc_Fat_Assign.

Exanuﬂe ' open file for writing

Mmc Fat Rewrite ()
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Mmc_Fat_Append

Prototype sub procedure Mmc Fat Append ()

Returns Nothing.

Opens the currently assigned file for appending. Upon this function execution
Description [file pointers will be positioned after the last byte in the file, so any subsequent
file write operation will start from there.

MMC/SD card and MMC library must be initialized for file operations. See

; Mmc_Fat_Init.
Requires —
The file must be previously assigned. See Mmc_Fat_Assign.
Example ' open file for appending

Mmc Fat Append()

Mmc_Fat_Delete

Prototype sub procedure Mmc Fat Delete ()

Returns Nothing.

Description [Deletes currently assigned file from MMC/SD card.

MMC/SD card and MMC library must be initialized for file operations. See

. Mmc_Fat_Init.
Requires - =
The file must be previously assigned. See Mmc_Fat_Assign.
' delete current file
Example

Mmc Fat Delete()
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Mmc_Fat_Write

Prokﬂype Zub procedure Mmc Fat Write (dim byref fdata as byte[ 512] , dim
ata len as word)
Returns Nothing.
Writes requested number of bytes to the currently assigned file opened for writing.
e Parameters:
Description
- fdata: data to be written.
- data len: number of bytes to be written.
MMC/SD card and MMC library must be initialized for file operations. See
Mmc_Fat_Init.
Requires The file must be previously assigned. See Mmc_Fat_Assign.
The file must be opened for writing. See Mmc_Fat_Rewrite or
Mmc_Fat_Append.
dim file contents as charf 42]
main:
Exan“ﬂe M&éiFat7Writo(filcicontcnts, 42) ' write data to the assigned
file
end.
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Mmc_Fat_Set_File_Date

sub procedure Mmc Fat Set File Date(dim year as word, dim month,
day, hours, mins, seconds as byte)

Prototype

Returns Nothing.

Sets the date/time stamp. Any subsequent file write operation will write this
stamp to the currently assigned file's time/date attributs.

Parameters:

Description |- year: year attribute. Valid values: 1980-2107
- month: month attribute. Valid values: 1-12

- day: day attribute. Valid values: 1-31

- hours: hours attribute. Valid values: 0-23

- mins: minutes attribute. Valid values: 0-59

- seconds : seconds attribute. Valid values: 0-59

MMC/SD card and MMC library must be initialized for file operations. See
Mmc_Fat_Init.

Requires The file must be previously assigned. See Mmc_Fat_Assign.

The file must be opened for writing. See Mmc_Fat_Rewrite or
Mmc_Fat_Append.

Example Mmc Fat Set File Date(2005,9,30,17,41,0)
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Mmc_Fat_Get_File_Date

Prototype

sub procedure Mmc Fat Get File Date(dim byref year as word, dim
byref month, day, hours, mins as byte)

Returns

Nothing.

Description

Reads time/date attributes of the currently assigned file.

Parameters:

- year: buffer to store year attribute to. Upon function execution year attribute is

returned through this parameter.

- month: buffer to store month attribute to. Upon function execution month
attribute is returned through this parameter.

- day: buffer to store day attribute to. Upon function execution day attribute is
returned through this parameter.

- hours: buffer to store hours attribute to. Upon function execution hours
attribute is returned through this parameter.

- mins: buffer to store minutes attribute to. Upon function execution minutes
attribute is returned through this parameter.

Requires

MMC/SD card and MMC library must be initialized for file operations. See
Mmc_Fat_Init.

The file must be previously assigned. See Mmc_Fat_Assign.

Example

dim year as word
month, day, hours, mins as byte

main:
Mmc Fat Get File Date(year, month, day, hours, mins)

end.
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Mmc_Fat_Get_File_Size

Prototype sub function Mmc Fat Get File Size() as longword

Returns Size of the currently assigned file in bytes.

Description |This function reads size of the currently assigned file in bytes.

MMC/SD card and MMC library must be initialized for file operations. See

. Mmc_Fat_Init.

Requires - -
The file must be previously assigned. See Mmc_Fat_Assign.
dim my file size as longword
main:

Example S

my file size = Mmc Fat Get File Size

end.
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Mmc_Fat_Get _Swap_File

sub function Mmc Fat Get Swap File(dim sectors cnt as longint,
dim byref filename as stringf 11], dim file attr as byte) as dword

Prototype

- Number of the start sector for the newly created swap file, if there was
Returns enough free space on the MMC/SD card to create file of required size.
- 0 - otherwise.

This function is used to create a swap file of predefined name and size on the
MMC/SD media. If a file with specified name already exists on the media,
search for consecutive sectors will ignore sectors occupied by this file. There-
fore, it is recommended to erase such file if it already exists before calling this
function. If it is not erased and there is still enough space for a new swap file,
this function will delete it after allocating new memory space for a new swap file.

The purpose of the swap file is to make reading and writing to MMC/SD media
as fast as possible, by using the Mmc_Read_Sector() and Mmc_Write_Sector()
functions directly, without potentially damaging the FAT system. The swap file
can be considered as a "window" on the media where the user can freely
write/read data. It's main purpose in the mikroBasic PRO for AVR's library is to
be used for fast data acquisition; when the time-critical acquisition has finished,
the data can be re-written into a "normal" file, and formatted in the most suitable
way.

Parameters:

Description

- sectors cnt: number of consecutive sectors that user wants the swap file to
have.

- filename: name of the file that should be assigned for file operations. File
name should be in DOS 8.3 (file_name.extension) format. The file name and
extension will be automatically padded with spaces by the library if they have
less than length required (i.e. "mikro.tx" -> "mikro .tx "), so the user does no
have to take care of that. The file name and extension are case insensitive.
The library will convert them to proper case automatically, so the user does not
have to take care of that.

Also, in order to keep backward compatibility with the first version of this
library, file names can be entered as UPPERCASE string of 11 bytes in length
with no dot character between file name and extension (i.e. "MIKROELETXT" -
> MIKROELE.TXT). In this case last 3 characters of the string are considered
to be file extension.

- file attr: file creation and attributs flags. Each bit corresponds to the
appropriate file attribut:
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Bit | Mask Description
0 0x01 [Read Only
1 0x02 |Hidden
2 0x04 [System
o 3 0x08 [Volume Label

Description 4 0x10 [Subdirectory
5 0x20 [Archive
6 0x40 [Device (internal use only, never found on disk)
7 0x80 [Not used

Note: Long File Names (LFN) are not supported.

MMC/SD card and MMC library must be initialized for file operations. See
Mmc_Fat_Init.

e Try to create a swap file with archive atribute,
whose size will be at least 1000 sectors.

! If it succeeds, it sends No. of start sector
over UART

dim size as longword

Requires

main:

size = Mmc Fat Get Swap File (1000, "mikroE.txt", 0x20)
Example if size then

UART17WritC(OxAA)

UART1 Write (Lo(size))

UART1 Write (Hi(size))

UART1 Write (Higher (size))

UART1 Write (Highest (size))

UART17WritC(OxAA

end if

end.
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Library Example

The following example demonstrates MMC library test. Upon flashing, insert a
MMC/SD card into the module, when you should receive the "Init-OK" message.
Then, you can experiment with MMC read and write functions, and observe the
results through the Usart Terminal.

' 1if defined, we have a debug messages on PC terminal
program MMC Test

{ SDEFINE RS232 debug}

dim MMC chip select as sbit at PORTB.B2

dim MMC chip select direction as sbit at DDRB.B2
' universal variables

dim k, i as word ' universal for loops and other stuff

Variables for MMC routines
dData as byte[ 512] ' Buffer for MMC sector reading/writing
data for registers as byte[ 16] ' buffer for CID and CSD registers
' Display byte in hex
sub procedure printhex(dim i as byte)
dim bHi, bLo as byte
bHi = i and 0xFO ' High nibble
PHi = bHi >> 4
PHi = bHi + "O"
if (bHi>"9") then
bHi = bHi + 7
end if
bLo = (i and 0xQ0F) + "O" ' Low nibble
if (bLo>"9") then
bLo = bLo+7
end if
UART1 Write (bHi)
UART1 Write (bLo)

end sub
main:
DDRC = 255
PORTC = 0

{ SIFDEF RS232 debug}
UART1 Tnit (19200)
{ SENDIF}

Delay ms (10)
DDRA = 255
PORTA = 1
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{ SIFDEF RS232 debug}
UART1 Write Text ("AVR-Started") ' If AVR present report
UART1 Write (13)
UART1 Write (10)
{ SENDIF)

' Beffore all, we must initialise a MMC card

SPI1 Init Advanced( SPI MASTER, SPI FCY DIV2, SPI CLK LO LEAD-
ING)

Spi_Rd_Ptr = @SPI1_Read

i = Mmc_ Init()
PORTC = 1
{ SIFDEF RS232 debug}
if (i 0) then
UART1 Write Text ("MMC Init-OK") ' If MMC present report
UART1 Write(13)
UART1 Write(10)
end if
if (i) then
UART1 Write Text ("MMC Init-error") ' If error report
UART1 Write(13)
UART1 Write(10)
end if
{ SENDIF)

for i=0 to 511

dDatal i] = "E" ' Fill MMC buffer with same characters
next i
1 = Mmc Write Sector (55, dData)

{ SIFDEF RS232 debug}
if(i = 0) then
UART1 Write Text ("Write-OK")

else ' 1if there are errors.....
UART1 Write Text ("Write-Error")
end if

UART1 Write (13)
UART1 Write (10)
{ SENDIF}

' Reading of CID and CSD register on MMC card.....
{ SIFDEF RS232 debug}
i = Mmc Read Cid(data for registers)
if (i = 0) then
for k=0 to 15
printhex(data for registers[ k] )
if (k <> 15) then
UART1 Write ("-")
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end if
next k
UART1 Write (13)
else
UART1 Write Text ("CID-error")
end if
i = Mmc Read Csd(data for registers)

if(i = 0) then
for k=0 to 15
printhex (data for registers| k])
if(k <> 15) then
UART1 Write("-")
end if
next K
UART1 Write (13)
UART1 Write (10)
else
UART1 Write Text ("CSD-error")
end if
{ SENDIF}
end.

Following example consists of several blocks that demonstrate various aspects of
usage of the Mmc_Fat16 library. These are:

- Creation of new file and writing down to it.

- Opening existing file and re-writing it (writing from start-of-file).

- Opening existing file and appending data to it (writing from end-of-file).
- Opening a file and reading data from it (sending it to USART terminal).
- Creating and modifying several files at once.

Program MMC FAT Test
dim
Mmc Chip Select as sbit at PORTG.B1
Mmc Chip Select Direction as sbit at DDRG.B1
dim
FAT TXT as stringf 20]
file contents as string{ 50]
filename as string{ 14] ' File names
character as byte
loop , loop2 as byte

size as longint

buffer as byte[ 512]
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P Writes string to USART
sub procedure Write Str(dim byref ostr as byte[ 2])
dim
i as byte
i=20
while ostr[ i] <> 0
UART1 Write (ostr[ i])
Inc (i)
wend
UART1 Write ($0A)
end sub'~

—————————————— Creates new file and writes some data to it
sub procedure Create New File

filename[ 7] = "A" ' Set filename for single-file
tests

Mmc Fat Assign(filename, O0xAO0) ' Will not find file and then cre-
ate file

Mmc Fat Rewrite ' To clear file and start with
new data

for loop =1 to 99 ' We want 5 files on the MMC
card

UART1 Write(".")
file contents[ 0] loop div 10 + 48
file contents[ 1] loop mod 10 + 48
Mmc Fat Write(file contents, 42) ' write data to the assigned
file
next loop
end sub'~

—————————————— Creates many new files and writes data to them
sub procedure Create Multiple Files

for loop2 = "B" to "Z"

UART1 Write (loop2) ' this line can slow down
the performance

filename[ 7] = loop2 ' set filename

Mmc Fat Assign(filename, O0xAO0) ' find existing file or cre-
ate a new one

Mmc Fat Rewrite ' To clear file and start
with new data

for loop = 1 to 44

file contents[ 0] byte(loop div 10 + 48)
file contents[ 1] byte (loop mod 10 + 48)
Mmc Fat Write(file contents, 42) ' write data to the assigned

file
next loop
next loop2
end sub'~
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P Opens an existing file and rewrites it

sub procedure Open File Rewrite
filename[ 7] = "C" ' Set filename for single-file tests
Mmc Fat Assign(filename, 0)
Mmc Fat Rewrite

for loop =1 to 55
file contents[ 0] = byte(loop div 10 + 48)
file contents[ 1] = byte(loop mod 10 + 48)
Mmc Fat Write(file contents, 42) ' write data to the assigned
file
next loop
end sub'~

fmmmm e Opens an existing file and appends data to it
! (and alters the date/time stamp)
sub procedure Open File Append

filename[ 7] = "B"

Mmc Fat Assign(filename, 0)

Mmc Fat Set File Date(2005,6,21,10,35,0)

Mmc Fat Append () ' Prepare file for append

file contents = " for mikroElektronika 2007" ' Prepare file
for append

file contents[ 26] = 10 ' LF

Mmc Fat Write(file contents, 27) ' Write data to assigned file
end sub'~

fmmmm e Opens an existing file, reads data from it and puts
it to USART
sub procedure Open File Read

filename[ 7] = "B"
Mmc Fat Assign(filename, 0)
Mmc Fat Reset (size) ' To read file, sub proce-

dure returns size of file
while size > 0
Mmc Fat Read (character)
UART1 Write (character) ' Write data to USART
Dec (size)
wend
end sub'~

P Deletes a file. If file doesn"t exist, it will first
be created
' and then deleted.
sub procedure Delete File
filename[ 7] = "F"
Mmc Fat Assign(filename, 0)
Mmc Fat Delete
end sub'~
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ation date
! and file size wvia USART
sub procedure Test File Exist
dim
fsize as longint
year as word
month , day, hour , minute as byte
outstr as bytel 12]

filename[ 7] = "B"

if Mmc Fat Assign(filename, 0) <> 0 then
'-—— file has been found - get its date
Mmc Fat Get File Date(year,month ,day,hour ,minute )
WordToStr (year, outstr)

Write Str(outstr)
ByteToStr (month , outstr)
Write Str(outstr)
WordToStr (day, outstr)
Write Str(outstr)
WordToStr (hour , outstr)
Write Str(outstr)
WordToStr (minute , outstr)

Write Str(outstr)
'--- get file size
fsize = Mmc Fat Get File Size
LongIntToStr (fsize, outstr)
Write Str(outstr)

else
'-—— file was not found - signal it
UART1 Write (0x55)
Delay ms (1000)
UART1 Write (0x55)

end if

end sub'~

least 100
' sectors (see Help for details)
sub procedure M Create Swap File()

dim i as word

for i=0 to 511
Buffer[ i] = 1
next i

size = Mmc_Fat Get Swap File (5000, "mikroE.txt", 0x20)
on this sub function for details

—————————————— Tests whether file exists, and if so sends its cre-

—————————————— Tries to create a swap file, whose size will be at

see help
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if (size <> 0) then
LongIntToStr (size, fat txt)
UARTI_Write_Text(fat_txt)

for i=0 to 4999
Mmc Write Sector(size, Buffer)

size = size + 1
UART1 Write(".")
next i
end if

end sub

P Main. Uncomment the sub function(s) to test the
desired operation (s)

main:
FAT TXT = "FAT16 not found"
file contents = "XX MMC/SD FAT16 library by Anton Rieckert#"
file contents[ 41] = 10 ' newline
filename = "MIKROOOxXTXT"

' we will use PORTC to signal test end

DDRC = OxFF

PORTC = 0

UART1 Init(19200)

'delay ms (100) ' Set up USART for file reading

UART1 Write Text ("Start")
'--— Init the FAT library
SPI1 Init Advanced( SPI MASTER, SPI FCY DIV128, SPI CLK LO_ LEADING)
Spi Rd Ptr = @SPI1 Read
' use fatl6 quick format instead of init routine if a formatting
is needed
if Mmc Fat Init() = 0 then
PORTC = 0xFO
' reinitialize spi at higher speed
SPI1 Init Advanced( SPI MASTER, SPI FCY DIV2, SPI CLK IO LEADING)
'-—- signal start-of-test
'--- test sub functions
Create New File
Create Multiple Files

Open File Rewrite
Open File Append
Open File Read
Delete File
Test File Exist
M Create Swap File()
UART1 Write("e")
else
UART17WriteiText(FATiTXT)
end if
'-—- signal end-of-test
PORTC = SOF
UART1 Write Text ("End")
end. '~!
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HW Connection

SPI-MIS0
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Pin diagram of MMC memory card
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ONEWIRE LIBRARY

The OneWire library provides routines for communication via the Dallas OneWire
protocol, e.g. with DS18x20 digital thermometer. OneWire is a Master/Slave proto-
col, and all communication cabling required is a single wire. OneWire enabled
devices should have open collector drivers (with single pull-up resistor) on the
shared data line.

Slave devices on the OneWire bus can even get their power supply from data line.
For detailed schematic see device datasheet.

Some basic characteristics of this protocol are:

- single master system,

- low cost,

- low transfer rates (up to 16 kbps),

- fairly long distances (up to 300 meters),
- small data transfer packages.

Each OneWire device has also a unique 64-bit registration number (8-bit device
type, 48-bit serial number and 8-bit CRC), so multiple slaves can co-exist on the
same bus.

Note: Oscillator frequency Fosc needs to be at least 8MHz in order to use the rou-
tines with Dallas digital thermometers.

External dependencies of OneWire Library

This variable must be

defined in any project

that is using OneWire
Library:

Description: Example :

dim OW Bit Read as dim OW Bit Read as

OneWire read line.

sbit sfr external

sbit at PINB.B2

dim OW Bit Write as
sbit sfr external

OneWire write line.

dim OW Bit Write as
sbit at PORTB.B2

dim OW Bit Direction
as sbit sfr external

Direction of the OneWire pin.

dim OW Bit Direction
as sbit at DDRB.B2

Library Routines

- Ow_Reset
- Ow_Read
- Ow_Write
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Ow_Reset

Prototype sub function Ow Reset() as word

- 0 if the device is present

Returns - 1 if the device is not present

Issues OneWire reset signal for DS18x20.
Description |Parameters :

- None.

Devices compliant with the Dallas OneWire protocol.
Global variables :

Requires - 0w Bit Read: OneWire read line

-owW Bit wWrite: OneWire write line.

-0wW Bit Direction: Direction of the OneWire pin

must be defined before using this function.

' OneWire pinout

dim OW Bit Read as sbit at PINB.B2

dim OW Bit Write as sbit at PORTB.B2

E I dim OW Bit Direction as sbit at DDRB.B2
xample ' end of OneWire pinout

' Issue Reset signal on One-Wire Bus
Ow Reset ()
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Ow_Read

Prototype

sub function Ow Read() as byte

Returns

Data read from an external device over the OneWire bus.

Description

Reads one byte of data via the OneWire bus.

Requires

Devices compliant with the Dallas OneWire protocol.
Global variables :

-0W Bit Read: OneWire read line

-ow Bit Write: OneWire write line.

-owW Bit Direction: Direction of the OneWire pin

must be defined before using this function.

Example

// OneWire pinout

dim OW Bit Read as sbit at PINB.B2

dim OW Bit Write as sbit at PORTB.B2
dim OW Bit Direction as sbit at DDRRB.B2
// end of OneWire pinout

' Read a byte from the One-Wire Bus
dim read data as byte

read data = Ow Read()
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Ow_Write

Prototype sub procedure Ow Write(dim par as byte)

Returns Nothing.

Writes one byte of data via the OneWire bus.
Description |Parameters :

- par: data to be written

Devices compliant with the Dallas OneWire protocol.
Global variables :

Requires -ow Bit Read: OneWire read line

-ow Bit wWrite: OneWire write line.

-owW Bit Direction: Direction of the OneWire pin

must be defined before using this function.

// OneWire pinout

dim OW Bit Read as sbit at PINB.B2

dim OW Bit Write as sbit at PORTB.B2

E I dim OW Bit Direction as sbit at DDRB.BZ
xample // end of OneWire pinout

' Send a byte to the One-Wire Bus

Ow Write (0xCC)
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Library Example

This example reads the temperature using DS18x20 connected to pin PORTB.2.
After reset, MCU obtains temperature from the sensor and prints it on the Lcd. Make
sure to pull-up PORTB.2 line and to turn off the PORTB leds.

program OneWire

' Lcd module connections

dim LCD RS as sbit at PORTD.B2
LCD EN as sbit at PORTD.B3
LCD D4 as sbit at PORTD.B4
LCD D5 as sbit at PORTD.BS5S
LCD D6 as sbit at PORTD.B6
LCD D7 as sbit at PORTD.B7
LCD RS Direction as sbit at DDRD.B2
LCD _EN Direction as sbit at DDRD.B3
LCD D4 Direction as sbit at DDRD.B4
LCD D5 Direction as sbit at DDRD.B5
LCD D6 Direction as sbit at DDRD.B6
LCD D7 Direction as sbit at DDRD.B7

' End Lcd module connections

]

OneWire pinout
dim OW Bit Write as sbit at PORTB.B2
OW Bit Read as sbit at PINB.B2
OW Bit Direction as sbit at DDRB.B2
' end OneWire definition
! Set TEMP RESOLUTION to the corresponding resolution of used
DS18x20 sensor:
' 18520: 9 (default setting can be 9,10,11,o0r 12)
' 18B20: 12
const TEMP RESOLUTION as byte = 12

dim text as byte[ 9]
temp as word

sub procedure Display Temperature( dim tempZ2write as word )
const RES SHIFT = TEMP RESOLUTION - 8

dim temp whole as byte
temp fraction as word

text = "000.0000"
' check if temperature is negative
if (temp2write and 0x8000) then
text[ 0] = "-"
temp2write = not templ2write + 1
end if
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' extract temp whole
temp whole = word(tempZwrite >> RES SHIFT)
' convert temp whole to characters
if ( temp whole div 100 ) then
text[ 0] = temp whole div 100 + 48
else
text[ 0] = "O"
end if
text[ 1] = (temp whole div 10)mod 10 + 48 ' Extract tens digit
text[ 2] = temp whole mod 10 + 48 ' Extract ones digit

' extract temp fraction and convert it to unsigned int

temp fraction = word(temp2Z2write << (4-RES SHIFT))
temp fraction = temp fraction and 0xO000F
temp fraction = temp fraction * 625

' convert temp fraction to characters

text[ 4] = word(temp fraction div 1000) + 48 ' Extract
thousands digit

text[ 5] = word((temp fraction div 100)mod 10 + 48) '
Extract hundreds digit

text[ 6] = word((temp fraction div 10)mod 10 + 48) '
Extract tens digit

text[ 7] = word(temp fraction mod 10) + 48 ' Extract

ones digit

' print temperature on Lcd
Lcd Out (2, 5, text)

end sub
main:
text = "000.0000"
UART1 Init (9600)
Led Init () ' Initialize Lcd
Lcd Cmd (LCD _CLEAR) ' Clear Lcd
Lcd Cmd (LCD_CURSOR_OFF) ' Turn cursor off

Lcd Out(l, 1, " Temperature: ")
' Print degree character, "C" for Centigrades
Led Chr(2,13,178) ' different Lcd displays have different char
code for degree
' if you see greek alpha letter try typing
178 instead of 223
Led Chr(2,14,"C")

'-—-- main loop
while TRUE
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'-—-- perform temperature reading

Ow_Reset () !
Ow Write (0xCC)
Ow Write (0x44) !
Delay us (120)

Ow_Reset ()
Ow Write (0xCC) !
Ow Write (OxBE) !

temp Ow_Read()

Onewire reset
Issue command
Issue command

Issue command
Issue command

temp = (Ow_Read() << 8) + temp

Display Temperature (temp)

Delay ms (520)
wend
end.

signal
SKIP ROM
CONVERT T

SKIP ROM
READ_ SCRATCHPAD

--- Format and display result on Lcd
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HW Connection
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Example of DS1820 connection
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PORT EXPANDER LIBRARY

The mikroBasic PRO for AVR provides a library for communication with the
Microchip’s Port Expander MCP23S17 via SPI interface. Connections of the AVR
compliant MCU and MCP23S17 is given on the schematic at the bottom of this
page.

Note: Library uses the SPI module for communication. The user must initialize SPI
module before using the Port Expander Library.

Note: Prior to calling any of this library routines, Spi_Rd_Ptr needs to be initialized
with the appropriate SPI_Read routine.

Note: Library does not use Port Expander interrupts.

External dependencies of Port Expander Library

The following variables
must be defined in all

sbit sfr external

. . Description: Example :
projects using Port P P
Expander Library:

dim SPExpanderRST as . dim SPExpanderRST as
Reset line.

sbit at PORTB.BRO

dim SPExpanderRST as
sbit at PORTB.RO

Chip Select line.

dim SPExpanderCS as
sbit at PORTB.BI

dim

SPExpanderRST Directi
on as sbit sfr
external

Direction of the Reset pin.

dim
SPExpanderRST Directi
on as sbit at DDRB.BO

dim
SPExpanderCS Direction
as sbit sfr external

Direction of the Chip
Select pin.

dim
SPExpanderCS Directio
ns as sbit at DDRB.B1

Library Routines

- Expander_Init

- Expander_Read_Byte
- Expander_Write_Byte

- Expander_Read_PortA
- Expander_Read_PortB
- Expander_Read_PortAB
- Expander_Write_PortA
- Expander_Write_PortB
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- Expander_Write_PortAB

- Expander_Set_DirectionPortA
- Expander_Set_DirectionPortB
- Expander_Set_DirectionPortAB
- Expander_Set PullUpsPortA

- Expander_Set PullUpsPortB

- Expander_Set PullUpsPortAB

Expander_lInit

Prototype sub procedure Expander Init (dim ModuleAddress as byte)

Returns Nothing.

Initializes Port Expander using SPI communication.
Port Expander module settings :

- hardware addressing enabled

- automatic address pointer incrementing disabled (byte mode)
Description |- BANK_O register adressing

- slew rate enabled

Parameters :

- ModuleAddress: Port Expander hardware address, see schematic at the bot-
tom of this page

Global variables :

- sPExpandercs: Chip Select line

- SPExpanderRST: Reset line

Requires - SPExpanderCs Direction: Direction of the Chip Select pin
- SPExpanderRST Direction: Direction of the Reset pin

must be defined before using this function.

SPI module needs to be initialized. See SPI1_Init and SPI1_Init Advanced routines.

' port expander pinout definition

dim SPExpanderCS as sbit at PORTB.B1
SPExpanderRST as sbit at PORTB.BO
SPExpanderCS Direction as sbit at DDRB.B1
SPExpanderRST Direction as sbit at DDRB.BO

Example
SPI1 Init() ' initialize SPI module
Spi Rd Ptr = @SPI1 Read ' Pass pointer to SPI Read function
of used SPI module
Expander Init (0) ' initialize port expander
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Expander_Read_Byte

sub function Expander Read Byte (dim ModuleAddress as byte, dim

Prototype RegAddress as byte) as byte

Returns Byte read.
The function reads byte from Port Expander.
Parameters :

Description

- Moduleaddress: Port Expander hardware address, see schematic at the
bottom of this page
- Reghddress: Port Expander's internal register address

Requires Port Expander must be initialized. See Expander_Init.

' Read a byte from Port Expander's register

dim read data as byte
Example

read data = Expander Read Byte (0,1)

Expander_Write_Byte

sub procedure Expander Write Byte (dim ModuleAddress as byte, dim

PrOtOtype RegAddress as byte, dim Data as byte)
Returns Nothing.
Routine writes a byte to Port Expander.
Parameters :
Description

- ModuleAddress: Port Expander hardware address, see schematic at the
bottom of this page

- Reghddress: Port Expander's internal register address

- bata : data to be written

Requires Port Expander must be initialized. See Expander_Init.

' Write a byte to the Port Expander's register

Example Expander Write Byte(0,1,0xFF)
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Expander_Read_PortA

Prototype sub function Expander Read PortA(dim ModuleAddress as byte) as byte

Returns Byte read.

The function reads byte from Port Expander's PortA.

. Parameters :
Description

- Moduleaddress: Port Expander hardware address, see schematic at the
bottom of this page

Port Expander must be initialized. See Expander_Init.

Requires ' . .
q Port Expander's PortA should be configured as input. See Expander_Set_Direc-
tionPortA and Expander_Set_DirectionPortAB routines.
' Read a byte from Port Expander's PORTA
dim read data as byte
Example Expander Set DirectionPortA (0, 0xFF) ' set expander's porta

to be input

read data = Expander Read PortA (0)

Expander_Read_PortB

Prototype sub function Expander Read PortB(dim ModuleAddress as byte) as byte

Returns Byte read.

The function reads byte from Port Expander's PortB.

e Parameters :

Description

- Moduleaddress: Port Expander hardware address, see schematic at the
bottom of this page

Port Expander must be initialized. See Expander_Init.

Requires Port Expander's PortB should be configured as input. See Expander_Set_Direc-
tionPortB and Expander_Set_DirectionPortAB routines.

' Read a byte from Port Expander's PORTB
dim read data as byte

Exanuﬂe Expander Set DirectionPortB (0, 0xFF) ' set expander's portb
to be input

read data = Expander Read PortB(0)
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Expander_Read PortAB

Prototype sub function Expander Read PortAB(dim ModuleAddress as byte) as word

Returns Word read.

The function reads word from Port Expander's ports. PortA readings are in the
higher byte of the result. PortB readings are in the lower byte of the result.

Description |Parameters :

- ModuleAddress: Port Expander hardware address, see schematic at the
bottom of this page
Port Expander must be initialized. See Expander_|nit.

Requires Port Expander's PortA and PortB should be configured as inputs. See
Expander_Set_DirectionPortA, Expander_Set_DirectionPortB and
Expander_Set_DirectionPortAB routines.

' Read a byte from Port Expander's PORTA and PORTB
dim read data as word

Exan“ﬂe Expander Set DirectionPortAB (0, OxFFFF) ' set expander's
porta and portb to be input
read data = Expander Read PortAB(0)
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Expander_Write_PortA

sub procedure Expander Write PortA (dim ModuleAddress as byte, dim
Prototype - -
Data as byte)
Returns Nothing.
The function writes byte to Port Expander's PortA.
Parameters :
Description
- ModuleAddress: Port Expander hardware address, see schematic at the
bottom of this page
- Data : data to be written
Port Expander must be initialized. See Expander_lnit.
Requires ' :
q Port Expander's PortA should be configured as output. See
Expander_Set_DirectionPortA and Expander_Set_DirectionPortAB routines.
' Write a byte to Port Expander's PORTA
Example Expander Set DirectionPortA(0,0x00) ' set expander's porta
to be output
Expander Write PortA (0, OxAA)
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Expander_Write_PortB

sub procedure Expander Write PortB(dim ModuleAddress as byte, dim
Prototype 5 - -
ata as byte)
Returns Nothing.
The function writes byte to Port Expander's PortB.
Parameters :
Description
- Moduleaddress: Port Expander hardware address, see schematic at the
bottom of this page
- Data : data to be written
Port Expander must be initialized. See Expander_Init.
Requires Port Expander's PortB should be configured as output. See
Expander_Set_DirectionPortB and Expander_Set DirectionPortAB routines.
' Write a byte to Port Expander's PORTB
Example Expander Set DirectionPortB(0,0x00) ' set expander's portb
to be output
Expander Write PortB (0, 0x55)
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Expander_Write_PortAB

sub procedure Expander Write PortAB(dim ModuleAddress as byte,

Prototype dim Data as word)

Returns Nothing.
The function writes word to Port Expander's ports.
Parameters :

Description

- ModuleAddress: Port Expander hardware address, see schematic at the
bottom of this page

- Data : data to be written. Data to be written to PortA are passed in pata's
higher byte. Data to be written to PortB are passed in pata's lower byte

Port Expander must be initialized. See Expander_Init.

Requires Port Expander's PortA and PortB should be configured as outputs. See
Expander_Set_DirectionPortA, Expander_Set_DirectionPortB and
Expander_Set_DirectionPortAB routines.

' Write a byte to Port Expander's PORTA and PORTB

Example Expander Set DirectionPortAB(0,0x0000) ' set expander's
porta and portb to be output

Expander Write PortAB(0, 0xAA55)
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Expander_Set_DirectionPortA

Prototype

sub procedure Expander Set DirectionPortA(dim ModuleAddress as
byte, dim Data as byte)

Returns

Nothing.

Description

The function sets Port Expander's PortA direction.
Parameters :

- ModuleAddress: Port Expander hardware address, see schematic at the
bottom of this page

- bata : data to be written to the PortA direction register. Each bit corresponds
to the appropriate pin of the PortA register. Set bit designates corresponding
pin as input. Cleared bit designates corresponding pin as output.

Requires

Port Expander must be initialized. See Expander_Init.

Example

' Set Port Expander's PORTA to be output
Expander Set DirectionPortA(0,0x00)

Expander_Set_DirectionPortB

sub procedure Expander Set DirectionPortB(dim ModuleAddress as

Prototype byte, dim Data as byte)
Returns Nothing.
The function sets Port Expander's PortB direction.
Parameters :
Description |- Modulenddress: Port Expander hardware address, see schematic at the
bottom of this page
- bata : data to be written to the PortB direction register. Each bit corresponds
to the appropriate pin of the PortB register. Set bit designates corresponding
pin as input. Cleared bit designates corresponding pin as output.
Requires Port Expander must be initialized. See Expander_lnit.
' Set Port Expander's PORTB to be input
Example

ExpanderisetiDirectionPortB(0,0xFF)
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Expander_Set DirectionPortAB

sub procedure Expander Set DirectionPortAB(dim ModuleAddress as

PrOtOtype byte, dim Direction as word)
Returns Nothing.
The function sets Port Expander's PortA and PortB direction.
Parameters :
- ModuleAddress: Port Expander hardware address, see schematic at the
.. bottom of this page
Description

- Direction: data to be written to direction registers. Data to be written to the
PortA direction register are passed in Direction's higher byte. Data to be
written to the PortB direction register are passed in Direction's lower byte.
Each bit corresponds to the appropriate pin of the PortA/PortB register. Set bit
designates corresponding pin as input. Cleared bit designates corresponding
pin as output.

Requires Port Expander must be initialized. See Expander_lnit.

' Set Port Expander's PORTA to be output and PORTB to be input

Example Expander Set DirectionPortAB (0, 0x00FF)

Expander_Set PullUpsPortA

sub procedure Expander Set PullUpsPortA(dim ModuleAddress as

Prototype byte, dim Data as byte)

Returns Nothing.

The function sets Port Expander's PortA pull up/down resistors.
Parameters :

Description |- Moduleaddress: Port Expander hardware address, see schematic at the
bottom of this page

- Data : data for choosing pull up/down resistors configuration. Each bit
corresponds to the appropriate pin of the PortA register. Set bit enables pull-up
for corresponding pin.

Requires Port Expander must be initialized. See Expander_lnit.

' Set Port Expander's PORTA pull-up resistors

Example Expander Set PullUpsPortA (0, OxFF)
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Expander_Set PullUpsPortB

Protot sub procedure Expander Set PullUpsPortB(dim ModuleAddress as
rototype byte, dim Data as byte)
Returns Nothing.
The function sets Port Expander's PortB pull up/down resistors.
Parameters :
Description |- Moduleaddress: Port Expander hardware address, see schematic at the
bottom of this page
- bata : data for choosing pull up/down resistors configuration. Each bit
corresponds to the appropriate pin of the PortB register. Set bit enables
pull-up for corresponding pin.
Requires Port Expander must be initialized. See Expander_Init.
E I ' Set Port Expander's PORTB pull-up resistors
xample Expander Set PullUpsPortB (0, OxFF)

Expander_Set PullUpsPortAB

sub procedure Expander Set PullUpsPortAB(dim ModuleAddress as

PrOtOtype byte, dim PullUps as word)
Returns Nothing.
The function sets Port Expander's PortA and PortB pull up/down resistors.
Parameters :
- ModuleAddress: Port Expander hardware address, see schematic at the bot-
Description [tom of this page
- pullups: data for choosing pull up/down resistors configuration. PortA pull
up/down resistors configuration is passed in Pullups's higher byte. PortB pull
up/down resistors configuration is passed in rul1Ups's lower byte. Each bit
corresponds to the appropriate pin of the PortA/PortB register. Set bit enables
pull-up for corresponding pin.
Requires Port Expander must be initialized. See Expander_Init.
' Set Port Expander's PORTA and PORTB pull-up resistors
Example

Expander Set PullUpsPortAB (0, OxFFFF)

MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD

299



CHAPTER 6
Libraries

mikroBasic PRO for AVR

Library Example
The example demonstrates how to communicate with Port Expander MCP23S17.

Note that Port Expander pins A2 A1 A0 are connected to GND so Port Expander
Hardware Address is O.

program PortExpander

' Port Expander module connections

dim SPExpanderRST as sbit at PORTB.BRO
SPExpanderCS as sbit at PORTB.B1
SPExpanderRST Direction as sbit at DDRB.BO
SPExpanderCS Direction as sbit at DDRB.B1

' End Port Expander module connections

dim counter as byte' = 0
main:
counter = 0
DDRC = OxFF ' Set PORTC as output
' If Port Expander Library uses SPI1 module
SPI1 Init() ' Initialize SPI module used with PortExpander
Spi Rd Ptr = @SPI1 Read ' Pass pointer to SPI Read

sub function of used SPI module

v

If Port Expander Library uses SPI2 module

' SPI2 Init() ' Initialize SPI module used with PortExpander

! Spi Rd Ptr = @SPI2 Read ' Pass pointer to SPI Read
sub function of used SPI module

Expander Init (0) ' Initialize Port Expander

Expander Set DirectionPortA (0, 0x00) ' Set Expander"s PORTA to be
output

Expander Set DirectionPortB (0, 0xFF) ' Set Expander"s PORTB to be
input

Expander Set PullUpsPortB (0, 0xFF) ' Set pull-ups to all of the

Expander"s PORTB pins

while TRUE ' Endless loop
Expander Write PortA (0, counter) ' Write 1 to expander"s PORTA
Inc (counter)
PORTC = Expander_Read_PortB(O) ' Read expander"s PORTB and

write it to LEDs
Delay ms (100)
wend

end.
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HW Connection
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PS/2 LIBRARY

The mikroBasic PRO for AVR provides a library for communication with the common

PS/2 keyboard.

Note: The library does not utilize interrupts for data retrieval, and requires the oscil-
lator clock to be at least 6MHz.

Note: The pins to which a PS/2 keyboard is attached should be connected to the

pull-up resistors.

Note: Although PS/2 is a two-way communication bus, this library does not provide
MCU-to-keyboard communication; e.g. pressing the Caps Lock key will not turn on

the Caps Lock LED.

External dependencies

of PS/2 Library

The following variables
must be defined in all
projects using PS/2
Library:

Description:

Example :

dim PS2 Data as sbit
sfr external

PS/2 Data line.

dim PS2 Data as sbit
at PINC.BO

dim PS2 In Clock as
sbit sfr external

PS/2 Clock line in.

dim PS2 In Clock as
sbit at PINC.B1

dim PS2 Out Clock as
sbit sfr external

PS/2 Clock line out.

dim PS2 Out Clock as
sbit at PORTC.BO

dim
PS2 Data Direction as
sbit sfr external

Direction of the PS/2 Data
pin.

dim
PS2 Data Direction as
sbit at DDRC.RBO

dim
PS2 Clock Direction

as sbit sfr external

Direction of the PS/2
Clock pin.

dim
PS2 Clock Direction
as sbit at DDRC.B1

Library Routines

- Ps2_Config
- Ps2_Key_Read
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Ps2_Config

Prototype

sub procedure Ps2 Config()

Returns

Nothing.

Description

Initializes the MCU for work with the PS/2 keyboard.

Requires

Global variables :

pata: Data signal line

In Clock: Clock signal line in

out Clock: Clock signal line out

Data Direction: Direction of the Data pin
Clock Direction: Direction of the Clock pin

must be defined before using this function.

Example

// PS2 pinout definition

dim
dim
dim
dim
dim

// E

PS2 Data as sbit at PINC.BO
PS2 In Clock as sbit at PINC.BI

PS2 Out Clock as sbit at PORTC.BI

PS2 Data Direction as sbit at DDRC.BO
PS2 Clock Direction as sbit at DDRC.B1
nd of PS2 pinout definition

Ps2 Config() ' Init PS/2 Keyboard
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Ps2_Key_Read

sub function Ps2 Key Read(dim byref value as byte, dim byref spe-

Prokﬂype cial as byte, dim byref pressed as byte) as byte

- 1 if reading of a key from the keyboard was successful

Returns - 0 if no key was pressed

The function retrieves information on key pressed.
Parameters :

- value: holds the value of the key pressed. For characters, numerals, punctu-
Description |ation marks, and space value will store the appropriate ASCIl code. Routine
“recognizes” the function of Shift and Caps Lock, and behaves appropriately.
For special function keys see Special Function Keys Table.

- special: is a flag for special function keys (F1, Enter, Esc, etc). If key
pressed is one of these, special will be set to 1, otherwise 0.

- pressed: is set to 1 if the key is pressed, and 0 if it is released.

Requires PS/2 keyboard needs to be initialized. See Ps2_Config routine.

dim value, special, pressed as byte

do {

if (Ps2 Key Read(value, special, pressed)) then
Example if ((value = 13) and (special = 1)) then
break
end if
end if

loop until (0=1)
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Special Function Keys

Adapter Board|T6369C datasheet Scroll Lock 28

F1 1 Num Lock 29

F2 2 Left Arrow 30

F3 3 Right Arrow 31

F4 4 Up Arrow 32

F5 5 Down Arrow 33

F6 6 Escape 34

F7 7 Tab 35
F8 8
F9 9
F10 10
F11 1
F12 12
Enter 13
Page Up 14
Page Down 15
Backspace 16
Insert 17
Delete 18
Windows 19
Ctrl 20
Shift 21
Alt 22
Print Screen 23
Pause 24
Caps Lock 25
End 26
Home 27
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Library Example

This simple example reads values of the pressed keys on the PS/2 keyboard and
sends them via UART.

program PS2 Example

dim keydata, special, down as byte

dim PS2 Data as sbit at PINC.BO
PS2 Clock Input as sbit at PINC.B1

PS2 Clock Output as sbit at PORTC.B1

PS2 Data Direction as sbit at DDRC.BO
PS2 Clock Direction as sbit at DDRC.B1

main:
UART1 Init(19200) ' Initialize UART module at 19200 bps
Ps2 Config() ' Init PS/2 Keyboard
Delay ms (100) ' Wait for keyboard to finish
UART1 Write ("R") ' Ready

while TRUE '
Endless loop

if (Ps2 Key Read(keydata, special, down) <> 0) then ' If
data was read from PS/2
if (((down <> 0) and (keydata = 16)) <> 0) then '

Backspace read
UART1 Write (0x08) '
Send Backspace to USART terminal
else if (((down <> 0) and (keydata = 13)) <> 0) then !
Enter read
UART1 Write (10) !
Send carriage return to usart terminal
UART1 Write(13) !
Uncomment this line if usart terminal also expects line feed
! for new line transition
else if (((down <> 0) and (special = 0) and (keydata <>
0)) <> 0) then ' Common key read
UART1 Write (keydata) '
Send key to usart terminal
end if
end if
end if
end if
Delay ms (10) ' Debounce period
wend
end.
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PWM LIBRARY

CMO module is available with a number of AVR MCUs. mikroBasic PRO for AVR provides
library which simplifies using PWM HW Module.

Note: For better understanding of PWM module it would be best to start with the example provided
in Examples folder of our mikroBasic PRO for AVR compiler. When you select a MCU, mikroBasic
PRO for AVR automaticaly loads the correct PWM library (or libraries), which can be verified by look-
ing at the Library Manager. PWM library handles and initializes the PWM module on the given AVR
MCU, but it is up to user to set the correct pins as PWM output, this topic will be covered later in this
section. mikroBasic PRO for AVR does not support enhanced PWM modules.

Library Routines

- PWM_Init

- PWM_Set Duty
- PWM_Start

- PWM_Stop

- PWM1_Init

- PWM1_Set Duty
- PWM1_Start

- PWM1_Stop

Predefined constants used in PWM library

The following variables are
used in PWM library functions:

_PWM PHASE CORRECT MODE Selects Phase Correct PWM mode on first PWM library.

Selects Phase Correct PWM mode on second PWM
library (if it exists in Library Manager.

Description:

_PWM1 PHASE CORRECT MODE

_PWM_FAST MODE Selects Fast PWM mode on first PWM library.

Selects Fast PWM mode on second PWM library (if it
exists in Library Manager.

PWM1 FAST MODE

_PWM_PRESCALER 1 Sets prescaler value to 1 (No prescaling).

_PWM PRESCALER 8 Sets prescaler value to 8.

Sets prescaler value to 32 (this value is not available on
_PWM_PRESCALER 32 every MCU. Please use Code Assistant to see if this
value is available for the given MCU.

_PWM PRESCALER 64 Sets prescaler value to 64.

Sets prescaler value to 128 (this value is not available
_PWM_PRESCALER 128 on every MCU. Please use Code Assistant to see if this
value is available for the given MCU.
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_PWM_PRESCALER 256 Sets prescaler value to 256.
_PWM_PRESCALER 1024 Sets prescaler value to 1024.

Sets prescaler value to 1 on second PWM library (if it
exists in Library Manager).

Sets prescaler value to 8 on second PWM library (if it
exists in Library Manager).

Sets prescaler value to 32 on second PWM library (if it
exists in Library Manager). This value is not available
on every MCU. Please use Code Assistant to see if this
value is available for the given MCU.

Sets prescaler value to 64 on second PWM library (if it
exists in Library Manager).

_PWM1 PRESCALER 1

_PWM1 PRESCALER 8

_PWM1 PRESCALER 32

_PWM1_PRESCALER 64

Sets prescaler value to 128 on second PWM library (if it
exists in Library Manager). This value is not available
on every MCU. Please use Code Assistant to see if this
value is available for the given MCU.

_PWM1 PRESCALER 128

Sets prescaler value to 256 on second PWM library (if it

PWM1 PRESCALER 256 T
- - - exists in Library Manager).

Sets prescaler value to 1024 on second PWM library (if

PWM1 PRESCALER 1024 . . . .
- - - - it exists in Library Manager).

_PWM_INVERTED Selects the inverted PWM mode.

Selects the inverted PWM mode on second PWM
library (if it exists in Library Manager).

_PWM1_INVERTED

_PWM_NON_INVERTED Selects the normal (non inverted) PWM mode.

Selects the normal (non inverted) PWM mode on sec-

—FWM1_NON_INVERTED ond PWM library (if it exists in Library Manager).

Note: Not all of the MCUs have both PWM and PWM1 library included. Sometimes, like its the
case with ATmega8515, MCU has only PWM library. Therefore constants that have in their
name PWM1 are invalid (for ATmega8515) and will not be visible from Code Assistant. It is
highly advisable to use this feature, since it handles all the constants (available) nad eliminates
any chance of typing error.
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PWM_Init

Prototype

sub procedure PWM Init (dim wave mode as byte,
dim inverted as byte,

byte,

dim duty as byte)

dim prescaler as

Returns

Nothing.

Description

Initializes the PWM module. Parameter wave_mode is a desired PWM mode.
There are two modes: Phase Correct and Fast PWM. Parameter prescaler
chooses prescale value N = 1,8,64,256 or 1024 (some modules support 32 and
128, but for this you will need to check the datasheet for the desired MCU).
Paremeter inverted is for choosing between inverted and non inverted PWM
signal. Parameter duty sets duty ratio from 0 to 255. PWM signal graphs and
formulas are shown below.
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PWM _Init must be called before using other functions from PWM Library.

t
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You need a CMO on the given MCU (that supports PWM).

Before calling this routine you must set the output pin for the PWM (according
Requires to the datasheet):

DDRB.3 = 1; // set PORTB pin 3 as output for the PWM

This code oxample is for ATmega16, for different MCU please consult datasheet
for the correct pinout of the PWM module or modules.

Initialize PWM module:

Example . - .
PWM Init( PWM FAST MODE, PWM PRESCALER 8, PWM NON INVERTED,

127)

PWM_Set_Duty

Prototype sub procedure PWM Set Duty(dim duty as byte)

Returns Nothing.

Changes PWM duty ratio. Parameter duty takes values from 0 to 255, where 0
Description |is 0%, 127 is 50%, and 255 is 100% duty ratio. Other specific values for duty
ratio can be calculated as (percent*255)/100.

PWM module must to be initialised (PWM_Init) before using PWM_Set_Duty

Requires

function.

For example lets set duty ratio to 75%:
Example

PWM Set Duty(192)
PWM_Start

Prototype sub procedure PWM Start ()

Returns Nothing.
Description |Starts PWM.

MCU must have CMO module to use this library. PWM _Init must be called
Requires before
using this routine.

Example PWM_Start ()
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PWM_Stop

Prototype sub procedure PWM Stop ()

Returns Nothing.

Description |Stops the PWM.
MCU must have CMO module to use this library. PWM_Init and PWM_Start

Requires must be called before

q using this routine using this routine, otherwise it will have no effect as the PWM

module is not running.

Example PWM Stop ()

Note: Not all the AVR MCUs support both PWM and PWM1 library. The best way to verify this is
by checking the datasheet for the desired MCU. Also you can check this by selecting a MCU in
mikroBasic PRO for AVR looking at the Library Manager. If library manager loads both PWM and
PWM1 library (you are able to check them) then this MCU supports both PWM libraries. Here you
can take full advantage of our Code Assistant and Parameter Assistant feature of our compiler.

PWM1_Init

Prototype

sub procedure PWMl Init (dim wave mode as byte,
dim duty as byte)

byte,

dim inverted as byte,

dim prescaler as

Returns

Nothing.

Description

Initializes the PWM module. Parameter wave_mode is a desired PWM mode. There
are two modes: Phase Correct and Fast PWM. Parameter prescaler chooses
prescale value N = 1,8,64,256 or 1024 (some modules support 32 and 128, but for
this you will need to check the datasheet for the desired MCU). Paremeter inverted is
for choosing between inverted and non inverted PWM signal. Parameter duty sets
duty ratio from 0 to 255. PWM signal graphs and formulas are shown below.
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The N variable represents the prescaler factor (1, 8, 64, 256, or 1024). Some
modules also support 32 and 128 prescaler value, but for this you will need to
check the datasheet for the desired MCU)

PWM1_Init must be called before using other functions from PWM Library.

You need a CMO on the given MCU (that supports PWM).

Before calling this routine you must set the output pin for the PWM (according
Requires to the datasheet):

DDRD.7 = 1; // set PORTD pin 7 as output for the PWM1

This code oxample is for ATmega16 (second PWM module), for different MCU
please consult datasheet for the correct pinout of the PWM module or modules.

Initialize PWM module:

Example
p PWM1l Init( PWM1 FAST MODE, PWM1 PRESCALER 8, PWM1 NON INVERTED,

127)
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PWM1_Set_Duty

Prototype sub procedure PWM1 Set Duty(dim duty as byte)
Returns Nothing.
Changes PWM duty ratio. Parameter duty takes values from 0 to 255, where 0
Description |is 0%, 127 is 50%, and 255 is 100% duty ratio. Other specific values for duty
ratio can be calculated as (percent*255) /100.
. PWM module must to be initialised (PWM1_Init) before using PWM_Set_Duty
Requires .
function.
For example lets set duty ratio to 75%:
Example
PWM1 Set Duty(192)
PWM1_Start
Prototype sub procedure PWMl Start ()
Returns Nothing.
Description |Starts PWM.
MCU must have CMO module to use this library. PWM1_Init must be called
Requires before
using this routine.
Example PWM1l Start ()
PWM1_Stop
Prototype sub procedure PWM1 Stop ()
Returns Nothing.
Description |Stops the PWM.
MCU must have CMO module to use this library. PWM1_Init and PWM1_Start
Requires must be called before
q using this routine using this routine, otherwise it will have no effect as the PWM
module is not running.
Example PWM1_Stop () ;
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Library Example

The example changes PWM duty ratio on pin PB3 continually. If LED is connected
to PB3, you can observe the gradual change of emitted light.

program PWM Test

dim current duty as byte
current dutyl as byte

main:
DDBO bit = 0 ' Set PORTB pin 0 as input
DDB1 bit = 0 ' Set PORTB pin 1 as input
DDCO bit = 0 ' Set PORTC pin 0 as input
DDC1 bit = 0 ' Set PORTC pin 1 as input
current duty = 127 ' initial value for current duty
current dutyl = 127 ' initial value for current duty
DDB3 bit =1 ' Set PORTB pin 3 as output pin
for the PWM (according to datasheet)
DDD7 bit =1 ' Set PORTD pin 7 as output pin

for the PWM1 (according to datasheet)

PWM_Init ( PWM PHASE CORRECT MODE, _PWM_PRESCALER 8,
_PWM_NON_INVERTED, 127)
PWM1 Init( PWM1 PHASE CORRECT MODE, _PWM1 PRESCALER 8,

_PWM1 NON_INVERTED, 127)
while TRUE ' Endless loop

if (PINBO bit <> 0) then ' Detect if PORTB pin 0 is pressed

Delay ms (40) ' Small delay to avoid deboucing effect
Inc(current duty) ' Increment duty ratio
PWM Set Duty(current duty) ' Set incremented duty

end if

if (PINB1 bit <> 0) then ' Detect if PORTB pin 1 is pressed
Delay ms (40) ' Small delay to avoid deboucing effect
Dec (current duty) ' Decrement duty ratio
PWM Set Duty(current duty) ' Set decremented duty ratio

end if

if (PINCO bit <> 0) then ' Detect if PORTC pin 0 is pressed
Delay ms (40) ' Small delay to avoid deboucing effect
Inc(current dutyl) ' Increment duty ratio
PWM1 Set Duty(current dutyl) ' Set incremented duty

end if
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if (PINC1 bit <> 0) then ' Detect if PORTC pin 1 is pressed
Delay ms (40) ' Small delay to avoid deboucing effect
Dec (current dutyl) ' Decrement duty ratio
PWM1 Set Duty(current dutyl) ' Set decremented duty ratio
end if
wend
end.

HW Connection
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PWM demonstration
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PWM 16 BIT LIBRARY

CMO module is available with a number of AVR MCUs. mikroBasic PRO for AVR
provides library which simplifies using PWM HW Module.

Note: For better understanding of PWM module it would be best to start with the
example provided in Examples folder of our mikroBasic PRO for AVR compiler.
When you select a MCU, mikroBasic PRO for AVR automaticaly loads the correct
PWM-16bit library, which can be verified by looking at the Library Manager. PWM
library handles and initializes the PWM module on the given AVR MCU, but it is up
to user to set the correct pins as PWM output, this topic will be covered later in this
section.

Library Routines

- PWM16bit_Init

- PWM16bit_Change Duty
- PWM16bit_Start

- PWM16bit_Stop
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Predefined constants used in PWM-16bit library

The following variables are used in

- . Description:
PWM-16bit library functions: P
_PWM16_PHASE CORRECT_MODE_8BIT Selects Phase Correct, 8-bit mode.
_PWM16 PHASE CORRECT MODE 9BIT Selects Phase Correct, 9-bit mode.

_PWM16_PHASE CORRECT MODE_10BIT |Selects Phase Correct, 10-bit mode.

_PWM16 FAST MODE 8BIT Selects Fast, 8-bit mode.
_PWM16 FAST MODE O9BIT Selects Fast, 9-bit mode.
_PWM16 FAST MODE 10BIT Selects Fast, 10-bit mode.
_PWM16 PRESCALER 16bit 1 Sets prescaler value to 1 (No prescaling).
_PWM16 PRESCALER 16bit 8 Sets prescaler value to 8.
_PWM16 PRESCALER 16bit 64 Sets prescaler value to 64.
_PWM16 PRESCALER 16bit 256 Sets prescaler value to 256.
_PWM16 PRESCALER 16bit 1024 Sets prescaler value to 1024.
_PWM16 INVERTED Selects the inverted PWM-16bit mode.
PWM16 NON_ INVERTED Selects the normal (non inverted) PWM-16bit mode.

Selects the Timer/Counter1 (used with
PWM16bit_Start and PWM16bit_Stop.

Selects the Timer/Counter3 (used with
PWM16bit_Start and PWM16bit_Stop.

Selects the channel A on Timer/Counter1 (used with
PWM16bit_Change_Duty).

TIMERI

_TIMER3

_TIMERL CH A

Selects the channel B on Timer/Counter1 (used with
PWM16bit_Change_Duty).

Selects the channel C on Timer/Counter1 (used with
PWM16bit_Change_Duty).

Selects the channel A on Timer/Counter3 (used with
PWM16bit_Change_Duty).

Selects the channel B on Timer/Counter3 (used with
PWM16bit_Change_Duty).

Selects the channel C on Timer/Counter3 (used with
PWM16bit_sChange_Duty).

_TIMER1 CH B

_TIMERL CH C

_TIMER3 CH A

_TIMER3 CH B

_TIMER3 CH C
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Note: Not all of the MCUs have 16bit PWM, and not all of the MCUs have both Timer/Counter1
and Timer/Counter3. Sometimes, like its the case with ATmega168, MCU has only
Timer/Counter1 and channels A and B. Therefore constants that have in their name Timer3 or
channel C are invalid (for ATmega168) and will not be visible from Code Assistant. It is highly
advisable to use this feature, since it handles all the constants (available) and eliminates any
chance of typing error.

PWM16bit_Init
Protot sub procedure PWMltbit Init (dim wave mode as byte, dim prescaler as
rototype byte, dim inverted as byte, dim duty as word, dim timer as byte)
Returns Nothing.
Initializes the PWM module. Parameter wave mode is a desired PWM-16bit
mode.
There are several modes included :
- PWM, Phase Correct, 8-bit
- PWM, Phase Correct, 9-bit
- PWM, Phase Correct, 10-bit
- Fast PWM, 8-bit
- Fast PWM, 9-bit
- Fast PWM, 10-bit
Parameter prescaler chooses prescale value N = 1,8,64,256 or 1024 (some
modules support 32 and 128, but for this you will need to check the datasheet
for the desired MCU). Paremeter inverted is for choosing between inverted
and non inverted PWM signal. Parameter duty sets duty ratio from 0 to TOP
Description value (this value varies on the PWM wave mode selected). PWM signal graphs

and formulas are shown below.

FAST f _ fclk ifo
MODE PN < (14TOP)
TOP y /\ /'\\

Duty Ratio - ¥ -

™ S
, Va -,
\ N ,
/ ny .

| 1
Zt;wn 3tewm Apum EStL'n'f: 6tlvwn E?tIJWM

I
T
» Eeam

MNon Inverted
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The N variable represents the prescaler factor (1, 8, 64, 256, or 1024).

PWM16bit_Init must be called before using other functions from PWM Library.

You need a CMO on the given MCU (that supports PWM-16bit).

Before calling this routine you must set the output pin for the PWM (according
Requires to the datasheet):

DDRB.B1 = 1; // set PORTB pin 1 as output for the PWM-16bit
This code example is for ATmega168, for different MCU please consult
datasheet for the correct pinout of the PWM module or modules.

Initialize PWM-16bit module:

Example
PWM16bit Init( PWM16 PHASE CORRECT MODE 8BIT,

_PWM16 PRESCALER 16bit 8, PWM16 NON INVERTED, 255, TIMERI)
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PWM16bit_Change_Duty

sub procedure PWMlé6bit Change Duty(dim duty as word, dim channel

Prototype as byte)

Returns Nothing.

Changes PWM duty ratio. Parameter duty takes values shown on the table
below. Where 0 is 0%, and TOP value is 100% duty ratio. Other specific values
for duty ratio can be calculated as (percent*TOP) /100.

Timer/Countgr Mode of TOP Update of TOVn Flag
Operation : OCRNX at : Seton:

Description PWM, Phase Correct, 8 bit Ox00FF |TOP BOTTOM

PWM, Phase Correct, 9 bit O0x01FF |TOP BOTTOM

PWM, Phase Correct, 10 bit Ox03FF [TOP BOTTOM
Fast PWM, 8 bit Ox00FF |TOP TOP
Fast PWM, 9 bit 0x01FF [TOP TOP
Fast PWM, 10 bit Ox03FF |TOP TOP

PWM module must to be initialised (PWM16bit_Init) before using
PWM_Set_Duty function.

Example lets set duty ratio to :

Requires

Example
PWMl6bit Change Duty( 300, TIMERL1 CH A )
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PWM16bit_Start

Prototype sub procedure PWMl6bit Start(dim timer as byte)

Returns Nothing.

Starts PWM-16bit module with alredy preset values (wave mode, prescaler,
inverted and duty) given in the PWM16bit_Init.

MCU must have CMO module to use this library. PWM16bit_Init must be called
before

using this routine, otherwise it will have no effect as the PWM module is not ini-
tialised.

Description

Requires

PWMlébit Start( _TIMERL ) // Starts the PWM-1l6bit module
on Timer/Counterl

Example or

PWMlébit Start( TIMER3 ) // Starts the PWM-16bit module
on Timer/Counter3

PWM16bit_Stop

Prototype |sub procedure PWM16 Stop(dim timer as byte)

Returns Nothing.

Description |Stops the PWM-16bit module, connected to Timer/Counter set in this stop function.

MCU must have CMO module to use this library. Like in PWM16bit_Start
before, PWM16bit_Init must be called before

using this routine , otherwise it will have no effect as the PWM module is not
running.

Requires

PWMl6bit Stop( _TIMERIL ) // Stops the PWM-16bit module on
Timer/Counterl

Example or

PWMlébit Stop( TIMER3 ) // Stops the PWM-1l6bit module on
Timer/Counter3

Library Example

The example changes PWM duty ratio continually by pressing buttons on PORTC (0-3). If LED is
connected to PORTB.B1 or PORTB.B2 ,you can observe the gradual change of emitted light. This
example is written for ATmega168. This AVR MCU has only Timer/Counter1 split over two chan-
nels A and B. In this example we are changing the duty ratio on both of these channels.
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program PWM Test

dim current duty as byte
current dutyl as byte

main:
DDCO bit = 0
DDC1 bit = 0

DDC2 bit = 0
DDC3 bit = 0

current duty = 127
current dutyl = 127
DDB1l bit =1

for the PWM (according
DDB2 bit = 1

for the PWM (according

PWM16bit Init( PWM16 FAST MODE 9BIT,

_PWM16_ INVERTED, 255, 1)
while TRUE
if (PINC.BO <> 0) then

Delay ms (40)
Inc(current duty)

PWM Set Duty(current duty) !

end if
if (PINC.B1l <> 0)
Delay ms (40)

Dec (current duty)

then

PWM Set Duty(current duty) !

end if
if (PINC.B2 <> 0)
Delay ms (40)

Inc(current dutyl)

then

PWM1 Set Duty(current dutyl) !

end if
if (PINC.B3 <> 0)
Delay ms (40)

Dec (current dutyl)

then

PWM1 Set Duty(current dutyl) !

end if

wend

' Set
' Set

PORTC pin O
PORTC pin 1

as
as

input
input

' Set
' Set

PORTC pin 2
PORTC pin 3

as
as

input
input

' initial value for current duty
' initial value for current duty

' Set PORTB pin 1 as output pin

to datasheet)

' Set PORTB pin 2 as output pin

to datasheet)

_PWM16 PRESCALER 16bit 1,

' Endless loop

' Detect if PORTC pin 0 is pressed
' Small delay to avoid deboucing effect
' Increment duty ratio
Set incremented duty

' Detect if PORTC pin 1 1is pressed
' Small delay to avoid deboucing effect
' Decrement duty ratio
Set decremented duty ratio

' Detect if PORTC pin 2 1is pressed
' Small delay to avoid deboucing effect
' Increment duty ratio
Set incremented duty

' Detect if PORTC pin 3 is pressed

' Small delay to avoid deboucing effect
' Decrement duty ratio

Set decremented duty ratio
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HW Connection
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PWM demonstration
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RS-485 LIBRARY

RS-485 is a multipoint communication which allows multiple devices to be connect-
ed to a single bus. The mikroBasic PRO for AVR provides a set of library routines
for comfortable work with RS485 system using Master/Slave architecture. Master
and Slave devices interchange packets of information. Each of these packets con-
tains synchronization bytes, CRC byte, address byte and the data. Each Slave has
unique address and receives only packets addressed to it. The Slave can never ini-
tiate communication.

It is the user’s responsibility to ensure that only one device transmits via 485 bus at
a time.

The RS-485 routines require the UART module. Pins of UART need to be attached
to RS-485 interface transceiver, such as LTC485 or similar (see schematic at the
bottom of this page).

Library constants:

- START byte value = 150

- STOP byte value = 169

- Address 50 is the broadcast address for all Slaves (packets containing address 50
will be received by all Slaves except the Slaves with addresses 150 and 169).

Note:

- Prior to calling any of this library routines, UART_Wr_Ptr needs to be initialized
with the appropriate UART_Write routine.

- Prior to calling any of this library routines, UART_Rd_Ptr needs to be initialized
with the appropriate UART_Read routine.

- Prior to calling any of this library routines, UART_Rdy_Ptr needs to be initialized
with the appropriate UART_Ready routine.

- Prior to calling any of this library routines, UART_TX Idle_Ptr needs to be
initialized with the appropriate UART_TX Idle routine.

MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD 325



CHAPTER 6

Libraries mikroBasic PRO for AVR
External dependencies of RS-485 Library
The following variable
must be defined in all i
Description: Example :

projects using RS-485
Library:

dim RS485 rxtx pin as
sbit sfr external

Control RS-485 Trans-
mit/Receive operation
mode

dim RS485 rxtx pin as
sbit at PORTD.B2

dim

RS485 rxtx pin direc-
tion as sbit sfr
external

Direction of the RS-485
Transmit/Receive pin

dim

RS485 rxtx pin direc-
tion as sbit at
DDRD.B2

Library Routines

- RS485Master_Init
- RS485Master_Receive
- RS485Master_Send

- RS485Slave_Init

- RS485Slave Receive
- RS485Slave_Send
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RS485Master_Init

Prototype sub procedure RS485Master Init ()

Returns Nothing.

Description |[Initializes MCU as a Master for RS-485 communication.

Global variables :

- RS485 rxtx pin - this pin is connected to RE/DE input of RS-485
transceiver(see schematic at the bottom of this page). RE/DE signal controls
RS-485 transceiver operation mode.

Requires
- RS485 rxtx pin direction - direction of the RS-485 Transmit/Receive pin
must be defined before using this function.
UART HW module needs to be initialized. See UARTX_Init.
' RS485 module pinout
dim RS485 rxtx pin as sbit at PORTD.B2
dim RS485 rxtx pin direction as sbit at DDRD.B2
' End of RS485 module pinout
' Pass pointers to UART functions of used UART module
UART Wr Ptr = QUART1 Write
Example - -

UART Rd Ptr = QUARTL Read
UART Rdy Ptr = @UART1 Data Ready
UART TX Idle Ptr = QUART1 TX Idle

UART1 Init(9600) ' initialize UART module
RS485Master Init () ' intialize MCU as a Master
for RS-485 communication
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RS485Master _Receive

Protot sub procedure RS485Master Receive (dim byref data buffer as
rototype  yvter 207)

Returns Nothing.
Receives messages from Slaves. Messages are multi-byte, so this routine must
be called for each byte received.
Parameters :
- data buffer: 7 byte buffer for storing received data, in the following manner:

Descriotion |- datal 0..2] : message content

P - datal 3] : number of message bytes received, 1-3

- data[ 4] : is set to 255 when message is received
- datal 5] : is set to 255 if error has occurred
- datal 6] : address of the Slave which sent the message
The function automatically adjusts data[ 4] and datal 5] upon every received
message. These flags need to be cleared by software.

Requires MCU must be initialized as a Master for RS-485 communication. See

q RS485Master_Init.

dim msg as byte[ 20]

Example S
RS485Master Receive (msg)
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RS485Master_Send

sub procedure Rs485Master Send(dim byref data buffer as bytel 20],
dim datalen as byte, dim slave address as byte)

Prototype

Returns Nothing.

Sends message to Slave(s). Message format can be found at the bottom of this
page.

. Parameters :
Description

- data buffer: data to be sent
- datalen: number of bytes for transmition. Valid values: 0...3.
- slave address: Slave(s) address

MCU must be initialized as a Master for RS-485 communication. See
RS485Master_Init.

Requires
It is the user’s responsibility to ensure (by protocol) that only one device sends
data via 485 bus at a time.

dim msg as byte[ 20]

Example ' send 3 bytes of data to slave with address 0x12

RS485Master Send(msg, 3, 0x12)
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RS485Slave _Init

Prokﬂype sub procedure RS485Slave Init(dim slave address as byte)

Returns Nothing.

Initializes MCU as a Slave for RS-485 communication.
Description |Parameters :

- slave address: Slave address

Global variables :

- RS485 rxtx pin - this pin is connected to RE/DE input of RS-485
transceiver(see schematic at the bottom of this page). RE/DE signal controls
RS-485 transceiver operation mode. Valid values: 1 (for transmitting) and 0
(for receiving)

Requires
- RS485 rxtx pin direction - direction of the RS-485 Transmit/Receive pin
must be defined before using this function.
UART HW module needs to be initialized. See UARTx_Init.
' RS485 module pinout
dim RS485 rxtx pin as sbit at PORTD.B2
dim RS485 rxtx pin direction as sbit at DDRD.B2
' End of RS485 module pinout
' Pass pointers to UART functions of used UART module
UART Wr Ptr = @UART1 Write
Example - -

UART_Rd_Ptr = QUART1_Read
UART Rdy Ptr = QUART1 Data Ready
UART TX Idle Ptr = QUART1 TX Idle

UART1 Init(9600) ' initialize UART module
RS485Slave Init (160) ' intialize MCU as a Slave
for RS-485 communication with address 160
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RS485Slave_Receive

sub procedure RS485Slave Receive (dim byref data buffer as

Prototype bytel 20] )

Returns Nothing.

Receives messages from Master. If Slave address and Message address field
don't match then the message will be discarded. Messages are multi-byte, so
this routine must be called for each byte received.

Parameters :

- data buffer: 6 byte buffer for storing received data, in the following manner:
-datal 0..2] : message content

- datal 3] : number of message bytes received, 1-3

- data[ 4] : is set to 255 when message is received

- datal 5] : is set to 255 if error has occurred

Description

[
[
[
[

The function automatically adjusts datal 41 and datal 5] upon every received
message. These flags need to be cleared by software.

MCU must be initialized as a Slave for RS-485 communication. See
RS485Slave_|Init.

dim msg as byte[ 5]

Requires

Example

RS485Slave Read (msg)
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RS485Slave_Send

sub procedure RS485Slave Send(dim byref data buffer as byte[ 20] ,
dim datalen as byte)

Prototype

Returns Nothing.

Sends message to Master. Message format can be found at the bottom of this
page.

Description |Parameters :

- data buffer: data to be sent
- datalen: number of bytes for transmition. Valid values: 0...3.

MCU must be initialized as a Slave for RS-485 communication. See
Requires RS485Slave_lInit. It is the user’s responsibility to ensure (by protocol) that only
one device sends data via 485 bus at a time.

dim msg as byte[ 8]

Exan“ﬂe ' send 2 bytes of data to the master

RS485Slave Send(msg, 2)

Library Example
This is a simple demonstration of RS485 Library routines usage.

Master sends message to Slave with address 160 and waits for a response. The Slave accepts
data, increments it and sends it back to the Master. Master then does the same and sends incre-
mented data back to Slave, etc.

Master displays received data on PO, while error on receive (0xAA) and number of consecutive
unsuccessful retries are displayed on P1. Slave displays received data on PO, while error on
receive (0xAA) is displayed on P1. Hardware configurations in this example are made for the
EasyAVR5A board and ATmega16.

RS485 Master code:
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program RS485 Master Example

dim dat as byte[ 10] ' buffer for receving/sending messages
i, j as byte
cnt as longint

dim rs485 rxtx pin as sbit at PORTD.2 ' set transcieve pin
rs485 rxtx pin direction as sbit at DDRD.2 ' set transcieve
pin direction

' Interrupt routine

sub procedure interrupt() org 0x1l6
RS485Master Receive (dat)
end sub
main:
cnt = 0
PORTA = 0 ' clear PORTA
PORTB = 0 ' clear PORTB
PORTC = 0 ' clear PORTC
DDRA = 0OxFF ' set PORTA as output
DDRB = 0OxFF ' set PORTB as output
DDRC = 0OxFF ' set PORTB as output

' Pass pointers to UART sub functions of used UART module
UART Wr_ Ptr= QUARTL Write

UART Rd Ptr = @UART1 Read

UART Rdy Ptr = QUART1 Data Ready

UART TX Idle Ptr = QUART1 TX Idle

UART1 Init (9600) ' initialize UART1 module
Delay ms (100)

RS485Master Init () ' initialize MCU as Master
dat[ 0] = OxAA

dat[ 1] = O0xFO

dat[ 2] = OxOF

dat[ 4] = 0 ' ensure that message received flag is 0
dat[ 5] = 0 ' ensure that error flag is 0

dat[ 6] = 0

RS485Master Send(dat,1,160)

SREG I bit =1 ' enable global interrupt
RXCIE bit =1 ' enable interrupt on UART receive
while TRUE
Inc(cnt)
if (dat[ 5] <> 0) then ' if an error detected, signal it
PORTC = dat[ 5] ' by setting PORTC
end if
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if (dat[ 4] <> 0) then ' if message received successfully
cnt = 0
dat[ 4] = 0 ' clear message received flag
J = dat[ 3]

for i = 1 to dat[ 3]
PORTB = dat[ 1-1]
next i
dat[ 0] = dat[ 0] +1
Delay ms (1)
RS485Master Send(dat,1,160)

' show data on PORTB

' increment received dat[ 0]
' send back to slave

end if

if (cnt > 100000) then ' if in 100000 poll-cycles the answer
Inc (PORTA) ! was not detected, signal
cnt = 0 ! failure of send-message

RS485Master Send(dat,1,160)
if (PORTA > 10) then
PORTA = 0
RS485Master Send(dat,1,50)
address
end if
end if
wend
end.

RS485 Slave code:
program RS485 Slave Example
dim dat as byte[ 20]

messages
i, j as byte

dim rs485 rxtx pin as sbit at PORTD.B2

' 1f sending failed 10 times

send message on broadcast

' buffer for receving/sending

' set transcieve pin

rs485 rxtx pin direction as sbit at DDRD.B2 ' set transcieve

pin direction

' Interrupt routine
sub procedure interrupt() org 0x16
RS485Slave Receive (dat)

end sub

main:
PORTB = 0
PORTC = 0
DDRB = OxFF
DDRC = O0OxFF

' clear PORTB
' clear PORTC

' set PORTB as output
' set PORTB as output
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v

Pass pointers to UART sub functions of used UART module
UART Wr Ptr = QUART1 Write
UART Rd Ptr @UART1 Read
UART Rdy Ptr = QUART1 Data Ready
UART TX Idle Ptr = @UART1 TX Idle

UART1 Init(9600) ' initialize UART1 module

Delay ms (100)

RS485Slave Init (160) ' Intialize MCU as slave, address 160
dat[ 4] = 0 ' ensure that message received flag is 0
dat[ 5] = 0 ' ensure that message received flag is 0
dat[ 6] = 0 ' ensure that error flag is 0
SREG I bit =1 ' enable global interrupt

RXCIE bit =1 ' enable interrupt on UARTs receive

while TRUE

if (dat[ 5] <> 0) then ' 1if an error detected, signal it by
PORTC = dat[ 5] ' setting PORTC
dat[ 5] = 0
end if
if (dat[ 4] <> 0) then ' upon completed valid message receive
dat[ 4] = 0 ! datal 4] is set to OxFF
J = dat[ 3]
for i = 1 to dat[ 3] ' show data on PORTB
PORTB = dat[ i-1]
next i
dat[ 0] = dat[ 0] +1 ' increment received dat[ 0]
Delay ms (1)
RS485Slave Send(dat, 1) ' and send it back to master
end if
wend

end.
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HW Connection
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Example of interfacing PC to ATmega16 MCU via RS485 bus with LTC485 as RS-
485 transceiver
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Message format and CRC calculations
Q: How is CRC checksum calculated on RS485 master side?
START BYTE = 0x96; ' 10010110
STOP_ BYTE = 0xA9; ' 10101001
PACKAGE:
START BYTE 0x96
ADDRESS
DATALEN
[ DATAL] ' if exists
[ DATA2] ' if exists
[ DATAZ] ' if exists
CRC
STOP BYTE 0xA9
DATALEN bits
bit7 =1 MASTER SENDS
0 SLAVE SENDS
bite = 1 ADDRESS WAS XORed with 1, IT WAS EQUAL TO START BYTE or
STOP_BYTE
0 ADDRESS UNCHANGED
bit5 = 0 FIXED
bitd = 1 DATA3 (if exists) WAS XORed with 1, IT WAS EQUAL TO
START BYTE or STOP BYTE
0 DATA3 (if exists) UNCHANGED
bit3 = 1 DATA2 (if exists) WAS XORed with 1, IT WAS EQUAL TO
START BYTE or STOP BYTE
0 DATA2 (if exists) UNCHANGED
bitz2 = 1 DATAl (if exists) WAS XORed with 1, IT WAS EQUAL TO
START BYTE or STOP BYTE
0 DATAl (if exists) UNCHANGED
bitlbit0 = 0 to 3 NUMBER OF DATA BYTES SEND
CRC generation
crc_send = datalen " address;
crc_send "= data[ 0] ; ' if exists
crc_send "= datal 1] ; ' if exists
crc_send "= datal 2] ; ' if exists
crc_send = ~crc_send;
if ((crc_send == START BYTE) || (crc _send == STOP BYTE))
crc_send++;
NOTE: DATALEN<4..0> can not take the START BYTE<4..0> or
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SOFTWARE I’C LIBRARY

The mikroBasic PRO for AVR provides routines for implementing Software | C com-
munication. These routines are hardware independent and can be used with any
MCU. The Software | C library enables you to use MCU as Master in | C communi-
cation. Multi-master mode is not supported.

Note: This library implements time-based activities, so interrupts need to be dis-
abled when using Software | C.

Note: All Software | C Library functions are blocking-call functions (they are waiting
for I C clock line to become logical one).

Note: The pins used for Software | C communication should be connected to the
pull-up resistors. Turning off the LEDs connected to these pins may also be

required.

External dependencies of Soft_I2C Library

The following variables
must be defined in all
projects using Soft_I2C
Library:

Description:

Example :

dim
Soft I2C Scl Output
as sbit sfr external

Soft 12C Clock output line.

dim

Soft I2C Scl Output
as sbit at PORTC.BO

dim
Soft I2C Sda Output
as sbit sfr external

Soft 12C Data output line.

dim

Soft I2C Sda Output
as sbit at PORTC.B1

dim
Soft I2C Scl Input as
sbit sfr external

Soft 12C Clock input line.

dim

Soft I2C Scl Input as
sbit at PINC.BO

dim
Soft I2C Sda Input as
sbit sfr external

Soft 12C Data input line.

dim

Soft I2C Sda Input as
sbit at PINC.Bl1

dim

Soft I2C Scl Pin Dire
ction as sbit sfr
external

Direction of the Soft I2C
Clock pin.

dim

Soft I2C Scl Pin Dire
ction as sbit at
DDRC.BO

dim

Soft I2C Sda Pin Dire
ction as sbit sfr
external

Direction of the Soft 12C
Data pin.

dim

Soft I2C Sda Pin Dire
ction as sbit at
DDRC.B1
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- Soft_12C_Init
- Soft_12C_Start
- Soft_12C_Read
- Soft_12C_Write
- Soft_12C_Stop
- Soft_12C_Break
Soft_I12C_Init
Prototype sub procedure Soft I2C Init ()
Returns Nothing.
Description |Configures the software 12C module.
Global variables :
- Soft I12C scl Output: Soft 12C clock output line
- Soft I2C sda Output: Soft 12C data output line
. - Soft I2C Scl Input: Soft 12C clock input line
Requires - == 2 _ _
- Soft 12C sda Input: Soft 14C data input line
- Soft I2C scl Pin Direction: Direction of the Soft 12C clock pin
- Soft I2C sda Pin Direction: Direction of the Soft 12C data pin
must be defined before using this function.
'Soft I2C pinout definition
dim Soft I2C Scl Output as sbit at PORTC.BO
dim Soft I2C Sda Output as sbit at PORTC.Bl
dim Soft I2C Scl Input as sbit at PINC.BO
dim Soft I2C Sda Input as sbit at PINC.B1
Example . Tl T . . .
dim Soft I2C Scl Pin Direction as sbit at DDRC.BO
dim Soft I2C Sda Pin Direction as sbit at DDRC.BI
'End of Soft I2C pinout definition
Soft T2C Init ()
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Soft_I2C_Start

Prototype |sub procedure Soft I2C Start()

Returns Nothing.

Description |Determines if the I2C bus is free and issues START signal.

Software 12C must be configured before using this function. See Soft_I2C_Init

Requires ,
routine.
Exampl ' Issue START signal
ample Soft I2C Start()
Soft_12C_Read

Prototype sub function Soft I2C Read(dim ack as word) as byte

Returns One byte from the Slave.

Reads one byte from the slave.

. Parameters :
Description

- ack: acknowledge signal parameter. If the ack==0 not acknowledge signal will
be sent after reading, otherwise the acknowledge signal will be sent.

Soft I12C must be configured before using this function. See Soft_I2C _Init routine.

Requires . . . . :
Also, START signal needs to be issued in order to use this function. See
Soft_12C_Start routine.
dim take as word

Example ' Read data and send the not acknowledge signal

take = Soft I2C Read(0)
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Soft_12C_Write

Prototype sub function Soft I2C Write(dim Data as byte) as byte

- 0 if there were no errors.

Returns ) . o 2
- 1 if write collision was detected on the 1C bus.

Sends data byte via the | C bus.
Description |Parameters :

- Data: data to be sent

Soft I2C must be configured before using this function. See Soft_I12C_Init routine.

Requires ] . . ) .
Also, START signal needs to be issued in order to use this function. See
Soft_12C_Start routine.
dim data, error as byte
Example error = Soft T2C Write (data)
error = Soft I2C Write (0xA3)
Soft_12C_Stop
Prototype |sub procedure Soft I2C Stop()
Returns Nothing.
Description [Issues STOP signal.
Requires Soft I12C must be configured before using this function. See Soft_12C_Init routine.
Exanuﬂe ' Issue STOP signal

Soft I2C Stop()
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Soft_I2C_Break

Prototype |sub procedure Soft I2C Break()

Returns Nothing.

All Software 12C Library functions can block the program flow (see note at the
top of this page). Call this routine from interrupt to unblock the program execu-
Description tion. This mechanism is similar to WDT.

Note: Interrupts should be disabled before using Software | C routins again
(see note at the top of this page).

Requires Nothing.

'Soft I2C pinout definition

dim Soft I2C Scl Output as sbit at PORTC.BO
dim Soft I2C Sda Output as sbit at PORTC.B1
dim Soft I2C Scl Input as sbit at PINC.BO
dim Soft I2C Sda Input as sbit at PINC.B1

dim Soft I2C Scl Pin Direction as sbit at DDRC.BO
dim Soft I2C Sda Pin Direction as sbit at DDRC.B1
'End of Soft I2C pinout definition

dim counter as byte

sub procedure TimerOOverflow ISR() org 0x12
counter = 0
if (counter >= 20) then
Soft I2C Break()

counter = 0 'reset counter
else
Inc (counter) 'increment counter
Example end if
end sub
main:
TOIEO bit =1 'Timer0 overflow interrupt enable
TCCRO bit =5 'Start timer with 1024 prescaler
SREG I bit = 0 'Interrupt disable

'try Soft I2C Init with blocking prevention mechanism

SREG I bit = 1 'Interrupt enable

Soft I2C Init()

SREG I bit = 0 'Interrupt disable
end.
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Library Example

The example demonstrates Software | C Library routines usage. The AVR MCU is
connected (SCL, SDA pins) to PCF8583 RTC (real-time clock). Program reads date
and time are read from the RTC and prints it on Lcd.

program RTC Read

dim seconds, minutes, hours, day, month, year as byte ' Global
date/time variables

]

Software I2C connections

dim Soft I2C Scl Output as sbit at PORTC.BO
Soft I2C Sda Output as sbit at PORTC.BI
Soft I2C Scl Input as sbit at PINC.BO
Soft I2C Sda Input as sbit at PINC.B1

Soft I2C Scl Direction as sbit at DDRC.BO
Soft I2C Sda Direction as sbit at DDRC.B1
End Software I2C connections

]

]

Lcd module connections
dim LCD RS as sbit at PORTD.B2
LCD EN as sbit at PORTD.B3
LCD D4 as sbit at PORTD.B4
LCD D5 as sbit at PORTD.BS
LCD D6 as sbit at PORTD.B6
LCD D7 as sbit at PORTD.B7
LCD RS Direction as sbit at DDRD.B2
LCD EN Direction as sbit at DDRD.B3
LCD D4 Direction as sbit at DDRD.B4
LCD D5 Direction as sbit at DDRD.B5S
LCD D6 Direction as sbit at DDRD.B6
LCD D7 Direction as sbit at DDRD.B7
End Lcd module connections

]

e Reads time and date information from RTC

(PCF8583)
sub procedure Read Time ()
Soft I2C Start() ' Issue start signal
Soft I2C Write (0xAO0) ' Address PCF8583, see PCF8583 datasheet
Soft I2C Write(2) ' Start from address 2
Soft I2C Start() ' Issue repeated start signal
Soft I2C Write (0xAl) ' Address PCF8583 for reading R/W=1
seconds = Soft_I2C_Read(l) ' Read seconds byte
minutes = Soft I2C Read(1l) ' Read minutes byte
hours = Soft I2C Read(l) ' Read hours byte
_day = Soft I2C Read(l) ' Read year/day byte
~month = Soft I2C Read(0) ' Read weekday/month byte)
Soft I2C Stop() ' Issue stop signal}

end sub
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o Formats date and time
sub procedure Transform Time ()

seconds = ((seconds and O0xFO0) >> 4)*10 + (seconds and 0x0F) '
Transform seconds

minutes = ((minutes and O0xFO0) >> 4)*10 + (minutes and O0x0F) '
Transform months

hours = ((hours and 0xFO0) >> 4)*10 + (hours and 0x0F) '
Transform hours

year = (_day and 0xCO) >> 6 '
Transform year

_day = (( day and 0x30) >> 4)*10 + (_day and 0xOF) !
Transform day

~month = ((_month and 0x10) >> 4)*10 + (_month and OxO0F) '
Transform month
end sub

o Output values to Lcd
sub procedure Display Time ()

Led Chr(l, 6, ( day / 10) + 48) ' Print tens digit of day
variable

Led Chr(l, 7, (_day mod 10) + 48) ' Print oness digit of day
variable

Led Chr(l, 9, ( month / 10) + 48)

Lcd Chr (1,10, ( month mod 10) + 48)

Lcd Chr(1,15, year + 56) ' Print year vaiable + 8
(start from year 2008)

Lcd7Chr(2 6, (hours / 10) + 48)

Lcd Chr(2, 7, (hours mod 10) + 48)

Led Chr(2, 9, (minutes / 10) + 48)

Lcd7Chr(2 10, (minutes mod 10) + 48)

Led Chr (2,12, (seconds / 10) + 48)

Lcd Chr (2,13, (seconds mod 10) + 48)
end sub

P Performs project-wide init
sub procedure Init Main()

Soft I2C Init() ' Initialize Soft I2C communication
Led Init () ' Initialize Lcd
Lcd Cmd (LCD_CLEAR) ' Clear Lcd display
Lcd7Cmd(LCD CURSOR_OFF) ' Turn cursor off
Lcd Out (1,1, "Date:™) ' Prepare and output static text on Lcd
Lcd Chr(l1,8,":")
Lcdichr(l 11 ")
Lcd Out (2,1, "Time:")
Lcd Chr(2,8,":")
Lcdichr(2 11 ")
Led Out(1,12,"200M)
end sub
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e Main sub procedure

main:
Init Main() ' Perform initialization
while TRUE ' Endless loop
Read Time () ' Read time from RTC (PCF8583)
Transform Time () ' Format date and time
Display Time () ' Prepare and display on Lcd
wend
end.
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SOFTWARE SPI LIBRARY

The mikroBasic PRO for AVR provides routines for implementing Software SPI com-
munication. These routines are hardware independent and can be used with any
MCU. The Software SPI Library provides easy communication with other devices via

SPI: A/D converters, D/A converters, MAX7219, LTC1290, etc.

Library configuration:

- SPI to Master mode
- Clock value = 20 kHz.

- Data sampled at the middle of interval.

- Clock idle state low.

- Data sampled at the middle of interval.
- Data transmitted at low to high edge.

Note: The Software SPI library implements time-based activities, so interrupts need
to be disabled when using it.

External dependencies of Software SPI Library

The following variables
must be defined in all
projects using Software
SPI Library:

Description:

Example :

dim Chip Select as
sbit sfr external

Chip select line.

dim Chip Select as
sbit at PORTB.BO

dim SoftSpi SDI as

dim SoftSpi SDI as

sbit sfr external

sbit sfr external Data In line. sbit at PINB.B6

dim SoftSpi SDO as . dim SoftSpi SDO as

sbit sfr external Data Out line. sbit at PORTB.B5

dim SoftSpi CLK as . dim SoftSpi CLK as
L Clock line. -

sbit at PORTB.B7

dim
Chip Select Direction
as sbit sfr external

Direction of the Chip
Select pin.

dim
Chip Select Direction
as sbit at DDRB.BO

dim
SoftSpi SDI Direction
as sbit sfr external

Direction of the Data In
pin.

dim
SoftSpi SDI Direction
as sbit at DDRB.B6

dim
SoftSpi SDO Direction
as sbit sfr external

Direction of the Data Out
pin

dim
SoftSpi SDO Direction
as sbit at DDRB.B5

dim
SoftSpi CLK Direction
as sbit sfr external

Direction of the Clock pin.

dim
SoftSpi CLK Direction
as sbit at DDRB.R7

346 MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD




mikroBasic PRO for AVR

CHAPTER 6
Libraries

Library Routines

- Soft_SPI_Init
- Soft_ SPI_Read
- Soft_SPI_Write

Soft_SPI_Init

Prototype

sub procedure Soft SPI Init()

Returns

Nothing.

Description

Configures and initializes the software SPI module.

Requires

Global variables:

- Chip Select:
SoftSpi SDI:
SoftSpi SDO:
- SoftSpi CLK:
- Chip Select

Chip select line

Data in line

Data out line

Data clock line

~Direction: Direction of the Chip select pin
Softspi SDI Direction: Direction of the Data in pin

- SoftSpi SDO Direction: Direction of the Data out pin

Softspi CLK Direction: Direction of the Data clock pin

must be defined before using this function.

Example

' soft spi pinout definition

dim
dim
dim
dim
dim
dim
dim
dim

Chip Select
SoftSpi SDI
SoftSpi SDO
SoftSpi CLK
Chip Select

SoftSpi SDI
SoftSpi SDO
SoftSpi CLK .

as sbit at PORTB.BO
as sbit at PINB.B6
as sbit at PORTB.BS5
as sbit at PORTB.B7
Direction as sbit at DDRB.BO
Direction as sbit at DDRB.B6
Direction as sbit at DDRB.B5
Direction as sbit at DDRB.B7

' end of soft spi pinout definition

Soft SPI Init() ' Init Soft SPI
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Soft_ SPI_Read

Prototype sub function Soft SPI Read(dim sdata as byte) as word

Returns Byte received via the SPI bus.

This routine performs 3 operations simultaneously. It provides clock for the Soft-
ware SPI bus, reads a byte and sends a byte.

Description Parameters :

- sdata: data to be sent.

Requires Soft SPI must be initialized before using this function. See Soft_SPI_Init routine.

dim data read as byte
data send as byte

Exannﬂe ' Read a byte and assign it to data read variable
' (data send byte will be sent via SPI during the Read operation)
data read = Soft SPI Read(data send)

Soft_SPI_Write

Prototype sub procedure Soft SPI Write(dim sdata as byte)

Returns Nothing.

This routine sends one byte via the Software SPI bus.
Description |Parameters :

- sdata: data to be sent.

Requires Soft SPI must be initialized before using this function. See Soft_SPI_Init routine.

' Write a byte to the Soft SPI bus

Example Soft SPI Write (0xAA)
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Library Example

This code demonstrates using library routines for Soft SPI communication. Also, this
example demonstrates working with Microchip's MCP4921 12-bit D/A converter.

program Soft SPI

' DAC module connections

dim Chip Select as sbit at PORTB.O
SoftSpi CLK as sbit at PORTB.7
SoftSpi SDI as sbit at PINB.6 ' Note: Input signal
SoftSpi SDO as sbit at PORTB.5

dim Chip Select Direction as sbit at DDRB.O
SoftSpi CLK Direction as sbit at DDRB.7
SoftSpi SDI Direction as sbit at DDRB.6
SoftSpi SDO Direction as sbit at DDRB.5

' End DAC module connections

dim value as word

sub procedure InitMain ()

DDAO bit = 0 ' Set PAO pin as input
DDAl bit = 0 ' Set PAl pin as input
Chip Select =1 ' Deselect DAC
Chip Select Direction = 1 ' Set CS# pin as Output
Soft Spi Init() ' Initialize Soft SPI
end sub
' DAC increments (0..4095) --> output voltage (0..Vref)

sub procedure DAC Output (dim valueDAC as word)
dim temp as byte

Chip Select = 0 ' Select DAC chip

' Send High Byte

temp = word(valueDAC >> 8) and OxOF ' Store wvalueDAC[ 11..8] to
templ 3..0]

temp = temp or 0x30 ' Define DAC setting, see
MCP4921 datasheet

Soft SPI Write (temp) ' Send high byte via Soft SPI

' Send Low Byte

temp = valueDAC ' Store valueDA(C[ 7..0] to temp[ 7..0]
Soft SPI Write (temp) ' Send low byte via Soft SPI
Chip Select =1 ' Deselect DAC chip
end sub
main:
InitMain () !

Perform main initialization
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value = 2048 ' When program starts, DAC gives
! the output in the mid-range
while (TRUE) ' Endless loop
if ((PINAO bit) and (value < 4095)) then ' If PAO button is
pressed
Inc (value) ! increment value
else
if ((PINAl bit) and (value > 0)) then ' If PA1l button is
pressed
Dec (value) ' decrement value
end if
end if
DAC Output (value) ' Send value to DAC chip
Delay ms (1) ' Slow down key repeat pace
wend
end.
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SOFTWARE UART LIBRARY

The mikroBasic PRO for AVR provides routines for implementing Software UART
communication. These routines are hardware independent and can be used with
any MCU. The Software UART Library provides easy communication with other
devices via the RS232 protocol.

Note: The Software UART library implements time-based activities, so interrupts
need to be disabled when using it.

External dependencies of Software UART Library

The following variables
must be defined in all

as sbit sfr external

. . Description: Example :
projects using Software P P
UART Library:
dim Soft UART Rx Pin Receive line dim Soft UART Rx Pin
as sbit sfr external ' as sbit at PIND.BO
dim Soft UART Tx Pin e dim Soft UART Tx Pin
- —, Transmit line. - — -

as sbit at PORTD.B1

dim

Soft UART Rx Pin Dire
ction as sbit sfr
external

Direction of the Receive
pin.

dim

Soft UART Rx Pin Dire
ction as sbit at
DDRD.BO

dim

Soft UART Tx Pin Dire
ction as sbit sfr
external

Direction of the Transmit
pin.

dim

Soft UART Tx Pin Dire
ction as sbit at
DDRD.B1

Library Routines

- Soft_UART_Init

- Soft UART_Read
- Soft UART_Write
- Soft UART_Break
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Soft_UART _Init

sub function Soft UART Init (dim baud rate as longword, dim

Prokﬂype inverted as byte) as byte

- 2 - error, requested baud rate is too low
Returns - 1 - error, requested baud rate is too high
- 0 - successfull initialization

Configures and initializes the software UART module.
Parameters :

- baud rate: baud rate to be set. Maximum baud rate depends on the MCU’s
clock and working conditions.

- inverted: inverted output flag. When set to a non-zero value, inverted logic

Description | on output is used.

Software UART routines use Delay_Cyc routine. If requested baud rate is too
low then calculated parameter for calling belay Cyc exceeeds Delay Cyc argu-
ment range.

If requested baud rate is too high then rounding error of pelay cyc argument
corrupts Software UART timings.

Global variables:

Soft UART Rx Pin: Receiver pin

- Soft UART Tx Pin: Transmiter pin

Soft UART Rx Pin Direction: Direction of the Receiver pin
Soft UART Tx Pin Direction: Direction of the Transmiter pin

Requires

must be defined before using this function.

' Soft UART connections

dim Soft UART Rx Pin as sbit at PIND.BO

dim Soft UART Tx Pin as sbit at PORTD.B1

dim Soft UART Rx Pin Direction as sbit at DDRD.BO

E I dim Soft UART Tx Pin Direction as sbit at DDRD.BI
xample ' Soft UART connections

' Initialize Software UART communication on pins Rx, Tx, at 9600
bps
Soft UART Init (9600, 0)
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Soft_UART Read

Prototype sub function Soft UART Read(dim byref error as byte) as byte
Returns Byte received via UART.
The function receives a byte via software UART.
This is a blocking function call (waits for start bit). Programmer can unblock it by
calling Soft_ UART_Break routine.
i Parameters :
Description
- error: Error flag. Error code is returned through this variable.
- 0 - no error
- 1 - stop bit error
- 255 - user abort, Soft UART_Break called
Requires Software UART must be initialized before using this function. See the
9 Soft_UART_Init routine.
dim data as byte
error as byte
' wait until data 1is received
do
E I data = Soft Uart Read(error)
xample loop until (error = 0)
' Now we can work with data:
if (data) then
end if
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Soft UART_Write

Prototype sub procedure Soft UART Write (udata as byte)

Returns Nothing.

This routine sends one byte via the Software UART bus.
Description |Parameters :

- udata: data to be sent.

Software UART must be initialized before using this function. See the
Soft_ UART _Init routine.

Requires . - . o
q Be aware that during transmission, software UART is incapable of receiving
data — data transfer protocol must be set in such a way to prevent loss of infor-
mation.
dim some byte as byte
Example ' Write a byte via Soft Uart

some byte = 0xO0A
Soft Uart Write (some byte)
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Soft_ UART_Break

Prototype |[sub procedure Soft UART Break()
Returns Nothing.
Soft_ UART_Read is blocking routine and it can block the program flow. Call this
routine from interrupt to unblock the program execution. This mechanism is sim-
e ilar to WDT.
Description
Note: Interrupts should be disabled before using Software UART routines again
(see note at the top of this page).
Requires Nothing.
dim datal, error, counter as byte
sub procedure TimerOOverflow ISR() org 0x12
counter = 0
if (counter >= 20) then
Soft UART Break()
counter = 0 ' reset counter
else
Inc (counter) ' increment counter
end if
end sub
main:
TOIEO bit =1 ' Timer0 overflow interrupt
enable
TCCRO bit =5 ' Start timer with 1024
Example prescaler
SREG I bit = 0 ' Interrupt disable
Soft UART Init (9600)
Soft UART Write (0x55)
' try Soft UART Read with blocking prevention mechanism
SREG I bit =1 ' Interrupt enable
datal = Soft UART Read(&error)
SREG I bit = 0 ' Interrupt disable
end.
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Library Example

This example demonstrates simple data exchange via software UART. If MCU is

connected to the PC, you can test the example from the mikroBasic PRO for AVR
USART Terminal Tool.

program Soft UART
' Soft UART connections
dim Soft UART Rx Pin as sbit at PIND.BO
Soft UART Tx Pin as sbit at PORTD.B1
Soft UART Rx Pin Direction as sbit at DDRD.BO
Soft UART Tx Pin Direction as sbit at DDRD.B1
End Soft UART connections

dim error , counter, byte read as byte ' Auxiliary variables
main:
DDRB = O0OxFF ' Set PORTB as output (error signalization)
PORTB = 0 !

No error

error = Soft UART Init (9600, 0) ' Initialize Soft UART at 9600 bps
if (error > 0) then

PORTB = error '
while TRUE
nop !
wend
end if
Delay ms (100)

Signalize Init error

Stop program

for counter = "z" to "A" step -1 ' Send bytes from 'z' downto 'A'
Soft UART Write (counter)

Delay ms (100)
next counter

while TRUE ' Endless loop

byte read = Soft UART Read(error ) ' Read byte, then test error flag
if (error <> 0) then ' If error was detected

PORTB error ! signal it on PORTB
else

Soft UART Write (byte read) !
ed, return byte read
end if
wend
end.

If error was not detect-
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SOUND LIBRARY

The mikroBasic PRO for AVR provides a Sound Library to supply users with routines
necessary for sound signalization in their applications. Sound generation needs
additional hardware, such as piezo-speaker (example of piezo-speaker interface is
given on the schematic at the bottom of this page).

External dependencies of Sound Library

The following variables
must be defined in all
projects using Sound

Library:

Description: Example :

dim Sound Play Pin as
sbit sfr external

dim Sound Play Pin as

Sound output pin. sbit at PORTC.B3

dim dim

Sound Play Pin Direct [Direction of the Sound out-|sound Play Pin Direct
ion as sbit sfr putpm_ ion as sbit at
external DDRC.B3

Library Routines

- Sound_Init
- Sound_Play
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Sound_Init

Prototype sub procedure Sound Init ()

Returns Nothing.

Description |Configures the appropriate MCU pin for sound generation.

Global variables:

- sound Play Pin: Sound output pin

Requires N .
q - sound Play Pin Direction: Direction of the Sound output pin
must be defined before using this function.
' Sound library connections
dim Sound Play Pin as sbit at PORTC.B3
dim Sound Play Pin Direction as sbit at DDRC.B3
Example ' End of Sound library connections
Sound Init ()
Sound_Play
sub procedure Sound Play(dim freq in Hz as word, dim duration ms
Prototype - - -
as word)
Returns Nothing.
Generates the square wave signal on the appropriate pin.
i Parameters :
Description

- freq in Hz: signal frequency in Hertz (Hz)
- duration ms: signal duration in miliseconds (ms)

In order to hear the sound, you need a piezo speaker (or other hardware) on
Requires designated port. Also, you must call Sound_Init to prepare hardware for output
before using this function.

' Play sound of 1KHz in duration of 100ms

Example Sound_Play (1000, 100)
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Library Example

The example is a simple demonstration of how to use the Sound Library for playing
tones on a piezo speaker.

program Sound

' Sound connections
dim Sound Play Pin as sbit at PORTC.B3
dim Sound Play Pin direction as sbit at DDRC.B3
' End Sound connections

sub

end

sub

end

sub

end

sub

end

sub

end

sub

end

sub

end

sub
dim

procedure Tonel
Sound Play (500,
sub

procedure Tone?2
Sound Play (555,
sub

procedure Tone3
Sound Play (625,
sub

procedure Melody
Tonel () Tone2()
Tonel () Tone2 ()
Tonel () Tone2()
Tonel () Tone2()
Tonel () Tone2 ()
Tone3 () Tone3 ()
sub

procedure ToneA
Sound Play (1250,
sub

procedure ToneC
Sound Play (1450,
sub

procedure ToneE
Sound Play (1650,
sub

200)

200)

200)

Tone3
Tone3
Tone3
Tone3
Tone3
Tone?2

20)

20)

80)

procedure Melody2

counter as byte
for counter =

' Frequency =

' Frequency =

' Frequency =

500Hz,

555Hz,

625Hz,

' Plays the melody

Tone3 ()
Tone3 ()

Tone3 ()

Tone?2 ()

Tonel ()

Duration = 200ms
Duration = 200ms
Duration = 200ms

"Yellow house"

' Tones used in Melody2 function

' Plays Melody2

9 to 1 step -1
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ToneA
ToneC
ToneE
next counter
end sub

main:
DDRB = 0x00
Delay ms (2000)
Sound Init ()

Sound Play (2000,
ond

while TRUE

if (PINB.7 <> 0)

Tonel ()
while
nop
wend

end if

if (PINB.6 <> 0)

Tone?2 ()
while
nop
wend
end if

if (PINB.5 <> 0)

Tone3 ()
while
nop
wend
end if

if (PINB.4 <> 0)

Melody?2 ()
while

nop
wend
end if

if (PINB.3 <> 0)

Melody ()
while
nop
wend
end if
wend
end.

1000)

then

(PINB.7 <> 0)

then

(PINB.6 <> 0)

then

(PINB.5 <> 0)

then

(PINB.4 <> 0)

then

(PINB. 3)

v

v

Configure PORTB as input
Initialize sound pin
1 sec-

Play starting sound, 2kHz,

' endless loop
If PORTB.7 is pressed play Tonel

Wait for button to be released

If PORTB.6 is pressed play Tone?2

Wait for button to be released

If PORTB.5 is pressed play Tone3

Wait for button to be released

If PORTB.4 is pressed play Melody2

Wait for button to be released

If PORTB.3 is pressed play Melody

Wait for button to be released
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HW Connection

PIE

PIEZO —
SPEAKER

L
VCC -

@]

LI
g

(.—

i

. . |nn|:| mc—:lmh—:lmnl:
e
I PORTB.B3 L L

FB.3
PEA
PE.S
PEE
PE.T

<’ PORTB.B4
1 0

‘.’ PORTB.BS |
4 o

}j_ll_ll_ll_ll_ll_ll_ll_ll_ll_l

T
i

GND

9LVOINLY

IlI-iilI:lI:II:II:II:II:II:II:II:

SHCILLATON
P -

_'_c PORTB.B6
8
KTAL1

"3——!——' PORTB.BT

E
o W s s s s s | _

a

0

%]
|_||_||_||_|T|_u_n_u_|

Example of Sound Library sonnection

MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD 361



CHAPTER 6
Libraries mikroBasic PRO for AVR

SPI LIBRARY

mikroBasic PRO for AVR provides a library for comfortable with SPI work in Master mode. The
AVR MCU can easily communicate with other devices via SPI: A/D converters, D/A converters,
MAX7219, LTC1290, etc.

Note: Some AVR MCU's have alternative SPI ports, which SPI signals can be redirected to by
setting or clearing SPIPS (SPI Pin Select) bit of the MCUCR register. Please consult the appro-
priate datasheet.

Library Routines

- SPI1_Init

- SPI1_Init_Advanced
- SPI1_Read

- SPI1_Write

- SPI1_Init

SPI1_lInit

Prototype sub procedure SPI1 Init()

Returns Nothing.

This routine configures and enables SPI module with the following settings:

- master mode

- 8 bit data transfer

- most significant bit sent first

- serial clock low when idle

- data sampled on leading edge
- serial clock = fosc/4

Description

Requires MCU must have SPI module.

' Initialize the SPI module with default settings

Example SPT1 Tnit ()
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SPI1_Init_Advanced

Prototvpe sub procedure SPI1 Init Advanced(dim mode, fcy div,
yp clock and edge as byte)
Returns Nothing.
Configures and initializes SPI. SPI1_Init_Advanced or SPI1_Init needs to be
called before using other functions of SPI Library.
Parameters mode, fcy div and clock_and_edge determine the work mode for
SPI, and can have the Tollowing values:
i Predefined libra
Mask Description y
const
SPI mode constants:
0x10 Master mode _SPI _MASTER
0x00 Slave mode _SPI SLAVE
Clock rate select constants:
0x00 Sck Fosc/4, Master mode _SPI_FCY DIV4
0x01 Sck = Fosc/l1l6, Master mode _SPI _FCY DIV16
0x02 Sck = Fosc/64, Master mode _SPI_FCY DIV64
Descnpﬂon 0x03 Sck = Fosc/128, Master mode _SPI_FCY DIV128
0x04 Sck Fosc/2, Master mode _SPI_FCY DIV2
0x05 Sck = Fosc/8, Master mode SPI FCY DIVS8
0x06 Sck = Fosc/32, Master mode _SPI_FCY DIV32
SPI clock polarity and phase constants:
Clock idle level is low, sample
0x00 o SPI_CLK LO LEADING
on rising edge - - - =
Clock idle level is low, sample
0x04 , SPI CLK LO TRAILING
on falling edge - - - =
0x08 Clock idle leyel is high, sample SPT CLK HI LEADING
on rising edge - - - =
lock idle level is high 1
oxoc | Clock idle level is high, sample SPI CLK HI TRAILING
on falling edge - - - =
Note: Some SPI clock speeds are not supported by all AVR MCUs and these
are: rosc/2, Fosc/8, Fosc/32.Please consult appropriate datasheet.
Requires MCU must have SPI module.
' Set SPI to the Master Mode, clock = Fosc/32 , clock idle level
Example is high, data sampled on falling edge:
P SPI1 Init Advanced( SPI MASTER, SPI FCY DIV32,
_SPI CLK HI TRAILING);
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SPI1_Read
Prototype sub function SPI1 Read(dim buffer as byte) as byte
Returns Received data.
Reads one byte from the SPI bus.
i Parameters :
Description
- buffer: dummy data for clock generation (see device Datasheet for SPI
modules implementation details)
Requires SPI module must be initialized before using this function. See SPI1_Init and
q SPI1_Init_Advanced routines.
' read a byte from the SPI bus
Example dim take, dummyl as byte
take = SPI1 Read (dummyl)
SPI1_Write
Prototype sub procedure SPI1 Write(dim wrdata as byte)
Returns Nothing.
Writes byte via the SPI bus.
Description |Parameters :
-wrdata: data to be sent
Requires SPI module must be initialized before using this function. See SPI1_Init and
q SPI1_Init_Advanced routines.
' write a byte to the SPI bus
dim buffer as byte
Example
SPI1 Write (buffer)
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Library Example

The code demonstrates how to use SPI library functions for communication between
SPI module of the MCU and Microchip's MCP4921 12-bit D/A converter

program SPI

' DAC module connections
dim Chip Select as sbit at PORTB.BO

Chip Select Direction as sbit at DDRB.
' End DAC module connections

dim value as word

sub procedure InitMain()
DDAO bit 0 '
DDAl bit 0 '
Chip Select 1 !
Chip Select Direction 1 !
SPI1 Init() '
end sub

' DAC increments (0..4095)

--> output voltage

BO

Set PAO pin as input
Set PAl pin as input
Deselect DAC

Set CS# pin as Output
Initialize SPI1 module

(0..Vref)

sub procedure DAC Output (dim valueDAC as word)

dim temp as byte
Chip Select 0
' Send High Byte

temp = word(valueDAC >> 8) and OxO0F '
temp[ 3..0]
temp = temp or 0x30 ' Define DAC setting,

SPI1 Write (temp)

' Send Low Byte
temp valueDAC !
SPI1 Write (temp) !

Store wvalueDAC[ 7.
Send low byte via

.0]

' Select DAC chip
Store wvalueDAC[ 11..8] to
see MCP4921 datasheet
' Send high byte wvia SPI

to templ 7..0]

SPI

' Deselect DAC chip

' Endless loop
If PAO button is

! increment value

Chip Select =1
end sub
main:
InitMain () ' Perform main initialization
value = 2048 ' When program starts, DAC gives
! the output in the mid-range
while TRUE
if ((PINAO bit) and (value < 4095)) then '
pressed
Inc (value)
else
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if ((PINAl bit) and (value > 0)) then ' If PAl button is pressed
Dec (value) ! decrement value
end if
end if
DAC Output (value) ' Send value to DAC chip
Delay ms (1) ' Slow down key repeat pace
wend
end.

HW Connection

All lines are disconnected

Vref line is connected
Vec line is connected

Y
Vil
us CN10
vee 1 = —
oot ‘ool oo | CORNECTOR
— ]
SPIMOSI 4 E::'“ :f% [_Gho
MCP 4921 = COnz
{lPa.0 7 1
i ]
[ i
i %
NFes :> 1
.
[Jrer
o—E g i
Wi WCC GND
_CECILLATOR _L_[ GND g i'l_
= i ]> %
. KTAL1

E - %
i (=2} i
i ]
[ I
i I
[ I

SPI HW connection
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SPI ETHERNET LIBRARY

The £nC28T60 is a stand-alone Ethernet controller with an industry standard Serial
Peripheral Interface (SPI™). It is designed to serve as an Ethernet network interface
for any controller equipped with SPI.

The enc28J60 meets all of the IEEE 802.3 specifications. It incorporates a number
of packet filtering schemes to limit incoming packets. It also provides an internal
DMA module for fast data throughput and hardware assisted IP checksum calcula-
tions. Communication with the host controller is implemented via two interrupt pins
and the SPI, with data rates of up to 10 Mb/s. Two dedicated pins are used for LED
link and network activity indication.

This library is designed to simplify handling of the underlying hardware (Enc28J60).
It works with any AVR MCU with integrated SPI and more than 4 Kb ROM memory.

SPI Ethernet library supports:

- |IPv4 protocol.

- ARP requests.

- ICMP echo requests.

- UDP requests.

- TCP requests (no stack, no packet reconstruction).
- packet fragmentation is NOT supported.

Note: Prior to calling any of this library routines, Spi_Rd_Ptr needs to be initialized
with the appropriate SPI_Read routine.

Note: The appropriate hardware SPI module must be initialized before using any of
the SPI Ethernet library routines. Refer to SPI Library.
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External dependencies of SPI Ethernet Library

The following variables
must be defined in all
projects using SPI Eth-
ernet Library:

Description:

Example :

dim SPI Ethernet CS
as sbit sfr external

ENC28J60 chip select pin.

dim SPI Ethernet CS
as sbit at PORTB.B4

dim SPI Ethernet RST
as sbit sfr external

ENC28J60 reset pin.

dim SPI Ethernet RST
as sbit at PORTB.B5

dim

SPI Ethernet CS Direc
tion as sbit sfr
external

Direction of the ENC28J60
chip select pin.

dim

SPI Ethernet CS Direc
tion as sbit at

DDRB. B4

dim

SPI Ethernet RST Dire
ction as sbit sfr
external

Direction of the ENC28J60
reset pin.

dim

SPI Ethernet RST Dire
ction as sbit at
DDRB.B5

The following routines must be defined in all project
using SPI Ethernet Library:

Description:

Example :

regqlength as word)

sub function Spi Ethernet UserTCP(dim remoteHost

as word

as “byte,
dim
remotePort as word, TCP request
dim handler.
localPort as word,
dim

Refer to the
library example
at the bottom
of this page

for code
implementation.

sub function Spi Ethernet UserUDP(dim remoteHost

as “byte,

dim remotePort
as word,

dim destPort as
word,

dim reglength as
word) as word

UDP request
handler.

Refer to the
library example
at the bottom
of this page

for code
implementation.
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Library Routines

- Spi_Ethernet_Init

- Spi_Ethernet_Enable

- Spi_Ethernet_Disable

- Spi_Ethernet_doPacket

- Spi_Ethernet_putByte

- Spi_Ethernet_putBytes

- Spi_Ethernet_putString

- Spi_Ethernet_putConstString
- Spi_Ethernet_putConstBytes
- Spi_Ethernet_getByte

- Spi_Ethernet_getBytes

- Spi_Ethernet_UserTCP

- Spi_Ethernet_UserUDP

Spi_Ethernet _Init

sub procedure Spi Ethernet Init(dim mac as “byte, dim ip as

PrOtOtype “byte, dim fullDuplex as byte)

Returns Nothing.
This is MAC module routine. It initializes Enc28J60 controller. This function is
internaly splited into 2 parts to help linker when coming short of memory.
ENC28J60 controller settings (parameters not mentioned here are set to default):
- receive buffer start address : 0x0000.
- receive buffer end address : 0x192aD.
- transmit buffer start address: 0x192F.
- transmit buffer end address : 0x1FFF.
- RAM buffer read/write pointers in auto-increment mode.

.. - receive filters set to default: CRC + MAC Unicast + MAC Broadcast in OR mode.
Description

- flow control with TX and RX pause frames in full duplex mode.

- frames are padded to ¢0 bytes + CRC.

- maximum packet size is set to 1518.

- Back-to-Back Inter-Packet Gap: 0x15 in full duplex mode; 0x12 in half duplex mode.

- Non-Back-to-Back Inter-Packet Gap: 0x0012 in full duplex mode; 0x0c12 in
half duplex mode.

- Collision window is set to 43 in half duplex mode to accomodate some
ENC28J60 revisions silicon bugs.

- CLKOUT output is disabled to reduce EMI generation.

- half duplex loopback disabled.

- LED configuration: default (LEDA-link status, LEDB-link activity).
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Parameters:

- mac: RAM buffer containing valid MAC address.

- ip: RAM buffer containing valid IP address.

- fullbuplex: ethernet duplex mode switch. Valid values: 0 (half duplex mode)
and 1 (full duplex mode).

Description

Requires The appropriate hardware SPI module must be previously initialized.

const Spi Ethernet HALFDUPLEX = 0
const Spi Ethernet FULLDUPLEX = 1

myMacAddr as bytel 6] ' my MAC address
myIpAddr as bytel 4] ' my IP addr
myMacAddr[ 0] = 0x00
myMacAddr[ 1] = 0x14
myMacAddr][ 2] = 0xA5
myMacAddr[ 3] = 0x76
Exan"ﬂe myMacAddr] 4] = 0x19
myMacAddr[ 5] = O0x3F
myIpAddr| 0] = 192
myIpAddr| 1] = 168
myIpAddr] 2] = 20
myIpAddr| 3] = 60
Spi Init ()

Spi Ethernet Init (PORTC, 0, PORTC, 1, myMacAddr, myIpAddr,
SpiiEthernetiFULLDUPLEX)
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Spi_Ethernet_Enable

Prototype sub procedure Spi Ethernet Enable(dim enFlt as byte)

Returns Nothing.

This is MAC module routine. This routine enables appropriate network traffic on
the ENC28J60 module by the means of it's receive filters (unicast, multicast,
broadcast, crc). Specific type of network traffic will be enabled if a correspon-
ding bit of this routine's input parameter is set. Therefore, more than one type of
network traffic can be enabled at the same time. For this purpose, predefined
library constants (see the table below) can be ORed to form appropriate input
value.

Parameters:

- enF1t: network traffic/receive filter flags. Each bit corresponds to the
appropriate network traffic/receive filter:

Bit | Mask Description Predefined library const
MAC Broadcast traffic/receive filter
0 0201 [flag. When set, MAC broadcast Spi Ethernet BROADCAST
traffic will be enabled.
Description MAC Multicast traffic/receive filter

1 0x02 |flag. When set, MAC multicast traf- | Spi Ethernet MULTICAST
fic will be enabled.

2 0x04 |not used none
3 0x08 [not used none
4 0x10 |not used none

CRC check flag. When set, pack-
5 0220 [ets with invalid CRC field will be Spi_Ethernet CRC
discarded.

6 0x40 |not used none

MAC Unicast traffic/receive filter
7 0x80 |flag. When set, MAC unicast traffic [Spi Ethernet UNICAST
will be enabled.
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Note: Advance filtering available in the Enc28760 module such as pattern
Match, Magic Packet and Hash Table can not be enabled by this routine.
Additionaly, all filters, except CRC, enabled with this routine will work in OR
mode, which means that packet will be received if any of the enabled filters
. accepts it.

Description
Note: This routine will change receive filter configuration on-the-fly. It will not, in
any way, mess with enabling/disabling receive/transmit logic or any other part of
the Enc28760 module. The Enc28J60 module should be properly cofigured by
the means of Spi_Ethernet_Init routine.

Requires Ethernet module has to be initialized. See Spi_Ethernet_Init.

Spi Ethernet Enable (Spi Ethernet CRC or Spi Ethernet UNICAST) '

Example enable CRC checking and Unicast traffic

Spi_Ethernet_Disable

Prototype sub procedure Spi Ethernet Disable (dim disFlt as byte)

Returns Nothing.

This is MAC module routine. This routine disables appropriate network traffic on
the ENC28J60 module by the means of it's receive filters (unicast, multicast,
broadcast, crc). Specific type of network traffic will be disabled if a correspon-
ding bit of this routine's input parameter is set. Therefore, more than one type of
network traffic can be disabled at the same time. For this purpose, predefined
.. library constants (see the table below) can be ORed to form appropriate input
Description value.

Parameters:

- disF1t: network traffic/receive filter flags. Each bit corresponds to the
appropriate network traffic/receive filter:
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Bit [ Mask Description Predefined library const

MAC Broadcast traffic/receive filter
0 | 0x01 [flag. When set, MAC broadcast traffic[Spi Ethernet BROADCAST
will be disabled.

MAC Multicast traffic/receive filter
1 | 0x02 [flag. When set, MAC multicast traffic |Spi Ethernet MULTICAST
will be disabled.

2 | 0x04 |not used none
3 | 0x08 |not used none
4 10x10 |not used none

CRC check flag. When set, CRC check
5 | 0220 |will be disabled and packets with invalid | Spi Ethernet CRC
CRC field will be accepted.

6 | 0x40 |not used none

Description

MAC Unicast traffic/receive filter flag.
7 | 0x80 |When set, MAC unicast traffic will be |Spi Ethernet UNICAST
disabled.

Note: Advance filtering available in the Enc28760 module such as pattern
Match, Magic Packet and Hash Table can not be disabled by this routine.

Note: This routine will change receive filter configuration on-the-fly. It will not, in
any way, mess with enabling/disabling receive/transmit logic or any other part of
the Enc28360 module. The Enc28J60 module should be properly cofigured by
the means of Spi_Ethernet_Init routine.

Requires Ethernet module has to be initialized. See Spi_Ethernet_Init.

Spi Ethernet Disable(Spi Ethernet CRC or Spi Ethernet UNICAST) '

Example disable CRC checking and Unicast traffic
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Spi_Ethernet_doPacket

Prototype sub function Spi Ethernet doPacket () as byte

- 0 - upon successful packet processing (zero packets received or received
packet processed successfully).

- 1 - upon reception error or receive buffer corruption. Enc28760 controller

Returns needs to be restarted.

- 2 - received packet was not sent to us (not our IP, nor IP broadcast address).

- 3 - received IP packet was not IPv4.

- 4 - received packet was of type unknown to the library.

This is MAC module routine. It processes next received packet if such exists.
Packets are processed in the following manner:

- ARP & ICMP requests are replied automatically.

- upon TCP request the Spi_Ethernet_UserTCP function is called for further
processing.

- upon UDP request the Spi_Ethernet_UserUDP function is called for further
processing.

Description

Note: spi Ethernet dopacket must be called as often as possible in user's code.

Requires Ethernet module has to be initialized. See Spi_Ethernet_Init.

while TRUE

Example Spi Ethernet doPacket() ' process received packets

wend
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Spi_Ethernet_putByte

Prototype sub procedure Spi Ethernet putByte (dim v as byte)
Returns Nothing.
This is MAC module routine. It stores one byte to address pointed by the cur-
rent ENC28J60 write pointer (EWrPT).
Description Parameters:
- v: value to store
Requires Ethernet module has to be initialized. See Spi_Ethernet_Init.
dim data as byte
Example

Spi Ethernet putByte(data) ' put an byte into ENC28J60 buffer

Spi_Ethernet_putBytes

Prototype sub procedure Spi Ethernet putBytes(dim ptr as “byte, dim n as byte)
Returns Nothing.
This is MAC module routine. It stores requested number of bytes into Enc28760
RAM starting from current enc28J60 write pointer (EwrpT) location.
Description |Parameters:
- ptr: RAM buffer containing bytes to be written into ENC28J60 RAM.
- n: number of bytes to be written.
Requires Ethernet module has to be initialized. See Spi_Ethernet_Init.
dim
buffer as bytel 17]
Example buffer = "mikroElektronika"
Spi Ethernet putBytes(buffer, 16) ' put an RAM array into

ENC28J60 buffer
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Spi_Ethernet_putConstBytes

sub procedure Spi Ethernet putConstBytes(const ptr as “byte, dim

Prototype n as byte)

Returns Nothing.

This is MAC module routine. It stores requested number of const bytes into
ENC28J60 RAM starting from current enc28J60 write pointer (EwrpT) location.

Description |Parameters:

- ptr: const buffer containing bytes to be written into Enc28s60 RAM.
- n: number of bytes to be written.

Requires Ethernet module has to be initialized. See Spi_Ethernet_Init.

const
buffer as bytel 17]

Example buffer = "mikroElektronika"

Spi Ethernet putConstBytes (buffer, 16) ' put a const array into
ENC28J60 buffer

Spi_Ethernet_putString

Prototype sub function Spi Ethernet putString(dim ptr as “byte) as word

Returns Number of bytes written into znc28560 RAM.

This is MAC module routine. It stores whole string (excluding null termination) into
ENC28J60 RAM starting from current Enc28J60 write pointer (EwreT) location.

Description Parameters:

- ptr: string to be written into ENC28J60 RAM.

Requires Ethernet module has to be initialized. See Spi_Ethernet_Init.

dim
buffer as string] 16]

Example buffer = "mikroElektronika"
Spi Ethernet putString(buffer) ' put a RAM string into ENC28J60
buffer
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Spi_Ethernet_putConstString

Prototype sub function Spi Ethernet putConstString(const ptr as “byte) as word
Returns Number of bytes written into ENC28J60 RAM.
This is MAC module routine. It stores whole const string (excluding null termina-
tion) into Enc28J60 RAM starting from current enc28760 write pointer (EWRPT)
location.
Description
Parameters:
- ptr: const string to be written into ENC28J60 RAM.
Requires Ethernet module has to be initialized. See Spi_Ethernet_Init.
const
buffer as string| 16]
Example buffer = "mikroElektronika"
Spi Ethernet putConstString(buffer) ' put a const string into
ENC28J60 buffer

Spi_Ethernet_getByte

Prototype sub function Spi Ethernet getByte() as byte

Returns Byte read from ENC28J60 RAM.

Describtion This is MAC module routine. It fetches a byte from address pointed to by cur-

P rent ENC28J60 read pointer (ERDPT).

Requires Ethernet module has to be initialized. See Spi_Ethernet_Init.
dim buffer as byte<>

Exan“ﬂe gﬁ%fer = Spi Ethernet getByte() ' read a byte from ENC28J60
buffer
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Spi_Ethernet_getBytes

sub procedure Spi Ethernet getBytes(dim ptr as “byte, dim addr as
Prototype pros s _getBytes| " v
word, dim n as byte)
Returns Nothing.
This is MAC module routine. It fetches equested number of bytes from
ENC28J60 RAM starting from given address. If value of 0xrrrr is passed as the
address parameter, the reading will start from current Enc28J60 read pointer
(erDPT) location.
Description
P Parameters:
- ptr: buffer for storing bytes read from enc28760 RAM.
- addr: ENC28J60 RAM start address. Valid values: 0. .8192.
- n: number of bytes to be read.
Requires Ethernet module has to be initialized. See Spi_Ethernet_Init.
dim
buffer as byte[ 16]
Example o
Spi Ethernet getBytes (buffer, 0x100, 16) ' read 16 bytes,
starting from address 0x100
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Spi_Ethernet_UserTCP

sub function Spi Ethernet UserTCP(dim remoteHost as “byte, dim
Prototype remotePort as word, dim localPort as word, dim reglLength as word)
as word
Returns - 0 - there should not be a reply to the request.
- Length of TCP/HTTP reply data field - otherwise.
This is TCP module routine. It is internally called by the library. The user
accesses to the TCP/HTTP request by using some of the Spi_Ethernet_get rou-
tines. The user puts data in the transmit buffer by using some of the Spi_Ether-
net_put routines. The function must return the length in bytes of the TCP/HTTP
reply, or O if there is nothing to transmit. If there is no need to reply to the
TCP/HTTP requests, just define this function with return(0) as a single state-
ment.
Description |Parameters:
- remoteHost : client's IP address.
- remotePort: client's TCP port.
- localport: port to which the request is sent.
- regLength: TCP/HTTP request data field length.
Note: The function source code is provided with appropriate example projects.
The code should be adjusted by the user to achieve desired reply.
Requires Ethernet module has to be initialized. See Spi_Ethernet_Init.
This function is internally called by the library and should not be called by the
Example ,
user's code.
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Spi_Ethernet_UserUDP

sub function Spi Ethernet UserUDP(dim remoteHost as “byte, dim
Prototype remotePort as word, dim destPort as word, dim reglength as word)
as word

- 0 - there should not be a reply to the request.

Returns - Length of UDP reply data field - otherwise.
This is UDP module routine. It is internally called by the library. The user
accesses to the UDP request by using some of the Spi_Ethernet_get routines.
The user puts data in the transmit buffer by using some of the Spi_Ethernet_put
routines. The function must return the length in bytes of the UDP reply, or O if
nothing to transmit. If you don't need to reply to the UDP requests, just define
this function with a return(0) as single statement.

Description Parameters:

- remoteHost : client's IP address.

- remotePort: client's port.

- destport: port to which the request is sent.
- regLength: UDP request data field length.

Note: The function source code is provided with appropriate example projects.
The code should be adjusted by the user to achieve desired reply.

Requires Ethernet module has to be initialized. See Spi_Ethernet_Init.

This function is internally called by the library and should not be called by the

Example
P user's code.
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Library Example

This code shows how to use the AVR mini Ethernet library :

- the board will reply to ARP & ICMP echo requests

- the board will reply to UDP requests on any port :
returns the request in upper char with a header made of remote host IP &
port number

- the board will reply to HTTP requests on port 80, GET method with pathnames :

/ will return the HTML main page

/s will return board status as text string

N0 ... t7 will toggle P3.b0 to P3.b7 bit and return HTML main page
all other requests return also HTML main page.

Main program code:

include eth enc28j60 utils 'this is where you should write implemen-
tation for UDP and HTTP

Thdhkrkhhhkhkhkkhhkhkhkrkhkhhhhkhhkrkhhrkhhkhrkkhhkhkhrxkkhx

'* RAM variables

"X

Thhahkhkhkhhkrhkhkkhkhrhkhkhkkhkhkrhkhkhkhrhhkhkhkhxkhkhkk*x*xkx*

dim myMacAddr as byte] 6] ' my MAC address
myIpAddr as byte 4] ' my IP address
gwIpAddr as byte 4] ' gateway (router) IP address
ipMask as byte[ 4] ' network mask (for example
255.255.255.0)
dnsIpAddr as byte[ 4] ' DNS server IP address

' mE ehternet NIC pinout
SPI Ethernet Rst as sbit at PORTB.B4
SPI Ethernet CS as sbit at PORTB.BS
SPI Ethernet Rst Direction as sbit at DDRB.B4
SPI Ethernet CS Direction as sbit at DDRB.B5
' end ethernet NIC definitions

dim i as word

main:
' set PORTC as input
DDRC = 0
' set PORTD as output
DDRD = OxFF

httpCounter = 0
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myMacAddr[ 0] = 0x00
myMacAddr|[ 1] = 0x14
myMacAddr[ 2] = 0xA5
myMacAddr] 3] = 0x76
myMacAddr{ 4] = 0x19
myMacAddr] 5] = O0x3F
myIpAddr[ 0] = 192
myIpAddr{ 1] = 168
myIpAddr 2] = 20
myIpAddr[ 3] = 60
gwIpAddr 0] = 192
gwIpAddr[ 1] = 168
gwIpAddr] 2] = 20
gwIpAddr 3] = 6
ipMask[ 0] = 255
ipMask[ 1] = 255
ipMask[ 2] = 255
ipMaskl 3] = 0
dnsIpAddr 0] = 192
dnsIpAddr 1] = 168
dnsIpAddr[ 2] = 20
dnsIpAddr 3] = 1

] *

! * starts ENC28J60 with
! * reset bit on PORTB.B4
! * CS bit on PORTB.B5

! * my MAC & IP address

! * full duplex

] *

SPI1 Init Advanced( SPI MASTER, SPI FCY DIV2, SPI CLK LO LEAD-
ING)

SPI Rd Ptr = @SPI1 Read

SPI Ethernet UserTCP Ptr = @SPI Ethernet UserTCP

SPI Ethernet UserUDP Ptr = @SPI Ethernet UserUDP

SPI Ethernet Init (myMacAddr, myIpAddr, SPI Ethernet FULLDUPLEX)

' dhcp will not be used here, so use preconfigured addresses
SPI Ethernet confNetwork (ipMask, gwIpAddr, dnsIpAddr)

while TRUE ' do forever
SPI Ethernet doPacket () ' process incoming Ethernet packets
(E3
'* add your stuff here if needed
'* SPI Ethernet doPacket () must be called as often as possible
'* otherwise packets could be lost
T x

wend

end.
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Module eth_enc28j60_utils code:

module eth enc28j60 utils

Thhkhkkhhdhhhkhhhkhhdhhhhhhhhhkhh ok hhkhhhkhkrkhkhhkhhdhkrhkhrhhkhkhhkhhkrkhhhkhrkxkhx

'* ROM constant strings
Thhhkhkhkhhkhhkrhhhkhkhkhhhk kA hhkhkhkhkhkhk kA hkhkhkhkhhkhk kA hhkhkhkhhkhkkhkrhhkhkkhkkhhk k%

const httpHeader as stringf 30] = "HTTP/1.1 200 OK"+chr (10)+"Content-
type: " ' HTTP header

const httpMimeTypeHTML as string| 13] = "text/html"+chr (10) +chr (10)
' HTML MIME type

const httpMimeTypeScript as string[ 14] =
"text/plain"+chr (10) +chr (10) ' TEXT MIME type

const httpMethod as string 5]

Tx

”GET /"

'* web page, splited into 2 parts

'* when coming short of ROM, fragmented data is handled more effi-
ciently by linker

1%

'* this HTML page calls the boards to get its status, and builds

itself with javascript
1%

const indexPage as string] 513] =
"<meta http-equiv=" + Chr(34) + "refresh" +
Chr (34) + " content=" + Chr(34) + "3;url=http://192.168.20.60" +
Chr (34) + ">" +
"<HTML><HEAD></HEAD><BODY>"+
"<hl>AVR + ENC28J60 Mini Web Server</hl>"+
"<a href=/>Reload</a>"+
"<script src=/s></script>"+
"<table><tr><td valign=top><table border=1
style="+chr (34)+"font-size:20px ;font-family: terminal
;"+chr (34) +">"+
"<tr><th colspan=2>PINC</th></tr>"+
"<script>"+
"var str,i;"+
"str="+chr (34)+chr (34)+";"+
"for (1=0;1<8;i++) "+
"{ str+="+chr (34) +"<tr><td bgcolor=pink>BUTTON
#"+chr (34)+"+i+"+chr (34)+"</td>"+chr (34)+"; "+
"if (PINC& (1<<i)){ str+="+chr (34)+"<td
bgcolor=red>ON"+chr (34) +";} "+
"else { str+="+chr (34)+"<td
bgcolor=#cccccc>OFF"+chr (34)+";} "+
"str+="+chr (34)+"</td></tr>"+chr (34)+";} "+
"document.write(str) ;"+
"</script>"
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const indexPage2 as stringf 466] =
"</table></td><td>"+
"<table border=1 style="+chr (34)+"font-size:20px
;font-family: terminal ;"+chr(34)+">"+
"<tr><th colspan=3>PORTD</th></tr>"+
"<script>"+
"var str,i;"+
"str="+chr (34)+chr (34)+";"+
"for (1=0;i<8;i++)"+
"{ str+="+chr (34) +"<tr><td bgcolor=yellow>LED
#"+chr (34)+"+i+"+chr (34)+"</td>"+chr (34)+"; "+
"if (PORTD& (1<<i)){ str+="+chr (34) +"<td
bgcolor=red>ON"+chr (34) +";} "+
"else {str+="+chr(34)+"<td
bgcolor=#cccccc>OFF"+chr (34)+";} "+
"str+="+chr (34) +"</td><td><a
href=/t"+chr (34) +"+i+"+chr (34) +">Toggle</a></td></tr>"+chr (34)+";} "+
"document.write(str) ;"+
"</script>"+
"</table></td></tr></table>"+
"This is HTTP request
#<script>document.write (REQ)</script></BODY></HTML>"

dim getRequest as byte[ 15] ' HTTP request buffer
dyna as byte[ 31] ' buffer for dynamic response
httpCounter as word ' counter of HTTP requests

sub function SPI Ethernet UserTCP(dim byref remoteHost as byte[ 4],
dim remotePort, localPort, reglength as word) as word
sub function SPI Ethernet UserUDP(dim byref remoteHost as byte[ 4],
dim remotePort, destPort, reglength as word) as word

implements
Thhhkhhkhkhrkhhhkhhkdhhkhkhhkhkhkdhkhkhkrkhkhkhkhrkhkhkrkhkhkhhrkkx*k

'* user defined sub functions

'* put the constant string pointed to by s to the ENC transmit buffer

sub function putConstString (dim const s as “byte) as word
result = 0
while (s” <> 0)
SPI Ethernet putByte(s")
Inc(s)
Inc (result)
wend
end sub
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'* put the string pointed to by s to the ENC transmit buffer
1%
sub function putString(dim byref s as bytel 100] ) as word

result = 0

while (s[ result] <> 0)

SPI Ethernet putByte (s[ result])
Inc (result)

wend
end sub
T %
'* this sub function is called by the library
'* the wuser accesses to the HTTP request by successive calls to
SPI Ethernet getByte ()
'* the user puts data in the transmit buffer by successive calls to
SPI Ethernet putByte ()
'* the sub function must return the length in bytes of the HTTP reply,
or 0 if nothing to transmit
1%
'* if you don"t need to reply to HTTP requests,
'* just define this sub function with a return(0) as single state-

ment
1%

X
sub function Spi Ethernet UserTCP(dim byref remoteHost as byte[ 4],

dim remotePort, localPort, regLength
as word) as word

dim len as word ' my reply length
bitMask as byte ' for bit mask
tmp as byte[ 5] ' to copy const array to ram for memcmp
len =0
if (localPort <> 80) then ' I listen only to web request on port 80
result = 0
exit
end if

get 10 first bytes only of the request, the rest does not mat-

ter here
for len = 0 to 9
getRequest[ len ] = SPI Ethernet getByte()
next len
getRequest[ len ] = 0
len =0

while (httpMethod len ] <> 0)

tmp[ len ] = httpMethod] len ]

Inc(len )
wend
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if (memcmp (@getRequest, @tmp, 5) <> 0) then ' only GET method is
supported here

result = 0

exit
end if
httpCounter = httpCounter + 1 ' one more request done
if (getRequest[ 5] = "s") then ' if request path

name starts with s, store dynamic data in transmit buffer

' the text string replied by this request can be interpreted
as javascript statements

' by browsers

len = putConstString (ChttpHeader) ' HTTP header
len = len + putConstString(@httpMimeTypeScript) ' with text
MIME type

' add PORTC value (buttons) to reply

len = len + putString("var PINC= ")
WordToStr (PINC, dyna)

len = len + putString(dyna)

len = len_ + putString(";")

' add PORTD value (LEDs) to reply

len = len + putString("var PORTD= ")
WordToStr (PORTD, dyna)

len = len + putString(dyna)

len = len_ + putString(";")

' add HTTP requests counter to reply
WordToStr (httpCounter, dyna)

len = len + putString("var REQ= ")
len = len + putString(dyna)
len = len_ + putString(";")
else
if (getRequest[ 5] = "t") then ' if request path

name starts with t, toggle PORTD (LED) bit number that comes after
bitMask = 0

if (isdigit (getRequest[ 6] ) <> 0) then ''if 0 <=
bit number <= 9, bits 8 & 9 does not exist but does not matter
bitMask = getRequest[ 6] - "0O" ' convert ASCII
to integer
bitMask = 1 << bitMask ' create bit mask
PORTD = PORTD xor DbitMask ' toggle PORTD
with xor operator
end if
end if

end if
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if(len = 0) then ' what do to by default
len = putConstString (ChttpHeader) ' HTTP header
len = len + putConstString(GhttpMimeTypeHTML) ' with HTML
MIME type
len = len_ + putConstString(@indexPage) ' HTML page first part
len = len + putConstString(@indexPage2) ' HTML page
second part
end if
result = len ' return to the library with the
number of bytes to transmit
end sub

L 3

' * this sub function is called by the library

' * the user accesses to the UDP request by successive calls to
SPI Ethernet getByte ()

' * the user puts data in the transmit buffer by successive calls to
SPI Ethernet putByte ()

' * the sub function must return the length in bytes of the UDP reply,
or 0 if nothing to transmit

L 3

' * if you don"t need to reply to UDP requests,

' * just define this sub function with a return(0) as single state-

ment
L 3

L S
sub function Spi Ethernet UserUDP (dim byref remoteHost as byte[ 4],
dim remotePort, destPort, reglength
as word) as word
dim len as word ' my reply length
ptr as “byte ' pointer to the dynamic buffer
tmp as string| 5]

' reply is made of the remote host IP address in human readable

format
byteToStr (remoteHost[ 0] , dyna) ' first IP address byte
dynal 3] = "."
byteToStr (remoteHost[ 1] , tmp) ' second
dynal 4] = tmp[ 0]
dynal 5] = tmp[ 1]
dynal 6] = tmp[ 2]
dynal 7] = "."
byteToStr (remoteHost[ 2] , tmp) ' second
dynal 8] = tmp[ 0]
dynal 9] = tmp[ 1]
dynal[ 10] = tmp[ 2]
dyna[ 11] = "."
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byteToStr (remoteHost[ 3] , tmp) ' second
dynal 12] = tmp[ 0]
dynal 13] = tmp[ 1]
dynal 14] = tmp[ 2]
dyna[ 15] = ":" ' add separator

' then remote host port number
WordToStr (remotePort, tmp)

dynal 16] = tmp[ 0]
dynal 17] = tmp[ 1]
dynal 18] = tmp[ 2]
dynal 19] = tmp[ 3]
dynal 20] = tmp[ 4]
dynal 21] = " "

dynal 22] = "[ "

WordToStr (destPort, tmp)

dynal 23] = tmp[ 0]
dynal 24] = tmp[ 1]
dynal 25] = tmp[ 2]
dynal 26] = tmp[ 3]
dynal 27] = tmp[ 4]
dyna[ 28] = "] "
dyna[ 29] = " "
dynal 30] = 0

' the total length of the request is the length of the dynamic
string plus the text of the request
len = 30 + reglLength

' puts the dynamic string into the transmit buffer
ptr = @dyna
while (ptr” <> 0)
SPI Ethernet putByte (ptr”)
ptr = ptr + 1
wend

' then puts the request string converted into upper char into
the transmit buffer
while (regLength <> 0)
SPI Ethernet putByte (SPI Ethernet getByte())
reqlength = reglength - 1

wend

result = len ' back to the library with the length
of the UDP reply
end sub

end.
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HW Connection
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SPI GRAPHIC LCD LIBRARY

The mikroBasic PRO for AVR provides a library for operating Graphic Lcd 128x64
(with commonly used Samsung KS108/KS107 controller) via SPI interface.

For creating a custom set of Glcd images use Glcd Bitmap Editor Tool.

Note: The library uses the SPI module for communication. User must initialize SPI
module before using the SPI Graphic Lcd Library.

Note: This Library is designed to work with the mikroElektronika's Serial Lcd/Gled
Adapter Board pinout, see schematic at the bottom of this page for details.

External dependencies of SPI Graphic Lcd Library

The implementation of SPI Graphic Lcd Library routines is based on Port Expander
Library routines.

Prior to calling any of this library routines, Spi_Rd_Ptr needs to be initialized with the
appropriate SPI_Read routine.

External dependencies are the same as Port Expander Library external dependencies.
Library Routines
Basic routines:

- SPI_Glcd_Init

- SPI_Glcd_Set_Side

- SPI_Glcd_Set_Page
- SPI_Glcd_Set_X

- SPI_Glcd_Read_Data
- SPI_Glcd_Write_Data

Advanced routines:

- SPI_Glcd_Fill

- SPI_Glcd_Dot

- SPI_Glcd_Line

- SPI_Glcd_V_Line

- SPI_Gled_H_Line

- SPI_Glcd_Rectangle
- SPI_Glcd_Box

- SPI_Glcd_Circle

- SPI_Glcd_Set Font
- SPI_Glcd_Write_Char
- SPI_Glcd_Write_Text
- SPI_Glcd_Image
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SPI_Glcd_lInit

Prototype sub procedure SPI Glcd Init(dim DeviceAddress as byte)

Returns Nothing.

Initializes the Glcd module via SPI interface.

.. Parameters :
Description

- DeviceAddress: SPl expander hardware address, see schematic at the
bottom of this page

Global variables :

SsPExpanderCs: Chip Select line
SPExpanderRST: Reset line
- SPExpanderCs Direction: Direction of the Chip Select pin

Requires N .
q - SPExpanderRST Direction: Direction of the Reset pin
must be defined before using this function.
SPI module needs to be initialized. See SPI1_Init and SPI1_Init Advanced routines.
' port expander pinout definition
dim SPExpanderCS as sbit at PORTB.B1
SPExpanderRST as sbit at PORTB.BO
SPExpanderCS Direction as sbit at DDRB.B1
SPExpanderRST Direction as sbit at DDRB.BO
Exan“ﬂe ' If Port Expander Library uses SPI1 module

SPI1 Init Advanced( SPI MASTER, SPI FCY DIV2, SPI CLK HI TRAIL-
ING) ' Initialize SPI module used with PortExpander

SPI Rd Ptr = @SPI1 Read ' Pass pointer to SPI
Read function of used SPI module

SPI Glcd Init(0)
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SPI_Glcd_Set_Side

Prototype sub procedure SPI Glcd Set Side(dim x_pos as byte)

Returns Nothing.

Selects Glcd side. Refer to the Glcd datasheet for detail explanation.
Parameters :

- x_pos: position on x-axis. Valid values: 0..127
Description
The parameter x pos specifies the Glcd side: values from 0 to 63 specify the
left side, values from 64 to 127 specify the right side.

Note: For side, x axis and page layout explanation see schematic at the bottom
of this page.

Requires Glcd needs to be initialized for SPI communication, see SPI_Glcd_Init routines.

The following two lines are equivalent, and both of them select the left side of Glcd:

Example SPI Glcd Set Side(0)

SPI Glcd Set Side(10)

SPI_Glcd_Set_Page

Prototype sub procedure SPI Glcd Set Page (dim page as byte)

Returns Nothing.

Selects page of Glcd.

Parameters :

Description |_ page: page number. Valid values: 0..7

Note: For side, x axis and page layout explanation see schematic at the bottom
of this page.

Requires Glcd needs to be initialized for SPI communication, see SPI_Glcd_Init routines.

Example SPI Glcd Set Page(5)

392 MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD



mikroBasic PRO for AVR

CHAPTER 6

Libraries

SPI_Glcd_Set X

Prototype sub procedure SPI Glcd Set X(dim x pos as byte)
Returns Nothing.
Sets x-axis position to x_pos dots from the left border of Glcd within the select-
ed side.
Parameters :
Description
- x_pos: position on x-axis. Valid values: 0..63
Note: For side, x axis and page layout explanation see schematic at the bottom
of this page.
Requires Glcd needs to be initialized for SPI communication, see SPI_Glcd_Init routines.
Example SPI Glcd Set X(25)

SPI_Glcd_Read _Data

Prototype sub function SPI Glcd Read Data() as byte
Returns One byte from Glcd memory.
i Reads data from the current location of Glcd memory and moves to the next
Description !
location.
Glcd needs to be initialized for SPI communication, see SPI_Glcd_Init routines.
Requires Glcd side, x-axis position and page should be set first. See the functions
SPI_Glcd_Set_Side, SPI_Glcd_Set X, and SPI_Glcd_Set Page.
dim data as byte
Example

data = SPI Glcd Read Data()
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SPI_Glcd_Write_Data

Prototype sub procedure SPI Glcd Write Data(dim Ddata as byte)

Returns Nothing.

Writes one byte to the current location in Glcd memory and moves to the next
location.

Description Parameters :

- Ddata: data to be written

Glcd needs to be initialized for SPI communication, see SPI_Glcd_Init routines.

Requires Glcd side, x-axis position and page should be set first. See the functions
SPI_Glcd_Set_Side, SPI_Glcd_Set_X, and SPI_Glcd_Set Page.
dim ddata as byte

Example S
SPI Glcd Write Data (ddata)

SPI_Glcd _Fill

Prototype |sub procedure SPI Glcd Fill (dim pattern as byte)

Returns Nothing.

Fills Glcd memory with byte pattern.

Parameters :

Description |- pattern: byte to fill Glcd memory with

To clear the Glcd screen, use sp1 Gled Fill(0).

To fill the screen completely, use sPT Glcd Fill (0xFF).

Requires Glcd needs to be initialized for SPI communication, see SPI_Glcd_Init routines.

' Clear screen

Example SPI _Gled Fill(0)
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SPI_Glcd_Dot

sub procedure SPI Glcd Dot (dim os as byte, dim os as byte
Prototype P SPI_Gled Dot ( x_pos yte, y_p vte,

dim color as byte)

Returns Nothing.

Draws a dot on Glcd at coordinates (x pos, v pos).
Parameters :

- x_pos: X position. Valid values: 0..127
- v _pos: y position. Valid values: 0..63

Description |” color: colx_pos as byte; page_num as byte; color as byte)

or parameter. Valid values: 0..2

The parameter color determines the dot state: O clears dot, 1 puts a dot, and 2
inverts dot state.

Note: For x and y axis layout explanation see schematic at the bottom of this page.

Requires Glcd needs to be initialized for SPI communication, see SPI_Glcd_Init routines.

' Invert the dot in the upper left corner

Example SPI_Gled Dot (0, 0, 2)
SPL_Glcd_Line
sub procedure SPI Glcd Line(dim x start as integer, dim y start
Prototype as integer, dim x end as integer, dim y end as integer, dim color
as byte)
Returns Nothing.

Draws a line on Glcd.
Parameters :

- x_start: X coordinate of the line start. Valid values: 0..127
Description |- v start: y coordinate of the line start. Valid values: 0..63
- x_end: X coordinate of the line end. Valid values: 0..127

- v_end: y coordinate of the line end. Valid values: 0..63

- color: color parameter. Valid values: 0..2

Parameter color determines the line color: 0 white, 1 black, and 2 inverts each dot.

Requires Glcd needs to be initialized for SPI communication, see SPI_Glcd_Init routines.

' Draw a line between dots (0,0) and (20,30)
SPI Glecd Line(0, 0, 20, 30, 1)

Example
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SPI_Glcd_V_Line

sub procedure SPI Glcd V Line(dim y start as byte, dim y end as

Prototype byte, dim x pos as byte, dim color as byte)
Returns Nothing.

Draws a vertical line on Glcd.

Parameters :
Description |” y start: y coordinate of the line start. Valid values: 0..63

- v _end: y coordinate of the line end. Valid values: 0..63
- x_pos: X coordinate of vertical line. Valid values: 0..127
- color: color parameter. Valid values: 0..2

Parameter color determines the line color: 0 white, 1 black, and 2 inverts each dot.

Requires Glcd needs to be initialized for SPI communication, see SPI_Glcd_Init routines.

' Draw a vertical line between dots (10,5) and (10,25)

Example SPI_Gled_V_Line(5, 25, 10, 1)

SPI_Glcd_H_Line

sub procedure SPI Glcd V Line(dim x start as byte, dim x end as

PrOtOtype byte, dim y pos as byte, dim color as byte)

Returns Nothing.

Draws a horizontal line on Glcd.
Parameters :

- x start: X coordinate of the line start. Valid values: 0..127
Description |- x end: x coordinate of the line end. Valid values: 0..127

- v pos: y coordinate of horizontal line. Valid values: 0..63

- color: color parameter. Valid values: 0..2

The parameter color determines the line color: 0 white, 1 black, and 2 inverts
each dot.

Requires Glcd needs to be initialized for SPI communication, see SPI_Glcd_Init routines.

' Draw a horizontal line between dots (10,20) and (50,20)

Example SPT Glcd H Line (10, 50, 20, 1)
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SPI_Glcd_Rectangle

sub procedure SPI Glcd Rectangle (dim x upper left as byte, dim
Prototype y _upper left as byte, dim x bottom right as byte, dim
y bottom right as byte, dim color as byte)

Returns Nothing.

Draws a rectangle on Glcd.
Parameters :

- x upper left: X coordinate of the upper left rectangle corner. Valid values: 0..127

-y upper left: y coordinate of the upper left rectangle corner. Valid values: 0..63

- x _bottom right: X coordinate of the lower right rectangle corner. Valid
values: 0..127

- v bottom right: y coordinate of the lower right rectangle corner. Valid
values: 0..63

- color: color parameter. Valid values: 0..2

Description

The parameter color determines the color of the rectangle border: 0 white, 1
black, and 2 inverts each dot.

Requires Glcd needs to be initialized for SPI communication, see SPI_Glcd_Init routines.

' Draw a rectangle between dots (5,5) and (40,40)

Example SPI Glcd Rectangle(5, 5, 40, 40, 1)
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SPI_Glcd_Box

sub procedure SPI Glcd Box(dim x upper left as byte, dim
Prokﬂype y upper left as byte, dim x bottom right as byte, dim
y bottom right as byte, dim color as byte)

Returns Nothing.

Draws a box on Glcd.
Parameters :

- x_upper left: x coordinate of the upper left box corner. Valid values: 0..127
-y upper left:y coordinate of the upper left box corner. Valid values: 0..63

Description |_ % bottom right: X coordinate of the lower right box corner. Valid values: 0..127
-y bottom right: y coordinate of the lower right box corner. Valid values: 0..63
- color: color parameter. Valid values: 0..2
The parameter color determines the color of the box fill: 0 white, 1 black, and 2
inverts each dot.

Requires Glcd needs to be initialized for SPI communication, see SPI_Glcd_Init routines.
' Draw a box between dots (5,15) and (20,40)

Example

SPT_Glcd Box(5, 15, 20, 40, 1)

SPI_Glcd_Circle

sub procedure SPI Glcd Circle(dim x center as integer, dim y cen-
ter as integer, dim radius as integer, dim color as byte)

Prototype

Returns Nothing.

Draws a circle on Glcd.
Parameters :

- x_center: X coordinate of the circle center. Valid values: 0..127
Description |- v center: y coordinate of the circle center. Valid values: 0..63
- radius: radius size

- color: color parameter. Valid values: 0..2

The parameter color determines the color of the circle line: 0 white, 1 black,
and 2 inverts each dot.

Requires Glcd needs to be initialized for SPI communication, see SPI_Glcd_Init routine.

' Draw a circle with center in (50,50) and radius=10

Example SPI_Glcd Circle (50, 50, 10, 1)

398 MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD



mikroBasic PRO for AVR

CHAPTER 6

Libraries

SPI_Glcd_Set Font

Protot sub procedure SPI Glcd Set Font(dim activeFont as longint, dim

rototype aFontWidth as byte, dim aFontHeight as byte, dim aFontOffs as word)

Returns Nothing.

Sets font that will be used with SPI_Glcd_Write_Char and SPI_Glcd_Write_Text
routines.
Parameters :
- activeront: font to be set. Needs to be formatted as an array of char
- arontwidth: width of the font characters in dots.
Lo - aFontHeight : height of the font characters in dots.

Description |__ ... :¢.. number that represents difference between the mikroBasic PRO
character set and regular ASCII set (eg. if 'A" is 65 in ASCII character, and 'A'
is 45 in the mikroBasic PRO character set, aFontOffs is 20). Demo fonts
supplied with the library have an offset of 32, which means that they start with
space.

The user can use fonts given in the file “__Lib_GLCD_fonts.mbas” file located in
the Uses folder or create his own fonts.

Requires Glcd needs to be initialized for SPI communication, see SPI_Glcd_Init routines.

E I ' Use the custom 5x7 font "myfont" which starts with space (32):

xample SPI Glcd Set Font (Cmyfont, 5, 7, 32)
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SPI_Glcd_Write_Char

sub procedure SPI Glcd Write Char(dim chrl as byte, dim x pos as
byte, dim page num as byte, dim color as byte)

Prototype

Returns Nothing.

Prints character on Glcd.
Parameters :

- chr1: character to be written

- x_pos: character starting position on x-axis. Valid values: 0..(127-FontWidth)
- page num: the number of the page on which character will be written. Valid
Description | values: 0..7

- color: color parameter. Valid values: 0..2

The parameter color determines the color of the character: 0 white, 1 black,
and 2 inverts each dot.

Note: For x axis and page layout explanation see schematic at the bottom of
this page.

Glcd needs to be initialized for SPI communication, see SPI_Glcd_Init routines.

Requires Use the SPI_Glcd_Set_Font to specify the font for display; if no font is speci-
fied, then the default 5x8 font supplied with the library will be used.
E I ' Write character 'C' on the position 10 inside the page 2:
Xample SPI Glcd Write Char("C", 10, 2, 1)
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SPI_Glcd_Write_Text

Protot sub procedure SPI Glcd Write Text (dim byref text as stringf 40],
rototype dim x pos as byte, dim page numb as byte, dim color as byte)
Returns Nothing.
Prints text on Glcd.
Parameters :
- text: text to be written
- x_pos: text starting position on x-axis.
o - page num: the number of the page on which text will be written. Valid values: 0..7
Description ; )
- color: color parameter. Valid values: 0..2
The parameter color determines the color of the text: 0 white, 1 black, and 2
inverts each dot.
Note: For x axis and page layout explanation see schematic at the bottom of
this page.
Glcd needs to be initialized for SPI communication, see SPI_Glcd_Init routines.
Requires Use the SPI_Glcd_Set_Font to specify the font for display; if no font is speci-
fied, then the default 5x8 font supplied with the library will be used.
E I ' Write text "Hello world!" on the position 10 inside the page 2:
xample SPI Glcd Write Text ("Hello world!", 10, 2, 1)
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SPI_Glcd_Image

Prototype sub procedure SPI Glcd Image (dim const image as “byte)
yp _ _

Returns Nothing.

Displays bitmap on Glcd.
Parameters :

- image: image to be displayed. Bitmap array can be located in both code and
Description | RAM memory (due to the mikroBasic PRO for AVR pointer to const and
pointer to RAM equivalency).

Use the mikroBasic PRO’s integrated Glcd Bitmap Editor (menu option Tools »
Glcd Bitmap Editor) to convert image to a constant array suitable for display-
ing on Glcd.

Requires Glcd needs to be initialized for SPI communication, see SPI_Glcd_Init routines.

' Draw image my image on Glcd

Exan"ﬂe SPI Glcd Image (my image)

Library Example

The example demonstrates how to communicate to KS0108 Glcd via the SPI module, using seri-
al to parallel convertor MCP23S17.

program SPI Glcd
include bitmap

' Port Expander module connections

dim SPExpanderRST as sbit at PORTB.O
SPExpanderCS as sbit at PORTB.1
SPExpanderRST Direction as sbit at DDRB.O
SPExpanderCS Direction as sbit at DDRB.1

' End Port Expander module connections

dim someText as charf 20]
counter as byte

sub procedure Delay2S
delay ms (2000)
end sub
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main:
]
SPI1 Init Advanced(_ SPI MASTER,
ING)
Spi Rd Ptr

@SPI1 Read

SPI Read sub function of used SPI module

v v

_SPI_CLK _HI TRAILING) '

' Spi Rd Ptr = &SPIZ2 Read

SPI Read sub function of used SPI module

SPI Glcd Init (0)
via SPI
SPI Glcd Fill (0x00)

while TRUE
SPI Glcd Image (@truck bmp)
Delay2s () Delay2s ()

SPI Glcd Fill(0x00)
Delay2s

SPI Glcd Box(62,40,124,56,1)
SPI Glcd Rectangle(5,5,84,35,1)

SPI Glcd Line(0, 63, 127, 0,1)
Delay2s ()
counter = 5
while (counter < 60)
and vertical line
Delay ms (250)
SPI Glcd V Line (2, 54, counter,
SPI Glcd H Line(2, 120, counter,
counter = counter + 5
wend
Delay2s ()
SPI Glcd Fill(0x00)
SPI Glcd Set Font (@Character8x7,
"Character8x7"
SPI Glcd Write Text ("mikroE", 5, 7,

for counter = 1 to 10 '
SPI Glcd Circle (63,32,

next counter

Delay2s ()

3* counter,

SPI Gled Box (12,20, 70,63, 2)

Delay2s ()

1)

1)

8,

2)

Draw circles

1)

If Port Expander Library uses SPI1 module
_SPI_FCY DIV2,
Initialize SPI module used with PortExpander

_SPI_CLK_HI TRAIL-

' Pass pointer to

If Port Expander Library uses SPI2Z module
' SPI2 Init Advanced( SPI MASTER,
Initialize SPI module used with PortExpander

_SPI_FCY DIVZ2,

' Pass pointer to

' Initialize Glcd

' Clear Glcd

' Draw image

' Clear Glcd

' Draw box
' Draw rectangle
' Draw line

' Draw horizontal

' Clear Glcd

32) ' Choose font

' Write string

' Draw box
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SPI Glcd Fill (0xFF) ' Fill Glcd
SPI Glcd Set Font (@Character8x7, 8, 7, 32) ' Change font
someText = "8x7 Font"
SPI Glcd Write Text (someText, 5, 1, 2) ' Write string
Delay2s ()
SPI Glcd Set Font (@System3x6, 3, 5, 32) ' Change font
someText = "3X5 CAPITALS ONLY"
SPI Glcd Write Text (someText, 5, 3, 2) ' Write string
Delay2s ()
SPI Glcd Set Font (@Gfontdx7, 5, 7, 32) ' Change font
someText = "5x7 Font"
SPI Glcd Write Text (someText, 5, 5, 2) ' Write string
Delay2s ()
SPI Glcd Set Font (@FontSystem5x7 v2, 5, 7, 32) ' Change font
someText = "5x7 Font (v2)"
SPI Glcd Write Text (someText, 5, 7, 2) ' Write string
Delay2s ()
wend
end.
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HW Connection
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SPI LCD LIBRARY

The mikroBasic PRO for AVR provides a library for communication with Lcd (with
HD44780 compliant controllers) in 4-bit mode via SPI interface.

For creating a custom set of Lcd characters use Lcd Custom Character Tool.

Note: The library uses the SPI module for communication. The user must initialize
the SPI module before using the SPI Lcd Library.

Note: This Library is designed to work with the mikroElektronika's Serial Lcd
Adapter Board pinout. See schematic at the bottom of this page for details.

External dependencies of SPI Lcd Library

The implementation of SPI Lcd Library routines is based on Port Expander Library
routines.

Prior to calling any of this library routines, Spi_Rd_Ptr needs to be initialized with the
appropriate SPI_Read routine.

External dependencies are the same as Port Expander Library external dependencies.
Library Routines

- SPI_Lcd_Config
- SPI_Lcd_Out

- SPIl_Lcd Out Cp
- SPI_Lcd_Chr

- SPIl_Lcd _Chr_Cp
-SPIl_Lcd Cmd
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SPI_Lcd_Config

Prototype sub procedure SPI Lcd Config(dim DeviceAddress as byte)

Returns Nothing.

Initializes the Lcd module via SPI interface.

. Parameters :
Description

- DeviceAddress: spi expander hardware address, see schematic at the
bottom of this page

Global variables :

SPExpanderCs: Chip Select line
SPExpanderRsT: Reset line
- SPExpanderCS Direction: Direction of the Chip Select pin

Requires o ;
q - SPExpanderRST Direction: Direction of the Reset pin
must be defined before using this function.
SPI module needs to be initialized. See SPI1_Init and SPI1_Init Advanced routines.
' port expander pinout definition
dim SPExpanderCS as sbit at PORTB.B1
SPExpanderRST as sbit at PORTB.BO
SPExpanderCS Direction as sbit at DDRB.BI1
SPExpanderRST Direction as sbit at DDRB.BO
Example ' If Port Expander Library uses SPI1 module
SPI1 Init () ' Initialize SPI module used with
PortExpander
Spi Rd Ptr = @SPI1 Read ' Pass pointer to SPI Read func-
tion of used SPI module
SPI Lcd Config(0) ' initialize lcd over spi inter-
face
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SPI_Lcd_Out

sub procedure SPI Lcd Out (dim row as byte, dim column as byte,

PrOtOtype dim byref text as stringf 20])
Returns Nothing.
Prints text on the Lcd starting from specified position. Both string variables and
literals can be passed as a text.
e Parameters :
Description

- row: starting position row number
- column: starting position column number
- text: text to be written

Requires Lcd needs to be initialized for SPI communication, see SPI_Lcd_Config routines.

' Write text "Hello!" on Lcd starting from row 1, column 3:

Example SPI Lcd Out(l, 3, "Hello!")

SPI_Lcd_Out Cp

Prototype sub procedure SPI Lcd Out CP(dim text as stringf 19])

Returns Nothing.

Prints text on the Lcd at current cursor position. Both string variables and liter-
als can be passed as a text.

Description Parameters :

- text: text to be written

Requires Lcd needs to be initialized for SPI communication, see SPI_Lcd_Config routines.

' Write text "Here!" at current cursor position:

Example SPI Lcd Out CP("Here!")
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SPI _Lcd_Chr
Prototvpe sub procedure SPI Lcd Chr(dim Row as byte, dim Column as byte,
yp dim Out Char as byte)
Returns Nothing.
Prints character on Lcd at specified position. Both variables and literals can be
passed as character.
i Parameters :
Description
- Row: Writing position row number
- Column: writing position column number
-out Char: character to be written
Requires Lcd needs to be initialized for SPI communication, see SPI_Lcd_Config routines.
E I ' Write character "i" at row 2, column 3:
xample SPT Led Chr(2, 3, 'i')

SPI_Lcd_Chr_Cp

Prototype |sub procedure SPI Lcd Chr CP(dim Out Char as byte)

Returns Nothing.

Prints character on Lcd at current cursor position. Both variables and literals
can be passed as character.

Description
P Parameters :
-Out Char: character to be written
Requires Lcd needs to be initialized for SPI communication, see SPI_Lcd_Config routines.
' Write character "e" at current cursor position:
Example

SPI_Lcd Chr Cp('e')
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SPI Lcd Cmd

Prototype sub procedure SPI Lcd Cmd(dim out char as byte)

Returns Nothing.

Sends command to Lcd.

Parameters :

Description
P - out char: command to be sent

Note: Predefined constants can be passed to the function, see Available SPI
Lcd Commands.

Requires Lcd needs to be initialized for SPI communication, see SPI_Lcd_Config routines.

' Clear Lcd display:

Example SPI_Lcd_Cmd (LCD_CLEAR)

Available SPI Lcd Commands

Lcd Command Purpose
LCD_FIRST ROW Move cursor to the 1st row
LCD SECOND_ ROW Move cursor to the 2nd row
LCD_THIRD ROW Move cursor to the 3rd row
LCD_FOURTH ROW Move cursor to the 4th row
LCD_CLEAR Clear display

Return cursor to home position, returns a shifted display

BED_RETURN_HOME to its original position. Display data RAM is unaffected.

LCD CURSOR OFF Turn off cursor
LCD UNDERLINE ON Underline cursor on
LCD BLINK CURSOR ON Blink cursor on

LCD_MOVE CURSOR_LEFT Move cursor left without changing display data RAM

LCD MOVE_ CURSOR RIGHT |Move cursor right without changing display data RAM

LCD_TURN ON Turn Lecd display on

LCD_TURN OFF Turn Lcd display off

LCD_SHIFT LEFT Shift display left without changing display data RAM
LCD_SHIFT RIGHT Shift display right without changing display data RAM
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Library Example

This example demonstrates how to communicate Lcd via the SPI module, using
serial to parallel convertor MCP23S17.

program Spi Lcd

dim text as char 17]

' Port Expander module connections

dim SPExpanderRST as sbit at PORTB.BO
SPExpanderCS as sbit at PORTB.B1
SPExpanderRST Direction as sbit at DDRB.BO
SPExpanderCS Direction as sbit at DDRB.BI

' End Port Expander module connections

main:

text = "mikroElektronika"

' If Port Expander Library uses SPI1 module

SPI1 Init() ' Initialize SPI module
used with PortExpander

Spi Rd Ptr = @SPI1 Read ' Pass pointer to SPI Read

sub function of used SPI module

' If Port Expander Library uses SPI2 module

' SPI2 Init() ' Initialize SPI module
used with PortExpander

' Spi Rd Ptr = &SPI2 Read ' Pass pointer to SPI Read
sub function of used SPI module

SPI Lcd Config(0) ' Initialize Lcd over SPI
interface

SPI Lcd Cmd (LCD_CLEAR) ' Clear display

SPI Lcd Cmd (LCD CURSOR _OFF) ' Turn cursor off

SPI Lcd Out(l,6, "mikroE") ' Print text to Lcd, 1st
row, 6th column

SPI Lcd Chr Cp("!M) ' Append "!"

SPI Lcd Out(2,1, text) ' Print text to Lcd, 2nd
row, 1lst column

end.
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HW Connection
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SPI LCD8 (8-BIT INTERFACE) LIBRARY

The mikroBasic PRO for AVR provides a library for communication with Lcd (with
HD44780 compliant controllers) in 8-bit mode via SPI interface.

For creating a custom set of Lcd characters use Lcd Custom Character Tool.

Note: Library uses the SPI module for communication. The user must initialize the
SPI module before using the SPI Lcd Library.

Note: This Library is designed to work with mikroElektronika's Serial Lcd/Gled
Adapter Board pinout, see schematic at the bottom of this page for details.

External dependencies of SPI Lcd Library

The implementation of SPI Lcd Library routines is based on Port Expander Library
routines.

Prior to calling any of this library routines, Spi_Rd_Ptr needs to be initialized with the
appropriate SPI_Read routine.

External dependencies are the same as Port Expander Library external dependen-
cies.

Library Routines

- SPI_Lcd8 Config
- SPI_Lcd8_Out

- SPI_Lcd8 Out Cp
- SPI_Lcd8_Chr

- SPIl_Lcd8 Chr_Cp
- SPI_Lcd8_Cmd
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SPI_Lcd8_Config

Prototype sub procedure SPI Lcd8 Config(dim DeviceAddress as byte)

Returns Nothing.

Initializes the Lcd module via SPI interface.

o Parameters :
Description

- DeviceAddress: Spi expander hardware address, see schematic at the
bottom of this page

Global variables :

SPExpanderCs: Chip Select line

SPExpanderRST: Reset line

SPExpanderCs Direction: Direction of the Chip Select pin
SPExpanderRST Direction: Direction of the Reset pin

Requires

must be defined before using this function.

SPI module needs to be initialized. See SPI1_Init and SPI1_Init Advanced routines.

' port expander pinout definition

dim SPExpanderCS as sbit at PORTB.B1
SPExpanderRST as sbit at PORTB.BO
SPExpanderCS Direction as sbit at DDRB.BI1
SPExpanderRST Direction as sbit at DDRB.BO

Example Spil Tnit () ' Tnitialize spi

interface

Spi Rd Ptr = @SPI1 Read ' Pass pointer to

SPI Read function of used SPI module

SPI Lcd8 Config(0) ' Intialize lcd in

8bit mode via spi
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SPI_Lcd8 Out
Prototype sub procedure SPI Lcd8 Out(dim row as byte, dim column as byte,
yp dim byref text as stringl 19])
Returns Nothing.
Prints text on Lcd starting from specified position. Both string variables and liter-
als can be passed as a text.
i Parameters :
Description
- row: starting position row number
- column: starting position column number
- text: text to be written
Requires Lcd needs to be initialized for SPI communication, see SPI_Lcd8_ Config routines.
Exambl ' Write text "Hello!" on Lcd starting from row 1, column 3:
xample SPI Lcd8 Out(l, 3, "Hello!™)

SPI_Lcd8 Out Cp

Prototype sub procedure SPI Lcd8 Out CP(dim text as string{ 19])

Returns Nothing.

Prints text on Lcd at current cursor position. Both string variables and literals
can be passed as a text.

Description Parameters :

- text: text to be written

Requires Lcd needs to be initialized for SPI communication, see SPI_Lcd8_Config routines.

' Write text "Here!" at current cursor position:

Example SPI_Lcd8 Out CP("Here!™)
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SPI_Lcd8_Chr

sub procedure SPI Lcd8 Chr(dim Row as byte, dim Column as byte,

Prototype dim Out Char as byte)
Returns Nothing.
Prints character on Lcd at specified position. Both variables and literals can be
passed as character.
i Parameters :
Description

- row: Writing position row number
- column: writing position column number
- out char: character to be written

Requires Lcd needs to be initialized for SPI communication, see SPI_Lcd8_Config routines.

' Write character "i" at row 2, column 3:
)

Example SPT_Lcd8 Chr(2, 3, 'i')

SPI Lcd8 Chr _Cp

Prototype |sub procedure SPI Lcd8 Chr CP(dim Out Char as byte)

Returns Nothing.

Prints character on Lcd at current cursor position. Both variables and literals
can be passed as character.

Description Parameters :

- out char: character to be written

Requires Lcd needs to be initialized for SPI communication, see SPI_Lcd8_ Config routines.

Print “e” at current cursor position:
Example

' Write character "e" at current cursor position:
SPI Lcd8 Chr Cp('e')
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SPIl Lcd8 Cmd

Prototype sub procedure SPI Lcd8 Cmd(dim out char as byte)

Returns Nothing.

Description

Parameters :

Sends command to Lcd.

- out char: command to be sent

Note: Predefined constants can be passed to the function, see Available SPI
Lcd8 Commands.

Requires Lcd needs to be initialized for SPI communication, see SPI_Lcd8_Config routines.

Example

' Clear Lcd display:
SPI Lcd8 Cmd (LCD CLEAR)

Available SPI Lcd8 Commands

Lcd Command

Purpose

LCD_FIRST ROW

Move cursor to the 1st row

LCD SECOND ROW

Move cursor to the 2nd row

LCD THIRD ROW

Move cursor to the 3rd row

LCD FOURTH ROW

Move cursor to the 4th row

LCD_CLEAR

Clear display

LCD_RETURN_ HOME

Return cursor to home position, returns a shifted display
to its original position. Display data RAM is unaffected.

LCD_CURSOR _OFF

Turn off cursor

LCD_UNDERLINE ON

Underline cursor on

LCD BLINK CURSOR ON

Blink cursor on

LCD _MOVE CURSOR LEFT

Move cursor left without changing display data RAM

LCD _MOVE CURSOR RIGHT

Move cursor right without changing display data RAM

LCD_TURN ON

Turn Lcd display on

LCD_TURN OFF

Turn Lcd display off

LCD SHIFT LEFT

Shift display left without changing display data RAM

LCD SHIFT RIGHT

Shift display right without changing display data RAM
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Library Example

This example demonstrates how to communicate Lcd in 8-bit mode via the SPI mod-
ule, using serial to parallel convertor MCP23S17.

program Spi Lcd8 Test
dim text as char| 16]

' Port Expander module connections

dim SPExpanderRST as sbit at PORTB.O
SPExpanderCS as sbit at PORTB.1
SPExpanderRST Direction as sbit at DDRB.O
SPExpanderCS Direction as sbit at DDRB.1

' End Port Expander module connections

main:

text = "mikroE"

' If Port Expander Library uses SPI1 module

SPI1 Init() ' Initialize SPI mod-
ule used with PortExpander

Spi Rd Ptr = @SPI1 Read ' Pass pointer to SPI

Read sub function of used SPI module

' ' If Port Expander Library uses SPI2 module

' SPIZ2 Init() ' Initialize SPI mod-
ule used with PortExpander
' Spi Rd Ptr = &SPI2 Read ' Pass pointer to SPI

Read sub function of used SPI module

SPI Lcd8 Config(0) ' Intialize Lcd in
8bit mode via SPI

SPI Lcd8 Cmd(LCD CLEAR) ' Clear display

SPI Lcd8 Cmd(LCD _CURSOR OFF) ' Turn cursor off

SPI Lcd8 Out(l,6, text) ' Print text to Lcd,
lst row, 6th column...

SPI Lcd8 Chr CP("!") ' Append "!"

SPI Lcd8 Out (2,1, "mikroelektronika") ' Print text to Lcd,
2nd row, 1lst column...

SPI Lcd8 Out (3,1, text) ' For Lcd modules with
more than two rows

SPI Lcd8 Out (4,15, text) ' For Lcd modules with
more than two rows
end.
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HW Connection
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SPI T6963C GRAPHIC LCD LIBRARY

The mikroBasic PRO for AVR provides a library for working with Glcds based on
TOSHIBA T6963C controller via SPI interface. The Toshiba T6963C is a very popu-
lar Lcd controller for the use in small graphics modules. It is capable of controlling
displays with a resolution up to 240x128. Because of its low power and small out-
line it is most suitable for mobile applications such as PDAs, MP3 players or mobile
measurement equipment. Although this controller is small, it has a capability of dis-
playing and merging text and graphics and it manages all interfacing signals to the
displays Row and Column drivers.

For creating a custom set of Glcd images use Glcd Bitmap Editor Tool.

Note: The library uses the SPI module for communication. The user must initialize
SPI module before using the SP1 T6963C Glcd Library.

Note: This Library is designed to work with mikroElektronika's Serial Glcd 240x128
and 240x64 Adapter Boards pinout, see schematic at the bottom of this page for
details.

Note: Some mikroElektronika's adapter boards have pinout different from T6369C
datasheets. Appropriate relations between these labels are given in the table below:

Adapter Board|T6369C datasheet

RS C/D
R/W /RD
E /WR

External dependencies of SPI T6963C Graphic Lcd Library

The implementation of SPI T6963C Graphic Lcd Library routines is based on Port
Expander Library routines.

Prior to calling any of this library routines, Spi_Rd_Ptr needs to be initialized with the
appropriate SPI_Read routine.

External dependencies are the same as Port Expander Library external dependencies.
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Library Routines

- SPI_T6963C_Config

- SPI_T6963C_WriteData

- SPI_T6963C_WriteCommand
- SPI_T6963C_SetPtr

- SPI_T6963C_WaitReady

- SPI_T6963C_Fill

- SPI_T6963C_Dot

- SPI_T6963C_Write_Char

- SPI_T6963C_Write_Text

- SPI_T6963C_Line

- SPI_T6963C_Rectangle

- SPI_T6963C_Box

- SPI_T6963C_Circle

- SPI_T6963C_Image

- SPI_T6963C_Sprite

- SPI_T6963C_Set Cursor

- SPI_T6963C_ClearBit

- SPI_T6963C_SetBit

- SPI_T6963C_NegBit

- SPI_T6963C_DisplayGrPanel
- SPI_T6963C_DisplayTxtPanel
- SPI_T6963C_SetGrPanel

- SPI_T6963C_SetTxtPanel

- SPI_T6963C_PanelFill

- SPI_T6963C_GrFill

- SPI_T6963C_TxtFill

- SPI_T6963C_Cursor_Height
- SPI_T6963C_Graphics

- SPI_T6963C_Text

- SPI_T6963C_Cursor

- SP1_T6963C_Cursor_Blink
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SPI_T6963C_Config

sub procedure SPI T6963C Config(dim width as word, dim height as
Prototype word, dim fntW as word, dim DeviceAddress as byte, dim wr as
byte, dim rd as byte, dim cd as byte, dim rst as byte)

Returns Nothing.

Initalizes the Graphic Lcd controller.
Parameters :

- width: width of the Glcd panel

- height : height of the Glcd panel

- fntw: font width

- DeviceAddress: SPl expander hardware address, see schematic at the
bottom of this page

- wr: write signal pin on Glcd control port

- rd: read signal pin on Glcd control port

- cd: command/data signal pin on Glcd control port

- rst: reset signal pin on Glcd control port

Display RAM organization:
The library cuts RAM into panels : a complete panel is one graphics panel fol-
lowed by a text panel (see schematic below).

Description
schematic:
Fom - + /\
+ GRAPHICS PANEL #0 + |
+ +
+ +
+ +
- + | PANEL O
+ TEXT PANEL #0 + |
+ + \/
Fom - + /\
+ GRAPHICS PANEL #1 + |
+ +
+ +
+ +
R e Tt + | PANEL 1
+ TEXT PANEL #2 +
+ +
- + \/
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Requires

Global variables :

- sPExpandercs: Chip Select line

- SPExpanderRST: Reset line

- SPExpanderCs Direction: Direction of the Chip Select pin
- SPExpanderRST Direction: Direction of the Reset pin

must be defined before using this function.

SPI module needs to be initialized. See SPI1_Init and SPI1_Init Advanced routines.

Example

// port expander pinout definition

dim SPExpanderCS as sbit at PORTB.B1
SPExpanderRST as sbit at PORTB.BO
SPExpanderCS Direction as sbit at DDRB.Bl
SPExpanderRST Direction as sbit at DDRB.BO

' Initialize SPI module

SPI1 Init Advanced( SPI MASTER, SPI FCY DIV32,

_SPI _CLK HI TRAILING)

SPI Rd Ptr = @SPI1 Read ' Pass pointer to
SPI Read function of used SPI module

SPI T6963C Config (240, 64, 8, 0, 0, 1, 3, 4)

SPI_T6963C

_WriteData

Prototype

sub procedure SPI T6963C WriteData (dim Ddata as byte)

Returns

Nothing.

Description

Writes data to T6963C controller via SPI interface.

Parameters :

- Ddata: data to be written

Requires

Toshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.

Example

SPI T6963C WriteData (AddrL)
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SPI_T6963C_WriteCommand

Prototype sub procedure SPI T6963C WriteCommand(dim Ddata as byte)

Returns Nothing.

Writes command to T6963C controller via SPI interface.
Description |Parameters :

- Ddata: command to be written

Requires Toshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.

Example SPTI T6963C WriteCommand (SPT T6963C CURSOR POINTER SET)

SPI_T6963C_SetPtr

Prototype sub procedure SPI T6963C SetPtr(dim p as word, dim c as byte)

Returns Nothing.

Sets the memory pointer p for command c.

. Parameters :
Description

- p: address where command should be written
- ¢: command to be written

Requires SToshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.

SPI T6963C SetPtr (T6963C grHomeAddr + start,

Example T6963C ADDRESS POTNTER SET)

SPI_T6963C_WaitReady

Prototype |sub procedure SPI T6963C WaitReady ()

Returns Nothing.

Description [Pools the status byte, and loops until Toshiba Glcd module is ready.

Requires Toshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.

Example SPI T6963C WaitReady ()
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SPI_T6963C_Fill
Protot sub procedure SPI T6963C Fill(dim v as byte, dim start as word,
rototype dim len as word)
Returns Nothing.
Fills controller memory block with given byte.
Parameters :
Description
- v: byte to be written
- start: starting address of the memory block
- len: length of the memory block in bytes
Requires Toshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.
Example SPI T6963C Fill (0x33, O0xO00FF, 0x000F)
SPI_T6963C_Dot
sub procedure SPI T6963C Dot (dim x as integer, dim y as integer,
PrOtOtype dim color as byte)
Returns Nothing.
Draws a dot in the current graphic panel of Glcd at coordinates (x, y).
Parameters :
Description | = : dot position on x-axis
- v: dot position on y-axis
- color: color parameter. Valid values: SPI_T6963C_BLACK and
SPI_T6963C_WHITE
Requires Toshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.
Example SPI T6963C Dot (x0, y0, pcolor)
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SPI_T6963C_Write_Char

Protot sub procedure SPI T6963C Write Char(dim c as byte, dim x as byte,
rototype dim y as byte, dim mode as byte)
Returns Nothing.
Writes a char in the current text panel of Glcd at coordinates (x, y).
Parameters :
- c¢: char to be written
- x: char position on x-axis
- y: char position on y-axis
- mode : mode parameter. Valid values: SPI_T6963C_ROM_MODE_OR,
SPI_T6963C_ROM_MODE_XOR, SPI_T6963C_ROM_MODE_AND and
SPI_T6963C_ROM_MODE_TEXT
Mode parameter explanation:
Description

- OR Mode: In the OR-Mode, text and graphics can be displayed and the data
is logically “OR-ed”. This is the most common way of combining text and
graphics for example labels on buttons.

- XOR-Mode: In this mode, the text and graphics data are combined via the
logical “exclusive OR”. This can be useful to display text in negative mode, i.e.
white text on black background.

- AND-Mode: The text and graphic data shown on display are combined via the
logical “AND function”.

- TEXT-Mode: This option is only available when displaying just a text. The Text
Attribute values are stored in the graphic area of display memory.

For more details see the T6963C datasheet.

Requires Toshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.

Example SPI T6963C Write Char ("A",22,23,AND)
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SPI_T6963C_Write_Text

Protot sub procedure SPI T6963C Write Text (dim byref str as byte[ 10],
rototype dim x as byte, dim y as byte, dim mode as byte)
Returns Nothing.
Writes text in the current text panel of Glcd at coordinates (x, y).
Parameters :
- str: text to be written
- x: text position on x-axis
- v: text position on y-axis
- mode: mode parameter. Valid values: SPI_T6963C_ROM_MODE_OR,
SPI_T6963C_ROM_MODE_XOR, SPI_T6963C_ROM_MODE_AND and
SPI_T6963C_ROM_MODE_TEXT
Mode parameter explanation:
Description
- OR Mode: In the OR-Mode, text and graphics can be displayed and the data
is logically “OR-ed”. This is the most common way of combining text and
graphics for example labels on buttons.
- XOR-Mode: In this mode, the text and graphics data are combined via the
logical “exclusive OR”. This can be useful to display text in negative mode, i.e.
white text on black background.
- AND-Mode: The text and graphic data shown on the display are combined via
the logical “AND function”.
- TEXT-Mode: This option is only available when displaying just a text. The Text
Attribute values are stored in the graphic area of display memory.
For more details see the T6963C datasheet.
Requires Toshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.
E I SPI T6963C Write Text ("Glcd LIBRARY DEMO, WELCOME !", 0, O,
xample T6963C ROM MODE EXOR)
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SPI_T6963C_Line

sub procedure SPI T6963C Line(dim x0 as integer, dim y0 as inte-
ger, dim x1 as integer, dim yl as integer, dim pcolor as byte)

Prototype

Returns Nothing.

Draws a line from (x0, y0) to (x1, y1).
Parameters :

- x0: x coordinate of the line start

- y0: y coordinate of the line end

- x1: X coordinate of the line start

- y1: y coordinate of the line end

- pcolor: color parameter. Valid values: SPI_T6963C_BLACK and
SPI_T6963C_WHITE

Requires Toshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.

Description

Example SPI_T6963C Line (0, 0, 239, 127, T6963C WHITE)

SPI_T6963C_Rectangle

sub procedure SPI T6963C Rectangle(dim x0 as integer, dim y0 as

PrOtOtype integer, dim x1 as integer, dim yl as integer, dim pcolor as byte)
Returns Nothing.
Draws a rectangle on Glcd.
Parameters :
e - x0: x coordinate of the upper left rectangle corner
Description

- y0: y coordinate of the upper left rectangle corner

- x1: x coordinate of the lower right rectangle corner

- y1: y coordinate of the lower right rectangle corner

- pcolor: color parameter. Valid values: SPI_T6963C_BLACK and
SPI_T6963C_WHITE

Requires Toshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.

Example SPI T6963C Rectangle (20, 20, 219, 107, T6963C WHITE)
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SPI_T6963C_Box

Prototype

sub procedure SPI T6963C Box(dim x0 as integer, dim y0 as integer,
dim x1 as integer, dim yl as integer, dim pcolor as byte)

Returns

Nothing.

Description

Draws a box on the Glcd
Parameters :

- x0: x coordinate of the upper left box corner

- y0: y coordinate of the upper left box corner

- x1: x coordinate of the lower right box corner

- y1: y coordinate of the lower right box corner

- pcolor: color parameter. Valid values: SPI_T6963C_BLACK and
SPI_T6963C_WHITE

Requires

Toshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.

Example

SPI_T6963C Box (0, 119, 239, 127, T6963C WHITE)

SPI_T6963C_Circle

Prototype

sub procedure SPI T6963C Circle(dim x as integer, dim y as inte-
ger, dim r as longint, dim pcolor as byte)

Returns

Nothing.

Description

Draws a circle on the Glcd.
Parameters :

- x: X coordinate of the circle center

- v: y coordinate of the circle center

- r: radius size

- pcolor: color parameter. Valid values: SPI_T6963C_BLACK and
SPI_T6963C_WHITE

Requires

Toshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.

Example

SPI_T6963C Circle (120, 64, 110, T6963C_WHITE)
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SPI_T6963C_Image

Prototype sub procedure SPI T6963C image (const pic as “byte)

Returns Nothing.

Displays bitmap on Glcd.
Parameters :

- pic: image to be displayed. Bitmap array can be located in both code and
Description | RAM memory (due to the mikroBasic PRO for AVR pointer to const and
pointer to RAM equivalency).

Use the mikroBasic PRO’s integrated Glcd Bitmap Editor (menu option Tools »
Glcd Bitmap Editor) to convert image to a constant array suitable for display-
ing on Glcd.

Requires Toshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.

Example SPI T6963C_ Image (my image)

SPI_T6963C_Sprite

sub procedure SPI T6963C sprite(dim px, py, sx, sy as byte, const

Prototype pic as “byte)

Returns Nothing.

Fills graphic rectangle area (px, py) to (px+sx, py+sy) with custom size picture.
Parameters :

- px: X coordinate of the upper left picture corner. Valid values: multiples of the
font width

Description |- pov: y coordinate of the upper left picture corner

- pic: picture to be displayed

- sx: picture width. Valid values: multiples of the font width

- sy: picture height

Note: If px and sx parameters are not multiples of the font width they will be
scaled to the nearest lower number that is a multiple of the font width.

Requires Toshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.

Example SPI T6963C_Sprite(76, 4, einstein, 88, 119) ' draw a sprite
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SPI_T6963C_Set Cursor

Prototype sub procedure SPI T6963C set cursor (dim x, y as byte)
Returns Nothing.
Sets cursor to row x and column y.
Description Parameters :
- x: cursor position row number
- y: cursor position column number
Requires Toshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.
Example SPI T6963C Set Cursor (cposx, cCposy)
SPI_T6963C_ClearBit
Prototype sub procedure SPI T6963C clearBit (dim b as byte)
Returns Nothing.
Clears control port bit(s).
Description |Parameters :
- b: bit mask. The function will clear bit = on control port if bit = in bit mask is set to 1.
Requires Toshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.
Example ' clear bits 0 and 1 on control port

SPI_T6963C_ClearBit (0x03)

SPI_T6963C_SetBit

Prototype sub procedure SPI T6963C setBit(dim b as byte)
Returns Nothing.
Sets control port bit(s).
Description |Parameters :
- b: bit mask. The function will set bit = on control port if bit = in bit mask is set to 1.
Requires Toshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.
E I ' set bits 0 and 1 on control port
xample SPI_T6963C_SetBit (0x03)
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SPI_T6963C_NegBit
Prototype sub procedure SPI T6963C negBit(dim b as byte)
Returns Nothing.
Negates control port bit(s).
Description Parameters :
- b: bit mask. The function will negate bit x on control port if bit x in bit mask is
setto 1.
Requires Toshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.
E I ' negate bits 0 and 1 on control port
Xample  lspr 76963c NegBit (0x03)
SPI_T6963C_DisplayGrPanel
Prototype sub procedure SPI T6963C DisplayGrPanel (dim n as byte)
Returns Nothing.
Display selected graphic panel.
Description |Parameters :
- n: graphic panel number. Valid values: 0 and 1.
Requires Toshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.
' display graphic panel 1
Exan“ﬂe SPI T6963C DisplayGrPanel (1)
SPI_T6963C_DisplayTxtPanel
Prototype sub procedure SPI T6963C DisplayTxtPanel (dim n as byte)
Returns Nothing.
Display selected text panel.
Description |Parameters :
- n: text panel number. Valid values: 0 and 1.
Requires Toshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.
Example ' display text panel 1

SPT7T6963C7D1' splayTxtPanel (1)
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SPI_T6963C_SetGrPanel

Prototype sub procedure SPI T6963C SetGrPanel (dim n as byte)
Returns Nothing.
Compute start address for selected graphic panel and set appropriate internal
pointers. All subsequent graphic operations will be preformed at this graphic
panel.
Description
Parameters :
- n: graphic panel number. Valid values: 0 and 1.
Requires Toshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.
' set graphic panel 1 as current graphic panel.
Example SPI T6963C SetGrPanel (1)
SPI_T6963C_SetTxtPanel
Prototype sub procedure SPI T6963C SetTxtPanel (dim n as byte)
Returns Nothing.
Compute start address for selected text panel and set appropriate internal point-
ers. All subsequent text operations will be preformed at this text panel.
Description Parameters :
- n: text panel number. Valid values: 0 and 1.
Requires Toshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.
Exanuﬂe ' set text panel 1 as current text panel.

SPI T6963C SetTxtPanel (1)
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SPI_T6963C_PanelFill

Prototype sub procedure SPI T6963C PanelFill (dim v as byte)

Returns Nothing.

Fill current panel in full (graphic+text) with appropriate value (0 to clear).
Description |Parameters :

- v: value to fill panel with.

Requires Toshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.

clear current panel

Example .o t6963c paneirill (o)

SPI_T6963C_GrFill

Prototype sub procedure SPI T6963C GrFill(dim v as byte)

Returns Nothing.

Fill current graphic panel with appropriate value (0 to clear).
Description |Parameters :

- v: value to fill graphic panel with.

Requires Toshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.

' clear current graphic panel

Example SPI T6963C GrFill (0)

SPI_T6963C_TxtFill

Prototype sub procedure SPI T6963C TxtFill(dim v as byte)

Returns Nothing.

Fill current text panel with appropriate value (0 to clear).
Description |Parameters :

- v: this value increased by 32 will be used to fill text panel.

Requires Toshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.

' clear current text panel

Example SPT T6963C TxtFill (0)
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SPI1_T6963C_Cursor_Height

Prototype sub procedure SPI T6963C Cursor Height(dim n as byte)
Returns Nothing.
Set cursor size.
Description |Parameters :
- n: cursor height. Valid values: 0..7.
Requires Toshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.
Example SPI T6963C Cursor Height (7)
SPI_T6963C_Graphics
Prototype sub procedure SPI T6963C Graphics(dim n as byte)
Returns Nothing.
Enable/disable graphic displaying.
o Parameters :
Description
- n: graphic enable/disable parameter. Valid values: 0 (disable graphic
dispaying) and 1 (enable graphic displaying).
Requires Toshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.
' enable graphic displaying
Example SPI_T6963C Graphics (1)

SPI_T6963C_Text

Prokﬂype sub procedure SPI T6963C Text(dim n as byte)
Returns Nothing.
Enable/disable text displaying.
Description Parameters :
- n: text enable/disable parameter. Valid values: 0 (disable text dispaying) and 1
(enable text displaying).
Requires Toshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.
' enable text displaying
Example SPI_T6963C Text (1)
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SPI_T6963C_Cursor

Prototype sub procedure SPI T6963C Cursor(dim n as byte)
Returns Nothing.3q
Set cursor on/off.
Description |[Parameters :
- n: on/off parameter. Valid values: 0 (set cursor off) and 1 (set cursor on).
Requires Toshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.
Example | 7" 0
SPI_T6963C_Cursor_Blink
Prototype sub procedure SPI T6963C Cursor Blink(dim n as byte)
Returns Nothing.
Enable/disable cursor blinking.
Description Parameters :
- n: cursor blinking enable/disable parameter. Valid values: 0 (disable cursor
blinking) and 1 (enable cursor blinking).
Requires Toshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.
Example | T U

Library Example

The following drawing demo tests advanced routines of the SPI T6963C Glcd library. Hardware
configurations in this example are made for the T6963C 240x128 display, EasyAVR5A board and
ATmega16.
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program SPI T6963C 240x128

include Lib SPIT6963C Const
include bitmap
include bitmap2

dim

' Port Expander module connections
SPExpanderRST as sbit at PORTB.BO
SPExpanderCS as sbit at PORTB.B1
SPExpanderRST Direction as sbit at DDRB.BO
SPExpanderCS Direction as sbit at DDRB.B1

' End Port Expander module connections

dim panel as byte ' current panel
i as word ' general purpose register
curs as byte ' cursor visibility
cposx,
cposy as word ' cursor x-y position

txt, txtl as string] 29]

txtl = " EINSTEIN WOULD HAVE LIKED mE"
txt = " GLCD LIBRARY DEMO, WELCOME !"
DDRA = 0x00 ' configure PORTA as input
U *
' * 1init display for 240 pixel width and 128 pixel height
' * 8 bits character width
' * data bus on MCP23S17 portB
' * control bus on MCP23S17 portA
' * bit 2 is !WR
' * bit 1 is !RD
' * bit 0 is !CD
' * bit 4 is RST
' * chip enable, reverse on, 8x8 font internaly set in library
U *

' Pass pointer to SPI Read function of used SPI module

Spi_Rd_Ptr = @SPI1_Read
' Initialize SPI module

SPI1 Init Advanced( SPI MASTER, SPI FCY DIV2, SPI CLK HI TRAIL-
ING)
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' ' If Port Expander Library uses SPI2 module

' Pass pointer to SPI Read function of used SPI module

' Spi Rd Ptr = @SPI2 Read ' Pass pointer to SPI Read
function of used SPI module

' Initialize SPI module used with PortExpander
' SPI2 Init Advanced( SPI MASTER, _SPI_FCY DIV2,
_SPI_CLK_HI TRAILING)

' Initialize SPI Toshiba 240x128
SPI T6963C Config(240, 128, 8, 0, 2, 1, 0, 4)
'Delay ms (1000)

' * Enable both graphics and text display at the same time
*

SPI T6963C graphics (1)

SPT_T6963C_text (1)

panel = 0
i=0

curs = 0
cposx = 0
cposy = 0

' * Text messages
]

SPI_T6963C write text (txt, 0, 0, SPI_T6963C_ROM MODE_ XOR)
SPI_T6963C write text (txtl, 0, 15, SPI _T6963C_ROM MODE XOR)

1%

'* Cursor
%

SPI T6963C cursor height (8) ' 8 pixel height
SPI T6963C set cursor (0, O0) ' move cursor to top left
SPI T6963C cursor (0) ' cursor off

1%

'* Draw rectangles

T x

SPI T6963C rectangle
SPI T6963C rectangle
SPI T6963C rectangle
SPI T6963C rectangle
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'* Draw a cross

T x

SPI T6963C line (0, 0, 239, 127, SPI T6963C WHITE)
SPI T6963C line (0, 127, 239, 0, SPI T6963C WHITE)

T x

'* Draw solid boxes

T x

SPI T6963C box (0, 0, 239, 8, SPI T6963C WHITE)

SPI T6963C box (0, 119, 239, 127, SPI T6963C WHITE)

T x

'* Draw circles

T x

SPI T6963C circle(120, 64, 10, SPI T6963C WHITE)
SPI T6963C circle(120, 64, 30, SPI T6963C WHITE)
SPI T6963C circle(120, 64, 50, SPI T6963C WHITE)
SPI T6963C circle(120, 64, 70, SPI T6963C WHITE)
SPI T6963C circle(120, 64, 90, SPI T6963C WHITE)
SPI T6963C circle(120, 64, 110, SPI T6963C WHITE)
SPI T6963C circle(120, 64, 130, SPI T6963C WHITE)

SPI T6963C sprite(76, 4, (@einstein, 88, 119) ' Draw a sprite

SPI T6963C setGrPanel (1) ' Select other
graphic panel

SPI T6963C image (€mikroe) ' Fill the

graphic screen with a picture

while TRUE ' Endless loop

X
'* If PORTA 0 is pressed, toggle the display between graphic
panel 0 and graphic 1
X
if ( PINAO bit = 0) then
Inc (panel)
panel = panel and 1
SPI T6963C setPtr ((SPI _T6963C grMemSize +
SPI T6963C txtMemSize) * panel, SPI T6963C GRAPHIC HOME ADDRESS SET)
Delay ms (300)

T x
'* If PORTA 1 is pressed, display only graphic panel
T x
else
if ( PINAl bit = 0) then
SPI T6963C graphics (1)
SPI T6963C text (0)
Delay ms (300)
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1%

'* If PORTA 3 is pressed, display text and graphic panels
%
else
if ( PINA3 bit = 0) then
SPI T6963C graphics (1)
SPI T6963C text (1)
Delay ms (300)

1%

'* If PORTA 4 is pressed, change cursor
T x
else
if ( PINA4 bit = 0) then
Inc (curs)

if (curs = 3) then
curs = 0

end if

select case curs
case 0

' no cursor
SPI T6963C cursor (0)

case 1
' blinking cursor
SPI T6963C cursor (1)
SPI T6963C cursor blink(1l)
case 2
' non blinking cursor
SPI T6963C cursor (1)
SPI T6963C cursor blink(0)
end select
Delay ms (300)
end if
end if
end if
end if
end if

"k

'* Move cursor, even if not visible
T x
Inc (cposx)
if (cposx = SPI T6963C txtCols) then
cposx = 0
Inc (cposy)
if (cposy = SPI T6963C grHeight / SPI T6963C CHARACTER HEIGHT)

then
cposy = 0
end if
end if
SPI T6963C set cursor(cposx, cCposy)
Delay ms (100)
wend B
end.
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HW Connection
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SPI T6963C GRAPHIC LCD LIBRARY

The mikroBasic PRO for AVR provides a library for working with Glcds based on
TOSHIBA T6963C controller. The Toshiba T6963C is a very popular Lcd controller
for the use in small graphics modules. It is capable of controlling displays with a res-
olution up to 240x128. Because of its low power and small outline it is most suitable
for mobile applications such as PDAs, MP3 players or mobile measurement equip-
ment. Although small, this contoller has a capability of displaying and merging text
and graphics and it manages all the interfacing signals to the displays Row and Col-
umn drivers.

For creating a custom set of Glcd images use Glcd Bitmap Editor Tool.
Note: ChipEnable(CE), FontSelect(FS) and Reverse(MD) have to be set to appro-
priate levels by the user outside of the T6963C _Init function. See the Library Exam-

ple code at the bottom of this page.

Note: Some mikroElektronika's adapter boards have pinout different from T6369C
datasheets. Appropriate relations between these labels are given in the table below:

Adapter Board|T6369C datasheet

RS C/D
R/W /RD
E /WR
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External dependencies of T6963C Graphic Lcd Library

The following variables
must be defined in all
projects using T6963C

Graphic Lcd library:

Description:

Example :

dim T6963C dataPort
as byte sfr external

T6963C Data Port.

dim T6963C dataPort
as byte at PORTD

dim T6963C ctrlPort
as byte sfr external

T6963C Control Port.

dim T6963C ctrlPort
as byte at PORTC

dim T6963C ctrlwr as Write signal dim T6963C ctrlwr as

sbit sfr external 9 ’ sbit at PORTC.B2

dim T6963C ctrlrd as . dim T6963C ctrlrd as
- Read signal. =

sbit sfr external

sbit at PORTC.B1

dim T6963C ctrlcd
sbit sfr external

as

Command/Data signal.

dim T6963C ctrlcd as
sbit at PORTC.BO

dim T6963C ctrlrst as
sbit sfr external

Reset signal.

dim T6963C ctrlrst as
sbit at PORTC.B4

dim

T6963C dataPort Direc
tion as byte sfr
external

Direction of the T6963C
Data Port.

dim
T6963C dataPort Direc
tion as byte at DDRD

dim

T6963C ctrlPort Direc
tion as byte sfr
external

Direction of the T6963C
Control Port.

dim
T6963C ctrlPort Direc
tion as byte at DDRC

dim

T6963C ctrlwr Directi
on as sbit sfr
external

Direction of the Write pin.

dim
T6963C ctrlwr Directi
on as sbit at DDRC.B2

dim

T6963C ctrlrd Directi
on as sbit sfr
external

Direction of the Read pin.

dim
T6963C ctrlrd Directi
on as sbit at DDRC.B1

dim

T6963C ctrlcd Directi
on as sbit sfr
external

Direction of the Com-
mand/Data pin.

dim
T6963C ctrlcd Directi
on as sbit at DDRC.BO

dim

T6963C ctrlrst Direct
ion as sbit sfr
external

Direction of the Reset pin.

dim

T6963C ctrlrst Direct
ion as sbit at
DDRC.B4
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Library Routines

- T6963C_Init

- T6963C_WriteData

- T6963C_WriteCommand
- T6963C_SetPtr

- T6963C_WaitReady

- T6963C_Fill

- T6963C_Dot

- T6963C_Write_Char

- T6963C_Write_Text

- T6963C_Line

- T6963C_Rectangle

- T6963C_Box

- T6963C_Circle

- T6963C_Image

- T6963C_Sprite

- T6963C_Set_Cursor

- T6963C_DisplayGrPanel
- T6963C_DisplayTxtPanel
- T6963C_SetGrPanel

- T6963C_SetTxtPanel

- T6963C_PanelFill

- T6963C_GrFill

- T6963C_TxtFill

- T6963C_Cursor_Height
- T6963C_Graphics

- T6963C_Text

- T6963C_Cursor

- T6963C_Cursor_Blink
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T6963C_Init

Prototype

sub procedure T6963C init (dim width, height, fntW as byte)

Returns

Nothing.

Description

Initalizes the Graphic Lcd controller.
Parameters :

- width: width of the Glcd panel
- height: height of the Glcd panel
- fntw: font width

Display RAM organization:
The library cuts the RAM into panels : a complete panel is one graphics panel
followed by a text panel (see schematic below).

schematic:

+ GRAPHICS PANEL #0 + |

Requires

Global variables :

T6963C dataPort: Data Port

T6963C ctrlport: Control Port

T6963C ctrlwr: Write signal pin

T6963C ctrlrd: Read signal pin

T6963C ctrlcd: Command/Data signal pin

T6963C ctrlrst: Reset signal pin

T6963C dataPort Direction: Direction of Data Port
T6963C ctrlPort Direction: Direction of Control Port
T6963C ctrlwr Direction: Direction of Write signal pin
T6963C ctrlrd Direction: Direction of Read signal pin

- T6963C ctrled Direction: Direction of Command/Data signal pin
- T6963C ctrlrst Direction: Direction of Reset signal pin

must be defined before using this function.
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' T6963C module connections

dim T6963C ctrlPort as byte at PORTC
dim T6963C dataPort as byte at PORTD
dim T6963C ctrlPort Direction as byte at DDRD
dim T6963C dataPort Direction as byte at DDRC

dim T6963C ctrlwr as sbit at PORTC.B2

dim T6963C ctrlrd as sbit at PORTC.BI

dim T6963C ctrlcd as sbit at PORTC.BO

dim T6963C ctrlrst as sbit at PORTC.B4

dim T6963C ctrlwr Direction as sbit at DDRC.B2
dim T6963C ctrlrd Direction as sbit at DDRC.B1
dim T6963C ctrlcd Direction as sbit at DDRC.BO
dim T6963C ctrlrst Direction as sbit at DDRC.B4
' End of T6963C module connections

Example

' init display for 240 pixel width, 128 pixel height and 8 Dbits
character width
T6963C init (240, 128, 8)

T6963C_WriteData

Prototype sub procedure T6963C WriteData (dim mydata as byte)

Returns Nothing.
Writes data to T6963C controller.

Description |Parameters :

-mydata: data to be written

Requires Toshiba Glcd module needs to be initialized. See the T6963C _Init routine.

Example T6963C_ WriteData (AddrL)
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T6963C_WriteCommand

Prototype sub procedure T6963C WriteCommand (dim mydata as byte)
Returns Nothing.
Writes command to T6963C controller.
Description |[Parameters :
- mydata: command to be written
Requires Toshiba Glcd module needs to be initialized. See the T6963C_Init routine.
Example T6963C WriteCommand (T6963C CURSOR POINTER SET)

T6963C_SetPtr

Prototype sub procedure T6963C SetPtr(dim p as word, dim c as byte)
Returns Nothing.
Sets the memory pointer p for command c.
o Parameters :
Description
- p: address where command should be written
- c: command to be written
Requires Toshiba Glcd module needs to be initialized. See the T6963C_Init routine.
E I T6963C SetPtr (T6963C grHomeAddr + start,
xample T6963C_ADDRESS POINTER SET)
T6963C_WaitReady
Prototype |sub procedure T6963C WaitReady ()
Returns Nothing.
Description [Pools the status byte, and loops until Toshiba Glcd module is ready.
Requires Toshiba Glcd module needs to be initialized. See the T6963C_Init routine.
Example T6963C WaitReady ()
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T6963C _Fill
Prototype sub procedure T6963C Fill(dim v as byte, dim start, len as word)
Returns Nothing.

Fills controller memory block with given byte.

Parameters :
Description

- v: byte to be written

- start: starting address of the memory block

- len: length of the memory block in bytes
Requires Toshiba Glcd module needs to be initialized. See the T6963C _Init routine.
Example T6963C Fill (0x33,0x00FF, 0x000F)
T6963C_Dot
Prototype sub procedure T6963C Dot (dim x, y as integer, dim color as byte)
Returns Nothing.

Draws a dot in the current graphic panel of Glcd at coordinates (x, y).

Parameters :
Description

- x: dot position on x-axis

- v: dot position on y-axis

- color: color parameter. Valid values: T6963C_BLACK and T6963C_WHITE
Requires Toshiba Glcd module needs to be initialized. See the T6963C_Init routine.
Example T6963C Dot (x0, y0, pcolor)
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T6963C_Write_Char

Prototype sub procedure T6963C Write Char(dim c, x, y, mode as byte)
Returns Nothing.
Writes a char in the current text panel of Glcd at coordinates (x, y).
Parameters :
- c: char to be written
- x: char position on x-axis
- v: char position on y-axis
- mode: mode parameter. Valid values: T6963C_ROM_MODE_OR,
T6963C_ROM_MODE_XOR, T6963C_ROM_MODE_AND and
T6963C_ROM_MODE_TEXT
Mode parameter explanation:
Description
- OR Mode: In the OR-Mode, text and graphics can be displayed and the data
is logically “OR-ed”. This is the most common way of combining text and
graphics for example labels on buttons.
- XOR-Mode: In this mode, the text and graphics data are combined via the
logical “exclusive OR”. This can be useful to display text in the negative mode,
i.e. white text on black background.
- AND-Mode: The text and graphic data shown on display are combined via the
logical “AND function”.
- TEXT-Mode: This option is only available when displaying just a text. The Text
Attribute values are stored in the graphic area of display memory.
For more details see the T6963C datasheet.
Requires Toshiba Glcd module needs to be initialized. See the T6963C _Init routine.
Example T6963C Write Char('A',22,23,AND)
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T6963C_Write_Text

sub procedure T6963C Write Text (dim byref str as bytel 10] , dim x,
y, mode as byte)

Prototype

Returns Nothing.

Writes text in the current text panel of Glcd at coordinates (x, y).
Parameters :

- str: text to be written

- x: text position on x-axis

- v: text position on y-axis

- mode: mode parameter. Valid values: T6963C_ROM_MODE_OR,
T6963C_ROM_MODE_XOR, T6963C_ROM_MODE_AND and
T6963C_ROM_MODE_TEXT

Mode parameter explanation:

Description

- OR Mode: In the OR-Mode, text and graphics can be displayed and the data
is logically “OR-ed”. This is the most common way of combining text and
graphics for example labels on buttons.

- XOR-Mode: In this mode, the text and graphics data are combined via the
logical “exclusive OR”. This can be useful to display text in the negative mode,
i.e. white text on black background.

- AND-Mode: The text and graphic data shown on display are combined via the
logical “AND function”.

- TEXT-Mode: This option is only available when displaying just a text. The Text
Attribute values are stored in the graphic area of display memory.

For more details see the T6963C datasheet.

Requires Toshiba Glcd module needs to be initialized. See the T6963C_Init routine.

T6963C_Write Text (" GLCD LIBRARY DEMO, WELCOME !", 0, O,

Example T6963C_ROM MODE_XOR)

450 MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD



CHAPTER 6
mikroBasic PRO for AVR Libraries

T6963C_Line

sub procedure T6963C Line(dim x0, yO0, x1, yl as integer, dim

PrOtOtype pcolor as byte)

Returns Nothing.

Draws a line from (x0, y0) to (x1, y1).
Parameters :

Description |- x0: x coordinate of the line start
- v0: y coordinate of the line end
- x1: x coordinate of the line start
- y1: y coordinate of the line end
- pcolor: color parameter. Valid values: T6963C_BLACK and T6963C_WHITE

Requires Toshiba Glcd module needs to be initialized. See the T6963C_Init routine.

Example T6963C Line (0, 0, 239, 127, T6963C WHITE)

T6963C_Rectangle

sub procedure T6963C Rectangle(dim x0, y0, x1, yl as integer, dim
pcolor as byte)

Prototype

Returns Nothing.

Draws a rectangle on Glcd.
Parameters :

Description |- x0: x coordinate of the upper left rectangle corner

- y0: y coordinate of the upper left rectangle corner

- x1: x coordinate of the lower right rectangle corner

- y1: y coordinate of the lower right rectangle corner

- pcolor: color parameter. Valid values: T6963C_BLACK and T6963C_WHITE

Requires Toshiba Glcd module needs to be initialized. See the T6963C_Init routine.

Exan“ﬂe T6963C Rectangle (20, 20, 219, 107, T6963C WHITE)
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T6963C_Box

sub procedure T6963C Box(dim x0, y0, x1, yl as integer, dim pcol-

Prototype or as byte)

Returns Nothing.

Draws a box on Glcd
Parameters :

Description |- x0: x coordinate of the upper left box corner

- y0: y coordinate of the upper left box corner

- x1: x coordinate of the lower right box corner

- y1: y coordinate of the lower right box corner

- pcolor: color parameter. Valid values: T6963C_BLACK and T6963C_WHITE

Requires Toshiba Glcd module needs to be initialized. See the T6963C_Init routine.

Example T6963C Box (0, 119, 239, 127, T6963C _WHITE)

T6963C_Circle

sub procedure T6963C Circle(dim x, y as integer, dim r as

PrOtOtype longint, dim pcolor as byte)
Returns Nothing.
Draws a circle on Glcd.
Parameters :
Description

- x: X coordinate of the circle center

- v: y coordinate of the circle center

- r: radius size

- pcolor: color parameter. Valid values: T6963C_BLACK and T6963C_WHITE

Requires Toshiba Glcd module needs to be initialized. See the T6963C _Init routine.

Example T6963C Circle (120, 64, 110, T6963C WHITE)
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T6963C_Image
Prototype sub procedure T6963C Image (const pic as “byte)
Returns Nothing.
Displays bitmap on Glcd.
Parameters :
- pic: image to be displayed. Bitmap array can be located in both code and
Description | RAM memory (due to the mikroBasic PRO for AVR pointer to const and
pointer to RAM equivalency).
Use the mikroBasic PRO’s integrated Glcd Bitmap Editor (menu option Tools >
Glcd Bitmap Editor) to convert image to a constant array suitable for display-
ing on Glcd.
Requires Toshiba Glcd module needs to be initialized. See the T6963C_Init routine.
Example T6963C_Image (mc)
T6963C_Sprite
Prototype subAprocedure T6963C Sprite(dim px, py, sx, sy as byte, const pic
as “byte)
Returns Nothing.
Fills graphic rectangle area (px, py) to (px+sx, py+sy) with custom size picture.
Parameters :
- px: x coordinate of the upper left picture corner. Valid values: multiples of the
font width
Description |- pov: y coordinate of the upper left picture corner
- pic: picture to be displayed
- sx: picture width. Valid values: multiples of the font width
- sy: picture height
Note: If px and sx parameters are not multiples of the font width they will be
scaled to the nearest lower number that is a multiple of the font width.
Requires Toshiba Glcd module needs to be initialized. See the T6963C _Init routine.
Example T6963C Sprite(76, 4, einstein, 88, 119) ' draw a sprite
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T6963C_Set_Cursor

Prototype sub procedure T6963C Set Cursor(dim x, y as byte)
Returns Nothing.
Sets cursor to row x and column .
e Parameters :
Description
- x: cursor position row number
- y: cursor position column number
Requires Toshiba Glcd module needs to be initialized. See the T6963C_Init routine.
Example T6963C_Set Cursor (cposx, cposy)

T6963C_DisplayGrPanel

Prototype sub procedure T6963C DisplayGrPanel (dim n as byte)
Returns Nothing.
Display selected graphic panel.
Description |Parameters :
- n: graphic panel number. Valid values: 0 and 1.
Requires Toshiba Glcd module needs to be initialized. See the T6963C_Init routine.
Example | o000 LT

T6963C_DisplayTxtPanel

Prokﬂype sub procedure T6963C DisplayTxtPanel (dim n as byte)

Returns Nothing.
Display selected text panel.

Description |Parameters :
- n: text panel number. Valid values: 0 and 1.

Requires Toshiba Glcd module needs to be initialized. See the T6963C_Init routine.
' display text panel 1

Example T6963C DisplayTxtPanel (1)
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T6963C_SetGrPanel

Prokﬁype sub procedure T6963C SetGrPanel (dim n as byte)

Returns Nothing.
Compute start address for selected graphic panel and set appropriate internal
pointers. All subsequent graphic operations will be preformed at this graphic
panel.

Description
Parameters :
- n: graphic panel number. Valid values: 0 and 1.

Requires Toshiba Glcd module needs to be initialized. See the T6963C_Init routine.
' set graphic panel 1 as current graphic panel.

Example | 53¢ setorpanel (1)

T6963C_SetTxtPanel

Prokﬂype sub procedure T6963C SetTxtPanel (dim n as byte)
Returns Nothing.
Compute start address for selected text panel and set appropriate internal point-
ers. All subsequent text operations will be preformed at this text panel.
Description Parameters :
- n: text panel number. Valid values: 0 and 1.
Requires Toshiba Glcd module needs to be initialized. See the T6963C_Init routine.
' set text panel 1 as current text panel.
Example

T6963C SetTxtPanel (1)
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T6963C_PanelFill

Prototype sub procedure T6963C PanelFill (dim v as byte)

Returns Nothing.

Fill current panel in full (graphic+text) with appropriate value (0 to clear).
Description |Parameters :

- v: value to fill panel with.

Requires Toshiba Glcd module needs to be initialized. See the T6963C_Init routine.

clear current panel

Example T6963C_PanelFill (0)

T6963C_GrFill

Prototype sub procedure T6963C PanelFill (dim v as byte)

Returns Nothing.

Fill current panel in full (graphic+text) with appropriate value (0 to clear).
Description |Parameters :

- v: value to fill panel with.
Requires Toshiba Glcd module needs to be initialized. See the T6963C_Init routine.

clear current panel

Example T6963C_PanelFill (0)

T6963C_TxtFill

Prototype sub procedure T6963C TxtFill(dim v as byte)

Returns Nothing.

Fill current text panel with appropriate value (0 to clear).
Description |[Parameters :

- v: this value increased by 32 will be used to fill text panel.

Requires Toshiba Glcd module needs to be initialized. See the T6963C_Init routine.

' clear current text panel

Example T6963C TxtFill (0)

456 MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD



CHAPTER 6
mikroBasic PRO for AVR Libraries

T6963C_Cursor_Height
Prototype sub procedure T6963C Cursor Height(dim n as byte)

Returns Nothing.

Set cursor size.
Description |[Parameters :

- n: cursor height. Valid values: 0..7.

Requires Toshiba Glcd module needs to be initialized. See the T6963C _Init routine.

Example T6963C Cursor Height (7)

T6963C_Graphics

Prototype sub procedure T6963C Graphics(dim n as byte)

Returns Nothing.

Enable/disable graphic displaying.

o Parameters :
Description

- n: on/off parameter. Valid values: 0 (disable graphic dispaying) and 1 (enable
graphic displaying).

Requires Toshiba Glcd module needs to be initialized. See the T6963C _Init routine.

' enable graphic displaying

Example T6963C_Graphics (1)

T6963C_Text

Prototype sub procedure T6963C Text (dim n as byte)

Returns Nothing.

Enable/disable text displaying.

. Parameters :
Description

- n: on/off parameter. Valid values: 0 (disable text dispaying) and 1 (enable text
displaying).

Requires Toshiba Glcd module needs to be initialized. See the T6963C _Init routine.

' enable text displaying

Example T6963C Text (1)
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T6963C_Cursor

Prototype sub procedure T6963C Cursor (dim n as byte)

Returns Nothing.

Set cursor on/off.
Description |Parameters :

- n: on/off parameter. Valid values: 0 (set cursor off) and 1 (set cursor on).

Requires Toshiba Glcd module needs to be initialized. See the T6963C_Init routine.

' set cursor on

Example T6963C Cursor (1)

T6963C_Cursor_Blink

Prototype sub procedure T6963C Cursor Blink(dim n as byte)

Returns Nothing.

Enable/disable cursor blinking.

o Parameters :
Description

- n: on/off parameter. Valid values: 0 (disable cursor blinking) and 1 (enable
cursor blinking).

Requires Toshiba Glcd module needs to be initialized. See the T6963C_Init routine.

' enable cursor blinking

Example T6963C Cursor Blink(1)

Library Example

The following drawing demo tests advanced routines of the T6963C Glcd library. Hardware con-
figurations in this example are made for the T6963C 240x128 display, EasyAVR5A board and
ATmega16.
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program T6963C 240x128

include Lib T6963C Consts
include bitmap
include bitmap2

dim
dim

dim T6963C ctrlPort Direction as byte at DDRC

T6963C module connections

T6963C ctrlPort as byte at PORTC
T6963C dataPort as byte at PORTD

tion register
dim T6963C dataPort Direction as byte at DDRD ' DATA direc-
tion register

' CONTROL port
' DATA port
' CONTROL direc-

dim T6963C ctrlwr as sbit at PORTC.B2 ' WR write signal

dim T6963C ctrlrd as sbit at PORTC.B1 ' RD read signal

dim T6963C ctrlcd as sbit at PORTC.BO ' CD command/data signal
dim T6963C ctrlrst as sbit at PORTC.B4 ' RST reset signal

dim T6963C ctrlwr Direction as sbit at DDRC.B2 ' WR write sig-
nal direction

dim T6963C ctrlrd Direction as sbit at DDRC.B1 ' RD read sig-
nal direction

dim T6963C ctrlcd Direction as sbit at DDRC.BO ' CD
command/data signal direction

dim T6963C ctrlrst Direction as sbit at DDRC.B4 ' RST reset

signal direction

dim
dim
dim

dim T6963C ctrlce Direction as sbit at DDRC.

Signals not used by library, they are set

T6963C ctrlce as sbit at PORTC.B3
T6963C ctrlfs as sbit at PORTC.B6
T6963C ctrlmd as sbit at PORTC.BS

direction

dim T6963C ctrlfs Direction as sbit at DDRC.

direction

dim T6963C ctrlmd Direction as sbit at DDRC.

direction

v

End T6963C module connections

in main sub function

' CE signal
' FS signal
' MD signal
B3 ' CE signal
B6 ' FS signal
B5 ' MD signal

dim panel as byte ' current panel
i as word ' general purpose register
curs as byte ' cursor visibility

cposx,
cposy as word ' cursor x-y position
txtcols as byte ' number of text coloms
txt, txtl as string] 29]

txtl = " EINSTEIN WOULD HAVE LIKED mE"

txt = " GLCD LIBRARY DEMO, WELCOME !"
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DDRA = 0x00 ' configure PORTA as input

DDAO bit = 0 ' Set PBO as input
DDAl bit = 0 ' Set PBl as input
DDA2 bit = 0 ' Set PB2 as input
DDA3 bit = 0 ' Set PB3 as input
DDA4 bit = 0 ' Set PB4 as input

T6963C ctrlce Direction = 1
T6963C ctrlce = 0 !
T6963C ctrlfs Direction = 1
T6963C ctrlfs = 0 !
T6963C ctrlmd Direction = 1
T6963C ctrlmd = 0 !

Enable T6963C

Font Select 8x8

Column number select

panel = 0
i=0

curs = 0
cposx = 0
cposy = 0

' Initialize T6369C
T6963C init (240, 128, 8)

{ *
* Enable both graphics and text display at the same time
*}

T6963C graphics (1)

T6963C_ text (1)

{ *

* Text messages

*}

T6963C write text(txt, 0, O,
T6963C write text(txtl, 0, 15,

T6963C_ROM MODE XOR)
T6963C_ROM MODE XOR)

{*

* Cursor

*}

T6963C cursor height (8) ' 8 pixel height
T6963C set cursor (0, 0) ' Move cursor to top left
T6963C cursor (0) ' Cursor off

{*
* Draw rectangles
*}

T6963C rectangle(0, 0, 239, 127,

, 20, 219, 107,

T6963C WHITE)

T6963C rectangle

(
T6963C rectangle (
(
T6963C rectangle (

20
40, 40,
60, 60,

87,
67,

T6963C WHITE)
T6963C_ WHITE)
T6963C_ WHITE)
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{*
* Draw a cross
*}
T6963C line(0, 0, 239, 127, T6963C WHITE)
T6963C line(0, 127, 239, 0, T6963C WHITE)

{*

* Draw solid boxes

*}
T6963C box (0, 0, 239, 8, T6963C WHITE)
T6963C box (0, 119, 239, 127, T6963C WHITE)

'while true do nop
{*

* Draw circles

*}
T6963C circle (120, 64, 10, T6963C_WHITE)
T6963C circle (120, 64, 30, T6963C_WHITE)
T6963C circle (120, 64, 50, T6963C_WHITE)
T6963C circle (120, 64, 70, T6963C_WHITE)
T6963C circle (120, 64, 90, T6963C_WHITE)
T6963C circle (120, 64, 110, T6963C WHITE)
T6963C circle (120, 64, 130, T6963C WHITE)

T6963C sprite(76, 4, (@einstein, 88, 119) ' Draw a sprite
T6963C setGrPanel (1) ' Select other graphic panel

T6963C image (@mikroe)

while TRUE ' Endless loop

Tx

'* If PORTA 0 is pressed, toggle the display between graphic
panel 0 and graphic 1
Tx
if ( PINAO bit = 0) then
Inc (panel)
panel = panel and 1
T6963C setPtr((T6963C grMemSize + T6963C txtMemSize) * panel,
T6963C_GRAPHIC HOME ADDRESS SET)
Delay ms (300)

Tx

'* If PORTA 1 is pressed, display only graphic panel
L
else
if ( PINAl bit = 0) then
T6963C graphics (1)
T6963C text (0)
Delay ms (300)

MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD 461



CHAPTER 6
Libraries mikroBasic PRO for AVR

'* If PORTA 2 is pressed, display only text panel

else
if ( PINA2 bit = 0) then
T6963C graphics (0)
T6963C text (1)
Delay ms (300)

If PORTA 3 is pressed, display text and graphic panels

else
if ( PINA3 bit = 0) then
T6963C graphics (1)
T6963C text (1)
Delay ms (300)

'* If PORTA 4 is pressed, change cursor
else

if ( PINA4 bit = 0) then
Inc (curs)

if (curs = 3) then
curs = 0

end if

select case curs
case 0

' no cursor

T6963C cursor (0)
case 1
' blinking cursor
T6963C cursor (1)
T6963C cursor blink (1)
case 2
' non blinking cursor
T6963C cursor (1)
T6963C cursor blink(0)
end select

Delay ms (300)

end if
end if
end if
end if
end if
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T x

'* Move cursor, even if not visible

T x

Inc (cposx)

if (cposx = T6963C txtCols) then
cposx = 0
Inc (cposy)
if (cposy =

cposy = 0

end if

end if

T6963C _set cursor (cposx, cposy)

T6963C_grHeight / T6963C_CHARACTER HEIGHT) then

Delay ms (100)
wend
end.
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HW Connection
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TWI LIBRARY

TWI full master MSSP module is available with a number of AVR MCU models. mikroBasic PRO
for AVR provides library which supports the master TWI mode.

Library Routines

- TWI_Init

- TWI_Busy
- TWI_Start

- TWI_Stop

- TWI_Read
- TWI_Write
- TWI_Status
- TWI_Close

TWI_Init

Prototype sub procedure TWI Init(dim clock as longword)

Returns Nothing.

Initializes TWI with desired c1ock (refer to device data sheet for correct values
in respect with Fosc). Needs to be called before using other functions of TWI
Description Library.
You don’t need to configure ports manually for using the module; library will take
care of the initialization.

Requires Library requires MSSP module on PORTB or PORTC.

Example TWI Init (100000)

TWI_Busy

Prototype sub function TWI Busy() as byte

Returns Returns 0 if TWI start sequnce is finished, 1 if TWI start sequnce is not finished.

Description |Signalizes the status of TWI bus.

Requires TWI must be configured before using this function. See TWI_Init.

if (TWI Busy = 1)
Example -
end if
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TWI_Start

Prototype sub function TWI Start() as byte

Returns If there is no error function returns 0, otherwise returns 1.

Description |Determines if TWI bus is free and issues START signal.

Requires TWI must be configured before using this function. See TWI_Init.

if (TWI Start = 1)
Example S
end if

TWI_Read

Prototype sub function TWI Read(dim ack as byte) as byte

Returns Returns one byte from the slave.

Reads one byte from the slave, and sends not acknowledge signal if parameter

Description ack is 0, otherwise it sends acknowledge.

TWI must be configured before using this function. See TWI_Init.

Requires Also, START signal needs to be issued in order to use this function. See
TWI_Start.
Read data and send not acknowledge signal:

Example
tmp = TWI Read(0)

TWI_Write

Prototype sub procedure TWI Write (dim data as byte)

Returns Nothing.

Description |Sends data byte (parameter data_) via TWI bus.

TWI must be configured before using this function. See TWI_Init.

Requires Also, START signal needs to be issued in order to use this function. See
TWI_Start.
Example TWI Write (0xA3)

466 MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD



CHAPTER 6
Libraries

mikroBasic PRO for AVR
TWI_Stop
Prototype sub procedure TWI Stop ()
Returns Nothing.
Description |Issues STOP signal to TWI operation.
Requires TWI must be configured before using this function. See TWI_Init.
Example TWI Stop ()
TWI_Status
Prototype |sub function TWI Status() as byte
Returns Returns value of status register (TWSR), the highest 5 bits.
Description |Returns status of TWI.
Requires TWI must be configured before using this function. See TWI_Init.
Example status = TWI Status()
TWI_Close
Prototype sub procedure TWI Close()
Returns Nothing.
Description [Closes TWI connection.
Requires TWI must be configured before using this function. See TWI_Init.
Example TWI Close ()

Library Example

This code demonstrates use of TWI Library procedures and functions. AVR MCU is connected
(SCL, SDA pins ) to 24c02 EEPROM. Program sends data to EEPROM (data is written at address
2). Then, we read data via TWI from EEPROM and send its value to PORTA, to check if the cycle
was successful. Check the figure below.
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program TWI Simple

main:
DDRA = OxFF

TWI Init (100000)

TWI Start()

TWI Write (0xA2)

TWI Write(2)

TWI Write (OxAA)

TWI Stop ()

Delay 100ms ()

TWI Start(

TWI Write (0xA2)

TWI Write (2)

TWI Start(
TWI Write (0xA3)
PORTA = TWIiRead(O)
TWI Stop ()

end.

)
0
2
)

HW Connection

' configure PORTA as output

' initialize TWI communication
' issue TWI start signal
' send byte via TWI (device address + W)
' send byte (address of EEPROM location)
' send data (data to be written)
' issue TWI stop signal

' issue TWI start signal
' send byte via TWI (device address + W)
' send byte (data address)
' issue TWI signal repeated start
' send byte (device address + R)
' read data (NO acknowledge)
' issue TWI stop signal}

- \
[
(]
(]
| »
| 9
g B
WO VCC
.. : _TEEGND g
‘.LLU—‘.» XTALY
| -
i o
[
[
(]
[l

:l VO WiCC
i co
% '
L 1 7 8
] a0 wee [[—
g i b
+—{|ne  seL [}—
G"D%tL v [Jono soa [1-
]T = =
i 5)g| L 24c02
I
I
i
I
i
PC.A I
pco |l
[l

Interfacing 24c02 to AVR via TWI
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UART LIBRARY

UART hardware module is available with a number of AVR MCUs. mikroBasic PRO
for AVR UART Library provides comfortable work with the Asynchronous (full
duplex) mode.

You can easily communicate with other devices via RS-232 protocol (for example
with PC, see the figure at the end of the topic — RS-232 HW connection). You need
a AVR MCU with hardware integrated UART, for example ATmega16. Then, simply
use the functions listed below.

Library Routines

- UARTx_Init

- UARTx_Init_Advanced
- UARTx_Data_Ready

- UARTx_Read

- UARTx_Read_Text

- UARTx_Write

- UARTx_Write_Text

The following routine is for the internal use by compiler only:

- UARTx_TX_Idle
Note: AVR MCUs require you to specify the module you want to use. To select the
desired UART, simply change the letter = in the prototype for a number from 1 to 4.
Number of UART modules per MCU differs from chip to chip. Please, read the
appropriate datasheet before utilizing this library.

Example: uarT2 1nit () initializes UART 2 module.

Note: Some of the AVR MCUs do not support UARTx Init_ Advanced routine.
Please, refer to the appropriate datasheet.
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UARTx_Init

Prototype sub procedure UARTx Init (dim baud rate as longint)

Returns Nothing.

Configures and initializes the UART module.
The internal UART module module is set to:

- receiver enabled

- transmitter enabled

- frame size 8 bits

-1 STOP bit

- parity mode disabled

- asynchronous operation

Description

Parameters :
- baud rate: requested baud rate

Refer to the device data sheet for baud rates allowed for specific Fosc.

You'll need AVR MCU with hardware UART.
Requires
UARTXx_Init needs to be called before using other functions from UART Library.

'This will initialize hardware UART1 module and establish the
Example communication at 2400 bps
UART1 Init (2400)
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UARTx_Init_Advanced

Prototvpe sub procedure UARTx Init Advanced(dim baud rate as longword, dim
yp parity as byte, dim stop bits as byte)
Returns Nothing.
Configures and initializes UART module.
Parameter baud rate configures UART module to work on a requested baud rate.
Parameters parity and stop bits determine the work mode for UART, and
can have the following values:
Mask Description Predefined library const
Parity constants:
0x00 Parity mode disabled _UART NOPARITY
Desc"ptlon 0x20 Even parity _UART EVENPARITY
0x30 Odd parity UART ODDPARITY
Stop bit constants:
0x00 1 stop bit _UART ONE_STOPBIT
0x01 2 stop bits UART TWO STOPBITS
Note: Some MCUs do not support advanced configuration of the UART module.
Please consult appropriate daatsheet.
Requires MCU must have UART module.
' Initialize hardware UART1 module and establish communication at
Example 9600 bps, 8-bit data, even parity and 2 STOP bits
UART1 Init Advanced (9600, UART EVENPARITY, UART TWO STOPBITS)
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UARTx_Data_Ready

Prototype sub function UARTx Data Ready() as byte

Returns Function returns 1 if data is ready or o if there is no data.

Description |The function tests if data in receive buffer is ready for reading.

MCU with the UART module.

Requires The UART module must be initialized before using this routine. See the
UARTX_Init routine.
dim receive as byte
Example ' read data if ready
if (UART1 Data Ready() = 1) then
receive = UART1 Read()
UARTx_Read

Prototype sub function UARTx Read() as byte

Returns Received byte.

The function receives a byte via UART. Use the UARTx_Data_Ready function to

Description test if data is ready first.

MCU with the UART module.

Requires |10 UART module must be initialized before using this routine. See UARTx_Init
routine.
dim receive as byte

Example ;.Lead data if ready

if (UART1 Data Ready() = 1) then
receive = UART1 Read()
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UARTx_Read_Text

Prototvpe sub procedure UARTx Read Text (dim byref Output as stringl 255],
yp dim byref Delimiter as stringl 10] , dim Attempts as byte)
Returns Nothing.
Reads characters received via UART until the delimiter sequence is detected.
The read sequence is stored in the parameter cutput; delimiter sequence is
stored in the parameter delimiter.
Description . . - : .
P This is a blocking call: the delimiter sequence is expected, otherwise the proce-
dure exits( if the delimiter is not found). Attempts defines number of received
characters in which Delimiter sequence is expected. If Attempts is set to 255,
this routine will continously try to detect the Delimiter sequence.
. UART HW module must be initialized and communication established before
Requires : . . )
using this function. See UARTx_Init.
Read text until the sequence “OK” is received, and send back what’s been received:
UART1 Init (4800) ' initialize UART
module
Delay ms (100)
Example while TRUE
if (UART1 Data Ready() = 1) ' if data is received
UART1 Read Text (output, 'delim', 10) ' reads text until
'delim' is found
UARTlAWriteiText(output) ' sends back text
end if
wend.
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UARTXx_Write

Prototype |sub procedure UARTx Write(dim TxData as byte)

Returns Nothing.

The function transmits a byte via the UART module.
Description |Parameters :

- TxData: data to be sent

MCU with the UART module.

Requires The UART module must be initialized before using this routine. See UARTx_Init
routine.
dim data as byte

Example datai = 0x1E

UART1 Write (data )

UARTx_Write_Text

sub procedure UARTx Write Text (dim byref uart text as

Prototype stringl 255] )

Returns Nothing.

Description |Sends text (parameter uart_text) via UART. Text should be zero terminated.

UART HW module must be initialized and communication established before

Requires . . . !
q using this function. See UARTx_Init.
Read text until the sequence “OK” is received, and send back what's been received:
UART1 Init (4800) ' initialize UART
module
Delay ms (100)
Example while TRUE
if (UART1 Data Ready() = 1) ' 1f data 1s received
UART1 Read Text (output, 'delim', 10) ' reads text until
'delim' is found
UARTlgWriteiText(output) ' sends back text
end if
wend.
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Library Example

This example demonstrates simple data exchange via UART. If MCU is connected
to the PC, you can test the example from the mikroBasic PRO for AVR USART Ter-
minal.

program UART
dim uart rd as byte

main:
UART1 Init(19200) ' Initialize UART module at 9600 bps
Delay ms (100) ' Wait for UART module to stabilize
while TRUE ' Endless loop
if (UART1 Data Ready() <> 0) then ' If data is received,
uart rd = UART1 Read() ! read the received data,
UART1 Write (uart rd) ! and send data via UART
end if
wend
end.

HW Connection

A o T
| . CONNECT

| . . MCU TO PC
T
GABLE - -

Send
Data {Tx)

/5ol N \
RS-232 {5 / %{5 A 7(;55 o
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UART HW connection
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BUTTON LIBRARY

The Button library contains miscellaneous routines useful for a project development.

External dependencies of Button Library

The following variable

must be defined in all

projects using Button
library:

Description:

Example :

dim Button Pin as
sbit sfr external

Declares button pins.

dim Button Pin as
sbit at PINB.RO

dim
Button Pin Direction
as sbit sfr external

Declares direction of the
button pin.

dim
Button Pin Direction
as sbit at DDRB.BRO

Library Routines

- Button
Button
Protot sub function Button(dim time ms as byte, dim active state as
rototype byte) as byte

Returns - 255 if thg pin was in the active state for given period.
- 0 otherwise
The function eliminates the influence of contact flickering upon pressing a but-
ton (debouncing). The Button pin is tested just after the function call and then
again after the debouncing period has expired. If the pin was in the active state
in both cases then the function returns 255 (true).

Description Parameters :
- time ms : debouncing period in milliseconds
-active state: determines what is considered as active state. Valid values: 0

(logical zero) and 1 (logical one)

Global variables :

Requires - Button Pin: Button pin line

q -Button Pin Direction: Direction of the button pin

must be defined before using this function.
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PORTC is inverted on every PORTB.BO0 one-to-zero transition :
program Button
' Button connections
dim Button Pin as sbit at PINB.BO
dim Button Pin Direction as sbit at DDRB.BO
' End Button connections
dim oldstate as bit ' 0ld state flag
main:
Button Pin Direction = 0 ' Set Button pin as input
DDRC OxFF ' Configure PORTC as output
Example PORTC OxAA ' Initial PORTC value
oldstate = 0 ' oldstate initial wvalue

while TRUE

if (Button(l, 1) = 1) ' Detect logical one
oldstate =1 ' Update flag
end if
if (oldstate and Button(l, 0)) then ' Detect one-to-zero
transition
PORTC = not PORTC ' Invert PORTC
oldstate = 0 ' Update flag
end if
wend ' Endless loop

end.
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CONVERSIONS LIBRARY

mikroBasic PRO for AVR Conversions Library provides routines for numerals to strings and
BCD/decimal conversions.

Library Routines
You can get text representation of numerical value by passing it to one of the following routines:

- ByteToStr

- ShortToStr

- WordToStr

- IntToStr

- LongintToStr

- LongWordToStr
- FloatToStr

The following sub functions convert decimal values to BCD and vice versa:
- Dec2Bcd
- Bcd2Dec16
- Dec2Bcd16

ByteToStr

sub procedure ByteToStr (dim input as word, dim byref output as

Prototype stringl 2] )

Returns Nothing.

Converts input byte to a string. The output string is right justified and remaining
positions on the left (if any) are filled with blanks.

Description |Parameters :

- input: byte to be converted
- output : destination string

Requires Nothing.

dim t as word

txt as string 2]
Example -
t = 24
ByteToStr (t, txt) ' txt is " 24" (one blank here)
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ShortToStr
sub procedure ShortToStr (dim input as short, dim byref output as
Prototype stringl 3] )
Returns Nothing.
Converts input short (signed byte) number to a string. The output string is right
justified and remaining positions on the left (if any) are filled with blanks.
Description |[Parameters :
- input: short number to be converted
- output: destination string
Requires Nothing.
dim t as short
txt as string| 3]
Example S
t = -24
ByteToStr (t, txt) ' txt is " -24" (one blank here)
WordToStr
Prototype sub_procedure WordToStr (dim input as word, dim byref output as
stringl 4] )
Returns Nothing.
Converts input word to a string. The output string is right justified and the
remaining positions on the left (if any) are filled with blanks.
Description |Parameters :
- input: word to be converted
- output: destination string
Requires Nothing.
dim t as word
txt as string 4]
Example S
t = 437
WordToStr (t, txt) ' txt is " 437" (two blanks here)
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IntToStr
Prokﬂype sub.procedure IntToStr (dim input as integer, dim byref output as
string] 5]
Returns Nothing.

Converts input integer number to a string. The output string is right justified and
the remaining positions on the left (if any) are filled with blanks.

Description |[Parameters :

- input: integer number to be converted
- output: destination string

Requires Nothing.

dim input as integer
txt as string] 5]

Example

input = -4220
IntToStr (input, txt) ' txt is ' -4220"

LongintToStr

sub procedure LongintToStr (dim input as longint, dim byref output

Prototype |__ stringl 10] )

Returns Nothing.

Converts input longint number to a string. The output string is right justified and
the remaining positions on the left (if any) are filled with blanks.

Description |[Parameters :

- input: longint number to be converted
- output: destination string

Requires Nothing.

dim input as longint
txt as string] 10]

Example

input = -12345678
IntToStr (input, txt) ' txt is ! -12345678"
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LongWordToStr
sub procedure LongWordToStr (dim input as longword, dim byref out-
PrOtOtype put as stringf 9])
Returns Nothing.

Converts input double word number to a string. The output string is right justi-
fied and the remaining positions on the left (if any) are filled with blanks.

Description |Parameters :

- input: double word number to be converted
- output : destination string

Requires Nothing.

dim input as longint
txt as string] 9]

Example

input = 12345678
IntToStr (input, txt) ' txt is ! 12345678"

MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD 481



CHAPTER 6

Libraries mikroBasic PRO for AVR
FloatToStr
sub function FloatToStr (dim input as real, dim byref output as
Prototype stringl 22] )
- 3 if input number is NaN
- 2 if input number is -INF
Returns

- 1 if input number is +INF
- 0 if conversion was successful

Converts a floating point number to a string.
Parameters :

- input: floating point number to be converted
Description |- cutput: destination string

The output string is left justified and null terminated after the last digit.

Note: Given floating point number will be truncated to 7 most significant digits
before conversion.

Requires Nothing.

dim ffl, ff2, ff3 as real
txt as string 22]

ffl = -374.2

Examole F£2 = 123.456789
P ££3 = 0.000001234
FloatToStr (Ff1, txt) ' txt is "-374.2"
FloatToStr (££2, txt) ' txt is "123.4567"
FloatToStr (f£f3, txt) ' txt is "1.234e-06"
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Dec2Bcd
Prototype sub function Dec2Bcd(dim decnum as byte) as byte

Returns Converted BCD value.

Converts input number to its appropriate BCD representation.
Description |Parameters :

- decnum: number to be converted

Requires Nothing.

dim a, b as byte

Example o = 29
b = Dec2Bcd(a) ' b equals 34

Bcd2Dec16

Prototype sub function Bcd2Decl6 (dim bcdnum as word) as word

Returns Converted decimal value.

Converts 16-bit BCD numeral to its decimal equivalent.
Description |Parameters :

- bednum: 16-bit BCD numeral to be converted

Requires Nothing.

dim a, b as word

Example 0x1234 ' a equals 4660

Bcd2Declo6 (a) ' b equals 1234

a
b
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Dec2Bcd16

Prototype sub function Dec2Bcdl6 (dim decnum as word) as word

Returns Converted BCD value.

Converts decimal value to its BCD equivalent.
Description |Parameters :

- decnum decimal number to be converted

Requires Nothing.

dim a, b as word

Example o = 2345

b = Dec2Bcdlo6 (a) ' b equals 9029
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MATH LIBRARY

The mikroBasic PRO for AVR provides a set of library functions for floating point math handling.
See also Predefined Globals and Constants for the list of predefined math constants.

Library Functions

- acos
- asin

- atan
- atan2
- ceill

- COSs

- cosh
- eval_poly
- exp

- fabs
- floor
- frexp
- Idexp
- log
-log10
- modf
- pow
- sin

- sinh

- sqrt

- tan

- tanh

acos

Prototype |sub function acos(dim x as real) as real

The function returns the arc cosine of parameter x; that is, the value whose
Description |cosine is x. The input parameter x must be between -1 and 1 (inclusive). The
return value is in radians, between 0 and 4 (inclusive).

asin

Prototype sub function asin(dim x as real) as real

The function returns the arc sine of parameter x; that is, the value whose sine is
Description |x. The input parameter x must be between -1 and 1 (inclusive). The return value
is in radians, between -n/2 and n/2 (inclusive).
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atan
Prototype sub function atan(dim arg as real) as real
The function computes the arc tangent of parameter arg; that is, the value
Description |whose tangent is arg. The return value is in radians, between -n/2 and n/2
(inclusive).
atan2
Prototype sub function atan2 (dim y as real, dim x as real) as real
This is the two-argument arc tangent function. It is similar to computing the arc
Describtion tangent of y/x, except that the signs of both arguments are used to determine
P the quadrant of the result and x is permitted to be zero. The return value is in
radians, between -nand n (inclusive).
ceil
Prototype sub function ceil (dim x as real) as real
Description [ The function returns value of parameter = rounded up to the next whole number.
cos
Prototype sub function cos(dim arg as real) as real
Description | The function returns the cosine of arg in radians. The return value is from -1 to 1.
cosh
Prototype sub function cosh(dim x as real) as real
e The function returns the hyperbolic cosine of %, defined mathematically as
Description _ . . . .
(e*+e7%) /2. If the value of x is too large (if overflow occurs), the function fails.
eval_poly
Prototype sub fun_ctlon eve%lipoly (dim x as real, dim byref d as arrayf 10] of
real, dim n as integer) as real
.- Function Calculates polynom for number x, with coefficients stored in d 1, for
Description degree n
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exp

Prokﬂype sub function exp(dim x as real) as real

The function returns the value of e — the base of natural logarithms — raised to

Description the power x (i.e. ¢¥).

fabs

Prokﬂype sub function fabs(dim d as real) as real

Description | The function returns the absolute (i.e. positive) value of d.

floor

Prototype sub function floor (dim x as real) as real

Description | The function returns the value of parameter x rounded down to the nearest integer.

frexp

sub function frexp(dim value as real, dim byref eptr as integer)
as real

Prototype

The function splits a floating-point value value into a normalized fraction and an
Description |integral power of 2. The return value is a normalized fraction and the integer
exponent is stored in the object pointed to by eptr.

Idexp
Prototype sub function ldexp(dim value as real, dim newexp as integer) as real
i The function returns the result of multiplying the floating-point number vz1ue by
Description . .
2 raised to the power newexp (i.e. returns value » 20EWexP),
log

Prototype |sub function log(dim x as real) as real

Description | The function returns the natural logarithm of x (i.e. 109, (x)).

log10

Prototype |sub function 1logl0(dim x as real) as real

Description | The function returns the base-10 logarithm of x (i.e. 1og; (x)).
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modf

Prototype sub function modf (dim val as real, dim byref iptr as real) as real

The function returns the signed fractional component of va1, placing its whole

Description number component into the variable pointed to by iptr.

pow
Prototype sub function pow(dim x as real, dim y as real) as real
_ The function returns the value of x raised to the power vy (i.e. xY). If x is nega-
Description | . . ) . . ‘
tive, the function will automatically cast v into 1ongint.
sin

Prototype |sub function sin(dim arg as real) as real

Description | The function returns the sine of arg in radians. The return value is from -1 to 1.

sinh

Prototype sub function sinh(dim x as real) as real

The function returns the hyperbolic sine of x, defined mathematically as (e*-e7%) /2.

Description If the value of x is too large (if overflow occurs), the function fails.

sqrt

Prototype sub function sgrt(dim x as real) as real

Description | The function returns the non negative square root of x.

tan

Prototype sub function tan(dim x as real) as real

The function returns the tangent of = in radians. The return value spans the

Description allowed range of floating point in mikroBasic PRO for AVR.

tanh

Prototype sub function tanh(dim x as real) as real)

The function returns the hyperbolic tangent of =, defined mathematically as

Description | ;1 x)icosh(x).
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STRING LIBRARY

The mikroBasic PRO for AVR includes a library which automatizes string related tasks.

Library Functions

- memchr

- memcmp
- memcpy

- memmove
- memset

- strcat

- strchr

- strcm

p

- strcpy

- strlen

- strncat

- strncpy
- strspn

- strcspn
- strncmp
- strpbrk

- strrchr

- strstr

memchr

Prototype

sub function memchr (dim p as “byte, dim ch as byte, dim n as
word) as word

Description

The function locates the first occurrence of the word ch in the initial n words of
memory area starting at the address p. The function returns the offset of this
occurrence from the memory address p or 0xrrrF if ch was not found.

For the parameter p you can use either a numerical value (literal/variable/con-
stant) indicating memory address or a dereferenced value of an object, for
example @mystring OF @PORTB.
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memcmp

Prototype sub function memcmp (dim pl, p2 as “byte, dim n as word) as integer
yp

The function returns a positive, negative, or zero value indicating the relation-
ship of first n words of memory areas starting at addresses p1 and p2.

This function compares two memory areas starting at addresses 1 and p2 for n
words and returns a value indicating their relationship as follows:

Value Meaning

< 0 pl "less than" p2
Description |= ¢ pl "equal to" p2

> 0 pl "greater than" p2

The value returned by the function is determined by the difference between the
values of the first pair of words that differ in the strings being compared.

For parameters p1 and p2 you can use either a numerical value (literal/vari-
able/constant) indicating memory address or a dereferenced value of an object,
for example @mystring Or GPORTE.

memcpy

roto e su rocedure memcpy (dim pl, p2 as te, im nn as word)
Prototyp b p d di 1 2 Aby di d

The function copies nn words from the memory area starting at the address p2
to the memory area starting at p1. If these memory buffers overlap, the memcpy
function cannot guarantee that words are copied before being overwritten. If

. these buffers do overlap, use the memmove function.

Description
For parameters o1 and p2 you can use either a numerical value (literal/vari-
able/constant) indicating memory address or a dereferenced value of an object,
for example ¢mystring Or GPORTE.

memmove

Prototype sub procedure memmove (dim pl, p2, as “byte, dim nn as word)

The function copies nn words from the memory area starting at the address p2
to the memory area starting at o1. If these memory buffers overlap, the Memmove

function ensures that the words in p2 are copied to p1 before being overwritten.
Description _ _ . _
For parameters p1 and p2 you can use either a numerical value (literal/vari-

able/constant) indicating memory address or a dereferenced value of an object,
for example @mystring Or GPORTE.
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memset
Prokﬂype sub procedure memset (dim p as “byte, dim character as byte, dim n
as word)
The function fills the first n words in the memory area starting at the address p
with the value of word character.
Description . . . .
escriptio For parameter p you can use either a numerical value (literal/variable/constant)
indicating memory address or a dereferenced value of an object, for example
@mystring Or @PORTB.
strcat
Prokﬁype sub procedure strcat (dim byref sl, s2 as stringl 100])
o The function appends the value of string s2 to string s1 and terminates s1 with
Description
a null character.

strchr
Prokﬂype z:bw:zgction strchr (dim byref s as string] 100] , dim ch as byte)
The function searches the string s for the first occurrence of the character ch.
The null character terminating s is not included in the search.
Description
The function returns the position (index) of the first character ch found in s; if no
matching character was found, the function returns 0xrrrr.
strcmp

Prokﬂype sub function strcmp (dim byref sl, s2 as string 100] ) as short

The function lexicographically compares the contents of the strings s1 and s2
and returns a value indicating their relationship:

Value Meaning
.. < 0 sl "less than" s2
Description |_ s1 "equal to" s2
> 0 sl "greater than" s2

The value returned by the function is determined by the difference between the
values of the first pair of words that differ in the strings being compared.
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strcpy

Prototype sub procedure strcpy(dim byref sl, s2 as string{ 100])

The function copies the value of the string s2 to the string s1 and appends a

Description null character to the end of s1.

strcspn

Prototype sub function strcspn(dim byref sl, s2 as string{ 100] ) as word

The function searches the string s1 for any of the characters in the string s2.

The function returns the index of the first character located in s1 that matches
any character in s2. If the first character in s1 matches a character in s2, a
value of 0 is returned. If there are no matching characters in s1, the length of
the string is returned (not including the terminating null character).

Description

strlen

Prototype sub function strlen(dim byref s as stringl 100] ) as word

The function returns the length, in words, of the string s. The length does not

Description include the null terminating character.

strncat

sub procedure strncat (dim byref sl, s2 as stringf 100], dim size

Prototype as byte)

The function appends at most size characters from the string s2 to the string s1
Description |and terminates s1 with a null character. If s2 is shorter than the size charac-
ters, s2 is copied up to and including the null terminating character.
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strncmp
sub function strncmp (dim byref sl, s2 as stringf 100], dim len as
PrOtOtype byte) as short
The function lexicographically compares the first 1en words of the strings s1 and
s2 and returns a value indicating their relationship:
Value Meaning
< 0 sl "less than" s2
Description |= © sl "equal to" s2
> 0 sl "greater than" s2
The value returned by the function is determined by the difference between the
values of the first pair of words that differ in the strings being compared (within
first 1en words).
strncpy
Prototype sub procedure strncpy(dim byref sl, s2 as stringf 100], dim size
as word)
The function copies at most =ize characters from the string =2 to the string s1.
Description |If s2 contains fewer characters than size, s1 is padded out with null characters
up to the total length of the size characters.
strpbrk
Prototype sub function strpbrk(dim byref sl, s2 as string{ 100] ) as word
The function searches s1 for the first occurrence of any character from the
. string s2. The null terminator is not included in the search. The function returns
Description . . . .
an index of the matching character in s1. If s1 contains no characters from s2,
the function returns 0xrrrF.
strrchr
Prototype sub function strrchr (dim byref s as stringl 100] , dim ch as byte)
as word
The function searches the string s for the last occurrence of the character ch.
Describtion The null character terminating s is not included in the search. The function
P returns an index of the last ch found in s; if no matching character was found,
the function returns 0xrrrF.
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strspn

Prototype sub function strspn(dim byref sl, s2 as string{ 100] ) as byte

The function searches the string s1 for characters not found in the s2 string.

The function returns the index of first character located in s1 that does not
match a character in s2. If the first character in s1 does not match a character in
s2, a value of 0 is returned. If all characters in s1 are found in s2, the length of
s1 is returned (not including the terminating null character).

Description

strstr

Prototype sub function strstr(dim byref sl, s2 as stringf 100] ) as word

The function locates the first occurrence of the string s2 in the string s1 (exclud-
ing the terminating null character).

Description The function returns a number indicating the position of the first occurrence of
s2 in s1; if no string was found, the function returns 0xrrrr. If s2 is a null string,
the function returns 0.
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TIME LIBRARY

The Time Library contains functions and type definitions for time calculations in the UNIX time for-
mat which counts the number of seconds since the "epoch". This is very convenient for programs
that work with time intervals: the difference between two UNIX time values is a real-time differ-

ence measured in seconds.

What is the epoch?

Originally it was defined as the beginning of 1970 GMT. ( January 1, 1970 Julian day ) GMT,

Greenwich Mean Time, is a traditional term for the time zone in England.

The TimeStruct type is a structure type suitable for time and date storage.

Library Routines

- Time_dateToEpoch
- Time_epochToDate
- Time_datediff

Time_dateToEpoch

Prototype

sub function Time dateToEpoch(dim byref ts as TimeStruct) as
longint

Returns

Number of seconds since January 1, 1970 0hOOmnQO0s.

Description

This function returns the UNIX time : number of seconds since January 1, 1970
0hO0OmMnOO0s.

Parameters :

- £s: time and date value for calculating UNIX time.

Requires

Nothing.

Example

dim tsl as TimeStruct
Epoch as longint

' what is the epoch of the date in ts ?
epoch = Time dateToEpoch (tsl)
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Time_epochToDate

sub procedure Time epochToDate (dim e as longint, dim byref ts as

PrOtOtype TimeStruct)
Returns Nothing.
Converts the UNIX time to time and date.
i Parameters :
Description
- e: UNIX time (seconds since UNIX epoch)
- ts: time and date structure for storing conversion output
Requires Nothing.
dim ts2 as TimeStruct
epoch as longint
Exan“ﬂe ' what date is epoch 1234567890 ?
epoch = 1234567890
TimegepochToDate(epoch,ts?)
Time_dateDiff
Prototype sub function Time dateDiff (dim tl as “TimeStruct, dim t2 as
yp ~TimeStruct) as longint
Returns Time difference in seconds as a signed long.
This function compares two dates and returns time difference in seconds as a
signed long. The result is positive if -1 is before 2, null if -1 is the same as 2
and negative if 1 is after 2.
Description
P Parameters :
- £1: time and date structure (the first comparison parameter)
- £2: time and date structure (the second comparison parameter)
Requires Nothing.
dim tsl, ts2 as TimeStruct
diff as longint
Exan“ﬂe ' how many seconds between these two dates contained in tsl and

ts2 buffers?
diff Time dateDiff (tsl,

ts2)
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Library Example

Demonstration of Time library routines usage for time calculations in UNIX time format.
program Time Demo

dim epoch, diff as longint

VAR KA AAIAAA KA A AAXAAA KA RN A XA AR A AKX A AR KK

tsl, ts2 as TimeStruct
AR B S B B i I i I i I I b I b b b b b e

main:
tsl.ss 0
tsl.mn = 7

tsl.hh = 17
tsl.md = 23
tsl.mo =
tsl.yy = 2006

Ul

U *

' * What is the epoch of the date in ts ?
*

epoch = Time dateToEpoch (@tsl) ' 1148404020

L. S

' * What date is epoch 1234567890 2

1 *

epoch = 1234567890
Time epochToDate (epoch, @ts2) ' {0x1E, Ox1F, 0x17, 0x0D,
0x04, 0x02, 0x07D9)

[

' * How much seconds between this two dates ?

| *

diff = Time dateDiff (@tsl, @ts2) ' 86163870
end.

TimeStruct type definition

structure TimeStruct

dim ss as byte ' seconds

dim mn as byte ' minutes

dim hh as byte ' hours

dim md as byte ' day in month, from 1 to 31

dim wd as byte ' day in week, monday=0, tuesday=1l, .... sunday=6

dim mo as byte ' month number, from 1 to 12 (and not from O
to 11 as with unix C time !)

dim yy as word ' year Y2K compliant, from 1892 to 2038

end structure
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TRIGONOMETRY LIBRARY

The mikroBasic PRO for AVR implements fundamental trigonometry functions. These functions
are implemented as look-up tables. Trigonometry functions are implemented in integer format in
order to save memory.

Library Routines

- sinE3
- cosE3

sinE3

Prototype sub function sinE3 (dim angle deg as word) as integer

Returns The function returns the sine of input parameter.

The function calculates sine multiplied by 1000 and rounded to the nearest integer:
result = round(sin(angle deg)*1000)

Description |Parameters:

- angle deg: input angle in degrees

Note: Return value range: -1000..1000.

Requires Nothing.

dim res as integer
Example

res = sinE3(45) ' result is 707
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cosEk3
Prokﬂype sub function coskE3(dim angle deg as word) as integer
Returns The function returns the cosine of input parameter.
The function calculates cosine multiplied by 1000 and rounded to the nearest
integer:
result = round(cos(angle deg)*1000)
Description Parameters:
- angle deg: input angle in degrees
Note: Return value range: -1000..1000.
Requires Nothing.
dim res as integer
Example -
res = cosE3(196) ' result is -193
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